
 
 

MetaStock® 
Professional 

For Windows 98 and higher 
 

User's Manual 
Version 8.0 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

All Rights Reserved 
Copyright  1985-2002 

 
Printed in the USA 

Equis International 
3950 South 700 East, First Floor 

Salt Lake City, UT  84107 
http://www.equis.com 



 
 
 
 
 

 

 

 

 

 

Achelis Binary Wave, DataOnDemand, The DownLoader, Expert Advisor, The Explorer, Visual Control, 
QuoteCenter, and Smart Charts are trademarks of Equis International.  Equis, MetaStock, and OptionScope are 
registered trademarks of Equis International.  Reuters is a registered trademark of Reuters Limited.  eSignal is a 
registered trademark of Data Broadcasting Corporation.  IBM is a registered trademark of International Business 
Machines Corporation.  MS-DOS, Microsoft Windows, Microsoft Windows 98, Microsoft Windows NT, Microsoft 
IntelliMouse, Microsoft Office, Microsoft Word, Microsoft Excel, and Paint are registered trademarks of Microsoft 
Corporation.  ODDS is a trademark of Fishback Management & Research Co.  All other product names or services 
mentioned are trademarks or registered trademarks of their respective owners.



 
 
 

 

 

MetaStock Professional Contents •  i 

 

 

 

Contents 

Getting Started...............................................................................................1 
Welcome ....................................................................................................................................1 
What You Need to Run MetaStock Pro .....................................................................................2 
Two Quick Steps for Getting Up to Speed Fast.........................................................................2 
Installing MetaStock Pro............................................................................................................3 
Running MetaStock Pro.............................................................................................................3 
Getting Help...............................................................................................................................4 

The Workplace ...............................................................................................7 
Microsoft Windows Standard Features......................................................................................7 
Using the Menus ......................................................................................................................17 
Using Dialogs ..........................................................................................................................18 
Using the Toolbars...................................................................................................................19 
Using the Status Bar.................................................................................................................27 
HELP!  Using MetaStock Pro’s Help System..........................................................................29 
Changing the Appearance of MetaStock Pro’s Workplace......................................................31 

Collecting Your Data ...................................................................................41 
What is Data?...........................................................................................................................41 
DataOnDemand™....................................................................................................................42 
Collecting Local Real-time Data..............................................................................................43 
End-of-day Data Collection with The DownLoader................................................................58 

Chart Concepts............................................................................................63 
Managing Your Charting .........................................................................................................63 
Opening, Closing and Saving (General) ..................................................................................64 
Special Controls in the New, Open, and Save Dialogs ............................................................70 
Searching for Securities with the Find Command ...................................................................74 
Deleting Chart and Layout Files ..............................................................................................75 

Saving Your Work with Charts ...................................................................77 
What is a Chart?.......................................................................................................................77 
Creating a New Chart...............................................................................................................78 
Displaying Existing Charts ......................................................................................................79 
Saving Charts ...........................................................................................................................81 
Closing Charts..........................................................................................................................82 



 

 
 

ii  • Contents MetaStock Professional 

 

 

 

Scanning Charts with the Change Security Commands...........................................................83 
Scrolling Charts .......................................................................................................................85 
Cloning Charts .........................................................................................................................86 
Using the Microsoft IntelliMouse Pointing Device .................................................................87 

Combining Multiple Charts with Layouts ..................................................89 
What is a Layout? ....................................................................................................................89 
Creating a New Layout ............................................................................................................90 
Displaying an Existing Layout.................................................................................................91 
Scanning Charts in a Layout ....................................................................................................92 
Making Changes to a Layout ...................................................................................................92 
Saving a Layout .......................................................................................................................95 
Closing a Layout ......................................................................................................................96 

Recycling Your Work with Templates........................................................97 
What is a Template?.................................................................................................................97 
Creating a New Template ........................................................................................................97 
Applying an Existing Template ...............................................................................................98 
Making Changes to a Template .............................................................................................101 
Saving a Template..................................................................................................................101 
The Default Template ............................................................................................................102 

Customizing a Chart's Appearance .........................................................103 
Chart Window........................................................................................................................103 
Inner Windows.......................................................................................................................110 
Scales .....................................................................................................................................118 

Printing Charts and Data ..........................................................................133 
Introduction............................................................................................................................133 
Selecting and Configuring Your Printer ................................................................................133 
Customizing the Printout with Page Setup.............................................................................134 
Previewing Charts Before Printing ........................................................................................137 
Printing Charts and Data........................................................................................................138 

Working with Price Plots ..........................................................................143 
Introduction............................................................................................................................143 
Base Security Concept ...........................................................................................................143 
Types of Price Plots ...............................................................................................................144 
Modifying a Price Plot ...........................................................................................................146 
Updating and Editing a Price Plot's Data ...............................................................................152 
Copying, Deleting, and Moving Price Plots ..........................................................................153 
Inserting Price Plots ...............................................................................................................158 
Viewing Values on the Chart .................................................................................................158 

Working with Indicators............................................................................163 



 
 
 

 

 

MetaStock Professional Contents •  iii 

 

 

 

What is an Indicator? .............................................................................................................163 
Plotting an Indicator...............................................................................................................163 
Modifying an Indicator ..........................................................................................................167 
Copying, Deleting, and Moving Indicators............................................................................172 
Viewing Indicator Values with the Data Window .................................................................174 
Online Indicator Interpretation ..............................................................................................174 
Indicator Parameters ..............................................................................................................174 

Working with Line Studies........................................................................205 
What is a Line Study? ............................................................................................................205 
Drawing a Line Study ............................................................................................................205 
Modifying a Line Study .........................................................................................................208 
Adjusting, Copying, Deleting, and Moving Line Studies......................................................211 
Line Study Parameters ...........................................................................................................215 

Working with the Internet .........................................................................227 
Internet Integration.................................................................................................................227 
Collecting Data through the Internet......................................................................................228 
Updating MetaStock Pro........................................................................................................228 
E-mailing Charts with the Send Command............................................................................228 
Saving Charts as HTML ........................................................................................................228 
Internet Shortcut Menus.........................................................................................................229 
Equis on the Web...................................................................................................................234 

The MetaStock Formula Language ..........................................................235 
What is the MetaStock Formula Language? ..........................................................................235 
Price Array Identifiers............................................................................................................235 
Mathematical Operators .........................................................................................................236 
Operator Precedence ..............................................................................................................236 
Formula Functions .................................................................................................................237 
Function Parameters...............................................................................................................238 
Locating Errors in Formulas ..................................................................................................238 
Inserting Functions ................................................................................................................239 
Writing Comments.................................................................................................................240 
Nesting Functions ..................................................................................................................240 
The if() function.....................................................................................................................241 
Using "And" and "Or" Operators...........................................................................................241 
Referencing Existing Custom Indicators ...............................................................................242 
Referencing Securities with the Security Data Function .......................................................243 
Using Variables to Enhance and Simplify .............................................................................244 
Self Referencing Formulas Using PREV...............................................................................246 
The “P” Data Array Identifier................................................................................................247 
Formula Tips..........................................................................................................................248 
Using the Formula Organizer to Import and Export ..............................................................249 
Glossary .................................................................................................................................249 
Error Messages ......................................................................................................................251 
Functions................................................................................................................................252 



 

 
 

iv  • Contents MetaStock Professional 

 

 

 

Creating Your Own Indicators..................................................................299 
What is the Indicator Builder? ...............................................................................................299 
Indicator Builder Tutorial ......................................................................................................300 
Indicator Builder Dialog ........................................................................................................302 
Indicator Editor Dialog ..........................................................................................................303 
Copying and Deleting Custom Indicators ..............................................................................304 
Printing Custom Indicators ....................................................................................................304 
Pasting Functions Into Formulas............................................................................................305 
Creating Custom Indicators with Multiple Plots....................................................................306 
Creating Custom Indicators that Prompt for Input.................................................................306 
Sample Custom Indicators .....................................................................................................308 
Achelis Binary Waves............................................................................................................312 
Errors .....................................................................................................................................316 

Testing Your Trading Ideas ......................................................................319 
What is a System Test? ..........................................................................................................319 
Enhanced System Tester Tutorial ..........................................................................................320 
The Enhanced System Tester .................................................................................................327 
Creating a System Test ..........................................................................................................331 
The System Editor..................................................................................................................331 
Copying and Deleting System Tests ......................................................................................337 
Testing Systems .....................................................................................................................338 
The Test View Screen............................................................................................................343 
The Results Detail View Dialog ............................................................................................345 
Optimization ..........................................................................................................................356 
System Development Tips .....................................................................................................359 
Technical Reference...............................................................................................................362 
Trading Rule Syntax ..............................................................................................................365 

Ranking and Screening Securities...........................................................369 
What is The Explorer? ...........................................................................................................369 
The Explorer Tutorial ............................................................................................................370 
The Explorer Dialog ..............................................................................................................377 
Creating an Exploration .........................................................................................................379 
Copying and Deleting Explorations.......................................................................................384 
Printing Explorations .............................................................................................................384 
Running the Exploration ........................................................................................................385 
Viewing the Reports ..............................................................................................................388 
Sample Explorations ..............................................................................................................393 
Exploration Tips ....................................................................................................................395 

Getting Expert Advice on Your Securities ..............................................397 
What is the Expert Advisor? ..................................................................................................397 
Using Pre-packaged Experts ..................................................................................................398 
Expert Advisor Dialog ...........................................................................................................399 
Creating an Expert .................................................................................................................400 



 
 
 

 

 

MetaStock Professional Contents •  v 

 

 

 

Components of an Expert.......................................................................................................402 
Defining Bullish and Bearish Trends.....................................................................................403 
Writing Commentaries to Summarize and Instruct................................................................406 
Using Highlights to Emphasize Specified Conditions ...........................................................421 
Using Symbols to Identify Key Points on Charts ..................................................................425 
Using Alerts to Grab Your Attention.....................................................................................430 
Attaching an Expert to a Chart...............................................................................................435 
Copying and Deleting Experts ...............................................................................................436 
Printing Experts .....................................................................................................................436 
Pre-packaged Experts.............................................................................................................437 
Input() Function, Variables, and Multi-plot Indicators..........................................................437 
Expert Advisor Tips...............................................................................................................438 
Execution Errors in an Expert................................................................................................439 

Interpretation of Indicators and Line Studies .........................................441 
Indicator Guide ......................................................................................................................441 
Accumulation/Distribution.....................................................................................................446 
Accumulation Swing Index....................................................................................................446 
Andrews' Pitchfork ................................................................................................................447 
Aroon .....................................................................................................................................447 
Average True Range ..............................................................................................................448 
Bollinger Bands .....................................................................................................................449 
Candlesticks, Japanese...........................................................................................................450 
Candlevolume ........................................................................................................................451 
Chaikin A/D Oscillator ..........................................................................................................451 
Chaikin Money Flow .............................................................................................................453 
Chande Momentum Oscillator ...............................................................................................454 
Commodity Channel Index ....................................................................................................456 
Commodity Selection Index...................................................................................................456 
Correlation .............................................................................................................................457 
Cycle Lines ............................................................................................................................458 
DEMA....................................................................................................................................459 
Demand Index........................................................................................................................459 
Detrended Price Oscillator .....................................................................................................460 
Directional Movement ...........................................................................................................461 
Dynamic Momentum Index ...................................................................................................462 
Ease of Movement .................................................................................................................463 
Envelope ................................................................................................................................464 
Equivolume............................................................................................................................464 
Fibonacci Studies ...................................................................................................................465 
Forecast Oscillator .................................................................................................................467 
Fourier Transform..................................................................................................................467 
Gann Studies ..........................................................................................................................468 
Herrick Payoff Index .............................................................................................................470 
High/Low/Close Bar ..............................................................................................................470 
Inertia .....................................................................................................................................471 
Intraday Momentum Index.....................................................................................................472 
Kagi........................................................................................................................................472 



 

 
 

vi  • Contents MetaStock Professional 

 

 

 

Klinger Oscillator...................................................................................................................473 
Line Chart ..............................................................................................................................475 
Linear Regression Indicator ...................................................................................................475 
Linear Regression Slope ........................................................................................................476 
Linear Regression Trendline..................................................................................................477 
MACD ...................................................................................................................................478 
Market Facilitation Index.......................................................................................................479 
Mass Index.............................................................................................................................480 
Median Price ..........................................................................................................................481 
MESA Sine Wave..................................................................................................................482 
Momentum.............................................................................................................................482 
Money Flow Index.................................................................................................................483 
Moving Averages...................................................................................................................484 
Negative Volume Index .........................................................................................................489 
ODDS Probability Cones.......................................................................................................490 
On Balance Volume...............................................................................................................492 
Open Interest..........................................................................................................................494 
Option Indicators ...................................................................................................................494 
Parabolic SAR........................................................................................................................496 
Performance ...........................................................................................................................497 
Point & Figure .......................................................................................................................497 
Polarized Fractal Efficiency...................................................................................................498 
Positive Volume Index...........................................................................................................499 
Price Channel .........................................................................................................................500 
Price Oscillator.......................................................................................................................501 
Price Rate-Of-Change............................................................................................................501 
Price Volume Trend...............................................................................................................502 
Projection Bands ....................................................................................................................503 
Projection Oscillator ..............................................................................................................504 
Qstick Indicator......................................................................................................................505 
Quadrant Lines.......................................................................................................................506 
r-squared ................................................................................................................................506 
Raff Regression Channel .......................................................................................................508 
Random Walk Index ..............................................................................................................508 
Range Indicator......................................................................................................................509 
Relative Momentum Index.....................................................................................................510 
Relative Strength Comparative ..............................................................................................511 
Relative Strength Index..........................................................................................................512 
Relative Volatility Index........................................................................................................513 
Renko .....................................................................................................................................514 
Speed Resistance Lines..........................................................................................................515 
Spread ....................................................................................................................................515 
Standard Deviation.................................................................................................................516 
Standard Deviation Channel ..................................................................................................517 
Standard Error........................................................................................................................518 
Standard Error Bands.............................................................................................................518 
Standard Error Channel..........................................................................................................519 
Stochastic Momentum Index .................................................................................................520 
Stochastic Oscillator ..............................................................................................................521 



 
 
 

 

 

MetaStock Professional Contents •  vii 

 

 

 

Support and Resistance Levels ..............................................................................................523 
Swing Index ...........................................................................................................................524 
TEMA ....................................................................................................................................525 
Three Line Break ...................................................................................................................526 
Time Series Forecast..............................................................................................................527 
Tirone Levels .........................................................................................................................528 
Trade Volume Index ..............................................................................................................528 
Trendlines ..............................................................................................................................529 
TRIX ......................................................................................................................................531 
Typical Price ..........................................................................................................................532 
Ultimate Oscillator.................................................................................................................532 
Vertical Horizontal Filter .......................................................................................................533 
Volatility, Chaikin's ...............................................................................................................533 
Volume...................................................................................................................................534 
Volume Oscillator ..................................................................................................................535 
Volume Rate-Of-Change .......................................................................................................536 
Weighted Close......................................................................................................................537 
Wilder's Smoothing................................................................................................................537 
Williams' %R .........................................................................................................................538 
Williams' Accumulation/Distribution ....................................................................................539 
Zig Zag...................................................................................................................................539 

Appendices ................................................................................................541 
Information About Your Computer System...........................................................................541 
Installing and Using MetaStock Pro on a Network................................................................541 
Converting Custom Formulas, System Tests, Explorations, and Experts..............................542 
Program Performance ............................................................................................................543 
Using OptionScope ................................................................................................................543 
Suggested Reading.................................................................................................................544 

Index ...........................................................................................................547 
 





 

 
 

MetaStock Professional Getting Started • 1 

 

 

 

Getting Started 

Welcome  
When you need to make an investment decision, the last thing you want 
is to have your computer get in the way.  Technology should help you 
reach a decision, not hinder you. 
Which is why MetaStock Professional is based on visual investing. 
Visual investing lets your eyes operate the software, freeing your mind to 
concentrate on more important matters--like your trades. 
Visual investing is made possible through object orientation.  Simply put, 
“object orientation” means that the commands for objects are contained 
within the objects themselves.  Rather than having to search a maze of 
menus and toolbars, you access commands directly from the objects. 
To use MetaStock Professional, you only need to know two commands: 
• Right-click on everything.  The object will display a menu of its 

commands. 
• Drag and drop everything.  The on-screen animation of line studies 

and the fluid manner in which you can move indicators, prices, and 
inner windows greatly simplify the interface while helping you see 
investment opportunities. 

By mastering these two commands, you will be positioned to make better 
trades using MetaStock Professional’s extensive collection of analysis 
tools. 
Thank you for using MetaStock Professional. 



 

 
 

2 • Getting Started MetaStock Professional 

 

 

 

What You Need to Run MetaStock Pro 

Minimum Configuration 
• Microsoft Windows 98 (or higher) 
• Pentium 166 MHz 
• 32 megabytes of RAM 
• 50 megabytes of free hard disk space  

Minimum Configuration for Real-time Data 
Collection 
• Microsoft Windows 98 (or higher) 
• Pentium 233 MHz 
• 64 megabytes of RAM  
• 50 megabytes of free hard disk space for installation.  An additional 

100 megabytes for real-time data. 
• A real-time data feed compatible with MetaStock Pro (e.g., DBC 

Signal, etc.) 

Recommended Configuration 
• Microsoft Windows 98 (or higher) 
• Pentium 233 MHz (or faster) 
• 128 megabytes of RAM 
• 50 megabytes of free hard disk space for installation.  An additional 

200 megabytes (or more) for real-time data. 
• A real-time data feed compatible with MetaStock Pro (e.g., DBC 

Signal, etc.) 
Detailed information about your computer system is available from the 
About MetaStock command in the Help menu (see page 541). 

Two Quick Steps for Getting Up to Speed Fast 
The following steps will help you get up to speed as fast as possible.  

Ten Steps to Productivity  
The Ten Steps to Productivity, found in your Getting Started manual, are 
a quick and easy way to immediately begin using MetaStock Pro.  They 
provide clear, illustrated, step-by-step instructions for getting around 
MetaStock Pro's visually oriented interface.  It only takes 30 to 45 
minutes to go through these steps. 
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The Quickstart Tutorials 

 
Quickstart button 

The Quickstart Tutorials are on-screen tutorials of MetaStock Pro.  
Choose Quickstart Tutorials from the Help menu, or the Quickstart 
button wherever it appears in Help. 

Installing MetaStock Pro 
To install MetaStock Pro from a CD  
1. Insert the Program CD into your drive.  The setup program should 

start automatically. 
 
If the auto-run feature of Windows isn't enabled on your system, click 
the Start button and choose the Run command.  Type 
"D:\SETUP.EXE" in the Open box and click the OK button.   (Note 
that "D" represents the letter assigned to your CD-ROM drive.  If 
your drive is assigned a different letter, use it instead of  "D".) 

2. Follow the on-screen instructions.  You will be prompted to enter a 
Setup Key.  Your Setup Key is found on the back of the CD case. 

To remove (uninstall) MetaStock Pro from your hard 
disk  
1. Choose Settings from the Windows Start menu. 
2. Choose Control Panel. 
3. Choose Add/Remove Programs. 
4. Choose MetaStock Professional and click the Add/Remove button. 

Running MetaStock Pro 
Important:  Before your charts can receive real-time updates, you must 
be certain that the software supplied by your real-time data vendor is 
installed and operating correctly.  For more information, see your Getting 
Started manual. 

To run MetaStock Pro 
1. Choose Programs from the Start menu. 

 
MetaStock icon 

2. Choose the Equis International folder. 
3. Choose MetaStock Professional. 

Tip of the Day 
Every time you run MetaStock Pro you can see a MetaStock Pro tip to 
help you use MetaStock Pro more productively.  You can display the Tip 
of the Day dialog at any time by choosing Tip of the Day from the Help 
menu.  You can control the complexity of tips with the Options button. 
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Getting Help 
Equis International stands ready to help you with problems you may 
encounter or questions you may have with the operation of MetaStock 
Pro.  However, before picking up the phone, please consider using some 
of Equis' other support alternatives. 

Windows Related Problems 
If the problem is related to the Windows operating environment, please 
contact Microsoft via the Internet at 
http://www.microsoft.com/support. 
 

User's Manual 
The first place to check when you have a question about the operation of 
MetaStock Pro is in the user's manual (or help system).  The manual can 
be a great help if you run into a snag.  We have tried to provide every 
answer you will need to operate your software in the pages of your 
manual.  For immediate answers to most of your questions, please consult 
the manual. 

Context Sensitive Help 

 
Help button 

Every dialog in MetaStock Pro contains a Help button.  Click the mouse 
on a Help button and MetaStock Pro will display a detailed help screen 
about the dialog or feature.  In fact, almost all the information contained in 
the manual is just a mouse click away.  Many of the help screens provide 
step-by-step examples of how to accomplish a task.   
MetaStock Pro's help system can also be accessed by simply pressing the 
F1 key. 

Quickstart Tutorials 

 
Quickstart Button 

Some help topics have a Quickstart Tutorial associated with them. Click 
the Quickstart button to start the tutorial for that help topic. 

Equis Web Site 
You may also want to check out our web site on the Internet at 
http://www.equis.com.  Not only do we offer information about our 
products, we also offer valuable free services and information. 

Equis User Groups 
Equis has users all over the world.  In many of these areas, user groups 
have formed.  Contact Equis to find out if there is an Equis user group in 
your area.  Not only is this a great way to meet people with similar 
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interests, these clubs also offer a wealth of information and help not 
available elsewhere. 

Contact Technical Support 
If the problem or question relates to data or your data vendor, please 
contact your data vendor's technical support. 
If you've checked the manual and still cannot find the answer to your 
problem or question, Equis has a full staff of technical support 
representatives ready to help you.   
Please try to call us by phone only if the situation is urgent and you need 
an immediate answer.  This will ensure that lines are free when you and 
others have an urgent matter. 
There are several ways to reach our support staff: 
By E-mail 
support@equis.com 
By Fax 
801-265-2114 
By Mail 
Equis International 
Technical Support Dept. 
3950 South 700 East, Suite 100 
Salt Lake City, UT  84107 
By Phone 
801-265-9998 (8:00 AM to 5:00 PM Mountain Standard Time except 
Wednesdays, 9:00 AM to 5:00 PM) 
When calling technical support the first time, you will be provided with a 
customer number.  Please write it here for future reference. 
Customer # ________________________ 
When you call technical support, it is helpful if you can provide your 
version number and build date.  This information is displayed by 
choosing About MetaStock from the Help menu. 
Due to the inherent complexity in the design and creation of custom 
indicators, explorations, system tests, and experts,  Equis cannot 
provide free support for these tools.  However, support is available for a 
reasonable fee.  Call Equis at 801-265-9998 for details or fill-out the 
FORMULA HELP.DOC file found in the MetaStock folder.  This file is 
viewable with Wordpad.  
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The Workplace 

Microsoft Windows Standard Features 
This section explains the commands in MetaStock Pro that are standard 
to Microsoft Windows. 

Recent File List 
The four most recently opened or closed charts, Smart Charts, or layouts 
are displayed at the bottom of the File menu. 

 
To open one, you can either click it with the mouse, highlight it and press 
ENTER, or choose the number (with the File menu displayed) that 
corresponds to the one you want to open. 
An expanded list of your most recently opened items is available in the 
Open dialog by choosing the History shortcut (see page 67). 
You can also create a list of favorite charts, Smart Charts, layouts, and 
folders which is accessed in the Open dialog by choosing the Favorites 
shortcut (see page 67). 
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Exiting MetaStock Pro 
 
 
 

 
Close button 

Choose Exit from the File menu to exit MetaStock Pro.  If any of your 
open charts or layouts have been changed, you will be asked if you want 
to save them prior to exiting.  Smart Charts will be saved automatically. 
You can also exit MetaStock Pro by clicking the close button in the 
upper-right corner of the screen. 

 

To exit MetaStock Pro 
1. Choose Exit from the File menu. 
2. Save any open charts or layouts when prompted. 

Undo, Redo 

 
Undo button 

Choose Undo and Redo from the Edit menu or toolbar.  Use the Undo 
command to cancel the most recent command or action completed.  The 
Undo command is useful if you've deleted something by accident or if you 
don't like the results of your last action.  Choose the Undo command to 
return to the condition prior to your last action. 
If nothing is available to "undo," the command is disabled. 
Use the Redo command to cancel the results of the most recent Undo 
command.  The Redo command restores the command or action you 
undid. 
If nothing is available to "redo," the command is disabled. 

Cut, Copy, Paste 

 
Cut button 

Choose the Cut, Copy, and Paste commands from the Edit menu.  Use the 
Cut command to move the selected object's data (i.e.,  price values, 
indicator values, or moving average values) to the Windows clipboard.  
You can then transfer the clipboard information to another Windows 
application (such as a word processor or spreadsheet) using the Paste 
command.  For information on creating OLE links using these commands 
see page 9. 
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Copy button 

The Copy command is used to copy the selected chart or the selected 
object's data (e.g., price values, indicator values, etc.) to the Windows 
clipboard.  You can then transfer the clipboard information to another 
Windows application (such as a word processor or spreadsheet) using the 
Paste command. 
You can also press CTRL+SHIFT+Print Scrn to copy a chart to the clipboard. 

 
Paste button 

The Paste command is used to transfer the information in the Windows 
clipboard to the insertion point of the current window. 

See your Windows User's Manual for additional information concerning 
the Cut, Copy, and Paste commands. 

To copy indicator or price values to a Windows 
spreadsheet 
1. Display the desired indicator or security plot. 
2. Select the plot by clicking the left mouse button anywhere on the 

indicator or price plot.  Small black handles will appear on the plot to 
show that it is selected. 

3. Choose Copy from the Edit menu. 
4. Open (or switch to) your spreadsheet. 
5. Click on the cell you wish to copy the plot's data to. 
6. Choose Paste from the spreadsheet's Edit menu. 

To copy a chart to a Windows word processor document 
1. Display the desired chart in MetaStock Pro. 
2. Select the chart by clicking anywhere on the chart's background.  

Make sure you have not selected an individual object within the 
chart.  You should also make sure that the chart is not maximized; 
otherwise the toolbar will be included. 

3. Choose Copy from the Edit menu. 
4. Open (or switch to) your word processor document. 
5. Position the cursor at the desired location within the document. 
6. Choose Paste from the word processor's Edit menu. 

Creating OLE links 
One of the great features found in many programs designed for Windows 
98 or NT 4.0 is the ability to create links between programs using OLE 
(object linking and embedding).  For example, you could create an OLE 
link between MetaStock Pro and Excel.  Data that exists in the Excel 
spreadsheet could be plotted in MetaStock Pro.  If the data changes in 
Excel, the changes will also be made in MetaStock Pro because of the 
OLE link.  (Note that Excel 7.0 can only handle a Paste Link of about 
1,000 records.  Excel 97 doesn't have this limitation). 
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OLE links are created by copying data from one OLE compatible 
Windows application and then pasting it (using the Paste Special 
command in the Edit menu) to the other application.  The following 
illustration shows the Paste Special dialog found in Microsoft Excel 
(typical of others). 

 
When using the Paste Special dialog, be sure to look at the helpful 
messages at the bottom of the dialog.  These instructions will guide you 
through the process of creating the link. 
If you right click on an indicator in MetaStock Pro that has been paste 
linked from another application (i.e., Excel, Lotus 123, etc.), two options 
appear in the shortcut menu—Update Link and Open Link. 
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Use the Update Link command to refresh the indicator in MetaStock Pro 
with the data from the server application (i.e., Excel, Lotus 123, etc.).  
Choose Open Link to open the server application so that you can edit the 
data in the server application. 
Note that links to a real-time chart in MetaStock Pro can adversely affect 
MetaStock Pro's performance, especially if intense calculations are 
involved.  A warning message appears if you attempt to create an OLE 
link to a real-time chart. 

To create an OLE link between an indicator in a 
MetaStock Pro chart and an Excel spreadsheet 
1. Display the desired chart and indicator in MetaStock Pro. 
2. Right-click on the indicator plot and choose Copy from the shortcut 

menu.  Note that you could also copy the security's prices instead of 
the indicator (if desired). 

3. Open (or switch to) your spreadsheet. 
4. Position the cursor at the desired location within the spreadsheet. 
5. Right-click on the cell and choose Paste Special from the shortcut 

menu.   
6. Choose the Paste Link radio button and choose Csv from the list.  

Click OK.  Csv stands for "comma separated values."   

 
(Note that Excel 7.0 and earlier can only handle a Paste Link of about 
1,000 records.  Excel 97 doesn't have this limitation). 
The link has now been created.  If changes are made to the indicator in 
MetaStock Pro (e.g., different number of time periods, etc.) the changes 
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will automatically be reflected in the spreadsheet—even if the 
spreadsheet is not open. 

To link data in an Excel spreadsheet to MetaStock Pro  
At this point you can perform further calculations on the indicator values 
in Excel if desired.  Once these new values are calculated, they can be 
linked back to MetaStock Pro and plotted in a new inner window by 
doing the following: 
1. Select the entire column of newly calculated values in the spreadsheet 

by clicking on the column heading. 
2. Right-click on the selected column and choose Copy from the 

shortcut menu.  In the illustration below, columns A and B are the 
values linked from MetaStock Pro.  Column D is the newly 
calculated values that will be linked back to MetaStock Pro. 

 
3. Switch back to MetaStock Pro. 
4. Choose New Inner Window from the Window menu to open a new 

inner window in the chart. 
5. Right-click on the new inner window and choose Paste Special from 

the shortcut menu. 
6. Choose the Paste Link radio button and choose Csv from the list.  

Click OK. 

To link a chart in MetaStock Pro to a Word document  
Now to really exploit the power of OLE, you could create a third link 
between the MetaStock Pro chart and your Word document. 
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1. Right-click on the chart and choose Copy from the shortcut menu. 

 

2. Open (or switch to) your Word document. 

3. Position the cursor at the desired location within the document. 
4. Choose Paste Special from Word’s Edit menu.   
5. Choose the Paste Link radio button and choose MetaStock Pro 

Chart Object from the list.  Click OK. 
6. Switch back to MetaStock Pro and draw a trendline on the chart.  

Watch the chart in Word as the trendline magically appears through 
the power of OLE. 

Now whenever you change the parameters (e.g., the number of periods in 
a moving average) in the original indicator within MetaStock Pro, the 
spreadsheet will automatically reflect the changes.  The spreadsheet will 
then perform the additional calculations and plot the results in the new 
inner window back in MetaStock Pro.  The chart in the Word document 
will also be updated.  And what’s more, MetaStock Pro’s Smart Chart 
feature keeps the OLE links.  So the next time you load the chart, all of 
the above steps and calculations will be performed seamlessly.  

OLE Tips 
• To insure proper date alignment when creating a link from an Excel 

spreadsheet to a MetaStock Pro chart, you can copy the Date column 
along with the data values. 
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"Not" sign 

• You can drag and drop an indicator or price plot from MetaStock Pro 
to a spreadsheet.  Before dropping the plot into the spreadsheet, 
however, make sure that the "not" sign next to the mouse pointer has 
disappeared  (This may take a moment, depending on the speed of 
your computer and the amount of data). 

• The faster your computer and the more memory it has, the better 
OLE links will perform. 

• When creating a link from a spreadsheet to MetaStock Pro, the text 
in the top cell of the column is automatically displayed in the inner 
window title bar. 

• When using the Paste Special dialog, look at the information at the 
bottom of the dialog if you need help. 

• You don't have to have all the applications open in order for the OLE 
links to remain up-to-date.  Once an OLE link is established the 
exchanging of information occurs seamlessly in the background. 

Delete 
Choose the Delete command from the Edit menu to delete the selected 
object.  For example, if you want to delete a moving average, select the 
moving average, and choose Delete.  The Delete command is also 
available from an object's shortcut menu. 
If you have the "Confirm Deletion of Objects" option enabled in the 
Applications Properties dialog (see page 32), a dialog will appear after 
you choose Delete prompting you to confirm the deletion. 
See page 157 for more information on deleting price plots.  See page 173 
for more information on deleting indicators.  See page 214 for more 
information on deleting line studies. 

To delete an object from a chart  
1. Right-click on the desired object (i.e., line study, indicator, or price 

plot). 
2. Choose Delete from the object's shortcut menu. 

System Menus 
 

 
System box 

The upper-left corner of every window contains a square box called the 
system box.  The application window, the chart windows, and even the 
charts' inner windows have a system box.  Click the system box to display 
the window's system menu. 
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The System menu contains commands to move, resize, and close the 
window.  The Next command in a chart window's system menu is used to 
switch to the next open chart.  

Windowing Commands 
The Tile, Cascade, and Arrange Icons commands in the Windows menu 
are common to most Windows applications.  The Stack and Column 
commands are unique to MetaStock Pro. 

 
Cascade button 

The Cascade command arranges the open chart windows alphabetically in 
an overlapping formation so that only the title bars of all but the front chart 
are visible.  

 
Column button 

The Column command arranges the open chart windows alphabetically 
from left to right in vertical columns alphabetically so that all are 
completely visible on the screen. 

 
Stack button 

The Stack command arranges the open chart windows alphabetically so 
that the charts are stacked on top of each other and are fully visible.  
Arranging them in a stacked formation allows you to easily compare charts 
across their date axes.   

 
Tile button 

The Tile command arranges the open chart windows alphabetically from 
left to right and top to bottom so that all are completely visible on the 
screen. 

 The Arrange Icons command arranges all chart icons at the bottom of 
MetaStock Pro's workspace.   
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Restore / Minimize 
Maximize / Close buttons 

All windows, including the  MetaStock Pro application window, can be 
minimized by clicking on the minimize button, or maximized by clicking 
on the maximize button, in the top right corner of the chart. 
To restore a minimized or maximized window to it's previous position, 
click on the Restore button. 
An inner window is a window within a chart window that can be 
controlled within the confines of the chart window.  A chart can contain 
up to 10 inner windows. The most common reason for opening an inner 
window is to plot an indicator.  However, price plots are also contained 
within an inner window.   
The Arrange Inner Windows command is available from the Chart 
shortcut menu by right-clicking on an inner window.  You can also 
choose Arrange Inner Windows from the Window menu.  The Arrange 
Inner Windows command resizes the inner windows within a chart so 
they are equally sized. 
Any window can be closed by clicking on the Close button. 

Open Windows List 
The bottom section of the Window menu lists the names of each of the 
open charts (or layouts) in the order in which they were opened.  A check 
mark designates the currently selected chart.  

 
To switch between charts using the Window menu,  click on the desired 
name.  You can also switch by simply clicking directly on the desired 
chart in the MetaStock Pro workspace.  The selected chart has a unique 
heading background color. 
For more information see page 103. 
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Accessibility Options 
MetaStock supports all of the Accessibility Options found in your 
Windows Control Panel.  These options allow you to customize windows 
to suit varying eyesight, hearing, and motor skills without requiring any 
additional expenditure on software or hardware.  Refer to your Windows 
Help system for more information on using these options. 

To adjust the Accessibility Options on your computer 
system 
1. Click the Windows Start button. 
2. Choose Control Panel from the Settings menu. 
3. Double-click the Accessibility Options icon. 
If the Accessibility Options icon is not displayed in your Control Panel, 
you will need to install it using Windows Setup.  Choose Add/Remove 
Programs from the Control Panel to access Windows Setup. 

Help  
The Help menu provides three different ways to access MetaStock Pro’s 
help system.  For more information on using the help system, see page 29. 

 
For information on contacting Equis technical support, see page 5. 

Using the Menus 
MetaStock Pro's menu organization, and many other program features, 
are similar to Microsoft Office applications.  Notice the similarities 
between MetaStock Pro's and Word's menu bars. 
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Many of the menu commands can be accessed with special keystroke 
combinations called "accelerator keys."  For example, instead of 
choosing System Tester from the Tools menu, you could press the 
accelerator key CTRL+T.  If a command has an accelerator key, it is shown 
in the menu next to the command.  Many menu items also have a picture 
displayed next to them.  Choose this same icon from a toolbar to access 
the command without using the menus. 

 

 

To select a command using the menus 
1. Click the left mouse button once directly on the menu item (i.e., File, 

Edit, View, etc.).   
2. When the menu drops down, click once on the desired command. 

Using Dialogs 
After you choose a command, a dialog often appears.  A dialog is used to 
select options pertaining to the command or feature.  If an option in a 
dialog is dimmed, this means the option is not available. 
Some dialogs provide various sets of options.  These sets of options are 
divided into tabbed pages.  For example, the System Testing Options 
dialog has two tabs: Testing and Reporting.  Click on the tab to display 
the page's options. 
The System Testing Options dialog is a good example of the various 
controls within a dialog. 
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Restoring Factory Defaults 
The Defaults button in a dialog sets the options in the dialog to the 
original default settings as they were shipped.  Every Properties dialog in 
MetaStock Pro contains a Defaults button.  When the Defaults button is 
clicked, the Defaults dialog appears. 

 

 Using the Toolbars 
The tools on the toolbars give you quick access to many of the commonly 
used commands and features in MetaStock Pro. 
To find out the name of a tool, hold the mouse pointer motionless over 
the tool for about a second and a ScreenTip will appear showing the 
name of the tool. 
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The status bar also provides a brief description of the tool on which the 
mouse is positioned (see page 27). 

To select a command using the toolbar 
1. Position the mouse over the desired button. 
2. Click the left mouse button once. 

Displaying/Removing Toolbars 
You can control which toolbars appear by choosing Toolbars from the 
View menu.   

 
You can control the color, size, and ScreenTip display with the 
checkboxes at the bottom of the Toolbars dialog. 
You can also right-click on any toolbar and check/uncheck the desired 
toolbars from the shortcut menu. 

 
Note that you can choose to have separately displayed toolbars for each 
of the groups of line studies (i.e., Trendline, Gann, and Text).  Or you 
can just choose the Line Studies toolbar.  The Line Studies toolbar 
contains rotator arrows that allow you to rotate between the three groups 
of line studies. 
Some people like to remove the toolbars to provide more space for charts.   
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Custom Toolbar 
The custom toolbar provides shortcut buttons to your favorite charts, 
layouts, templates, and even other documents and programs.   
To display the custom toolbar, choose Toolbars from the View menu, 
then choose Custom.  

 

You can also right click on any toolbar and choose Custom from the 
shortcut menu to display the Custom toolbar. 
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To edit the items shown on the custom toolbar, choose Toolbars from the 
View menu, then choose Custom Toolbar Properties, or right click on the 
custom toolbar and choose Custom Toolbar Properties from the shortcut 
menu.  The Customize dialog will appear from which you can edit, 
delete, and create new custom shortcut buttons. 

 
To change the path, icon, or screen tip for an existing shortcut, select the 
item, then choose Edit.   
To change the order in which the icons are displayed, use the arrows 
displayed to the right of the shortcut list. 
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To add a new item to the toolbar, choose New.  The Create Button dialog 
will appear.   

 
Click the Browse button to navigate to the item you are adding.  This can 
be a chart, layout, template, document, application, URL, etc.  If you 
choose a document, the application used to edit that type of document will 
start when you click on that shortcut.  If you know the path to the item you 
are adding, you may simply type the path in the box (ie. c:\program 
files\equis\metastock\charts\colorful.mwt).  After you have selected the 
item or typed the path, click Next. The Select An Icon dialog will appear. 

 
Select an icon for this button.  Choose an icon to represent this item 
on the toolbar.  The first selection is the icon windows uses for this file. 
Enter the screen tip for this button.  Type a label for this button 
that will appear when you hold the mouse pointer over it. 
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Enter the status bar prompt for this button.  Type a label for this 
button that will appear in the status bar when you hold the mouse pointer 
over it. 
 

To add an item to the custom toolbar: 
1. Choose Toolbars from the View menu, then choose Custom 

Toolbar Properties, or right click on the Custom toolbar and choose 
Custom Toolbar Properties from the shortcut menu. 

2. Click the New button. 
3. Click the Browse button and navigate to the item you are adding, or 

type the path in the box, then click Next. 
4. Choose an icon to represent this item on the toolbar. 
5. Type the name of this icon as you want it to appear in the screentip. 

Click Next. 
6.  Type the name of this icon as you want it to appear in the status bar, 

then click Finish. 

Chart Toolbar 
The chart toolbar appears at the bottom right corner of a chart.  You can 
turn all chart toolbars on and off from the Application Properties dialog 
(see page 31).  You can remove an individual chart's chart toolbar by 
right-clicking on the chart toolbar and choosing Remove Toolbar from 
the shortcut menu. 
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The chart toolbar can be displayed or removed using any of the following 
methods: 

• Use the Show All Chart Toolbars option in the Application 
Properties dialog.  The Application Properties dialog is displayed by 
right-clicking on the Application's menu bar or by choosing Options 
from the Tools menu.   
 

 

Note that the Show All Chart Toolbars box in the Application  

Properties dialog has a gray square in it if you have removed a data 
toolbar from a currently displayed individual chart.  This is just a 
visual reminder that checking the box will turn on an individual 
chart's chart toolbar that you have previously turned off. 

• Right-click directly on the chart toolbar and choose Remove 
Toolbar.  Note that this only removes the toolbar for the selected 
chart. 

• Use the Show Chart Toolbar option in the Chart Window Properties 
dialog (see page 104).  Note that this only removes the toolbar for 
the selected chart. 

For more information on the options in the Applications Properties 
dialog, see page 31. 

Color and Line Style Toolbars 
The Color and Style toolbars allow you to quickly change the color, line 
style, and weight of the selected plot (i.e., indicator, price, or line study). 
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To change the color or line style of a plot  
1. Select the plot (i.e., indicator, price, or line study) by clicking 

directly on the plot.  Small black boxes appear on the plot showing 
that it is selected. 

2. Choose the desired color or line style from the toolbar. To see more 
colors or to create custom colors, click the small triangle on the right 
side of the color toolbar and click More Colors. 
 
Note: If you select a heavier line weight, the Style will always appear 
as a solid line. 

 

To create custom colors 
1. Click the small triangle on the right side of the color toolbar. 

The color toolbar expands, and the More Colors buttons 
appears. 

2. Click the More Colors button. The Color dialog appears. 
3. In the Color dialog, click anywhere in the color swatch to set the 

hue and saturation. 
4. Use the slider on the right side of the dialog to adjust the 

luminosity (brightness). 
5. Click the Add to Custom Colors button. The new color appears 

in one of the Custom Colors boxes in the lower left corner of the 
dialog. 

Floating and Docking Toolbars 
All toolbars (except for chart toolbars) can be moved anywhere on the 
screen you desire.  Perhaps you are doing a lot of work with trendline 
studies.  To decrease the distance the mouse must travel when using the 
trendline toolbar, you may want to move the toolbar closer to the area of 
the chart in which you are working. 

 
QuickList button 

If the Standard toolbar is docked on either the left or right side of the 
screen (so it appears vertically), the Indicator QuickList changes to a 
button that displays the Indicators dialog. 
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To float and dock a toolbar  
1. Double-click on the toolbar.  Note that you must double-click on an 

area between or below the toolbar buttons.  The tools will now 
appear in a floatable window. 

 

 
2. Click and drag  the toolbar to the desired location.  If you want the 

toolbar docked on the screen’s edge, drag the toolbar until the mouse 
appears over the edge.  The drag box will change shape to indicate 
that it can be docked. 

3. To return a floating toolbar to its docked location, simply double-
click on the title bar of the floating toolbar’s window. 

Using the Status Bar 
The status bar appears at the bottom of the screen.  It provides you with 
feedback on the location of the mouse pointer (i.e., menu commands, 
tools, line studies on a chart, and x-/y-axis coordinates).  It also displays 
the current time.  

 
As you move through menu commands, the status bar gives you a more 
detailed explanation of the highlighted command.  When the mouse is 
positioned over a tool on the toolbar, a brief explanation of the tool is 
provided. 



 

 
 

28 • The Workplace MetaStock Professional 

 

 

 

The status bar is also very helpful when selecting and modifying objects 
on a chart, such as indicators, price plots, and line studies.  If you have 
numerous objects on a chart, the status bar is helpful in telling you which 
one the mouse is currently positioned over.  This can be very helpful, 
especially when the objects are grouped close together. 
As you move the mouse around on a chart, the x-axis (i.e., date/time) and  
y-axis values at the mouse location are continuously updated.  This can be 
useful for such tasks as drawing support/resistance lines (see page 444) to 
help you locate an exact price level, drawing trendlines (see page 529) to 
help locate more precise date and price coordinates, etc. 
You can use the Data Window for more detailed information on price 
values at the mouse pointer location (see page 160). 

Displaying/Removing the Status Bar 
The status bar can be displayed or removed using the Application 
Properties dialog.  To display this dialog choose Options from the Tools 
menu or right-click on the application menu bar and choose Application 
Properties.  

 

To display/remove the status bar  
1. Choose Options from the Tools menu. 
2. From the General page, (un)check the Display Status Bar box. 
3. Click the OK button. 
For more information on the options in the Applications Properties 
dialog, see page 31. 
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HELP!  Using MetaStock Pro’s Help System 
 

 
Help button 

The quickest way to find out how a specific feature in MetaStock Pro 
operates is to use the online help system.  MetaStock Pro's help system 
can be accessed from every dialog within MetaStock Pro by simply 
clicking the Help button or pressing the F1 key. 
The MetaStock Pro's User's Manual and the help system are based on the 
same material.  The help system is like having a User's Manual that 
automatically turns its pages based on what you are doing. 
If you find that you need more help than what the manuals or help system 
provide, you can contact Equis' technical support (see page 5). 

Getting Around with the Help System 
There are three primary ways of using the system.  The method you 
choose depends on how you prefer to obtain information.  When you are 
looking in a book for information on a specific topic, do you usually use 
the Table of Contents or do you use the Index? 
If you use the Table of Contents, then you'll probably feel more 
comfortable using the Contents page in the Help dialog.  If you prefer the 
Index, you'll want to use the Index or Find pages in the Help dialog. 

Contents 
The Contents page is used to access MetaStock Pro's Help Contents page.  
The Contents page is the main jumping off point for the on-line help 
system.  It is organized very similarly to a Table of Contents in a book.  
But instead of turning the pages to reach the desired subject, you simply 
double-click on the topics. 
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Index  
The Index page is used to search for help on a specific topic.  Begin by 
typing the first few letters of the topic you are looking for. For example, 
suppose you want to find out how to print a chart.  If you type the word 
"print" in the edit box, the index entry list will quickly display those 
keywords beginning with "Print."  Double-click "Print - charts" to display 
the corresponding help page. 

 

Find 
The Find page is used to search for every occurrence of a word or phrase 
within MetaStock Pro's help topics.  This search is more extensive yet less 
selective than using the Index page.  For example, suppose you want to 
find every occurrence of the word "resistance" within the help topics.  If 
you type the word "resistance" in the edit box, every help topic containing 
the word "resistance" will appear in the list.  Double-click the desired help 
topic to view. 
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Context Sensitive Help 

 
Context Sensitive Help 
button 

The Context Sensitive command displays a "question mark" next to the 
mouse pointer indicating that you are in help mode.  You can click the 
special help mode pointer on any of the menu commands, toolbar, or 
chart objects to display the corresponding help page.  For example, 
clicking the help mode pointer on a chart's x-axis will display a help 
screen on the x-axis scales.  Likewise, clicking on the Print button will 
display a help screen on printing. 
You can also press the F1 key when a menu command is highlighted to 
display help for that command. 

Quickstart Tutorials 

 
Quickstart button 

The Quickstart Tutorials are a quick and easy way to get up to speed with 
MetaStock Pro.  These interactive videos are fun and informative for both 
the beginner and the experienced MetaStock user.  To run the Quickstart 
Tutorials, choose Quickstart Tutorials from the Help menu, or watch for 
the Quickstart button when viewing MetaStock help topics. 

Changing the Appearance of MetaStock Pro’s Workplace 

Changing the Application Properties 
Use the Application Properties dialog  to choose from various options 
pertaining to the overall MetaStock Pro application.  You use this dialog 
to control the appearance of the general workspace, the location of files, 
your network user name, etc. 
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Access the Application Properties dialog by choosing Options from the 
Tools menu or right-click on the application's menu bar. 

General Page 

 
Restore workspace on startup.  Check this box if you want 
MetaStock Pro’s workspace to appear exactly as it did when you last 
exited the program.  This includes all charts that were open. 
Display status bar.  Check this box if you want the status bar 
displayed (see page 27). 
Enable integrated browser  Check this box if you want to view web 
pages requested by MetaStock in MetaStock's built-in web browser.  If 
you do not check this box, your default web browser will be launched 
when you access a web page from within MetaStock. 
Confirm deletion of objects.  Check this box if you want MetaStock 
Pro to prompt you to select "yes" or "no" each time you delete an object 
(e.g., trendline, indicator, etc.) from a chart (see page 214). 
Return to Select mode after drawing.  Check this box if you want 
MetaStock Pro to return to select mode (see page 207) after drawing a 
line study. 
Allow mixed case ticker symbols.  Check this box if you want 
MetaStock Pro to allow upper and lower case characters when creating 
new securities or adding new symbols to the Symbol Database.  Mixed 
case symbols are required by some data vendors. 
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File Locations Page 

 

The DownLoader.  Type the path to The DownLoader folder.  This is 
usually C:\Program Files\Equis\The DownLoader (see page 58 for more 
information on using The DownLoader). 
OptionScope.  Type the path to the OptionScope folder.  This is 
usually C:\Program Files\Equis\OptionScope. 
 

Chart Options Page 
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Show All chart title bars.  Check this box if you want the title bars 
displayed for all charts.  To control this option for individual charts, see 
page 104. 
Show All chart toolbars.  Check this box if you want the data 
toolbars displayed on all charts.  To control this option for individual 
charts, see page 105.  Note that this box has a gray square in it if you 
have removed a data toolbar from a single chart that is currently 
displayed.  This is just a visual reminder that checking the box will turn 
on a chart's data toolbar that you have previously turned off. 
Show ChartTips.  Check this box if you want ChartTips to display 
next to the mouse pointer.  ChartTips allow you to quickly display the 
values for a particular plot without invoking any special command.  By 
simply positioning the mouse over a plot  (e.g., price bar, indicator, 
moving average, etc.) and holding the mouse pointer motionless for a 
second or so, a ChartTip displays, giving you information about the plot.  
P&F boxes stay square.  Check this box if you want P&F boxes to 
stay square when plotting a point & figure chart (see page 497).  Purists 
to point & figure charting prefer to have exactly square X and O boxes.  
However, the advantage of leaving the box unchecked is that the point & 
figure charts will utilize chart space much more efficiently. 
Note that if you manually scale the y-axis, this option is ignored because 
it becomes impossible to keep the boxes square. 
 Scroll rescales y-axis.  Check this box if you want the y-axis to 
automatically rescale when moving through the data using a chart's scroll 
bar.  Checking this box will slow down the scrolling somewhat.  
However, you can leave this box unchecked and manually rescale the y-
axis using the Rescale Y-Axis button on the chart toolbar (see page 86). 
Ignore weekend data.  Check this box if you do not want weekend 
data to be displayed in your charts. 
Use Smart Charts.  Choose this option if you want each chart to load 
its individual Smart Chart (see page 77) rather than retaining the previous 
chart's information when using the Change Security commands (see page 
83). You can also select this option in the Options tab of the Choose a 
Security dialog (see page 84).  
Use chart as template.  Choose this option if you want each chart to 
use the same set of indicators and styles rather than using each individual 
Smart Chart when using the Change Security commands (see page 83).  
You can also select this option in the Options tab of the Choose a 
Security dialog (see page 84).  
Keep line studies.  Check this box if you want line studies to be 
transferred from one chart to the next when using the Change Security 
commands (see page 83). 
For most circumstances, you will probably want to leave this box 
unchecked, because a line study drawn on one security is rarely useful on 
another security's chart (without some adjustments). 



 

 
 

MetaStock Professional The Workplace • 35 

 

 

 

Note that this option is disabled if you choose the Use Smart Charts 
option. 
You can also select this option in the Options tab of the Choose a 
Security dialog (see page 84).  
Change All charts in layout.  Check this box if you want to use a 
layout as a multi-chart template when using the Change Security 
commands (see page 83).  When selected, this option causes all charts in 
the layout to change to the new security when using the Next Security 
command (or button on the Chart Toolbar), the Previous  Security 
command (or button on the Chart Toolbar), or the Choose a Security 
command (or button on the Chart Toolbar). If this option is not selected, 
only the active chart will be changed.  You can also select this option in 
the Options tab of the Choose a Security dialog (see page 84).  
Show empty holidays.  Check this box if you want a blank space 
displayed in place of market holidays.  On line plots (see page 151) this 
will cause a break to appear in the line.  This option is primarily used by 
cycle analysts interested in maintaining equal time/space relationships on 
their charts. 
Show empty weekends.  Check this box if you want a blank space 
displayed on the chart in place of weekends.  On line plots (see page 151) 
this will cause a break to appear in the line.  This option is primarily used 
by cycle analysts interested in maintaining equal time/space relationships 
on their charts. 
 

User Info Page 
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Name.  Type your name.  Your name is used for multi-user network 
control of shared data files (see page 541).  If you change your User 
Name, it does not take effect until the next time you run MetaStock Pro. 

Real-time Page 

 
Enable Real-time.  Check this box if you want intraday data to flow 
into MetaStock Pro from your real-time data vendor.  Note that real-time 
data will only flow into MetaStock Pro if your vendor's software is 
properly installed and running (see your Getting Started manual for real-
time vendor information). 
Enable Live Bars.  Check this box if you want the current bar to reflect 
the incoming real-time tick prices.  If this is left unchecked, a bar will not 
appear until the end of the specified intraday interval (i.e., 1-minute, 5-
minute, etc). 
Recalculate Expert Live.  Check this box if you would like the 
experts that are attached to your intraday charts to recalculate and update 
with each new tick.  If left unchecked, experts will only recalculate at the 
completion of each bar.  A mathematically complex expert can be 
demanding on your system's resources, particularly with actively traded 
securities.  If your system is struggling to keep up, you may want to leave 
this box unchecked. 
Update Commentary on.  Choose when to update the expert 
commentary attached to a chart—with each tick, at the completion of 
each bar, or with the Refresh button only. 
Maximum number of records in intraday charts.  Enter the 
number of bars (or ticks) that a chart can display (between 200 and 
65,500).  If the number of bars exceeds this number, the oldest bars will 
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automatically be removed from the chart.  Note however, that no data is 
actually lost, since MetaStock Pro stores all data to the security's files. 
Configure Server.  The Real-time Configuration dialog is used to 
configure various functions of the data, files, data vendor, and servers.  
For more information on this dialog see page 51. 

Alerts Page 

 
Allow e-mail alerts.  Check this box to enable e-mail notifications for 
Expert Advisor alerts  (see page 430).  This feature requires a MAPI 
compatible e-mail program, such as Microsoft Exchange, Microsoft 
Outlook, Eudora, etc.  If you do not have a MAPI compatible e-mail 
program installed on your computer, this box will be disabled. 

 
Address Book  button 

To.  Enter the e-mail address to notify when an Expert Advisor alert is 
triggered (see page 430).  To notify multiple e-mail addresses, create a 
mailing list in your e-mail program, then enter the mailing list in this box.  
The address book from your MAPI compatible e-mail program will be 
displayed when you click the Address Book button.   
Allow pager alerts.  Check this box to enable pager notification when 
an Expert Advisor alert is triggered. You may only use a pager that can 
receive data transfers.  If you do not have a modem installed in your 
computer, this box will be disabled. 
Country code.  If a country code is required to make a call from your 
computer to your pager, enter the country code in this box. 
Area code.  Enter the area code for your pager. 
Phone number.  Enter the phone number for your pager.   
Connect using.  Select a modem from the list.  Click the Configure 
button to re-configure the selected modem. 
Pager ID.  Enter your pager ID in this box.  Your pager ID is assigned to 
you by your pager service provider. 
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Your location.  Select the current location of your computer.  Click the 
Dialing Properties button to re-configure the selected location. 

Online Data Vendor Page 
The controls on the Online Data Vendor page of Application Properties 
are explained in detail in the vendor features chapter of your Getting 
Started manual.  This page is available only if you chose an online 
vendor during installation. 

 

Enlarging the Space Allotted for Charts 
If you want more screen space allotted for your charts, you may want to 
try the Full Screen command in the View menu.  Enabling Full Screen 
mode increases the space allotted for charts by about 10%.  It does this 
by removing the application's title bar, the menu bar, and the status bar.  
You can even expand the screen further by removing the toolbars with 
the Toolbars command in the View menu. 
The following illustration shows a maximized chart in Full Screen mode.  
Notice the Close Full Screen button in the bottom right corner of the 
screen. 
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Even though the menu bar is not visible in Full Screen mode, you can 
still access it with the accelerator keys (ALT+F, ALT+E, ALT+V, ALT+I, 
ALT+O, ALT+T, ALT+W, and ALT+H).  For example, to access the Tools 
menu you can press ALT+T. 

Restoring the Screen to Normal View 
To return the screen to normal view while in Full Screen mode, click the 
Close Full Screen button that appears on the screen.   

 
Or right-click on the empty workspace and uncheck the Full Screen 
option from the Application shortcut menu.   
You can also press ALT+V and uncheck Full Screen from the View menu 
to return to normal view. 

Using Dual Monitors with MetaStock Pro 
MetaStock Pro supports dual monitor capacity.  To maximize MetaStock 
Pro on both monitors, choose Full Desktop from the View menu. 
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Collecting Your Data 

What is Data? 
Before you can look at a chart, you must have data.  A chart is simply a 
graphical representation of price data.  Price data can include Open, 
High, Low, Close, Volume, and Open Interest information for a specific 
time period.  MetaStock Pro can use price data that is stored on your local 
hard drive, or stored remotely on a computer at your data vendor.    
Data that is stored remotely at your data vendor is called online data.  
Online data is accessed through MetaStock Pro's DataOnDemand™ 
technology.  You simply choose a symbol from the online data vendor 
shortcut, or if you already have a chart open, just type the symbol.  The 
data flows instantly to your chart from your data vendor, usually through 
the Internet.   
Data that is stored on your hard drive is called local data.   To view local 
data, you must first create a security file, then collect the data through 
real-time collection with MetaStock Professional or end-of-day collection 
with The DownLoader.   
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Intraday data is based 
on trades as they occur 
throughout the day. 
End-of-day data is based 
on the high, low, open, 
close, and volume for an 
entire trading day. 

DataOnDemand allows you to display a chart of intraday or end-of-day 
data that is stored in a database on a remote computer.  This information 
can be temporarily stored on your hard drive, but the main storage location 
is the remote computer at your data vendor. 
Real-time data collection with MetaStock Professional  allows you to view 
intraday data that is collected and stored locally on your hard drive as the 
trades occur. 
End-of-day data collection with The DownLoader allows you to display a 
chart of end-of day data that is downloaded and stored locally on your 
hard drive.    
The goal of each of these  processes is the same  to retrieve data that 
can be displayed as a chart in MetaStock Pro.  For more information on 
collecting data from your data vendor, see your Getting Started manual. 

DataOnDemand™ 
Online data is end-of-day or intraday data that is stored on a remote 
computer.  You access online data through MetaStock Pro's 
DataOnDemand technology by simply choosing the symbol from the 
Open dialog, or by typing the symbol if you already have a chart 
displayed.   MetaStock Pro then requests data for that security from your 
data vendor.  The data is temporarily held in your computer's memory 
while you have the chart displayed.  Online data can be stored in an 
online cache folder, much like a web browser saves web pages, for quick 
retrieval.  See your Getting Started manual for online cache information 
specific to your data vendor. 

Managing Online Securities 
Because your data is stored remotely on a computer at your data vendor, 
you will not need to create securities or perform any file or data 
maintenance.  If you choose to store the data temporarily on your hard 
drive in the online cache, you may use that data with The Explorer or 
view the data in a datasheet in The DownLoader.  If there is an error in 
the data, or a split occurs after you have stored the data in your online 
cache, you can re-collect the data from your vendor by choosing Refresh 
Data from the View menu while you have the chart displayed. 

The DataOnDemand Collection Process 
DataOnDemand occurs entirely behind the scenes.  You just tell 
MetaStock Pro what chart you want to display.  MetaStock Pro will get 
the data from your online vendor and display the chart on your screen. 
Your chart will then be updated as the trades occur. 
If you have previously opened a chart for a security, MetaStock Pro will 
first check for data stored in your online cache folder for that security, 
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then retrieve any additional data to fill in to the current period from your 
data vendor.  The data is then displayed in your chart. 

Important Facts About DataOnDemand 
• With DataOnDemand, you have the entire database of securities 

supported by the vendor available to you instantly.  You simply type 
a symbol and the data appears.   

• DataOnDemand is the quickest way to view a chart! 
• DataOnDemand is only available while you are connected to your 

data vendor.  If your connection is interrupted, or not available, you 
will not be able to display up-to-date charts.   

• Running explorations on online data is extremely slow.  If you plan 
to run explorations regularly, you should consider using local data 
instead. 

• Each time you open a new online security after your cache has 
reached its limit, the oldest security will be removed from the cache, 
and the newly requested security will be added. 

• Data in the online cache can be merged with local data files to create 
permanent securities on your hard drive.  See the DownLoader 
User's Manual for information on the Merge function. 

• Because the data is primarily stored on a remote computer at your 
data vendor, you do not need a large amount of hard drive space for 
storing data.   

 

 
Refresh button 

• If any changes are made to the data by the vendor, a split occurs for 
example, you can quickly update the data in your online cache by 
choosing Refresh from the View menu or clicking the Refresh button 
on the Chart Toolbar while you have the chart displayed.  You will 
not need to edit the data in the datasheet or use any of the other file 
and data maintenance features in The DownLoader. 

Collecting Local Real-time Data  
Local real-time data is intraday data that is collected and stored on your 
computer as the trades occur.  Before you can store local data, you must 
create security files for the data to be stored in.  You are limited to 
viewing the charts for the securities you have created.  If you enter a 
symbol in the Choose a Security dialog that does not have a security file 
created, you will be prompted to create a security file for it.  The chart 
will then be displayed and the data will be stored. 

Creating Real-time Securities 
Real-time securities are stored locally on your hard drive.  Once the 
securities have been created, they remain on your hard drive until you 
delete them.  You are limited only by the size of your hard drive.  Each 
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local data folder can contain up to 6,000 securities, and you can have an 
unlimited number of folders.  The MetaStock File Server updates the data 
in your real-time security files.  As long as the File Server is running, 
your charts will be updated, even if MetaStock Pro has been shut down.  
See page 51 for more information on the real-time collection process. 
To create securities for real-time data collection, choose New, then 
Security from the File menu in MetaStock Pro.  You may also do this in 
The DownLoader.   

 

The New Security dialog also appears if you begin typing the name or 
ticker symbol of a security that does not already exist.  As you type, the 
Choose a Security dialog appears (see page 84).  If the active chart 
contains local data, and the security or ticker symbol is not found within 
the Choose a Security dialog, the New Security dialog will appear, 
allowing you to create a new security.  After specifying the parameters in 
the New Security dialog, click the OK button.  If the periodicity is set for 
intraday and MetaStock Pro is in real-time mode, the chart for the new 
security will open and begin to collect data.  

Folder.  Type (or use the Browse button to select) the folder that will 
contain the new security file.  See page 50 for information on creating 
new folders. 
Name.  Type the name of the security.  If you use the Symbol Database 
(see page 46), the name and symbol will automatically be filled in.   
Symbol.  Type the ticker symbol for the security.  Click the Look-up 
button for help with ticker symbols.  
First Date.  This field is disabled when you choose Intraday as the 
Periodicity. 
Periodicity.  Choose Intraday to maintain intraday price data (e.g., tick, 
5-minute, hourly, etc.).   
Units.  Choose the unit format in which you would like the price data to 
be displayed.  For example, if you choose "1/8," the portion of the price 
to the right of the decimal will be displayed in eighths.  Only the 
numerator is shown; the denominator is dropped (e.g., 25 3/8 is displayed 
as 25 ^3).  If you choose "decimal" (the default), the portion of the price 
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to the right of the decimal will be displayed in decimal format (e.g., 
25.375, 45.25, etc.). 
Opening Prices/Open Interest.  To track the Opening Prices or 
Open Interest, select these boxes.   
Open interest is available with most futures and options contracts. 
Interval.  Choose the interval from the drop-list.  The interval specifies 
how often to update real-time charts.  For example, choosing "5" causes 
MetaStock Professional to update the security with 5-minute bars.    Once 
the interval has been chosen for a security, it cannot be changed. 
A 5-minute bar labeled on a chart at 11:15 includes the first tick of 
11:10:00 through the last tick of 11:14:59.  Similarly, a 1-minute bar 
includes all ticks from 11:14:00 to 11:14:59. 
This option is only available when Intraday has been chosen as the 
Periodicity. 
Start/End Times.  Specify the time to begin and end collecting intraday 
data.  Start and End times are required so that MetaStock Pro knows 
when to store data.  They are normally set to correspond with the times 
the market opens and closes.  Enter the Start and End times from your 
local time zone.  If you want after-market ticks to be included in the last 
bar, see page 52 for the "Last bar lag time" option. 
Browse.  Click the Browse button to select the data folder where the 
new security will be created.  The folder you select appears in the Folder 
edit box. 
Look-up.  Use the Look-up button to display the Symbol Database, 
which is used to quickly fill in the Name and Symbol fields with the 
desired security.  See page 46 for more information on using the Symbol 
Database. 

  
Create Button 

Create.  Choose the Create button to repeatedly create multiple 
securities without leaving the dialog.  When you’re done creating 
securities, click the Cancel button. 

To create new local intraday securities  
1. Choose New from the File menu.  Choose Security.  
2. Complete the security attribute information in the New Security 

dialog.  If you do not know the ticker symbol, click the Look-up 
button.  See page 46 for more information on using the Symbol 
Database. 

If the security you are creating is intraday and you are running in real-
time mode, the chart will immediately appear once you click the New 
Security dialog's OK button.  The new security will be created in the 
specified data folder. 
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Using the Symbol Database to Create Securities 
The Symbol Database provides you with instant access to ticker symbol 
information on over 15,000 stocks and about 7,200 mutual funds, for all 
major US exchanges.  In addition, futures, indices (both U.S. and 
international), market indicators, and Canadian stocks that are symbol-
compatible with Reuters DataLink data service are available.  The 
Database is used to place the name and ticker symbol of the selected 
security in the New Security dialog.   
It can also be used to quickly create multiple security files at once.  The 
number of securities selected (i.e., highlighted) in the Symbol Database is 
displayed on the status bar at the bottom of the application window. 

 
Type.  Use the Type drop list to choose the type of security to list (i.e., 
stocks, futures, etc.). 
Group.  Use the Group drop-list to control which securities are listed in 
the dialog.  The contents of the drop-list are dependent on your selection 
in the Type box.   
If you are searching for a specific security and you're not sure which 
exchange grouping the security belongs to, you should select the "All" 
group to list all securities.   
You can also choose from several specialized groups (i.e., S&P 100 
stocks, NYSE stocks, etc.).  The group called "optionable stocks" lists all 
stocks on which options are traded. 
Search.  Use this box to search the list for the specified name or symbol. 
Select All.  Click this button to quickly select all securities listed. 
Deselect All.  Click this button to quickly deselect all securities. 
New Symbol.  Click this button to add a new symbol to the database. 
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Delete Symbol.  Click this button to delete the selected symbol from 
the database. 
Edit Symbol.  Click this button to edit the properties of the selected 
symbol. 

Creating Multiple Securities with the Symbol Database 
Instead of you having to create each security file individually, the 
Symbol Database dialog allows you to search for and select multiple files 
to create at once.  The number of securities selected (i.e., highlighted) in 
the Symbol Database is displayed on the status bar at the bottom of the 
application window. 
You can even create special groupings of stocks, such as the Dow 30 
stocks, S&P 100 stocks, all optionable stocks, etc. 

To create multiple securities using the Symbol Database  
1. Choose New from the File menu.  Choose Security. 
2. Click the Look-up button.  The Symbol Database dialog will appear. 
3. Choose the Type and Group to specify the securities listed. 

 
Note that you can restrict the list and select individual securities by 
typing specific names or symbols in the Search box.  Simply 
separate them with a semi-colon (e.g. MSFT;IBM;AAPL;NSCP). 
 
You can also separate the names or symbols with a comma to find 
everything beginning with a certain letter (e.g. A,B,C will show 
every security beginning with an A, a B, and a C). 

4. Click the Select All button to quickly select all securities generated 
by the search.  To select a continuous group of securities, click on 
the first item, then hold down the SHIFT key as you click on the last 
item.  All items between the first and last items will be selected.  To 
select multiple individual securities, hold down the CTRL key as 
you click on each one. 

5. Click the OK button.  The New Security dialog will appear with the 
text "(MULTIPLE)" in the Name, Symbol, and Units fields.  The 
Start and End times will be blank.  

 

 
6. Verify that the remaining attributes in the New Security dialog are 

set correctly. 



 

 
 

48 • Collecting Your Data MetaStock Professional 

 

 

 

7. Click the OK button in the New Security dialog to create the 
selected securities. 

Creating Futures Contracts with the Symbol Database 
If you use the Reuters DataLink or DBC Signal data services to collect 
your end-of-day data, you can use the Symbol Database dialog to create 
indices and futures (in addition to stocks and mutual funds). 
If you select a Futures symbol from the Symbol Database dialog, the 
Futures Contracts dialog is displayed.  You use this dialog to specify 
which contracts to create. 
Use the Contracts page to control the type and date range for the 
contracts. 

  

Specific contracts.  Choose this box to create all contracts for the 
selected futures between the specified start month and end month.  If you 
only need to create the contracts for one month, then specify the same 
month for the start and end months.  

Continuous contracts (Reuters DataLink only).  Choose this box 
to create a continuous contract for all the selected futures contracts. A 
continuous contract is a special contract that automatically rolls to the 
next contract when the current contract expires, thereby making it 
"continuous." 
Type.  Choose the type of continuous contract.  Note that the "time-
weighted average" returns an average of the nearby contract and the 
contract with a delivery month closest to 90 days into the future. 
Cash prices (DBC only).  Choose this box to create cash/spot symbols 
for all the selected futures. 
Use the Other page to control the future contract volume option. 
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Use volume from all contracts (Reuters DataLink only).  Choose 
this box if you want the volume for all contracts to be stored.  Even if 
you choose a specific contract month, checking this box will cause the 
volume to reflect the total volume for all contract months.   

Updating the Symbol Database 
The list of symbols is updated monthly on the Equis International web 
site at www.equis.com in the Files section of the Customer Support area.  
You may update this list automatically by choosing Update Symbol 
Database from the Tools menu in either MetaStock Pro or The 
DownLoader.  

Modifying the Symbol Database 
The symbols and information included in the Symbol Database can be 
adjusted.  To edit information for a specific symbol, select the symbol, 
then choose Edit Symbol from the Symbol Database dialog.  To delete a 
symbol, select the symbol, then choose Delete Symbol from the Symbol 
Database dialog.  To add a symbol, choose New Symbol from the 
Symbol Database dialog, or choose New symbol from the Tools menu in 
the Open dialog.    

Creating Custom Symbol Lists for the Symbol Database 
The Symbol Database includes nearly all U.S. and Canadian stocks and 
mutual funds.  However, if you follow securities that do not have a 
universally accepted symbol format, like futures, indices, or international 
securities, the symbols you need may not be included in the Symbol 
Database.  To accommodate these types of symbols, you can create your 
own groups of symbols for use inside the Symbol Database dialog by 
creating an ASCII file with a “SYM” extension.  For detailed instructions 
on creating these groups, refer to The DownLoader User’s Manual or 
Help file. 
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Creating Data Folders for Your Security Files 
MetaStock security files are stored in folders on your hard disk.  You can 
store up to 6,000 securities in a folder, and can create an unlimited 
number of folders. 

To create folders for your security files  
1. Choose New from the File menu.  Choose Security. 
2. Type the name of the new folder to create in the Folder box (e.g., 

c:\MetaStockData\stocks). 
3. Fill out the remaining information in the New Security dialog.  Note 

that you must also add a security at this time so that the folder will 
have a reason for being created.  Choose OK. 

4. Choose Yes when asked if you want to create the folder. 

Maintaining Local Securities 
All file and data maintenance functions for local data are found in The 
DownLoader.  The DownLoader is a separate program provided with 
MetaStock Pro. 

 
The DownLoader icon 

You can run The DownLoader using the Windows Start command by 
going to the Equis International folder and choosing The DownLoader.  
You also can run The DownLoader directly from within MetaStock Pro by 
choosing The DownLoader from the Tools menu.   
There are many unique functions that The DownLoader can perform: 
• You can create and edit local MetaStock security files using The 

DownLoader's datasheets. 
• You can convert security files from one format to another. 
• You can test the integrity of your security files. 
• You can sort securities or the securities' data. 
• You can merge securities. 
• You can delete securities or a range of data within the files. 
• You can copy and move your securities from one folder to another. 
The folder where The DownLoader program is located is specified in the 
Application Properties dialog (see page 33).  This specified folder must 
be correct in order for The DownLoader to run successfully from within 
MetaStock Pro. 
You can quickly access the data for an open chart by right-clicking on the 
price plot and choosing Edit Data from the shortcut menu.  The security's 
datasheet will open in The DownLoader where you can make the desired 
changes. 
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To edit local securities 
1. Right click on the price bar that needs to be edited. 
2. Choose Edit Data from the shortcut menu. 
3. Enter the desired changes. 
4. Choose Save from the File menu. 
If a chart for a security is open, any change made in The DownLoader to 
that security's attributes (e.g., name, ticker, units, etc.) will not be 
immediately reflected in the open chart.  The chart must be closed and 
then reopened to reflect the changes.  However, changes made to the 
pricing data itself (i.e., date, open, high, low, close, etc.) will be 
immediately reflected in the open chart. 

The Real-time Collection Process   
Real-time data collection is handled by the MetaStock File Server and the 
Equis Data Server.  The MetaStock File Server controls the data being 
stored into your local security files, while the Equis Data Server actually 
collects the data from your data vendor. 
When a new local intraday security is created and the chart opened, a 
request for data is sent to the Equis Data Server.  As the data is received 
by the Equis Data Server, it is passed to the MetaStock File Server to be 
stored, and to MetaStock Pro to be displayed (if the chart is open). 
When a chart of an existing local security is opened, the File Server 
retrieves the data already stored in the security file, then the Data Server 
requests new data from the data vendor. 

Real-time Configuration 
The Real-time Configuration dialog is used to configure various 
functions of the data, files, data vendor, and servers.  Note that many of 
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the configuration settings will not take effect until the Data Server and 
the File Server are restarted. 
 

 Equis Real-time 
Configuration button 

The Real-time Configuration dialog is accessed by clicking the Configure 
Server button on the Real-time page in the Application Properties dialog 
(see page 36), or by choosing the Equis Real-time Configuration 
application from the Equis International folder in the Windows Start menu. 
  

Data Options 
The Data Options page is used to adjust settings for data retrieved from 
the Equis Data Server. 

 
Last bar lag time (minutes).  This adjusts the lag time for the last bar 
of the day for all intraday securities.  Normally, the last bar for the day 
terminates exactly at the specified end trade time (see page 43).  If a lag 
time is in effect, the last bar will include any “late trades” beyond the 
ending trade time.  For example, if a 5-minute security has an ending 
trade time at 16:00, the last bar will normally end at 16:00.  If a 3-minute 
lag time is in effect, the last bar will still be time stamped with 16:00, but 
it will also contain any ticks that arrived through 16:03. 
If the lag time goes beyond the start time for the next trading session, the 
last bar will be terminated at the start time of the next session. 
Any change to this setting takes effect immediately and does not require 
restarting the Equis Data Server. 
Generate bars for intervals with no trades.  If this box is checked, 
"flat" bars will be displayed for time intervals during which there are no 
trades.  The last closing price will be used to generate these bars. 
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Replace vendor trade volume with calculated change in total 
volume.  Check this box to display volume as the change in volume 
since the previously reported trade.  If unchecked, the volume displayed 
is the volume as reported by the data vendor for the current trade. 
Warn if unusual time change.  If this box is checked, the Data 
Server will display a warning message on the screen if a large time 
change is detected in the data stream from the data vendor.  
This warning does not necessarily indicate a problem.  It may appear 
when the system automatically adjusts the system time according to 
Daylight Savings Time. 
If the data vendor does not supply its own time (i.e., the computer system 
time is used), or if the "Replace vendor supplied time with computer 
system time" checkbox is checked, this warning may occur if you 
manually change the system time while the server is running. 
A time change in the data stream should not cause any significant 
problems with the Data Server, but the time stamps of the records 
produced may be unusual. 
Replace vendor supplied time with computer system time.  If 
this box is checked, the Data Server will stamp all records with the 
computer system time rather than using the time provided by the vendor.  
Note that if the vendor does not supply time, the computer system time is 
automatically used and this box will have no effect. 
Adjust data record time (hours).  This control allows you to adjust 
all time stamps on all records by a specified number of hours.  This 
adjustment is applied to all records regardless of whether the times are 
supplied by the data vendor or the computer system time is used.  Note 
that this does not affect historical records stored in your data files. 

File Updates 
The File Updates page controls the folders where the MetaStock File 
Server is maintaining local real-time data. 
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Folders with MetaStock intraday data.  This list box shows all 
folders that the MetaStock File Server is currently maintaining.  All 
intraday data files in these folders will be updated with data while the 
File Server application is running. 
The Add button allows you to add a new folder to the list.  If the File 
Server is running, it will automatically start updating the intraday files 
contained in the new folder.  If the File Server is not currently running, it 
will begin updating the files in the folder when the application is started.  
The Remove button allows you to remove a folder from the list.  If the 
File Server is running, it will automatically stop updating all intraday 
securities contained in the removed folder. 
While it is possible to add and remove these folders when the File Server 
is running, it is not suggested that this be done on a regular basis.  The 
CPU time required by the File Server to add and remove a folder  “on the 
fly” is significant. 
Do not attempt to access a real-time data folder that is in use by another 
MetaStock Pro user (i.e., a shared folder on a network).  If you do, the 
other user will lose "write" privileges to the folder. 
Max # of records to store in intraday files.  The maximum number 
of records that MetaStock Pro can write to an intraday file is 65,500.  The 
minimum value for this option is 5,000.  If you need to conserve hard 
disk space or if the performance of your datasheets is poor, then you may 
want to lower this value.  If during normal operation, this maximum 
value is reached, MetaStock Pro removes 10% of the oldest records to 
make space for the new records. 

Data Vendor 
This page allows you to change settings for the real-time data vendor. 
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The name of your data vendor appears at the top of the dialog. 
Vendor DLL Folder.  All communications with a data vendor take 
place through the use of a special file called a DLL.  Each vendor has a 
unique DLL to implement the data collection. 
This control specifies where the vendor DLL is located.  Normally, this 
setting is initialized during program installation and should not be 
changed. 
Configure Vendor.  If the data vendor allows access to their 
configuration,  this button will be enabled.  If you click on this button, a 
dialog will appear that allows you to configure specific settings within 
the data vendor's application itself.  If the vendor does not allow access to 
their applications directly, this button will be disabled. 

Server Options 
This page allows you to change options for the Equis Data Server and 
MetaStock File Server applications. 
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The following are the Equis Data Server controls: 
Minimize main window.  If this box is checked, the Equis Data Server 
application will run in a minimized state (i.e., the main window of the 
application will not appear on the desktop). 
Terminate if no clients attached.  If this box is checked, the Equis 
Data Server application will automatically shut itself down when it 
detects that there are no client applications (i.e., MetaStock Pro, File 
Server, etc.) currently attached.  This frees system resources for other 
applications. 
Normal Priority / High Priority.  The Equis Data Server application is 
a multi-threaded application that runs in the background.  These radio 
buttons allow you to change the priority of this background operation.  
Normally, the Data Server should run at a high priority.  This ensures that 
the application has as much CPU time as possible to keep up with the 
real-time data flow from the vendor. 
This setting may be changed to "normal" if other applications seem to be 
unresponsive and if there is not a high volume of real-time data being 
processed.  However, a "normal" priority setting can hinder the ability of 
the Data Server to keep up with the real-time data flow. 
The following are the MetaStock File Server controls: 
Minimize main window.  If this box is checked, the MetaStock File 
Server application will run in a minimized state (i.e., the main window of 
the application will not appear on the desktop). 
Normal Priority / High Priority.  The MetaStock File Server 
application is a multi-threaded application that runs in the background.  
These radio buttons allow you to change the priority of this background 
operation.  Normally, the File Server should run at a high priority.  This 
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ensures that the application has as much CPU time as possible to keep up 
with the real-time data flow and to maintain the local intraday data files. 
This setting may be changed to "normal" if other applications seem to be 
unresponsive and if there is not a high volume of real-time data being 
processed.  A "normal" priority setting can hinder the ability of the File 
Server to keep up with the real-time data flow. 

Things to Know about the Equis Servers 
You should not be concerned with the operation of the Equis Data Server 
and File Server applications.  In fact, you may never even need to see 
them.  These programs do the "behind the scenes" work. 

 MetaStock File 
Server  

 Equis Data Server 

If you prefer that the taskbar not show the buttons for the Data Server and 
File Server, right-click on the buttons and choose Minimize.  Once 
minimized, you can click on their icons on the right side of the taskbar to 
switch back. 
The majority of the options in the menus of the Equis Data Server and 
File Server are standard controls and need no explanation.  However, the 
following  provides a brief explanation of a few options in the View 
menu that do require additional explanation. 
If you exit MetaStock Pro while the File Server is collecting data, a 
message box appears asking if you want to shut down the File Server.  To 
continue to collect real-time data after shutting down MetaStock Pro, 
click No.  Once the File Server has been closed, the Data Server will shut 
down also. 

Performance Statistics 

 Performance 
Statistics button 

The Statistics dialogs of the Data Server and File Server are accessed by 
choosing Performance Statistics from the View menu or clicking the 
Performance Statistics button on the toolbar.    
The Performance pages of the File Server's and Data Server's Statistics 
dialog provide feedback on the efficiency of the flow of real-time data.  
The Efficiency area at the bottom of the Statistics page is worth noting.  
It shows the current and minimum amount of idle time.  If these values 
get too low, warnings may start popping up on your screen complaining 
about MetaStock Pro's inability to keep up.  To remedy this, you may 
need to reduce the number of real-time securities you follow, or upgrade 
your computer's resources (i.e., RAM, CPU, hard disk). 

Cache 
The Cache page of the File Server Statistics dialog shows the total real-
time securities being processed, the current cache size (in RAM), and the 
amount of this cache being used.   
The cache temporarily holds the real-time data as it waits to be sent to the 
appropriate data files.  The cache size will automatically 
increase/decrease (up to 2 meg) as needed to accommodate the flow of 
real-time data. 
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Controlling the Message Levels 
As the Data Server and File Server process the incoming real-time data, a 
running log of informative messages is maintained in the window.  To 
control the amount of detail to display, choose from one of three options 
in the View menu:  Critical Messages Only, Standard and Critical 
Messages (default), Diagnostic, Standard, and Critical Messages. 

Important Facts About Real-time Data 
• Real-time data collection provides data as the trades occur.  You do 

not need to wait until the end of the day to get your data.  For active 
day-traders, this is a necessity. 

• Intraday data collected through real-time data collection is stored 
locally on your hard drive.  The data can require a significant amount 
of hard drive space, depending on how many securities you are 
following and what periodicity you prefer.  You will need more 
room on your hard drive for data if you prefer tick data over hourly 
data, for example. 

• Because local intraday data is stored on your computer, it can be 
used for your analysis anytime you need it.  For example, you can 
collect prices all day, take your laptop with you when you leave the 
office, and do your analysis after market hours. 

• You can also use local intraday data in other software that is OLE 
compatible (see page 9). 

• MetaStock Pro cannot collect history for local intraday securities.  
Your history begins when you first create the security file.  To view 
historical intraday data, use DataOnDemand (see page 42). 

End-of-day Data Collection with The DownLoader 
Downloaded data is stored locally on your hard drive.  You must create 
security files and download data before opening a chart.  Once the data 
has been collected, it can be used with any of MetaStock Pro's advanced 
analysis tools.  The DownLoader is used to collect data from one of 
several end-of-day data vendors, and for more comprehensive data 
maintenance such as editing, merging, deleting, and sorting security files. 

Creating Local End-of-day Securities  
Security files are created using the New Security dialog.  You can do this 
in either MetaStock Pro or The DownLoader.  The New Security dialog 
is accessed by choosing New from the File menu, then Security. 



 

 
 

MetaStock Professional Collecting Your Data • 59 

 

 

 

   
The New Security dialog also appears if you begin typing the name or 
ticker symbol of a security that does not already exist.  As you type, the 
Choose a Security dialog appears (see page 84).  If the active chart 
contains local data, and the security or ticker symbol is not found within 
the Choose a Security dialog, the New Security dialog will appear, 
allowing you to create a new security.  After specifying the parameters in 
the New Security dialog, click the OK button.  You will then need to 
download the data for that security using The DownLoader. 
Folder.  Type (or use the Browse button to select) the folder that will 
contain the new security file.  See page 49 for information on creating 
new folders. 
Name.  Type the name of the security.  If you use the Symbol Database 
(see page 46), the name and symbol will automatically be filled in.   
Symbol.  Type the ticker symbol for the security.  Click the Look-up 
button for help with ticker symbols.  
First Date.  Enter the first date for which you want to collect data.  Note 
that you can enter the year using two or four digits (i.e., 98 or 1998).  
You will specify the Last Date to collect at the time of data collection. 
Units.  Choose the unit format in which you would like the price data to 
be displayed.  For example, if you choose "1/8," the portion of the price 
to the right of the decimal will be displayed in eighths.  Only the 
numerator is shown; the denominator is dropped (e.g., 25 3/8 is displayed 
as 25 ^3).  If you choose "decimal" (the default), the portion of the price 
to the right of the decimal will be displayed in decimal format (e.g., 
25.375, 45.25, etc.). 
Opening Prices/Open Interest.  To track the Opening Prices or 
Open Interest, select these boxes.   
Open interest is available with most futures and option contracts. 
Browse.  Click the Browse button to select the data folder where the 
new security will be created.  The folder you select appears in the Folder 
edit box. 
Look-up.  Use the Look-up button to display the Symbol Database 
which is used to quickly fill in the Name and Symbol fields with the 
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desired security.  See page 46 for more information on using the Symbol 
Database. 
Periodicity.  Choose the desired periodicity for the security.  Choose 
Daily if you want to maintain price data for each day that the security 
trades.  Choose Weekly if you want to maintain price data for the security 
on a weekly basis (Friday to Friday).  Choose Monthly if you want to 
maintain price data for the security on a monthly basis (month-end to 
month-end).  (See page 43 for information on adding intraday securities.) 

 
Create Button 

Create.  Choose the Create button to repeatedly create multiple securities 
without leaving the dialog.  When you’re finished creating securities, click 
the Cancel button. 

To create new local end-of-day securities   
1. Choose New from the File menu.  Choose Security.  
2. Complete the security attribute information in the New Security 

dialog.  If you do not know the ticker symbol, click the Look-up 
button.  See page 46 for more information on using the Symbol 
Database. 

3. Collect data for this security by choosing Download Prices from the 
Tools menu in The DownLoader. 

Maintaining Local Securities with The DownLoader 
All file and data maintenance functions are found in The DownLoader.  
The DownLoader is a separate program provided with MetaStock Pro. 

 
The DownLoader icon 

You can run The DownLoader using the Windows Start command by 
going to the Equis International folder and choosing The DownLoader.  
You also can run The DownLoader directly from within MetaStock Pro by 
choosing The DownLoader from the Tools menu.  
There are many unique functions that The DownLoader can perform: 
• You can create and edit MetaStock security files using The 

DownLoader's datasheets. 
• You can update your local end-of-day security files from an end-of-

day data vendor (e.g., CompuServe, Dial/Data, Reuters DataLink, 
Telescan, etc.). 

• You can convert security files from one format to another. 
• You can test the integrity of your security files. 
• You can sort securities or the securities' data. 
• You can merge securities. 
• You can delete securities or a range of data within the files. 
• You can copy and move your securities from one folder to another. 
The folder where The DownLoader program is located is specified in the 
Application Properties dialog (see page 33).  This specified folder must 



 

 
 

MetaStock Professional Collecting Your Data • 61 

 

 

 

be correct in order for The DownLoader to run successfully from within 
MetaStock Pro. 

You can quickly access the data for an open chart by right-clicking on the 
price plot and choosing Edit Data from the shortcut menu.   The security's 
datasheet will open in The DownLoader where you can make the desired 
changes. 

 

To edit end-of-day securities 
1. Right click on the price bar that needs to be edited. 
2. Choose Edit Data from the shortcut menu. 
3. Enter the desired changes. 
4. Choose Save from the File menu. 
If a chart for a security is open, any change made in The DownLoader to 
that security's attributes (e.g., name, ticker, units, etc.) will not be 
immediately reflected in the open chart.  The chart must be closed and 
then reopened to reflect the changes.  However, changes made to the 
pricing data itself (i.e., date, open, high, low, close, etc.) will be 
immediately reflected in the open chart. 

The DownLoader's Collection Process  
You use The DownLoader to collect data for end-of-day local securities.  
To connect to your end-of-day data vendor, choose Download Prices from 
the Tools menu in The DownLoader.  See The DownLoader User's 
Manual or Help file for more information. 

Important Facts About Downloading 
• The DownLoader can collect only end-of-day data.  End-of-day data 

includes Daily, Weekly, and Monthly prices. 
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• The data for the current trading day is not available until after the 
market closes. 

• All of the data is stored on your local hard drive, which takes up a 
significant amount of space. 

• You only have to be connected to your vendor for downloading for a 
short amount of time. 
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Chart Concepts 

Managing Your Charting 
MetaStock Pro  provides three ways to manage your charting using 
charts, Smart Charts™, and layouts.  All three file types are managed 
from one central location, the File menu. 

Charts 
A "chart" is a graphical representation of a security in a single window.  
A chart can contain price plots, indicators, line studies, text, etc. in one or 
multiple inner windows.  You can create a chart by choosing New Chart 
from the File menu.  To save a chart, choose Save As from the File menu, 
then provide a unique file name using the *.mwc extension. 
For more information on charts, see page 77. 

Smart Charts 
A “Smart Chart” is a chart that is saved with the security name.  You do 
not need to provide a file name.  The changes are saved automatically 
when you close the Smart Chart.  To open a Smart Chart, choose Open 
from the File menu.  The first time you open a Smart Chart, a special 
template is used, called DEFAULT.MWT (see page 102), to display the 
price information.   

Layouts 
A "layout" is a graphical representation of one or multiple securities in 
one or multiple windows.  A layout can contain price plots, line studies, 
text, etc.   
With a layout, you can group charts of the same or different securities 
into one manageable unit.  For example, perhaps you'd like to see charts 
of all of your computer stocks on the screen  not just today, but every 
day.  You could load them all, display them as you'd like, and then save 
them in a layout for later use using an *.mwl extension.  Or maybe you 
always like to display Corn and Wheat charts with a 14-day Stochastic, 
9-day RSI, and 10-day moving average.  Again, use a layout. 
For more information on layouts, see page 89. 
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Opening, Closing and Saving (General) 
This section explains the controls in the common Windows dialogs used 
to open, close, and save files.  These commands are found in the File 
menu. 

 

New Chart 
The New dialog is used to create a new chart.  Choose New from the File 
menu, then choose Chart. 
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History.  Choose the History shortcut from the Shortcut Bar to create a 
new chart for a security you have recently accessed.  You can adjust the 
size of the history by choosing Limit History Items from the Open 
dialog's Tools menu. 
Local Data.  Choose the Local Data shortcut from the Shortcut Bar to 
create a new chart for a security located on a local disk drive.  The local 
data folder from which you last viewed a security is displayed. 
Favorites.  Choose the Favorites shortcut from the Shortcut Bar to 
create a new chart for one of your pre-defined favorite securities.  To add 
an item to Favorites, choose Add to Favorites from the Open dialog's 
Tools menu. 
<Online Data Vendor>.  If you are using an online data vendor, you 
may select from a list of securities available from your vendor by 
choosing this shortcut from the Shortcut Bar.   
Look in.  Use this drop-list to select the folder that contains the security 
for which you want to create a chart.  Traverse the folders until the 
desired folder is listed. 
Security / Symbol.  The security you select from the list appears in this 
box.  This is the security for which a new chart will be created.  You can 
select multiple securities by holding down the SHIFT or CTRL key as you 
make your selections.  A new chart will be created for each selected 
security.  See page 68 for information on filtering securities in the New 
dialog. 
Files of type.  This is disabled since charts are always saved with a 
*.mwc extension. 
Periodicity.  Choose the desired periodicity from the drop list. (Only 
available when creating a chart for an online security.) 
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File Description.  Enter a description of the new chart. 
For more information on creating charts, see page 78.  For more 
information on the Shortcut Bar and menus found in the New dialog, see 
page 70. 
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Open Dialog 
The Open dialog is used to open Smart Charts, existing charts, and 
layouts.  Choose Open from the File menu. 

 
History.  Choose the History shortcut from the Shortcut Bar to select 
from the list of securities you have most recently accessed.  You can 
adjust the size of the history by choosing Limit History Items from the 
Tools menu. 
Local Data.  Choose the Local Data shortcut from the Shortcut Bar to 
open an existing Smart Chart located on a local disk drive.  The local data 
folder from which you last viewed a security is displayed. 
Favorites.  Choose the Favorites shortcut from the Shortcut Bar to 
choose from your list of pre-defined favorite securities, charts, and 
layouts.  To add an item to Favorites, choose Add to Favorites from the 
Tools menu. 
<Online Data Vendor>.  If you are using an online data vendor, you 
may select from a list of securities available from your vendor by 
choosing this shortcut from the Shortcut Bar.   
Look in.  Use the drop-list to select the folder that contains the desired 
Smart Chart, chart, or layout.  Traverse the folders until the desired folder 
is listed. 
Security / Symbol / File Name. The chart or layout you select from 
the underlying list appears in this box.  This is the chart or layout that 
will be opened.  You can select multiple charts or layouts to open by 
holding down the SHIFT or CTRL key as you make your selections.  See 
page 68 for information on filtering securities in the Open dialog. 

Files of type. Choose the type of files (i.e., Smart Charts, charts, or 
layouts) you want to display in the list.  The last folder you opened that 
type of file from will be displayed. 
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Periodicity.  Choose the desired periodicity from the drop list.  This 
option is available only when opening an online security. 

 
File Description. Enter a description of the chart or layout. 
For more information on displaying existing charts, see page 79.  For 
more information on displaying existing layouts, see page 91.  For more 
information on the Shortcut Bar and menus found in the Open dialog, see 
page 70. 

Filtering Securities in the Open and New Dialogs 
To filter online securities displayed in the Open and New dialogs, begin 
typing the name or symbol in the Security name / Symbol box.  As you 
type, the list is filtered.   
To filter local securities displayed in the Open and New dialogs type the 
security name or part of a security name in the Security box and press the 
ENTER key.  The wildcard characters * and ? can be used as shown below. 
B* Securities that begin with the letter "B" are displayed. 
*B Securities that end with the letter "B" are displayed. 
B?  Securities that begin with the letter "B" and are followed by only one 
other character are displayed. 
 To reset the list to display all securities, delete all characters in the 
Security box and press the ENTER key. 

Close and Close All Commands 
Choose the Close command from the File menu to close the selected 
chart or layout.  Choose the Close All command from the File menu to 
close all open charts and layouts.    If any changes were made to the chart 
or layout, you will be asked if you want to save the changes. 
You can also close a chart by double-clicking the system box at the top 
left corner of the chart.  
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For information on saving charts, see page 81.  For information on saving 
layouts, see page 95. 

Save Command 
The Save command is used to save charts and layouts.  When you open a 
chart or layout, MetaStock Pro copies it from your disk to the screen.  
Changes made to charts are temporarily stored in memory until you save 
them to the disk. 
Choose Save from the File menu.  If the selected chart or layout is 
unnamed, the Save As dialog will appear, prompting you to provide a 
name.  We recommend that you use the Save command when you are in 
the middle of making extensive changes so that you avoid losing your 
work due to power outages or other unplanned events.   
For more information on saving charts, see page 81.  For more 
information on saving layouts, see page 95. 

Save Dialog 
The Save dialog is used to save a chart, layout, or template to a file name 
that you provide.  Choose Save As from the File menu.  If you attempt to 
close a chart or layout that you have made changes to, MetaStock Pro 
will automatically ask you if you want to save the chart. 
For information on saving a chart as an Internet HTML file, see page 228. 
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Save in. Use the drop-list to select the folder where the file should be 
saved.  If you have selected Smart Chart from the Save As Type list, the 
tree is disabled and the chart is automatically saved with the security data 
file. 
File Name.  Type the name you want to assign to the file.  The name of 
the selected chart, layout, or template is displayed in the File Name box.  
You can save it to its existing path and name or you can specify a new 
one.  Charts are given a *.mwc file extension, layouts *.mwl, and 
templates *.mwt.  If you have selected Smart Chart from the Save As 
Type list, the File Name box is disabled since Smart Charts are 
automatically assigned a name. 
File Description. Enter a description of the file. 
Save As Type.  Choose the type of file you want to save.  Choose Chart 
if you want to save the selected chart to a file name.  Choose Template if 
you want to save a template based on the selected chart's contents.  
Choose Smart Chart if you want to save the selected chart as this 
security’s Smart Chart. 
To save charts as a layout, first use the New Layout command in the File 
menu (see page 90).  To save a chart as an Internet HTML file, see page 
228. 
See page 78 for information on creating a new chart.  See page 101 for 
more information on saving templates.  For more information on the 
Shortcut Bar and menus found in the Save dialog, see page 70. 

Save All Command 
You use the Save All command to save all open charts and layouts to 
their existing file names.  If a chart or layout is unnamed, the Save As 
dialog will appear prompting you to provide a name.  
For more information on saving charts, see page 81.  For more 
information on saving layouts, see page 95. 

Special Controls in the New, Open, and Save Dialogs 
The New, Open, and Save dialogs are very versatile.  From these dialogs 
you can control the information listed with the securities, rename 
securities, sort the list of securities, and delete folders, charts, layouts and 
templates. 
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The items on the Shortcut Bar give you quick access to your charts.  The 
controls in the Tools and Options menu are dependent on the item you 
choose from the Shortcut Bar.   

Shortcut Bar 
History.  The History shortcut provides quick access to the items you 
have recently opened.  You can limit the number of items in your history 
list by choosing Limit History Items from the Tools menu after choosing 
History from the Shortcut Bar.  To delete all items from your History, 
choose Clear History Items from the Tools menu after choosing History 
from the Shortcut Bar. 
Local Data.  Choose Local Data from the Shortcut Bar to display the 
last folder you opened a local chart from.   
Favorites.  Choose Favorites from the Shortcut Bar to display your list 
of favorite items.  To add an item to your favorites, choose Add to 
Favorites from the Tools menu or right-click on the item and choose Add 
to Favorites from the shortcut menu.  To organize your favorite items into 
folders, choose the Create in button from the Add Favorites dialog when 
adding an item to favorites, or choose Create new folder from the 
shortcut menu when right-clicking on an item in your favorites folder. 
<Online Data Vendor>.  The current online data vendor is listed on 
the Shortcut Bar for quick access to online data.  Click this shortcut, then 
choose from the list of folders and securities.  The list of securities that is 
displayed when you first select the online vendor shortcut includes all 
securities available from that vendor.  Choose a folder to filter this list.  
When using the Change Security commands, the folder you opened the 
original security from will be used to scan the securities.  For example, if 
you open IBM from the S&P 100 folder, using the Next Security button 
on the Chart Toolbar will scan through the securities in the S&P 100 
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folder only.  If you open IBM from the main list of securities, it will scan 
through the entire list. 

Tools Menu 
Select All.  Choose this option to select all securities currently displayed 
in the dialog. 
Add to Favorites.  Choose this option to add the selected item(s) to 
your Favorites folder.   
Symbol Database.  Choose this option to display the Symbol Database 
for the current online vendor.  From this dialog, you can edit or delete 
existing symbols, or add new symbols.   
New Symbol.  Choose this option to add a symbol to the Symbol 
Database.   
New Local Security.  Choose this option to display the New Security 
dialog from which you can create a new local security file. 
Find Local Security.  Choose this option to display the Find dialog.  
This dialog is used to search your disk for specified securities.  See page 
74 for more information on using the Find command. 
Clear History.  Choose this option to remove all items from your 
History.  This option is available only when you choose History from the 
Shortcut Bar.   
Limit History Items.  Choose this option to change the number of 
items listed in your history.  This option is available only when you 
choose History from the Shortcut Bar.   
Clear Favorites.  Choose this option to remove all items from your 
favorites.  This option is available only when you choose Favorites from 
the Shortcut Bar.   
Properties.  Choose this to display detailed information about the 
selected item.  If an online security is selected, the Edit Symbol dialog 
appears, allowing you to change the properties of the selected security in 
the Symbol Database.  Some of the information in the Properties dialog 
can be viewed by choosing the Details view from the Views drop-list at 
the top of the dialog. 

Options Menu 
View By Symbol.  Choose to view the securities by ticker symbol. 
View By Name.  Choose to view the securities by name. 
Load Options.  Choose this option to specify the amount of data to 
load and display when a chart is created (see page 80). 
Open with template.  Choose this option to select a template to apply 
to the security.  For more information on applying templates, see page 98. 
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Remove Existing Charts.  Choose this option if you want all open 
charts to be closed before displaying the new chart. 

Using the Open Dialog Toolbar  
Choose List from the Views drop-list to display just the securities’ names 
or ticker symbols.  Choose Details to display name, periodicity, date 
ranges, etc. 
If the dialog is in Detail mode, you can sort the list by clicking on the 
column headings.  Click on the column heading you want the list sorted 
by.  Click on the heading a second time to reverse the sort order.  
You can also resize the width of the columns by dragging the column 
heading separators. 
The Recent button takes you back to the folder you were viewing prior to 
the current folder.  The Up One Level button allows you to move to the 
folder that is up one level from the current folder.  The Create New 
Folder button allows you to create a new folder in the current folder.    
Charts, layouts, templates and folders can be deleted by selecting the 
item, then clicking the Delete button.  You may also delete these items by 
right-clicking on the item and choosing Delete from the shortcut menu. 

Using the Right-click Shortcut Menu 
You can right-click directly on an item in the list to display commands 
specific to that item.   

  
Rename.  Choose the Rename command to rename the item.  This 
command is available only for items saved on a local drive (i.e. local 
securities, folders, layouts, charts, templates, etc). 
Delete item.  Choose Delete item  to delete the selected item. 
Add to Favorites.  Choose this to add the selected item(s) to your 
Favorites. 
Properties.  Choose this to display detailed information about the 
selected item.  If an online security is selected, the Edit Symbol dialog 
appears, allowing you to change the properties of the selected security in 
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the Symbol Database.  The Properties dialog is also accessed by choosing 
Properties from the Tools menu.  Some of the information in the 
Properties dialog can be viewed by choosing the Details view from the 
Views drop-list at the top of the dialog. 

Searching for Securities with the Find Command 
The Find command lets you search your disk for securities by name 
and/or symbol.  The results of the search are displayed at the bottom of 
the dialog.  This command is available from the Open and New dialogs 
by choosing Find Local Security from the Tools menu. 

 
Name.  Enter the name of the security to find.  Use the drop-list to select 
from previously entered names.  Use the wildcard character *, to find any 
character.  For example, M* will find all securities beginning with the 
letter "M" and  ME* will find all securities beginning with the letters 
"ME".  Leave the box blank to find all securities in the specified drive 
and folder. 
Symbol.  Enter the symbol of the security to find.  Use the drop-list to 
select from previously entered symbols.  See the information about using 
wildcard characters in the Name section above. 
Look in.  Enter (or use the Browse button to select) the folder to search. 
Include subfolders.  Check this box if you want the search to include 
subfolders for the folder specified in the Look in box. 
Find Now.  Click this button to start the search. 
Stop.  Click this button to stop a search in progress.  If you stop before 
the search is complete, no securities will be listed. 
New Search.  Click this button to clear the current search and specify a 
new one. 
Open.  Click this button to open a chart of the selected security. 
Options.  Choose this button to display the Load Options dialog, where 
you can control the amount of data to display in the chart (see page 80). 
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If the specified securities are found, the dialog will expand and list the 
securities.  You can display a chart of a security by selecting the security 
and choosing the Open button, or by double-clicking on the security’s 
name. 
Note that you can right-click on the listed securities to change the way 
the files are displayed (i.e., by name, by symbol, small icons, large icons, 
detail or list).  You can sort the listed securities by clicking on the column 
headings. 

Deleting Chart and Layout Files 
Each chart and layout is saved with a unique file name.  Charts are saved 
with a *.mwc extension; layouts with *.mwl. 
Charts and layouts can be deleted from the Open dialog by choosing 
Delete from their right-click shortcut menu, or by clicking the Delete 
button.  Securities can only be deleted using The DownLoader (see page 
60 in this manual).  Templates can be deleted from the Open Template 
dialog (see page 100) by choosing Delete from their right-click shortcut 
menu, or by clicking the Delete button. 

To delete charts or layouts  
1. Choose Open from the File menu. 
2. Choose Layout or Charts from the List Files of Type drop-list. 
3. Right-click directly on the layout or chart to delete. 
4. Choose Delete from the shortcut menu. 
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Saving Your Work with Charts 

What is a Chart? 
A chart is the focal point of much of what you do in MetaStock Pro.  A 
chart is a graphical representation of security prices along with any 
accompanying indicators and line studies.  In MetaStock Pro, a chart is 
contained within a single window.  The window is divided into one or 
more inner windows where the prices and indicators are plotted. 

 
A chart helps you perform a visual interpretation of a security.  Indicators 
can be plotted on a chart to help you see what prices have done in the 
past, what they are currently doing, and what they may do in the future 
(see page 163).  Line studies can be drawn on a chart to see how prices 
(and indicators) react at certain price levels or time intervals (see page 
205). 

The Convenience of Smart Charts 
To help with the management of your charts, MetaStock Pro 
automatically creates for every security a special type of chart called a 
Smart Chart.  A Smart Chart is simply a chart that is automatically saved 
under the security's name each time you are done working with it.  The 
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next time you load a security's Smart Chart, it appears exactly as it did 
when you last saw it.  This frees you from having to worry about saving 
your charts using the more involved (yet more flexible) Save As 
command (see page 69). 
Smart Charts appear in the Open dialog.  Choose Smart Charts from the 
Files of Type drop-list to display the Smart Charts.  MetaStock Pro 
maintains one Smart Chart per security.  If you have not yet opened the 
Smart Chart for a security, a special template called DEFAULT.MWT 
(see page 102) is used to determine how your Smart Chart will look 
initially.  You may then make the necessary changes which will be saved 
automatically. 
You may find that you only need to see one chart of a security. If this is 
the case, then Smart Charts will be a great convenience for you.  
However, if you'd like the flexibility of having multiple charts per 
security, then use the Save As command (see page 69) to assign a name 
to each chart.   
If you want to save a Smart Chart under a unique filename, choose Save 
As from the File menu.  Specify the file type as "Chart." 

Accessing Smart Charts from Read-only Media 
In order for a Smart Chart and its information (e.g., trendlines, indicators, 
moving averages, etc.) to be saved, you must be able to write to the disk 
on which the data is located.  If you are accessing data from a read-only 
disk (e.g., CD-ROM, network drive, etc.), changes to Smart Charts 
cannot be saved.  If you need to save the changes,  you can save the chart 
as a Chart file using the Save As command (see page 81). 

Creating a New Chart 

 
New button 

A new chart is created by using the New command in the File menu.  
When a new chart is created and displayed on the screen, a special 
default template called DEFAULT.MWT is automatically used to 
determine how the initial chart will appear.  For more information on the 
default template, see page 102. 
You can apply a custom template to a new chart at the time you are 
creating the chart by choosing the Template button in the New dialog.  
See page 97 for more information on Templates. 
The name of a chart appears in the chart's title bar.  Newly created charts 
are assigned a default name of "CHARTx.MWC" where "x" is a number 
corresponding to the number of unnamed charts opened. 
If you attempt to close or save a chart that has a default "CHARTx" 
name, the Save As dialog will appear prompting you to provide the chart 
a customized name (if desired). 

To create a chart  
1. Choose New from the File menu.  Choose Chart. 
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2. From the Look in box, select the folder where the security you want 
to chart is located. 

3. Double-click the name of the security you want to chart. 

Displaying Existing Charts 

 
Open button 

After a chart is saved (either manually by you or automatically as a Smart 
Chart), it can be redisplayed by using the Open command in the File 
menu. 

 
Use the Files of Type drop-list to choose Charts or Smart Charts to 
display in the list.  If the chart or Smart Chart you want to open is not 
listed, make sure the correct folder is chosen in the Look in box. 

To select multiple charts, 
hold the SHFT or CTRL 
keys down as you click. 

If you want to open multiple charts at once, you can select multiple charts 
from the list in the Open dialog and click the OK button.  Each chart you 
select will be opened. 
If you click on a chart's name, a description of the chart (if one was 
entered) is displayed in the Description box. 
You can also filter the securities displayed in the Open dialog.  See page 
68 for more information.  
If displaying the securities in the Open dialog is too slow, you may want 
to reduce the number of securities in the folder.  Although a folder can 
hold up to 6,000 securities, anything over 1,000 may cause the Open 
dialog to display very slowly on some computers. 
You can apply a custom template to a Smart Chart by choosing Open 
with Template from the Options menu.  See page 97 for more 
information on Templates. 
If you attempt to open a chart or Smart Chart that is already open, the 
open chart or Smart Chart is selected.  If you need to make a "clone" of 
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an open chart, use the New Window command in the Window menu (see 
page 86). 

To open an existing chart  
1. Choose Open from the File menu. 
2. From the Files of Type drop-list, select either Charts or Smart 

Charts, depending on the type of chart you want to open. 
3. If you chose Smart Charts, you can also apply a template (if desired) 

by choosing Open with Template from the Options menu. 
4. From the Look in box or Shortcut Bar, select the folder where the 

chart you want to display is located. 
5. Double-click the name of the chart you want to display. 

To quickly open multiple charts  
1. Choose Open from the File menu. 
2. From the Files of Type drop-list, select either Charts or Smart 

Charts, depending on the type of chart you want to open. 
 
If you chose Smart Charts, you can also apply a template to each of 
the charts (if desired) by choosing Open with Template from the 
Options menu. 

3. From the Look in box or Shortcut Bar, select the folder where the 
charts you want to display are located. 

4. Select multiple charts by holding down the CTRL key as you click the 
mouse. 

5. Click the Open button. 

Controlling the Number of Periods Loaded 
You can control how many periods of data are loaded and displayed by 
choosing Load Options from the Options menu in the New or Open 
dialogs.  Up to 65,500 periods (i.e., days, weeks, months, etc.) of data can 
be loaded and displayed in a chart. 

 
Load [ ] periods display [ ] periods.  Enter the number of periods to 
load and display. 
Prompt for dates when chart is opened.  Select this button if you 
want to specify the amount of data loaded each time a chart is opened.   
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Specifying the Date Range When Loading 
If you choose the "Prompt for dates when chart is opened" button in the 
Load Options dialog, MetaStock Pro will prompt you for the amount of 
data to load each time a chart is created or opened.  This is useful to view 
different ranges of data for different charts. 

 
The periods displayed in the "Last __ time periods" box defaults to the 
last number entered.  Also note that the dates displayed in the First Date 
and Last Date boxes correspond to first and last dates available in the 
data file. 

To specify the date range when loading  
1. Choose New (or Open) from the File menu. 
2. Choose Load Options from the Options menu. 
3. Select the Prompt for dates when chart is opened button. 
4. Click the OK button. 
5. Select the security (or chart) you want to load.  The Date Range 

dialog will appear prompting you for the range of data to load. 

Identifying Composite Securities 
A composite is a special security type that links two securities together 
with a mathematical operator.  Composite securities are created with The 
DownLoader. 

 
Composite security 

Composite securities are easily identified from the Open and New dialogs 
by a special icon to the left of the security's name. 

Saving Charts 
When you open a chart, MetaStock Pro copies it from your disk to the 
screen.  Changes made to charts are temporarily stored in memory until 
you save them to the disk. 

 
Save button 

Charts are saved with the Save and Save As commands in the File menu.  
MetaStock Pro also has an automatic saving feature called Smart Charts.  
If you open a Smart Chart, the changes you make are automatically 
saved when the chart is closed (see page 77). 
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If you use the Save command to save a chart and the selected chart is 
unnamed, the Save dialog will appear prompting you to provide a name.  
If you attempt to close a chart to which you have made changes, you will 
be asked if you want to save the chart. 
We recommend that you save your charts often when making extensive 
changes so that you avoid losing your work due to power outages or 
other unplanned events. 
Although a Smart Chart is automatically maintained for every security, 
there may be times when you want a specific "chart" to replace the 
security's automatically-created Smart Chart.  Choose Smart Charts as the 
Save as type if you want the selected "chart" to replace the underlying 
security's Smart Chart. 

To save a chart 
1. Select the chart you want to save by clicking directly on the chart. 
2. Choose Save from the File menu.  If the chart is new and unnamed, 

you will be prompted to supply a name in the Save dialog (see page 
69). 

Closing Charts 
After you finish working on a chart, you should close it to free memory.  
If you attempt to close a chart to which you have made changes, 
MetaStock Pro will ask you if you want to save the chart first.  If you 
attempt to close a chart that has never been saved before (e.g., a newly 
created chart), MetaStock Pro displays the Save dialog which prompts 
you to provide the chart a name. 
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To close a chart  
1. Select the chart you want to close and do one of the following: 

• Choose Close from the File menu. 
• Click the Close button in the upper-right corner of the chart. 
• Double-click the chart's system box in the upper-left corner of 

the chart. 
2. If the chart has been changed, you are asked if you want to save it.  

If the chart is unnamed, you are prompted to provide a name. 

To close all open charts  
1. Choose Close All from the File menu. 
2. If any chart has been changed, you are asked if you want to save it.  

If any chart is unnamed, you are prompted to provide a name. 

Scanning Charts with the Change Security Commands 
A quick way to scan all the securities in a folder is with the Change 
Security commands.  The Change Security commands replace the base 
security of the selected chart or layout with the next (or previous) 
security in the folder.  All indicators are recalculated (using the same 
parameters) on the new base security.  Everything else about the chart or 
layout remains intact.  
There are four ways to access the Change Security commands.   
• You can choose them with the Change Security command in the File 

menu. 
• You can use the Microsoft IntelliMouse™ pointing device.  While 

holding the ALT key down, rotate the wheel forward to move to the 
next security or rotate back to move to the previous security.  See 
page 87 for more information on the IntelliMouse pointing device. 

• You can type ALT+RIGHT ARROW to move to the next security or 
ALT+LEFT ARROW to move to the previous security. 

• You can click the Next Security or Previous Security buttons on the 
Chart toolbar (see page 24).  

 
This feature can be a great time saver, particularly for those who like to 
look at all their securities with the same set of indicators. 
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If you are in the middle of scanning through securities, any changes made 
to a chart are reflected in all charts that you subsequently scan to. 
Smart Charts are unaffected unless you make changes to a chart.  If 
changes are made to the displayed security, the security's Smart Chart 
will be overwritten. 

To scan through charts  
1. Display a chart that you'd like to use as the base chart when scanning. 
2. Do one of the following: 

• Choose Change Security from the File menu.  Choose Next. 
• Type ALT+RIGHT ARROW. 
• Click the Next Security or Previous Security button on the 

Chart toolbar. 

Choose a Security 
If you like the idea of scanning charts, but don't want to sequentially 
advance through every security in the folder, you can use the Choose a 
Security dialog.  This dialog allows you to select a security from a list.  
The simplest way to access this dialog is to simply type the name or ticker 
symbol while a chart is displayed.  If you type the name, make sure the 
"By Name" radio button is selected (or the "By Symbol" button if typing a 
ticker symbol).  As you type, the Choose a Security dialog automatically 
appears and advances to the security's name or ticker symbol.  Press the 
ENTER key or click the OK button to display the chart. 

 
If you type a name or symbol that does not exist in your security files, the 
Choose a Security dialog will appear with no match.  Press the ENTER 
key or click the OK button and the New Security dialog automatically 
appears and allows you to create a new security.  See page 60 for more 
information on adding new securities. 
There are three ways to access the Choose a Security dialog.   
• Choose the Change Security command in the File menu.   
• Click the Choose Security button on the Chart toolbar (see page 24). 
• With a chart displayed, begin typing a security’s name.  As you type, 

the Choose a Security dialog will automatically appear. 

Options for Scanning Charts 
The Change Security options can be accessed by choosing the Options 
tab in the Choose Security dialog. 
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Use Smart Charts.  Choose this option to display a security's own 
Smart Chart when scanning (see page 34).   
Use Chart as Template.  Choose this option to scan charts with the 
same information (i.e., indicators, periodicity, etc.). 
Keep Line Studies. Check this box to transfer line studies from one 
chart to the next when scanning (see page 34). 
Change All Charts in a Layout.  Check this box to scan your charts 
using a multi-chart template or layout (see page 33).  

Scrolling Charts 
A horizontal scroll bar is located at the bottom of every chart.  This scroll 
bar lets you move forward and backward through the loaded data.  Click 
the left scroll button to scroll backward through the data, and click the 
right scroll button to scroll forward through the data.  You can also click 
and drag the scroller to move in either direction. 

 
To scroll your data, you must have more data loaded than displayed.  You 
can use the Load Options dialog (see page 80), the X-Axis properties 
dialog (see page 118), or the Zoom-In command (see page 128) to reduce 
the amount of data displayed versus the amount loaded. 
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You can also scroll through the data in a chart using the Microsoft 
IntelliMouse pointing device.  Simply rotate the wheel forward to scroll 
forward and rotate back to scroll backward.  See page 87 for more 
information on the IntelliMouse pointing device. 

Learn as You Plot 
You can scroll a chart by only a single time period (i.e., day, week, or 
month) by holding down the SHIFT key when clicking on a chart's 
horizontal scroll buttons. 
This can be useful if you want to do what we call "learn as you plot."  By 
analyzing a chart and then scrolling a chart forward one period at a time, 
thereby simulating the passing of time, you can quickly improve your 
technical analysis skills. 
It is helpful to use the histogram or dot as your indicator style when using 
learn as you plot.  If you use a standard line style, you will be able to see 
the direction the indicator is moving before you scroll to the next period. 

 

To automatically scroll through a chart, you can also use the Microsoft 
IntelliMouse pointing device.  See page 87 for more information on the 
autoscroll feature of the IntelliMouse pointing device. 

Rescale Y-Axis 
The Rescale Y-Axis button is used to manually force the y-axis to rescale.  
This tool is primarily used when you are using the chart's scroll bar to 
scroll through the data.  Choose this command from the View menu or 
from the Chart toolbar. 

 
 

 
Rescale Y-axis button 

When scrolling forward or backward through a chart, the y-axis scale 
remains fixed (unless the Scroll Rescales Y-Axis checkbox in the 
Application Properties dialog is checked, see page 34).  However, the data 
being scrolled may oscillate up and down.  Very often, the data moves 
outside the fixed range of the y-axis scale. When this occurs, use the 
Rescale Y-axis command to rescale the chart so that the data comes into 
complete view. 

Cloning Charts 
The New Window command in the Window menu is used to create a copy 
(i.e., clone) of the selected chart.  For example, if you have a chart named 
"IBM" selected, and you choose the New Window command, another 
chart will open containing the same data and plots.  The new chart will be 
unnamed with the title "Chart1-IBM."  
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This command is useful for quickly designing a layout or template that 
requires multiple charts of the same security. 

To clone a chart  
1. Select the desired chart by clicking anywhere on it. 
2. Choose New Window from the Window menu.  

Using the Microsoft IntelliMouse Pointing Device 
The Microsoft IntelliMouse pointing device is similar to a typical  
mouse in much of its functionality with one unique difference.  It contains 
a wheel that gives you quick and convenient access to several commonly 
used features in MetaStock Pro. 

 

IntelliMouse Action Result 
Rotate wheel Scrolls chart 
ALT + rotate wheel Scan through charts 
CTRL + rotate wheel Zoom-in/out 
SHIFT + rotate wheel Change periodicity 

Press wheel button and move Autoscroll chart 

 
Scrolling Charts.  When you have more data loaded than displayed, 
you are able to scroll through the data.  To scroll forward using the 
IntelliMouse pointing device, simply rotate the wheel forward (i.e., 
toward the monitor).  To scroll back using the IntelliMouse pointing 
device, simply rotate the wheel back (i.e., away from the monitor).  See 
page 85 for more information on scrolling through charts. 
Scanning Charts.  To scan from one chart to the next in your folder, 
hold the ALT key down and rotate the wheel forward (i.e., toward the 
monitor) to advance to the next security or rotate back to move to the 
previous security.  See page 83 for more information on scanning charts. 
Zoom Scaling Charts.  To zoom-in/out on a chart, hold the CTRL key 
down and rotate the wheel forward (i.e., toward the monitor) to zoom-in 
or back (i.e., away from the monitor) to zoom-out.  See page 128 for 
more information on zoom scaling. 
Change Periodicity of a Chart.  To change the periodicity in a chart, 
hold the SHIFT key down and rotate the wheel forward (i.e., toward the 
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monitor) to move to a shorter periodicity (e.g., weekly to daily) or back 
(i.e., away from the monitor) to move to a longer periodicity (e.g., weekly 
to monthly).  See page 120 for more information on periodicity. 
Autoscrolling Charts.  To scroll through a chart automatically, press 
the wheel button on the IntelliMouse pointing device.  The pointer will 
change to a double arrow.  Move the arrow left or right depending on 
which direction you wish to autoscroll.  The further you move the arrow 
away from its origin the faster the autoscroll.   

 

Note that you must have the wheel button assignment set to "Default" 
in the Windows Mouse Properties dialog in Control Panel.  Otherwise, 
the autoscroll feature will not operate.  See page 85 for more 
information on scrolling through charts. 
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Combining Multiple Charts with 
Layouts 

What is a Layout? 
Layouts provide a convenient way to manage groups of charts.  Maybe 
you'd like to combine your favorite computer stocks into one easily 
managed group.  Or maybe you'd like to see IBM along with the Dow and 
four of your favorite indicators.  The best way to manage such groups of 
charts is with a layout. 
A layout itself is a single file that, when opened, brings up all the charts  
that were saved in the layout.  When displayed on your screen, each 
member chart can be identified by the layout's name, which appears in 
each chart's heading.  A layout can even include minimized charts. 

 
When a layout is opened, each member chart is opened and positioned on 
the screen exactly as it appeared when the layout was saved, including the 
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scaling.  Even charts that were not visible (or were minimized) when the 
layout was saved will be opened. 

Creating a New Layout 
Layouts can be created after you have opened and arranged the desired 
charts.  You'll notice that the Layout command (choose File|New) is 
disabled until a chart (or charts) is opened. 

 
New button 

Once you have opened and arranged the desired charts to your liking, use 
the New command in the File menu to create the layout.  The Layout 
dialog is used to choose which charts to include in the layout. 
Until you save a newly created layout, a default name of "Layoutx" 
(where "x" is a number) is automatically assigned.  This name appears in 
the title bar of each chart included in the layout (along with the security 
name).  See page 95 for information on saving the layout with a new 
name. 

 
To select multiple charts, 
hold the SHFT or CTRL 
key down as you click the 
mouse. 

Add.  This button moves the selected chart(s) from the Available Charts 
list to the Included Charts list.  You can also double-click a chart to add it 
to the Included list. 
Add All.  This button moves all charts in the Available Charts list to the 
Included Charts list. 
Remove.  This button moves the selected chart(s) from the Included 
Charts list to the Available Charts list.  This removes the selected chart(s) 
from the layout.  You can also double-click a chart to remove it from the 
Included list. 
Remove All.  This button moves all charts from the Included list to the 
Available list.  This removes all charts from the layout. 

To create a layout  
1. Display the charts to include in the layout by using the Open (or 

New) command in the File menu (see page 78). 
2. Modify the charts as desired (e.g., add indicators, add moving 

averages, resize, etc.). 
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3. Choose New from the File menu.  Choose Layout. 
4. Click the Add All button to add all the open charts to the Included 

list.  These are the charts that will appear in the layout. 
5. To save the layout, choose Save As from the File menu, and give the 

layout a unique file name.   
Each chart will now have the name "Layoutx" (where "x" is a number) in 
the title bar to show that the chart is a member of the layout.  For more 
information on saving layouts, see page 95. 

Displaying an Existing Layout 

 
Open button 

After a layout has been saved, it can be re-opened using the Open 
command in the File menu.  If Layouts is selected in the Files of Type 
drop-list in the Open dialog, all layouts in the selected folder are 
displayed.  Layouts have a *.mwl file extension. 

 
To select multiple 
layouts, hold the SHFT or 
CTRL keys down as you 
click. 

If you want to open multiple layouts at once, you can select multiple 
layouts from the list in the Open dialog and click the OK button.  Each 
layout you select will be opened. 

If you click on a layout's name in the Open dialog, a description of the 
layout (if one was entered) is displayed in the Description box.  
The Options button (see page 80) in the Open dialog is disabled if the File 
Type is "Layouts."  This button is disabled because layouts always load 
the amount of data that was saved with the layout.   
When a layout is loaded, each chart included in the layout will have the 
layout name in its title bar. 

To display an existing layout  
1. Choose Open from the File menu. 
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2. From the Files of Type drop-list, select Layouts. 
3. From the Look in box, select the folder where the layout you want to 

display is located. 
4. Double-click the name of the layout you want to display. 

Scanning Charts in a Layout 
You can use the Change Security commands to scan the securities in a 
folder using a layout as the template.  This can be useful if you’d like to 
see more than one periodicity at a time, more than one Expert Advisor at 
a time, or like to see several different indicators plotted separately but 
still plotted with the price plot.   
To scan your securities using a multi-chart template or layout, choose the 
Change All Charts in a Layout option in the Change Security options (see 
page 33).  Once this option is selected, simply click the Next or Previous 
Security button on the Chart Toolbar to scan your securities in a layout.  
If this option is not selected, only the active chart will change to the new 
security. 

To scan charts in a layout 
1. Open a layout. 
2. Click the Choose a Security button on the chart toolbar. 
3. Click the Options tab. 
4. Select Use Chart As Template and Change All Charts in a 

Layout.  Click OK. 
5. Click the Next, Previous, or Choose a Security buttons from the 

Chart Toolbar to scan the securities in the folder containing the 
active chart's security. 

Making Changes to a Layout 
After a layout has been created, you can easily add and delete charts from 
the layout using the Edit Layout command in the File menu.  A layout 
must be open before the Edit Layout command is available.  If you choose 
the Edit Layout command when there is more than one layout open, the 
Select Layout dialog appears (see page 94). 
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For information on the controls in the Edit Layout dialog, see page 90. 
Whenever you make changes to individual charts within a layout, be sure 
to save the layout (see page 95) if you want the changes permanently 
reflected in the layout. 
The scaling of individual charts within a layout are set at the time the 
layout is saved.  Therefore, if you need to change the scaling of a chart 
within a layout, you must remove the chart from the layout, change the 
scaling, then re-add the chart to the layout. 
Special windowing commands implemented exclusively for layouts allow 
you to cascade, stack, and tile only those charts included in a layout.  By 
holding the SHIFT key down as you choose the cascade, tile, or stack 
options in the Window menu, you can arrange only those charts in the 
layout.  This feature is handy to view charts in a specific layout on your 
screen when you have multiple charts and layouts open simultaneously.  
See page 15 for more information on these windowing commands. 
If you want to save a chart that is already in a layout as a separate chart 
file, you should use the New Window command in the Window menu to 
create a duplicate of the chart (see page 86) and then use the Save As 
command in the File menu (see page 69). 
If you remove a chart from a layout using the Edit Layout dialog, the 
chart remains on your screen and becomes an unnamed chart (e.g., 
Chart1, Chart2, etc.). 

To edit charts within a layout  
1. Choose Open from the File menu.  Select Layout from the Files of 

Type drop-list. 
2. Select the desired layout and click Open. 
3. Make the desired changes to the chart(s) within the layout. 
4. Choose Save from the File menu. 

To add charts to a layout  
1. Choose Open from the File menu.  Choose Layout from the Files of 

Type drop-list. 
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2. Select the desired layout and click Open. 
3. Choose Open from the File menu.  Select Smart Charts from the 

Files of Type drop-list.  
4. Select the charts you want to add to the layout and click Open. 
5. Choose Edit Layout from the File menu. 
6. Select the charts you want to add to the layout from the Available 

Charts list and click the Add button to add them to Included Charts 
list.  You can also double-click a chart to add it to the Included 
Charts list.  

7. Click the OK button. 

To delete charts from a layout  
1. Choose Open from the File menu.  Select Layout from the Files of 

Type drop-list. 
2. Select the desired layout and click Open. 
3. Choose Edit Layout from the File menu. 
4. Select the charts you want to delete from the Included Charts list and 

click the Remove button.  You can also double-click a chart to 
remove it from the Included Charts list. 

5. Click the OK button. 
The charts will remain on your screen until you have saved, closed, and 
re-opened the layout. 

 
System box 

You can also remove a chart from a layout by double-clicking the chart's 
system box in the upper left corner of the chart.  The Close Layout dialog 
will appear.  Select "Close the chart and remove it from the layout." 

To tile/stack/cascade charts in a layout  
1. Select a chart in the layout you want to arrange by clicking anywhere 

on the chart. 
2. Hold the SHIFT key down to arrange only the charts in the layout, 

then click the tile, stack, or cascade button on the toolbar. 

Select Layout Dialog 
If you choose the Edit Layout command when you have more than one 
layout open, you are prompted to select the layout to edit from the Select 
Layout dialog. 



 

 
 

MetaStock Professional Combining Multiple Charts with Layouts • 95 

 

 

 

 
To select the layout to edit, you can either double-click the layout or click 
the layout and choose the OK button. 

Saving a Layout 

 
Save button 

When you make changes to a layout, you should save the layout using the 
Save or Save As commands in the File menu.  The Save command saves 
the layout to its existing name.  The Save As command lets you specify a 
new name (and location) for the layout. 

 
If you use the Save command to save a layout and the layout is unnamed 
(i.e., a newly created layout), the Save dialog will appear prompting you 
to provide a name.  If you attempt to close a layout to which you have 
made changes, you will be asked if you want to save the layout first. 
We recommend that you save your layouts often when making extensive 
changes so that you avoid losing your work due to power outages or other 
unplanned events. 

To save a layout 
1. Select the layout you want to save by clicking directly on any chart 

in the layout. 
2. Choose Save from the File menu.  If the layout is new and unnamed, 

you will be prompted to supply a name in the Save dialog (see page 
69). 
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Closing a Layout 
Since a layout is a set of charts, whenever you attempt to close a chart 
within a layout, the Close Layout dialog appears prompting you to close 
just the chart or to close the entire layout. 

 
If you attempt to close a layout to which you have made changes, 
MetaStock Pro will ask you if you want to save the layout.  If you attempt 
to close a layout that has never been saved before (e.g., a newly created 
layout), MetaStock Pro displays the Save As dialog in which you can 
provide the layout a name. 

To close a layout  
1. Select a chart in the layout you want to close and do one of the 

following: 
• Choose Close from the File menu. 
• Click the Close box in the upper-right corner of any chart in the 

layout. 
• Choose Close Layout from the chart's control menu.  The 

control menu is displayed by clicking on the system box in the 
upper left corner of the chart.   

 
System box 

• Double-click the chart's system box in the upper-left corner of 
the chart. 

2. The Close Layout dialog appears.  Choose Close the entire layout. 
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Recycling Your Work with 
Templates 

What is a Template? 
A template contains all the information in a chart or layout excluding the 
base security.  A template is applied to a security (either to an existing 
open chart or when loading a chart) at which time a new chart or layout is 
created based on the template's information.  Each template is saved as a 
file with a *.mwt extension. 
If the information from a template came from a single chart, then a chart 
is created when the template is applied.  If the information came from a 
layout, then a multi-chart layout is created. 
For example, suppose you like to analyze your securities with an RSI, 
MACD, and a 50-day moving average.  You could save this information 
in a template and apply it to any security in one quick step. 
You can also create a default template that is always used when a new 
chart is created (see page 102). 
Once a template is created, it can be used over and over. 

Creating a New Template 
A template is created from the information in either a chart or a layout.  
Once the chart or layout appears as you'd like, use the Save As command 
in the File menu to save the template. 
If you create a template when a multi-chart layout is selected, a multi-
chart template is created.  If you create a template when a single chart is 
selected, a single-chart template is created. 
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To create a template  
1. Choose Open from the File menu. 
2. Choose Smart Chart, Chart or Layout from the File of Type drop-

list.  Choose Smart Chart or Chart to create a single chart template.  
Choose Layout to create a multi-chart template. 

3. Select the desired chart or layout and click the Open button. 
4. Make the desired changes to the chart (i.e., add indicators or moving 

averages, change the scaling, etc.). 
5. Choose Save As from the File menu.   
6. Choose Template from the Save as type drop-list. 
7. Type a name in the File Name box. 
8. Click the Save button. 

Applying an Existing Template 
Templates can be applied to a chart on the screen, when you open a 
Smart Chart from the Open dialog, or when you create a new chart.  
When a template is applied to a chart, the template uses the chart's base 
security for all charts in the template. 
If the template was created from a single chart, then a chart is created 
when it is applied.  The name in the affected chart's title bar will appear as 
"Chartx-Security Name" (where "x" is a number).   
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If the template was created from a multi-chart layout, then a layout is 
created when the template is applied.  The name in each of the chart's title 
bars will appear as "Layoutx-Security Name:x" (where "x" in Layout 
refers to the layout number and "x" next to the Security Name is the 
chart's differentiating number). 

 
As previously mentioned, when a template is applied to a chart, a new 
chart is created.  However, the chart to which the template was applied 
remains on the screen.  If you do not want the original chart to remain on 
the screen, check the Close all open charts box in the Apply Templates 
dialog.   
A template can be applied to an open chart by right-clicking on the chart 
and selecting Apply Template from the shortcut menu. 
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You can also apply a template when creating a new chart or when opening 
Smart Charts by choosing Open with Template from the Options menu in 
the New or Open dialogs.  Note that this option is disabled in the Open 
dialog if you don't have Smart Charts selected in the Files of Type drop-
list. 
If you find templates useful for your analysis, you may also want to try the 
Change Security commands (see page 83). 

To apply a template to an open chart  
1. Right-click on the chart. 
2. Choose Apply Template from the shortcut menu. 
3. Choose the desired template from the Apply Template dialog. 

To apply a template when loading a security  
1. Choose Open or New from the File menu. 
2. If you are opening an existing security with the Open dialog, select 

Smart Charts from the Files of Type drop-list. 
3. Choose Open with Template from the Options menu. 
4. Choose the desired template from the Open Template dialog.  Click 

Open. 
5. Choose the desired security.  Click Open. 

Open Template Dialog 
You can apply a template to a security when loading by choosing Open 
with Template from the Options menu in the New or Open dialog.  If you 
are in the Open dialog, this option is disabled if you don't have Smart 
Charts selected in the Files of Type drop-list. 
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Look in.  Use the drop-list to select the drive for the folder of files you 
want to display in the list.  Traverse the folders until the folder containing 
the templates is listed. 
File Name.  The template you select from the list appears in this box.  
This is the template that will be opened and applied to the selected 
security.  
For information on creating templates, see page 97.  For information on 
creating layouts, see page 90. 

Making Changes to a Template 
Changes are made to a template by opening (applying) the desired 
template, making the changes, and resaving the template to the same file 
name. 

To make changes to an existing template  
1. Apply the template you want to change to a security or chart (see 

page 98). 
2. Make the desired changes. 
3. Choose Save As from the File menu. 
4. Choose Template from the Save as Type drop-list. 
5. Double-click the name of the template file you are currently editing.   
6. Choose Yes when asked if you want to "replace the existing file." 

Saving a Template 
Templates are saved using the Save As command in the File menu.  If you 
want the changes you have made to a template to be retained, you must 
save the template using the Save As command. 
You can also save a template as the default template.  The default 
template is automatically applied to all newly created charts.  See page 
102 for more information on the default template. 

To save a template  
1. Choose Save As from the File menu. 
2. Choose Template from the Save as Type drop-list. 
3. If you are editing a template and want to save the changes to the same 

template name, double-click the name of the template file. 
4. If you are saving a new template, type a name in the File Name box 

and click Save.   
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The Default Template 
You can control how a newly created chart appears using the default 
template.  The default template is a special template that is exactly like a 
regular template except that MetaStock Pro automatically applies it to 
newly created charts.  The default template that is shipped with 
MetaStock Pro is just a single chart with high-low-close price bars and 
volume. 
The default template is named DEFAULT.MWT and it is stored beneath  
the MetaStock Pro program folder (i.e., c:\Program 
Files\equis\metastock\charts) along with your other templates.  This 
means that the default template can be applied at any time just like a 
regular template. 
For example, you could change the default template so that candlesticks 
and a moving average are always plotted when a new chart is created.  
To quickly make the information in the currently selected chart the default 
template, right-click on the chart and choose Save as Default Template. 

 

To edit the default template  
1. Choose New from the File menu.  Choose Chart. 
2. Double-click any security or chart listed in the dialog. 
3. Make the desired changes to the chart. 
4. Right-click on the chart and choose Save as Default Template from 

the shortcut menu. 
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Customizing a Chart's Appearance 

Chart Window 

Selecting a Chart 
Before any changes can be made to a chart, the chart must be selected.  
You can select a chart from the Window menu (a checkmark designates 
the selected chart), or by clicking anywhere on the chart.  The selected 
chart is distinguished by its unique title bar color.  The name of the 
selected chart is also shown in the Application's title bar. 

 
The chart of Intel above has a different title bar color than the others.  
This lets you know that it is the selected chart. 
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To select a chart  
Do one of the following: 
• Click the mouse anywhere on the desired chart. 
• Choose the desired chart at the bottom of the Window menu. 

Modifying a Chart 
The properties of a chart are modified with the Chart Window Properties 
dialog.  This dialog is accessed by right clicking on a chart and selecting 
Chart Window Properties from the shortcut menu.  You can also choose 
Chart Window from the Format menu. 
Modifications made to a chart's window are retained automatically by 
MetaStock Pro's Smart Chart feature if you are working with a Smart 
Chart.  If you are working with a chart or layout, you should save the 
chart or layout to retain the changes. 

To modify a chart  
1. Right-click on the desired chart. 
2. Choose Chart Window Properties from the shortcut menu. 
3. Make the desired changes in the Chart Window Properties dialog. 
4. Click the OK button. 
For information on modifying an inner window's properties, see page 111. 

Chart Options 
The Chart Options page is located in the Chart Window Properties dialog.  
Choose Chart Window from the Format menu, or right-click on a chart 
and choose Chart Window Properties from the shortcut menu. 

 
Show Chart Title Bar.  Check this box if you want the title bar of the 
selected chart displayed.  The chart title bar displays the name of the chart 
(or layout) and the information specified in the "Title" page of this dialog 
(see page 107). 
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To control the display of the chart title bar for all charts, use the 
Application Properties dialog (see page 33). 

 
Show Chart Toolbar.  Check this box if you want the toolbar of the 
selected chart displayed (see page 24 for more information on the chart 
toolbar). 
To control the display of the chart toolbar for all charts, use the 
Application Property dialog (see page 34). 
Show Inner Window Title Bars.  Check this box if you want the inner 
window title bars in the selected chart displayed.  The inner window title 
bars display the names of the plots (e.g., security name, indicator name, 
etc.) in the inner window.  If you choose the accompanying "Show Values 
in Title Bars" box, the last period's value for the plot in each inner  
window will display.   
If this checkbox is grayed, it means that the display of at least one of the 
inner window title bars is being controlled by the inner window's 
properties page (see page 112).  
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Show Inner Window Splitter Bars.  Check this box if you want 
splitter bars between the inner windows.  The splitter bar allows you to 
resize inner windows with the mouse (see page 113). 

 

Scale Locations 
The Scale Locations page is located in the Chart Window Properties 
dialog.  Choose Chart Window from the Format menu (or right-click on a 
chart and choose Chart Window Properties from the shortcut menu). 
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Left (Y-Axis).  Check this box if you want a y-axis scale displayed on 
the left side of all inner windows in the chart.  Use the Y-Axis Properties 
dialog to control properties of the scale itself (see page 123). 
Right (Y-Axis).  Check this box if you want a y-axis scale displayed on 
the right side of all inner windows in the chart.  Some people like to have 
just the right y-axis displayed since it is closest to the most recent data.  
Use the Y-Axis Properties dialog to control properties of the scale itself 
(see page 123). 
Date (X-Axis).  Check this box if you want an x-axis scale displayed at 
the bottom of the chart window.  The same x-axis scale is used for all 
inner windows displayed in a chart.  Use the X-Axis Properties dialog to 
control properties of the scale itself (see page 118). 

Title 
The Title page is located in the Chart Window Properties dialog.  Choose 
Chart Window from the Format menu, or right-click on a chart and 
choose Chart Window Properties from the shortcut menu.   
While you can control what is displayed in the center and right side of the 
title bar, the name of the chart is always displayed on the left side. 
If you display the "Last Price" in an intraday chart, the change in price 
from the previous day's close is also included in parenthesis. 
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Center.  Choose the information to display in the center of the title bar.  
Right. Choose the information to display on the right side of the title bar. 
Description.  These boxes are used to enter or edit a description about 
the selected chart and/or layout.  This description appears in the Open 
dialog (see page 68).  Charts that are members of a layout share the same 
layout description. 

Repositioning Charts 
Since a chart is contained within a window, repositioning a chart is just a 
matter of using basic click and drag techniques common to all Windows 
programs.   
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If the title bar of a chart is not displayed, you can still move a chart by 
typing ALT+ "-" to access the chart's system box, choosing Move, and then 
using the arrow keys. 

To reposition a chart  
1. Position the mouse pointer over the chart's title bar. 
2. Click and drag the mouse until the chart is in the desired location. 
You can quickly arrange the charts on your screen by using the 
windowing commands (tile, cascade, etc.) in the Window menu (see page 
15). 

Resizing Charts 
Since a chart is contained within a window, resizing a chart is just a 
matter of using basic click and drag techniques common to all Windows 
programs.   
For information on resizing inner windows within a chart, see page 113. 

To resize a chart  
1. Position the mouse pointer over the chart's border until a double-

sided resizing arrow appears. 
2. Click and drag the mouse until the chart is the desired size. 

 
Minimize/Maximize 
buttons 

You can quickly enlarge a chart to full-screen with the maximize button, 
or you can minimize a chart with the minimize button.  The 
minimize/maximize buttons are found in the upper-right corner of a chart.  
You can restore a minimized chart to its original size by double-clicking 
directly on the minimized chart's title bar. 
The application itself (i.e., the MetaStock Pro program) is also contained 
within a window.  It can be resized using the same methods described 
above. 

Clearing a Chart 
The Delete All command in the Edit menu provides a quick and 
convenient way to remove indicators, line studies, symbols, text, and 
non-base securities from your chart.  Simply click on the items you want 
removed from the selected chart and click the OK button.  The chart will 
redisplay with the selected items removed.  
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Click the "Close Empty Inner Windows" box if you want MetaStock Pro 
to close any leftover inner windows. 

Inner Windows 

Opening Inner Windows 
An inner window is a window within a chart window that can be 
controlled within the confines of the chart window.  A chart can contain 
up to 10 inner windows. The most common reason for opening an inner 
window is to plot an indicator.  However, price plots are also contained 
within an inner window.   
There are four ways to open an inner window.  

1. You can use the Indicators command (see page 164) from the Insert 
menu to plot an indicator in a new inner window. 

 
2. You can drag and drop an indicator from the Indicator QuickList (see 

page 165). 
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3. You can choose New Inner Window from the Window menu.  
 

 
4. You can choose Inner Window, New from the chart shortcut menu.  

Right-click anywhere on a chart to access the chart shortcut menu. 

 
If you don't want to plot an indicator in an inner window (i.e., maybe 
you'd like to copy another security's prices into it), you should use 
methods three or four to create an empty inner window. 

Modifying Inner Windows 
The properties of an inner window are modified with the Inner Window 
Properties dialog.  This dialog is accessed by right-clicking on an inner 
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window and selecting Inner Window, then Properties from the shortcut 
menu.  
You can also choose Inner Window from the Format menu.  This 
command acts on the inner window most recently modified or clicked in.  
If you are working with a Smart Chart, modifications made to an inner 
window are retained automatically.  If you are working with a chart or 
layout, you should save the chart or layout to retain the changes. 

 
Background Color.  Choose the desired background color for the inner 
window.  You should choose a color that is different from any other items 
plotted in the window (e.g., a blue indicator on a blue background will 
disappear). 
Show Title Bar.  Check this box if you want to display the inner 
window's title bar.  The title bar displays the contents of the inner window 
(e.g., indicator, security name, etc.) and provides a system box and 
maximize/restore buttons.   
Show Value In Title Bar.  Check this box if you want the inner 
window to display the value of the last period's plot(s). 
Use Color of Plot.  Check this box if you want the plot values in the 
inner window title bar to match the color of the plot(s). 
Apply to All Inner Windows.  Check this box if you want the settings 
in this dialog to apply to all inner windows within the chart.  Leave it 
unchecked if you only want the settings to apply to the selected inner 
window. 
If an indicator is calculated on a security other than the chart's base 
security, the name of the security is shown in parenthesis after the 
indicator's name in the inner window’s title bar. 

To modify an inner window  
1. Right-click within the desired inner window. 
2. Choose Inner Window from the shortcut menu.  Then choose 

Properties. 
3. Make the desired changes to the Inner Window Properties dialog. 
4. Click the OK button. 
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For information on modifying a chart's properties, see page 104. 

Resizing Inner Windows 
The height of an inner window can be adjusted several ways including 
using the splitter bar, maximize/restore buttons, and the Arrange Inner 
Window command.   
Adjusting the height of an inner window is useful if you want to provide 
more space for a certain price plot or indicator.  Maybe you'd like to 
temporarily see the indicator enlarged to fit the entire chart window.  Or 
maybe you always like to have the base security plot occupy three-fourths 
of the chart.  
The Arrange Inner Windows command is available from the Chart 
shortcut menu by right-clicking on an inner window.  You can also choose 
Arrange Inner Windows from the Window menu.  The Arrange Inner 
Windows command resizes the inner windows within a chart so they are 
equally sized. 
Click on an inner window's maximize button to enlarge the inner window 
to occupy the entire chart.  To restore the chart to its pre-maximized state, 
click the restore button. 
Before maximizing the MACD's inner window... 

 
 
 
 
 
 
 
 



 

 
 

114 • Customizing a Chart's Appearance MetaStock Professional 

 

 

 

 
 
 
 
 
After maximizing the MACD's inner window... 

 
For information on resizing charts, see page 109. 

Resizing With The Splitter Bar 
An inner window can be resized with the splitter bar by positioning the 
mouse pointer over the border above an inner window, clicking the 
mouse, and dragging the border up/down until the inner window reaches 
the desired size. 

Moving Inner Windows 
One of the great advantages of having charts divided into inner windows 
is that the inner windows can be easily resized and even moved.  For 
example, if you have a chart with the indicator displayed above the price 
and you'd like the indicator below the price, you can simply drag and drop 
the inner window so that it appears where you'd like. You can even drag 
an inner window from one chart to another. 
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For information on moving charts, see page 108. 

To move an inner window  

 
Move pointer 

1. Position the mouse on the inner window's title bar.  Notice that the 
mouse displays a special move pointer.  This tells you that the inner 
window can be moved. 

2. Click  and hold the left mouse button on the inner window's title bar 
and drag the inner window until it is located where you'd like.  Note 
that you can even drag an inner window to another chart. 

3. Release the mouse button to drop the inner window. 

Closing Inner Windows 
Inner windows are closed much like a normal window.  You can click the 
inner window's close box in the top-right corner or you can double-click 
the system box in the top-left corner. 
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Note that you cannot close the last inner window.  A chart must contain at 
least one inner window.  

If an inner window does not have a title bar displayed (which means there 
is no close box or system box to click), you can still close the inner 
window.  Right-click on the inner window and choose Inner Window then 
Close Inner Window from the chart shortcut menu. 

 

To close an inner window  
Do one of the following: 
• Double-click the inner window's system box. 
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• Click the inner window's system box and choose Close Inner 
Window. 

• Click the Close button on the right side of the inner window title bar. 
• If the inner window's title bar is not displayed, right-click on the inner 

window and choose Inner Window, then Close Inner Window. 

Scales 
MetaStock Pro handles the scaling of charts automatically based on the 
data plotted.  However, you can override the automatic scaling by 
changing the properties of the scales or by using the Zoom Scaling tools 
(see page 128). 

X-Axis Properties 
The x-axis (or date scale) is located along the bottom of a chart.  One x-
axis is shared by all inner windows in the chart. 
You can change the properties of the x-axis by right-clicking directly on 
the chart's x-axis or by choosing X-Axis from the Format menu. 

 

Scale 
The Scale page is located in the X-Axis Properties dialog.  Choose X-
Axis from the Format menu (or right-click on a chart's x-axis and choose 
X-Axis Properties from the shortcut menu). 
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Displayed.  The First Date and Last Date boxes control the range of data 
displayed on the chart.  This range cannot be outside of the range of data 
loaded.  Click the "D" button to enter dates.  Click the "T" button to enter 
times. 
Loaded.  The First Date and Last Date boxes control the range of data 
loaded from the data file.  Click the "D" button to enter dates.  Click the 
"T" button to enter times. 
Retain Scale.  Check this box if you want the x- and y-axis to be scaled 
as currently specified when the chart is opened using the Open command 
in the File menu.  Checking this box instructs MetaStock Pro to override 
the settings in the Load Options dialog (see page 80).  Note that if the 
active chart is part of a layout, the Retain Scale option is disabled since 
layouts remember the exact scaling for each individual chart in the layout 
at the time the layout was saved. 
Font.  Choose this button to display the standard Windows Font dialog.  
Use this dialog to specify the font for the x-axis labels.  See page 171 for 
more information on fonts. 

To load more data into the chart using the Scale page  
1. Right-click on the chart's x-axis. 
2. Choose X-Axis Properties. 
3. From the Scale page, type an earlier date into the Loaded First Date 

box.  Note this assumes that you have earlier data in the file to load. 
4. Click the OK button. 

To display a specific range of data using the Scale page  
1. Right-click on the chart's x-axis. 
2. Choose X-Axis Properties. 
3. From the Scale page, type the range of dates to display in the 

Displayed First Date and Last Date boxes. 
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4. Click the OK button. 
The x-axis of a real-time chart displays three time frames: days of month, 
hours, and minutes.  For example, "18" means the 18th day of the month; 
"10h" means the 10th hour of the day; and ":48" means the 48th minute of 
the hour. 

 
A 5-minute bar labeled on the x-axis of a chart at 11:15 includes the first 
tick of 11:10:00 through the last tick of 11:14:xxx.  Similarly, a 1-minute 
bar includes all ticks from 11:14:00 to 11:14:xxx. 

Periodicity 
The Periodicity page is located in the X-Axis Properties dialog.  Choose 
X-Axis from the Format menu, or right-click on a chart's x-axis and 
choose X-Axis Properties from the shortcut menu. 

 
Use the periodicity page to specify the periodicity of the data.  For 
example, if your chart contains daily data, you could change the data into 
weekly bars.  Or if your chart contains tick data, you could change it to 
hourly bars.  Even though the periodicity has been changed, the same 
date range is maintained.  So if a daily chart ranging from 06/01/96 to 
12/31/96 is changed to weekly, the chart will display weekly bars for the 
same date range, 06/01/96 to 12/31/96. 
Volume and open interest are summed over the new period.  For 
example, monthly periodicity displays the sum of the entire month's 
volume. 
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If the last day loaded is not the end of the selected periodicity, MetaStock 
Pro displays a bar of the shortened period.  For example, if today is 
Wednesday and daily data is loaded, the last price bar of a weekly chart 
represents the shortened week of Monday through Wednesday. 
The Other periodicity option allows you to control the number of periods 
over which to compress the data.  This allows you to view the data using 
non-standard periods.  For example, a periodicity of eight periods with 
daily data loaded would display a price bar every eight trading days. 
You can also change the periodicity by right-clicking on the x-axis and 
choosing Periodicity from the shortcut menu. 

 
You can also click the Periodicity button on the chart toolbar to change 
the periodicity. 

 
You can also change the periodicity with your Microsoft IntelliMouse 
pointing device.  Hold the SHIFT key down and rotate the wheel forward  
to lengthen the periodicity or back to shorten the periodicity.  See page 87 
for more information on the Microsoft IntelliMouse pointing device. 

Margins 
The Margins page is located in the X-Axis Properties dialog.  Choose X-
Axis from the Format menu, or right-click on a chart's x-axis and choose 
X-Axis Properties from the shortcut menu. 
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Right Margin.  This box specifies how much blank space (by number of 
time periods) there is between the last data point and the right border of 
the chart.  This is useful to project trendlines or other line studies into the 
future. 
Real-time Margin.  This box specifies how much blank space (by 
number of time periods) to display between the last data point and the 
right margin.  This is the area of the chart where real-time bars are drawn.  
When the bars reach the right margin, the chart is redrawn.  The larger 
the number, the less redrawing required.  A small value like five will 
cause the chart to redraw every fifth bar. 
The following chart illustrates the location of the real-time margin and the 
right margin. 

 

Grid (X-axis) 
The Grid page is located in the X-Axis Properties dialog.  Choose X-Axis 
from the Format menu (or right-click on a chart's x-axis and choose X-
Axis Properties from the shortcut menu). 
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Show Grid.  Check this box if you want vertical grid lines to be 
displayed in every inner window at each of the x-axis labels. 
Color.  Choose the color of the grid lines from the drop-list. 
Style.  Choose the line style (dotted, dashed, etc.) of the grid lines from 
the drop-list. 
Weight.  Choose the weight (thick, thin, etc.) of the grid lines from the 
drop-list.  If you select a heavier weight, the Style will always appear as a 
solid line. 

Y-Axis Properties 
 
 

 
Rescale Y-Axis button 

The y-axis of a chart is located along the side of an inner window.    
If you want to quickly reset the y-axis to accommodate new data that you 
have scrolled to with the chart's scroll bar, use the Rescale Y-Axis button 
on the chart toolbar (see page 86).  The Scroll Rescales Y-axis option in 
the Application options dialog also lets you control the effect of scrolling 
on the y-axis (see page 33). 
You can also change the scaling of the y-axis by using drag and drop 
techniques directly on the y-axis scale of the chart.  See page 126 for more 
information. 
You can change the properties of the y-axis by right-clicking directly on 
the chart's y-axis or by choosing Left Y-Axis or Right Y-Axis from the 
Format menu. 
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Scale 
The Scale page is located in the Y-Axis Properties dialog.  Choose Left 
Y-Axis or Right Y-Axis from the Format menu (or right-click on an inner 
window's y-axis and choose Y-Axis Properties from the shortcut menu). 

 
Check the box under the Auto heading if you want the corresponding 
scaling control to be automatically determined by MetaStock Pro.  If the 
Auto box is unchecked, you can manually enter a value. 
Minimum.  Type the minimum value to display on the y-axis. 
Maximum.  Type the maximum value to display on the y-axis. 
Major Unit.  Type the major unit to increment the y-axis labels.  For 
example, if you want y-axis labels to display every five units, then type 
"5".  Grid lines (if enabled) are displayed at the major units. 
The y-axis is displayed in decimal or fractions (e.g., eighths, 32nds, etc.) 
depending on the "Units" setting in the security's data file.  Use The 
DownLoader to change the Units setting (see page 58 in this manual). 
Minor Unit.  Type the minor unit to increment the y-axis labels.  Hash 
marks are displayed at each minor unit along the y-axis scale.  For 
example, if you want scaling hash marks displayed every 2.5 units, then 
enter "2.5".  If you want y-axis labels to increment by five units, then 
type "5".  Note that labels are not displayed on the minor units hash 
marks. 
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Invert Scale.  Check this box if you want the y-axis scale inverted.  
Inverting the scale of indicators that are negatively correlated with the 
price (e.g., Williams' %R or interest rates) is a popular use of this feature. 
Semi-log Scale.  Check this box if you want the y-axis scaled in semi-
log.  In a semi-log scaled chart, the distance between each point is 
exponential.  For example, the distance between 30 and 60 (a 30 point, 
100% increase) is the same as the distance between 60 and 120 (a 60 
point, but still 100% increase).  Semi-log scaling is used to compare 
relative price changes rather than physical point changes. 

 
Font.  Choose this button to display the standard Windows Font dialog.  
Use this dialog to specify the font for the y-axis labels.  If you choose a 
font that is too large to display without overlapping, MetaStock Pro will 
not place a label at every major unit.  See page 171 for more information 
on fonts. 
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To change the y-axis scale  
1. Right-click on the chart's y-axis scale. 
2. Choose Y-Axis Properties. 
3. From the Scale page, uncheck the Auto box for the Minimum and 

Maximum controls and type the desired values for the range of the y-
axis. 

4. If you want to manually specify the step size of the y-axis, uncheck 
the Auto box for the Major and Minor units and enter the desired 
values.  If you want semi-log or inverted scaling, check the boxes. 

5. Click the OK button. 

Grid (Y-axis) 
The Grid page is located in the Y-Axis Properties dialog.  Choose Y-Axis 
from the Format menu, or right-click on an inner window's y-axis and 
choose Y-Axis Properties from the shortcut menu. 

 
Show Grid.  Check this box if you want grid lines to be displayed in the 
selected inner window at each of the y-axis major unit labels. 
Color.  Choose the color of the grid lines from the drop-list. 
Style.  Choose the line style (dotted, dashed, etc.) of the grid lines from 
the drop-list. 
Weight.  Choose the weight (thick, thin, etc.) of the grid lines from the 
drop-list.  If you select a heavier weight, the Style will always appear as a 
solid line. 

Using Drag and Drop to Change the Scaling 
Both the x- and y-axis can be adjusted using your mouse and basic drag 
and drop techniques.  By clicking directly on a chart's x- or y-axis and 
dragging either up/down (for y-axis) or left/right (for x-axis), the range of 
the scale will be adjusted. 
For example, if a chart's y-axis scale ranges between 50 and 70, you can 
adjust the scale to go from 40 to 70 by clicking directly on the y-axis at 



 

 
 

MetaStock Professional Customizing a Chart's Appearance • 127 

 

 

 

the "50" label, and dragging the mouse upwards.  The same type of 
adjustment can be done with the x-axis using the same technique. 

     

 

Scale Locations 
Some people like to display the y-axis scale on the right side of the chart 
since it is closer to the more recent data. 

To display/remove the x- or y-axis  
1. Right-click on the chart's inner window. 
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2. Choose Chart Window Properties from the shortcut menu. 
3. Click on the Scale Locations tab. 
4. Check the Left, Right, or Date boxes to display the corresponding 

scales.  Uncheck the boxes to remove the scales. 
5. Click the OK button. 

Zoom Scaling 
The Zoom-In, Zoom-Out, and Zoom Reset commands are selected from 
the View menu or from the Chart toolbar.  The Zoom Box command is 
selected from the View menu or from the standard toolbar. 

 
Zoom In button 

The Zoom In command progressively zooms in on the most recent data 
displayed in the chart.  Each time the command is used, the more detailed 
the view of the most recent data. 

 
Zoom Out button 

The Zoom Out command changes the scaling to the previously zoomed 
state.  For example, if you have used the Zoom In command to zoom in on 
the chart four times, the Zoom Out command will take you back to the 
third zoomed view.  Using it again will take you back to the second 
zoomed view, etc. 

 
Zoom Box button 

The Zoom Box command allows you to define a section of the chart to 
enlarge. 

 
Zoom Reset button 

The Zoom Reset command undoes the scaling effects of any zooming by 
resetting the chart's scales so that all the loaded data is displayed.  The 
zooming can be the result of using the Zoom In and Zoom Box commands 
or the automatic zooming that occurs as a result of the settings in the Load 
Options dialog (see page 80). 
You can also use the Microsoft IntelliMouse pointing device to zoom-
in/out on your chart.  Hold the CTRL key down and rotate the wheel 
forward to zoom-in or rotate back to zoom-out.  See page 87 for more 
information on the Microsoft IntelliMouse pointing device. 
The following illustrations show a chart before and after using the Zoom 
In command: 
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Before using the Zoom In command... 

 
 
After clicking twice on the Zoom In button... 

 
The following illustrations show a chart before and after zooming using 
the Zoom box command. 
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Before using the Zoom Box... 

 
 
 
 
After using the Zoom Box... 
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To zoom in on the most recent data  
Do one of the following: 
• Choose Zoom then Zoom In from the View menu repeatedly until 

the view you want is displayed. 

 
Zoom In button 

• Click the Zoom In button on the Chart toolbar repeatedly until the 
view you want is displayed. 

• Press CTRL+ "+" repeatedly until the view you want is displayed.  
CTRL+ "-" zooms out. 

• Using the Microsoft IntelliMouse pointing device, hold the CTRL key 
down and rotate the wheel forward to zoom-in or rotate back to 
zoom-out. 

To zoom in on a specified area  

 
Zoom Box mouse 
pointer 

1. Choose Zoom then Zoom Box from the View menu or toolbar.  A 
small box appears next to the mouse pointer indicating that you 
should select an area to zoom. 

2. Position the mouse pointer at one corner of the desired zoom area. 
3. Click and drag the mouse pointer to the opposite corner of the 

desired zoom area and release your mouse button. 

To reset a zoomed chart  
Do one of the following: 
• Choose Zoom then Zoom Reset from the View menu.  

 
Zoom Reset button 

• Click the Zoom Reset button on the Chart toolbar. 
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Printing Charts and Data 

Introduction 
MetaStock Pro's Print command lets you print charts and the pricing data 
in charts.  Before you can print, you must first select and configure your 
printer using the Print Setup dialog.   

Selecting and Configuring Your Printer 
MetaStock Pro uses the default Windows printer selected from the 
Windows Printers folder.  Direct access to your printer’s properties dialog 
is available from within MetaStock Pro via the Print menu.  To display  
the Properties dialog, open a chart, select Print from the File menu, and 
click the Properties button. 

 
See your Windows manual for additional information on the controls in 
the Print Setup dialog. 
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To select and configure your printer  
1. Choose Print from the File menu. 
2. Choose the desired printer from the Name drop-list. 
3. Click the Properties button if you need to change the printer’s 

configuration settings. 
4. Click the OK button. 

Customizing the Printout with Page Setup 
To control such things as paper size, margins, headers/footers, orientation, 
etc., use the Page Setup command in the File menu.  Maybe you'd like 
your company name to appear at the top of every page and the date and 
time at the bottom.  Or maybe you'd like a larger margin.  All this and 
more can be controlled within the Page Setup dialog. 

Layout 
The Layout page is located in the Page Setup dialog.  Choose Page Setup 
from the File menu or from the Print dialog. 

 
Print Layout.  Choose the Charts per Page button to specify the number 
of charts you want to appear on a page.  For example, if you have eight 
charts open and you want the charts printed on two pages then type "4" in 
the Charts per Page box. 
Choose Print to Fit to print all open charts on one page. 
Choose Print Where Displayed to print the charts in the same size and 
location as they appear on the screen. 
Page Border.  Choose the type of border to surround the page.  The 
Page Border is printed at the specified margin settings. 
Chart Border.  Choose the type of border to surround each chart. 
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Chart Title.  Check this box if you want the information appearing in the 
chart title bar (see page 107) to print.  Click the Font button to choose the 
desired font for the chart title. 
Automatically Reduce Fonts.  Choose this box if you want the x- and 
y-axis fonts to be reduced in relation to the size of the chart.  The smaller 
the chart, the smaller the font used.  Leave the box unchecked if you want 
the fonts to remain at the specified sizes. 

Margins 
The Margins page is located in the Page Setup dialog.  Choose Page 
Setup from the File menu or from the Print dialog. 

 
Page Margins.  Specify the distance the chart should be printed from 
the top, bottom, left, and right sides of the page.  Note that the Page 
Border is printed directly against the margins. 
Chart Spacing.  Specify the distance between charts on the printout. 
Units.  Choose inches or centimeters to use for the margin and chart 
spacing measurements. 

Header/Footer 
The Header/Footer page is located in the Page Setup dialog.  Choose 
Page Setup from the File menu or from the Print dialog. 
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Fields.  Click on the time, date, or page number buttons to automatically 
insert the corresponding field into your header or footer. 

 
Alignment.  Click on the button that corresponds with the way you want 
both your header and footer aligned. 

 
Header.  Type the desired header to be printed at the top of the page. 
Footer. Type the desired footer to be printed at the bottom of the page. 
Fonts.  Click this button to select the font for the header and footer.  The 
Font dialog is used to select the font and the font's style, size, effect, and 
color.  See page 171 for more information on fonts. 

Paper 
The Paper page is located in the Page Setup dialog.  Choose Page Setup 
from the File menu or from the Print dialog.   
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Use the Default Printer Settings.  Use the default settings already 
specified in the Windows Printer Properties for the selected printer. 
Use the Following Printer Settings.  Use the settings specified in 
this dialog. 
Paper Size.  Choose the size of paper (i.e., letter or legal) loaded in the 
printer's paper tray. 
Orientation.  Choose the orientation for your printout.  Landscape 
prints horizontally on the page; portrait prints vertically on the page. 
Black-on-White Printing.  Check this box to print charts with a white 
background and black foreground.  All background colors are printed as 
white; all foreground colors are printed as black. 
Invert Black and White.  Check this box if you want all black colors 
to print white and all white colors to print black. 
Thicken Lines by.  Check this box if you want all lines within a chart 
to print thicker by the specified percentage.  This includes price plots, 
indicators, and line studies (excluding text).  This setting also affects 
charts shared with other programs using the Copy and Paste commands 
(see page 8). 

Previewing Charts Before Printing 
 

 
Print Preview button 

To see how a chart will appear when printed, use the Print Preview 
command in the File menu or click the Print Preview button on the toolbar. 
Print Preview will show you an exact replica of the printed chart on your 
computer screen.  The Print Preview command is also available directly 
from the Print dialog. 
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The buttons along the top of the Print Preview screen allow you to print 
and change the view of the chart. 

To preview a chart before printing  
1. Select the chart you want to preview by clicking anywhere on the 

chart. 
2. Make any desired changes at the Page Setup dialog. 
3. Choose Print Preview from the Print dialog or the File menu. 

Printing Charts and Data 
Before you can print, be sure that you have selected the correct printer 
(see page 133). 

 
Print button 

You print charts or data by using the Print command located in the File 
menu, by clicking the Print button on the toolbar, or by right-clicking on 
a chart and choosing Print Chart from the shortcut menu.  
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Name.  Choose the desired printer from the drop-list.  Only those printers 
that you have installed from within Windows will appear. 

All open charts are listed 
at the bottom of the 
Window menu. 

Print What.  Choose what you want to print from this drop-list.  Choose 
Active Chart to print the currently selected chart.  Choose All Open 
Charts to print all charts currently open. 
From the As box, choose whether you'd like the chart(s) printed in 
graphics or text.  If you choose text, the Print Range options are made 
available. 
Copies.  Type the number of copies to print. 
Print Range.  If you have chosen to print Text, you can choose to print 
all or a specific range (by data points or dates).  The values default to the 
amount of data loaded.   
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Page Setup.  Choose this button to access the Page Setup dialog where 
you can specify the layout, margins, header/footer, and paper size.  See 
page 134 for more information. 
Print Preview.  Choose this button to access the Print Preview screen.  
This lets you see exactly how the printout will appear on your screen.  See 
page 137 for more information. 
Properties.  Choose this button to access the printer’s Properties dialog 
where you can configure your printer.  See page 133for more information. 

To print a chart  
1. Select the chart you want to print by clicking anywhere on the chart. 
2. Do one of the following: 

• Choose Print from the File menu. 
• Right-click on the chart and choose Print Chart from the Chart 

shortcut menu. 
• Click the Print button on the toolbar. 

3. Click the Print What drop-list and select Active Chart.  Click the 
As box and select Graphics. 

4. Click the OK button. 

To print a chart's pricing data  
1. Select the chart whose data you want to print by clicking on the 

chart. 
2. Do one of the following: 

• Choose Print from the File menu. 
• Right-click on the chart and choose Print Chart from the Chart 

shortcut menu. 
• Click the Print button on the toolbar. 

3. Click the Print What drop-list and select Active Chart.  Click the 
As drop-list and select Text. 

4. Choose the desired Print Range. 
5. Click the OK button. 

To print multiple charts  
1. Open the charts you want to print. 
2. Do one of the following: 

• Choose Print from the File menu. 
• Right-click on the chart and choose Print Chart from the Chart 

shortcut menu. 
• Click the Print button on the toolbar. 
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3. Click the Print What drop-list and select All Open Charts.  Click 
the As drop-list and select Graphics. 

4. Click the OK button. 
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Working with Price Plots 

Introduction 
The primary focus of a chart is its price plot.  Every chart consists of a 
base security.  A base security is simply a security's pricing data.  
There are nine different styles of displaying pricing data.  Each of these 
styles uses one or more of the four basic pieces of pricing data--open, 
high, low, or close.  Each of the nine styles has unique differences that 
can be interpreted in various ways. 

Base Security Concept 
Every chart has a base security.  The base security is the security that was 
selected when the chart was originally created.  All indicators plotted in a 
new inner window calculate on the chart's base security.  The base 
security's name is displayed in the chart's title bar. 

 
The base security of a chart can be changed by using the Change Security 
command in the File menu (see page 83). 
You can close the base security's inner window, but closing the inner 
window does not break the link to the base security.   
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If you close the inner window of the base security or delete the base 
security and want to redisplay it, right-click on the chart and choose 
Display Base Security from the Chart shortcut menu.  A new inner 
window will be created in which the base security will be plotted. 
Although a chart has only one base security,  pricing data for other 
securities can be displayed in inner windows within the same chart (see 
page 154).   

Types of Price Plots 
MetaStock Pro provides nine ways to view the pricing information: 
candlesticks, candlevolume, equivolume, kagi, high/low/close bars, line, 
point & figure, renko, and three line break.  The most common style of 
price plot is the high/low/close bar. 
The following illustration shows the same security's data plotted in each 
of the nine styles. 

 

   

  Candlestick Chart   Candlevolume Chart 

   
Equivolume Chart             High/Low/Close Bar Chart 
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      Kagi Chart    Line Chart 

      

Point & Figure Chart   Renko Chart 

 
Three Line Break Chart 

Line charts require only closing prices to plot, whereas Candlesticks 
require all four pieces of pricing information--open, high, low, and close.  
And as their names imply, Equivolume and Candlevolume incorporate 
volume into the price plot. 
Certain line studies (i.e., cycle lines, Gann grids, and Fibonacci Time 
Zones) plot unevenly on equivolume and candlevolume charts.  This is 
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because the distance between time periods on these charts varies.  The 
same line studies, when plotted on kagi, point & figure, renko, and three 
line break charts, also produce results inconsistent with normal 
interpretation. 
Indicators calculated on kagi, point & figure, renko, and three line break 
charts use all the data in each column and then display the average value 
of the indicator for that column. 

Modifying a Price Plot 
Price plots have several properties including style and color.  The 
properties of a price plot are changed from the Price Plot's Properties 
dialog.  

 
Right-click directly on the price plot and choose the Properties command 
to display the Properties dialog.  You can also double-click on the price 
plot to bypass the shortcut menu and go directly to the Properties dialog.  
The Properties dialog can also be displayed by choosing Prices from the 
Format menu. 
If you just want to change the line style of the price plot, the fastest way is 
to click directly on the plot to select it, and then choose the desired style 
from the Price Style QuickList on the Style toolbar. 
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Ambiguity Menu 
You can also use the TAB 
key to cycle through 
selectable objects on your 
chart. 

When you click on a plot (i.e., price, indicator, or line study), an 
"ambiguity" menu may appear if the plot you are clicking on is close to 
other plots.  When plots are very close together, it is impossible for 
MetaStock Pro to know which plot was clicked on.  The illustration 
below shows the ambiguity menu that appeared because MetaStock Pro 
didn’t know whether the price plot or moving average was clicked. 

 
When the ambiguity menu appears, simply choose the desired plot from 
the menu. 

Parameters Page 
The following sections explain the parameters for each of the price styles 
that require parameters (i.e., kagi, point & figure, renko, and three line 
break). 

To change a price plot's parameters  
1. Do one of the following: 

• Right-click on the price plot and choose Properties. 
• Double-click on the price plot. 

2. From the Parameters page of the Properties dialog, make the desired 
changes to the parameters. 
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3. Click the OK button. 

Kagi 

 
Reversal Amount.  Enter the Reversal Amount to control when the 
direction of the kagi chart changes.  For example, if you enter a reversal 
amount of 2.00 points, the kagi chart will change from up to down if there 
is a two point downward change in the closing prices.  Likewise, it will 
change from down to up if there is a two point upward change in the 
closing prices.  The length of time required to make the reversal does not 
matter. 
Calculation Method.  Choose one of the two calculation methods.  
Choose Percent if you want the reversal amount determined on a 
percentage basis (e.g., a Reversal Amount of 2.00 requires a two percent 
change in the close to cause a reversal).  Choose Points if you want the 
reversal amount determined on a points basis (e.g., a Reversal Amount of 
3.00 requires a three point change in the close to cause a reversal). 
Display Midpoint.  Choose Display Midpoint if you want a "tick" mark 
displayed at the midpoint of each of the up and down lines. 
 
Indicators calculated on kagi charts use all the data in each column and 
then display the average value of the indicator for that column. 
Also note that certain line studies, (i.e., Gann, Fibonacci time zones, 
cycle lines, etc.) when plotted on kagi charts, produce results inconsistent 
with normal interpretation. 
See page 472 for interpretation information on kagi charts. 
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Point & Figure 

 
Box Size.  Enter the Box Size (the size may contain a decimal portion, 
e.g., 1.33).  The default box size is determined automatically depending  
on the price of the security being charted.  Note that the smaller the box 
is, the more boxes will be displayed. 
Reversal Amount. Enter the Reversal Amount.  The Reversal Amount 
controls how many boxes the price must change to cause a reversal and 
move to the next column.  For example, specifying 3 boxes per reversal 
when the box size is set to 2 will require that prices change 6 points (3 
boxes times a box size of 2) before changing columns.  Because the 
reversal is in boxes, the number may not contain a decimal portion.  
Larger reversal amounts cause fewer, taller columns.  
Price Field.  Choose the price field to use when plotting the point & 
figure chart.  The default "High/Low Range" is recommended.  When 
calculated on the High/Low Range, MetaStock Pro takes into account the 
intraday extreme moves when drawing the boxes. 
 
A checkbox in the Chart Options page of the Application Options dialog 
(see page 34) lets you specify if you want point & figure boxes to stay 
square when plotting a point & figure chart.  Purists to point & figure 
charting prefer to have exactly square X and O.  However, the advantage 
of leaving the box unchecked is that the point & figure charts will utilize 
chart space much more efficiently. 
The inner window title bar of a point & figure chart displays information 
about the chart.  The first number is the Box Size and the second number 
is the Box Size multiplied by the Reversal Amount.  The Price Field that a 
point & figure chart is based on is also identified in the title bar of the 
chart.  
Indicators calculated on point & figure charts use all the data in each 
column and then display the average value of the indicator in that column. 
Also note that certain line studies, (i.e., Gann, Fibonacci time zones, cycle 
lines, etc.) when plotted on point & figure charts, produce results 
inconsistent with normal interpretation. 
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See page 498 for interpretation information on point & figure charts. 

Renko 

 
Box Size.  Enter the Box Size (the size may contain a decimal portion, 
e.g., 1.33).  The default box size is determined automatically depending 
on the price of the security being charted.  Note that the smaller the box, 
the more boxes displayed. 
 
Indicators calculated on renko charts use all the data in each column and 
then display the average value of the indicator in that column. 
Also note that certain line studies, (i.e., gann, Fibonacci time zones, cycle 
lines, etc.) when plotted on renko charts, produce results inconsistent 
with normal interpretation. 
See page 515 for interpretation information on renko charts. 

Three Line Break 

 
Lines.  Enter the lines per break.  The default is three.  Note that the 
smaller the lines per break, the more blocks displayed. 
 
Indicators calculated on three line break charts use all the data in each 
column and then display the average value of the indicator in that column. 
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Also note that certain line studies, (i.e., Gann, Fibonacci time zones, cycle 
lines, etc.) when plotted on three line break charts, produce results 
inconsistent with normal interpretation. 
See page 526 for interpretation information on three line break charts. 

Color/Style Page 
The color/style page allows you to change the color, line style, and weight 
of the selected price plot.  You can also make these changes by using the 
color and line style toolbars (see page 25). 

 
Price Styles.  Click on the Price Style drop-list to display the nine price 
styles: Bars, Candlesticks, Candlevolume, Equivolume, Line, Kagi, Point 
& Figure, Renko, and Three Line Break. 
Up.  Use this drop-list to select the color when the closing price moves 
upward (as compared to the previous period's price).  Note that this color 
only affects the currently selected Price Style.  If an expert containing a 
Highlight is attached to the chart (and its condition is true), the Highlight's 
color will override this setting. 
Down.  Use this drop-list to select the color when the closing price 
moves downward (as compared to the previous period's price).  Note that 
this color only affects the currently selected Price Style.  If an expert 
containing a Highlight is attached to the chart (and its condition is true), 
the Highlight's color will override this setting. 
Weight.  Use this drop-list to select the weight (i.e., thickness) of the 
price plot. 
Apply To All Price Styles.  Check this box if you want the Up and 
Down colors selected for the current price style to apply to all Price 
Styles (rather than just the currently selected Price Style). 

To change the style of the price plot  
1. Double-click on the price plot in the chart. 
2. From the Color/Style page, click the Price Styles drop-list. 
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3. Choose the desired price style and click the OK button. 
 
Or 

1. Select the price plot in the chart. 
2. Choose the desired price style from the Price Style QuickList located 

on the style toolbar. 

To change the color of a price plot  
1. Double-click on the price plot in the chart. 
2. From the Color/Style page, click the Up drop-list. 
3. Choose the desired color for upward price changes. 
4. Click the Down drop-list. 
5. Choose the desired color for downward price changes. 
6. Click the OK button. 

 
Or 

1. Select the price plot in the chart. 
2. Choose the desired color from the color palette located on the style 

toolbar. 

Updating and Editing a Price Plot's Data 
The method you use to update and edit data depends on the type of data 
you are using – online data, real-time local data, or end-of-day local data 
(see page 41). 
To update online data, choose Refresh from the View menu.  The data 
will be re-collected from your online vendor, including any splits or 
adjustments that have occurred since you opened the chart.  Note that 
weekly and monthly charts do not update in real time. 
Real-time data is updated automatically as the trades occur.  All you need 
to do is start MetaStock Pro, which will then start the File and Data 
Servers.  If your charts stop updating, there may be a problem with one of 
the servers (see page 51).  
To update your end-of-day downloaded data, use the Download Prices 
command in The DownLoader.  The DownLoader is a separate program 
provided with MetaStock Pro.  However, MetaStock Pro provides 
seamless integration with The DownLoader, making data changes quick 
and easy. 
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The DownLoader icon 

You can run The DownLoader using the Windows Start command by 
going to the Equis International folder and choosing The DownLoader.  Or 
you can run The DownLoader directly from within MetaStock Pro by 
choosing The DownLoader from the Tools menu.   
You can quickly access the data for an open chart by right-clicking on the 
price plot and choosing Edit Data from the shortcut menu.  The security's 
datasheet will open in The DownLoader where you can make the desired 
changes.   This makes it easy for you to quickly edit an erroneous price   
on a chart. 

 
If a chart for a security is open, changes made in The DownLoader to that 
security's attributes (i.e., name, ticker, units, etc.) will not be immediately 
reflected in the open chart.  The chart must be closed and then reopened 
to reflect the changes.  However, changes made to the pricing data itself 
(i.e., date, open, high, low, close, etc.) will be immediately reflected in 
the open chart. 

Copying, Deleting, and Moving Price Plots 
Copying, moving, and overlaying price plots involves basic drag and 
drop techniques.  Perhaps you want to see three computer stocks in the 
same chart.  Or maybe you want to overlay several stocks in the same 
inner window.   
"Moving" a price plot means to actually remove the selected price plot 
from its original location and move it to a new location.  "Copying" 
means to make a copy of the selected price plot and place the copy  in 
another location.  "Deleting" a price plot means to remove the selected 
price plot from the chart, but this does not delete the data permanently 
from the security file.   
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Copying and Moving a Price Plot 
You can copy any price plot from one inner window to another by 
selecting and dragging the price plot with the CTRL key depressed, and 
then dropping it in a new location.   
A price plot is moved from one inner window to another using the same 
procedure described in the previous paragraph, except that you don't need 
to hold the CTRL key down.  The only exception to this is if you attempt 
to move a base security price plot (see page 143) from one chart to 
another.  In this case the base security price plot is always copied.  This 
prevents the accidental removal of a base security from its chart. 
When you click on a price plot, an "ambiguity" menu may appear if the 
plot you are clicking on is close to other plots (e.g., moving averages, 
trendlines, etc.).  See page 147 for more information. 

 
“Not” sign 

A "not" sign appears next to the mouse pointer when dragging a price 
plot over an area where it cannot be dropped. 

The following illustrations show how to copy a price plot from one chart 
to another.  If the price plot is not the base security (see page 143), you 
can move the price plot by following the same procedure, except don't 
hold the CTRL key. 
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To copy or move a price plot to a new inner window in 
the same or different chart  
1. Open two charts. 
2. Position the mouse over the price plot you want to copy or move.   
3. Hold the CTRL key down. Then click and hold the left mouse button 

and drag the price plot to the destination chart's title bar. 
4. With the mouse still positioned over the destination chart's title bar, 

release the mouse button. 

To overlay a price plot on an existing plot  
1. Position the mouse over the price plot you want to copy or move.   
2. Hold the CTRL key down (for copying only).  Then click and hold the 

left mouse button and drag the price plot to the inner window 
containing the price plot or indicator you want to overlay on.  The 
inner window can be in the same chart or a different chart. 

3. Release the mouse button. 
4. Choose the desired option from the Scaling Options dialog (see page 

156) and click OK. 

Scaling Options Dialog 
When you copy or move a plot (i.e., price plot or indicator) to another 
inner window, it is likely that the other inner window's y-axis scale will 
not be compatible.  If this is the case, MetaStock Pro displays the Scaling 
Options dialog so that you can choose how to handle the scaling when the 
plot is overlayed. 

 
Display New Scale on Left.  Use a new scale on the left side of the 
chart that is compatible with the new plot.  The existing plot will 
continue to display, but the left y-axis scale represents the new plot. 
Display New Scale on Right.  Use a new scale on the right side of the 
chart that is compatible with the new plot.  The existing plot will 
continue to display, but the right y-axis scale represents the new plot. 
Merge with Scale on Left.  Adjust the existing left y-axis scale so that 
the new price plot can be represented. 
Merge with Scale on Right.  Adjust the existing right y-axis scale so 
that the new price plot can be represented. 
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Overlay without Scale.  Overlay the plot without displaying a scale.  
You may want to do this if you are only concerned about comparing 
relative  movements between the plots. 

Deleting a Price Plot 
Deleting a price plot from an inner window will remove the price plot  
and leave the inner window intact.  See page 116 for information on 
closing inner windows.   
You can delete the selected price plot by pressing the DEL key or by right-
clicking on the price plot and choosing Delete from the shortcut menu.  
You are asked to confirm the deletion.  An option in the Application 
Properties dialog controls whether the Confirm Deletions dialog appears 
(see page 32). 
You can also delete price plots by using the Cut command from the Edit 
menu or the price plot's shortcut menu.  However, the Cut command also 
copies the price plot to the Windows clipboard.  See page 8 for more 
information. 
If the price plot you delete is the chart's base security (see page 143), you 
can redisplay the base security by right-clicking on any inner window and 
choosing Display Base Security from the chart's shortcut menu.  A new 
inner window will be opened at the top of the chart where the base 
security will be replotted. 

 

To delete a price plot  
1. Do one of the following: 

• Right-click on the price plot and choose Delete. 
• Click the left mouse button on the price plot and press the DEL 

key. 



 

 
 

158 • Working with Price Plots MetaStock Professional 

 

 

 

• Select the price plot and choose Delete from the Edit menu. 
2. Choose Yes when asked to confirm the deletion. 

Confirm Deletions 
When you delete price plots, indicators, or line studies from a chart, the 
Confirm Deletions dialog will appear (if you haven't disabled it).   

 
Choose Yes if you want the selected object deleted.  Choose No to cancel 
the deletion. 
You can prevent this message from appearing by checking the "Don't 
display this message anymore" box in this dialog or by unchecking the 
"Confirm Deletion of Objects" box in the Application Properties dialog 
(see page 32).   

Inserting Price Plots 
Any security can be added to the current chart using the Insert Security 
command.  This method is quicker than opening the chart and using drag 
and drop to copy the price plot.   
To insert the price plot of a security that is not open, choose Security 
from the Insert menu.   

 
If the periodicities are not the same, the data will be displayed in the best 
way possible. 

Viewing Values on the Chart 
There are two ways to view a plot's value in a chart.  For a detailed, color-
coded view of the data, use the Data Window.  For a quick inspection of 
the data for a particular bar, use ChartTips. 
The Data Window displays the values at the location of the mouse 
pointer.  You can display the base security's date, time, open, high, low, 
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close, volume, open interest, price change from previous period, and 
indicator values.  The Data Window displays the values for the chart that 
the mouse pointer is in.  If the Data Window is docked, it will also 
display the ticker symbol. 

 
Data Window button 

The Data Window is displayed by choosing Data Window from the View 
menu, or by clicking the Data Window button on the toolbar. 

The format of the price values displayed in the Data Window are either in 
decimal or fractions depending on the "Units" setting for the security.  A 
security's Units setting is controlled with The DownLoader (see page 60 
in this manual). 
The color of the values displayed in the Data Window correspond to the 
color of the price plots represented.  You can turn this "coloring" of text 
off from the Data Window Properties dialog (see page 161). 

 
If you have multiple charts displayed on your screen, you can simply 
move the mouse from chart to chart and the Data Window will display the 
appropriate data. 
When attempting to display the data for a specific bar, you may want to 
use your mouse to quickly move to the general area of the chart, and then 
switch to the keyboard's arrow keys to zero in on the specific bar. 
The Data Window can be moved just like any window by clicking on the 
title bar and dragging.  You can also resize the Data Window vertically by 
clicking on the bottom border and dragging. 

The active chart's ticker 
symbol appears in a 
docked Data Window. 

You can dock the Data Window on the left or right side of the screen by 
clicking and dragging the Data Window to the desired side of the screen.  
Double-clicking anywhere on the Data Window will also dock it.  After it 
is docked, double-clicking returns it to a floating window, or you can 
click and drag it to the desired location.  Note that when the Data  
Window is docked, the ticker symbol of the security in the active chart is 
displayed. 
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ChartTips allow you to quickly display the values for a particular bar 
without invoking any special command.  By simply positioning the mouse 
over a plot  (e.g., price bar, indicator, moving average, etc.) and holding 
the mouse pointer motionless for a second or so, a ChartTip displays, 
giving you information about the plot.  The first line of a ChartTip 
provides the name of the plot plus any parameters associated with that 
plot.  The remaining lines provide other useful information about the plot. 

 

To display the Data Window  
Do one of the following: 

• Choose Data Window from the View menu. 
• Click the Data Window button on the toolbar. 

To remove the Data Window  
Do one of the following: 

• Choose Data Window from the View menu. 
• Click the Data Window button on the toolbar. 
• Double-click the control menu box on the Data Window. 
• Right-click on the Data Window and choose Remove Data 

Window. 

To dock the Data Window  
1. Display the Data Window. 
2. Double-click anywhere on the Data Window.  Or you can drag the 

Data Window until the mouse appears near the left or right edge of 
the screen.  Release the mouse button to dock it. 

To undock the Data Window  
Double-click anywhere on the Data Window.  It will return to a floating 
window. 



 

 
 

MetaStock Professional Working with Price Plots • 161 

 

 

 

Changing the Properties of the Data Window 
To specify the properties of the Data Window, use the Data Window 
Properties dialog.  This dialog is accessed by right-clicking on the Data 
Window or by choosing Data Window from the Format menu.   

 
Check the box next to the values you want displayed in the Data 
Window. 
Click on the General tab to access the "Update Only On Drag" and the 
"Display Data Window Text In Color" options. Check "Update Only On 
Drag" box if you would like the Data Window to update only when you 
are dragging the mouse (i.e., clicking and holding the left mouse button 
down).  Check the "Display Data Window Text In Color" box if you 
would like the color of the values in the Data Window to correspond to 
the color of the represented plot. 

To specify the contents of the Data Window  
1. Choose Data Window from the Format menu. 
2. Check the desired values to display in the Data Window Properties 

dialog. 
3. Click the OK button. 

Visual Inspection Using the Crosshairs 

 
Crosshairs button 

The crosshairs are helpful when inspecting the relative moves of indicator 
and price plots.  They are also good for spotting support/resistance levels 
(see page 523).  The crosshairs are turned on by choosing Crosshairs 
from the View menu or clicking the Crosshairs button on the trendline 
toolbar.  You can turn off Crosshairs by pressing the ESC key, clicking 
the Crosshairs button on the toolbar, or choosing Crosshairs from the 
View menu. 
You may find the crosshairs helpful when you have the Data Window 
displayed so that you can see the exact location of all values shown in the 
Data Window.  The mouse pointer disappears when crosshairs are 
displayed to allow better visibility of the underlying plot(s) at the 
intersection point. 
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Even when crosshairs are turned on, you still can use all the menus and 
toolbars.  In fact, you may find it helpful to have the crosshairs displayed 
when drawing line studies (see page 205). 

To turn on the crosshairs  
Choose Crosshairs from the View menu.  A checkmark will appear next 
to the menu item indicating they are turned on. 
Or 
Click the crosshairs button from the toolbar. 
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Working with Indicators 

What is an Indicator? 
An indicator is a mathematical calculation that can be applied to a 
security's price, volume or even to another indicator.  The result is a value 
that is used to anticipate future changes in prices.  Indicators are plotted 
either in a separate inner window or overlayed in the base security's inner 
window (e.g., a moving average).   
There are three types of indicators in MetaStock Pro (explained below).  
The small icon displayed next to indicators in the Indicator QuickList 
(see page 165) shows you the indicator's type.  These small icons are also 
described below. 
Price Indicators .  Price indicators are always calculated using 
security pricing data. 
Custom Indicators .  Custom indicators are calculated using a formula 
you created with the Indicator Builder (see page 299). 
Plot-based Indicators .  Plot-based indicators can be plotted directly 
on an existing plot (i.e., a price plot or another indicator plot).  For 
example, a moving average is a plot-based indicator since it is always 
calculated on an existing price or indicator.  If a plot-based indicator is 
not dropped directly on a plot (i.e., you plot it in a new inner window) it 
is calculated using the base security. 
All indicators (price, custom, and plot) appear together in the Indicator 
QuickList (see page 165) and the Indicators dialog (see page 164). 

Plotting an Indicator 
There are two ways of plotting an indicator in MetaStock Pro.  You can 
drag and drop an indicator from the Indicator QuickList or you can 
choose Indicators from the Insert menu to display the Indicators dialog. 
When an indicator is plotted, it is usually calculated on the chart's base 
security (see page 143).  However, some indicators (i.e., "plot-based" 
indicators) can be calculated on other indicators.  For example, a moving 
average can be calculated on any plot.  You could calculate a moving 
average using an indicator, another moving average, or a price plot. 
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If an indicator is calculated on a security other than the base security of 
the chart, the name of the security is shown in parenthesis after the 
indicator's name. 
Indicators calculated on kagi, point & figure, renko, and three line break 
charts use all the data in each column and then display the average value 
of the indicator for that column. 

Using the Indicators Dialog 
The Indicators dialog is accessed by choosing Indicators from the Insert 
menu.  The Indicator dialog lets you choose the indicator(s) and the inner 
window in which it should be plotted. 

 
You can select multiple 
indicators by holding 
down the CTRL or 
SHIFT key as you make 
your selections. 

You can select one (or multiple) indicators from the Indicators list on the 
left side of the dialog.  Pick an inner window in which to plot the 
indicator(s) from the Inner Windows list on the right side of the dialog.  
If the selected indicator is a "plot-based" indicator, then the Inner 
Windows list displays the plots within each of the inner windows.  This 
allows you to choose a specific plot on which to calculate the indicator.  
The inner windows listed on the right side of the dialog are labeled Inner 
Window #1, Inner Window #2, etc. corresponding with the location (top 
to bottom) in the chart. 
If you choose New Inner Window, the indicator is plotted in a new inner 
window at the top of the chart. 

To plot an indicator using the Indicators dialog  
1. Select the chart in which you want to plot an indicator. 
2. Choose Indicators from the Insert menu. 
3. Click the indicator(s) you want to plot in the Indicators list on the 

left side of the dialog. 
4. From the Inner Windows list on the right side of the dialog, choose 

the inner window in which to plot the indicator.   
5. Click the OK button. 
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Using the Indicator QuickList 
The Indicator QuickList (located on the standard toolbar) provides quick 
access to all the indicators in MetaStock Pro. 

 
You can drag indicators from the list and drop them on your charts.  If 
you drop an indicator on a chart's title bar, a new inner window is 
automatically created for the indicator at the top of the chart.  If you drop 
the indicator on an inner window title bar, the indicator will plot in a new 
inner window above the title bar.  If you drop the indicator on the x-axis, 
the new inner window will plot at the bottom of the chart.  

 
You can also drop an indicator on an existing plot.  Moving averages, 
Envelopes, and Bollinger Bands are almost always dropped on an existing 
plot, since you usually want them overlayed on a plot.  When you drop an 
indicator on an existing inner window, the Scaling Options dialog may 
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appear prompting you to choose how you want to handle the scaling (see 
page 156). 
When dragging an indicator from the QuickList, the status bar (see page 
27) provides useful feedback on the location of the mouse.  As a visual 
cue, the plot that will be used for the calculation changes to a unique 
color as the indicator is being dragged.  
A quick way to get to the desired indicator in the QuickList is to display 
the QuickList and then type the first letter of the indicator's name.  The 
list will quickly advance down the list to indicators beginning with that 
letter. 

 
Indicators button 

If the Standard toolbar (where the QuickList is found) is docked on either 
the left or right side of the screen (so it appears vertically), the Indicator 
QuickList changes to a button that displays the Indicators dialog when 
clicked. 

To plot an indicator in a new inner window using the 
QuickList  
1. Click the Indicator QuickList on the toolbar and scroll the list until 

the desired indicator appears. 
2. Position your mouse pointer over the small icon to the left of the 

desired indicator.  Note how the mouse pointer changes to a hand. 
3. Click and hold the left mouse button and drag the indicator until you 

have it positioned on any inner window title bar within the chart.  
Notice how the mouse cursor changes appearance when it's 
positioned over the  title bar.  You can even drop the indicator on the 
x-axis if you want it plotted at the very bottom of the chart. 

4. Drop the indicator by releasing the mouse button. 

To plot an indicator on an existing plot  
1. Click the Indicator QuickList on the toolbar and scroll the list until  

the desired "plot-based" indicator appears.  A plot based indicator 
has a  icon next to it.  See page 163 for more information on plot-
based indicators. 

2. Position your mouse pointer over the small icon to the left of the 
desired indicator.  Note how the mouse pointer changes to a hand. 

3. Click and hold the left mouse button and drag the indicator until you 
have it positioned over the plot to calculate on.  The color of the plot 
will change to inform you that it will be used for the indicator's 
calculation.  

4. Drop the indicator by releasing the mouse button. 

Controlling which Indicators are in the QuickList 
By default, all available indicators (including custom indicators) are 
displayed in the QuickList.  However, you may want to shorten the list by 
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excluding those you seldom use.  This can be done with the QuickList 
Properties dialog.   
The QuickList Properties dialog is displayed by choosing Indicator 
QuickList from the Format menu, or by right-clicking directly on the 
QuickList and choosing QuickList Properties.   

 
Check the indicators you want displayed in the QuickList.  Remove the 
check if you prefer not to have the indicator displayed.  You can check 
and uncheck all indicators by using the Check All and Uncheck All 
buttons. 

Modifying an Indicator 
After an indicator is plotted, you can modify any of its properties (e.g., 
color, number of periods, etc.) with the indicator's Properties dialog.  
Indicators can also be copied or moved to a new inner window within the 
same chart or a different chart. 
An indicator's Properties dialog can be accessed three ways: 
• You can right-click directly on the plotted indicator and choose 

Properties from the shortcut menu. 
• You can double-click directly on the plotted indicator. 
• You can select the indicator and choose Selected Object from the 

Format menu. 
You can press the TAB 
key to cycle through all 
selectable objects on 
your chart. 

When you are clicking on an indicator and the indicator is closely 
surrounded by other plots (e.g., prices, moving averages, etc.) a menu 
will pop up prompting you to choose the desired plot. 
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The following Properties dialog for the Relative Strength Index is typical 
of most indicator Property dialogs.  Indicators that do not require 
parameters (e.g., Median Price, Typical Price, etc.) do not have a 
Parameters page in the Properties dialog. 

 

To modify the properties of an indicator  
1. Position the mouse on the plotted indicator and double-click. 
2. Make the desired changes from the indicator's Properties dialog. 
3. Click the OK button. 

Properties Common to All Indicators 
Every Indicator Properties dialog contains two common pages--the 
Color/Style page and the Horizontal Line page.  You can modify the 
color/style and horizontal line placement of every indicator in MetaStock 
Pro. 
Every indicator Properties dialog also contains an Apply button.  If you 
click this button, the changes made in the Properties dialog are 
immediately applied.  The Properties dialog remains on the screen.  This 
is helpful if you need to make quick visual adjustments to an indicator. 
You display an indicator's Properties dialog by right-clicking on the 
indicator and choosing Properties from the shortcut menu. 
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Color/Style Page 
The Color/Style page is used to modify the selected indicator only.  The 
Color/Style page is located in the indicator's Properties dialog.  This 
dialog is displayed by right-clicking on the indicator and choosing 
Properties from the shortcut menu. 
You can also change the color and line style of the indicator by using the 
color and line style toolbars (see page 25). 
If you want to change the default color/style for all new indicators, choose 
Default Colors & Styles from the Tools menu.   

 
Color.  Choose the indicator color for the selected indicator from the 
drop-list. MetaStock Pro can automatically rotate through different colors 
when plotting indicators.  See page 171 for more information. 
Style.  Choose the line style for the selected indicator from the drop-list.   
The Invisible style is useful when overlaying one indicator on another 
(i.e., a moving average overlayed on an RSI).  When plotting a moving 
average on an existing indicator, there may be times that you want to hide 
the indicator and just show the moving average.  If you delete the 
indicator, the moving average will also disappear since it is dependent on 
the indicator for the calculation.  However, you can hide the indicator, by 
choosing the Invisible Style from the Color/Style page in the indicator's 
Properties dialog.  To redisplay a hidden indicator, use the TAB key to 
select it and then choose Selected Object from the Format menu. 
Weight.  Choose the thickness of the selected indicator from the drop-
list.  If you select a heavier weight, the Style will always appear as a solid 
line. 

Horizontal Lines Page 
Many indicators require specific values for their interpretation.  For 
example, a Stochastic is generally considered to be at an overbought level 
above 80 and oversold below 20.  Horizontal lines are usually placed at 
these levels to help in the interpretation. 
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The Horizontal Lines page allows you to control the placement of these 
lines for each indicator.  Every time the indicator is plotted, the specified 
horizontal lines are automatically drawn. 
The Horizontal Lines page is located in the indicator's Properties dialog.  
This dialog is displayed by right-clicking on the indicator and choosing 
Properties from the shortcut menu. 

 
You can also control the color, line style, and weight of the horizontal 
lines.  The color, style, and weight you choose is used for all horizontal 
lines drawn with the indicator. 

Default Colors and Styles Dialog 
The Default Colors and Style command in the Tools menu is used to 
change the default colors and styles used for new plots (i.e., indicators, 
line studies, and text/symbols).  Note that the default colors and styles do 
not affect existing charts.  They only affect new items.  
For example, if you always want new indicators plotted as dotted blue 
instead of solid red, you could use the Default Colors and Styles dialog to 
make this change. 

 
The Indicators and Line Studies pages contain the usual color, style, and 
weight drop-lists for modifying indicators and line studies.  Note that if 
you select a heavier weight, the Style will always appear as a solid line, 
regardless of the line style. 
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When the Auto Rotate checkbox on the Indicators page is checked, 
MetaStock Pro automatically chooses different colors for indicators 
plotted successively in the same inner window.  This is particularly useful 
if you frequently plot multiple indicators (e.g., moving averages) in the 
same inner window.  The background color of the indicator's inner 
window is automatically skipped. 
You can also change the font used for text (see page 223) and the size of 
symbols (see page 222) with the Text/Symbols page. 

 

Changing Fonts 
Click the Font button on the Text/Symbols page of the Default Colors 
and Styles dialog to change the fonts for text and symbols that appears on 
charts.  Note that this font does not change the fonts associated with the 
x- and y-axis, or headers/footers.  You can change the font for text, the x- 
and y-axis, symbol labels, and  headers/footers on charts using the 
standard Windows Font dialog.   

 
Font.  Choose the font.  The number and type of fonts appearing in this 
list depends on your printer selection. 
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Font Style.  Choose the style for the font. 
Font Size.  Choose the point size for the font. 
Effects.  Check the box for the desired effects. 
Color.  Choose the desired color for the font. 
Sample.  This box shows how your selected font will appear. 
Script.  Choose the desired script style for the font. 

Copying, Deleting, and Moving Indicators 
Just as price plots and line studies can be moved using drag and drop 
techniques, so can indicators.  Perhaps you want to see three of your 
favorite indicators overlayed on each other in the same inner window.  Or 
maybe you want to copy an RSI of the Dow into your IBM chart.  Or 
maybe you want to delete the moving average plotted on your Corn chart. 
Sometimes when you are trying to click on an indicator that is crowded 
among other plots,  a pop-up "ambiguity" menu appears from which you 
can select the desired plot.  See page 147 for more information. 
You can select multiple indicators for copying, moving, or deleting by 
holding down the SHIFT key as you click your mouse. 

Copying and Moving Indicators 

 
Move cursor 

Copying and moving an indicator plot involves basic drag and drop 
techniques.  The only difference between copying and moving is that you 
hold the CTRL key down when copying.  When the mouse pointer is 
positioned over an indicator, the mouse pointer displays a four-sided 
arrow (i.e., the move cursor) indicating that the indicator can be moved or 
copied. 
When an indicator (or any object, for that matter) is being copied, a small 
plus sign appears next to the mouse pointer while dragging. 
When you drag an indicator and drop it into an existing inner window, 
the Scaling Options dialog may appear prompting you to decide how to 
handle the scaling (see page 156). 
You can copy (or move) an indicator to a new inner window by dragging 
and dropping the indicator on a chart title bar or inner window title bar. 

To move (or copy) an indicator to an existing inner 
window  
1. Position the mouse over the indicator you want to move or copy.   
2. If copying, hold the CTRL key down.  Click and hold the left mouse 

button and drag the indicator to another inner window.  The inner 
window can be in the same chart or a different chart. 

3. Release the mouse button. 
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4. Choose the desired option from the Scaling Options dialog (see page 
156) and click OK. 

To move (or copy) an indicator to a new inner window  
1. Position the mouse over the indicator you want to move or copy.   
2. If copying, hold the CTRL key down.  Click and hold the left mouse 

button and drag the indicator so that it is positioned over the desired 
chart title bar, or inner window title bar.  The chart can be the same 
chart or a different chart. 

3. Release the mouse button. 

Deleting Indicators 
You can delete an indicator by right-clicking on the indicator plot and 
choosing Delete from the shortcut menu.  You can also delete an indicator 
by selecting the indicator and pressing the DEL key.  An option in the 
Application Properties dialog (see page 32) controls whether or not you 
are asked to confirm the deletion of the object. 

 

To delete an indicator  
1. Position the mouse on the desired indicator plot. 
2. Click the right mouse button. 
3. Choose Delete from the shortcut menu or press the DEL key.. 
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Viewing Indicator Values with the Data Window 

 
Data Window button 

To see the numerical values of a chart at the mouse pointer's location, use 
the Data Window.  The Data Window is displayed by choosing Data 
Window from the View menu.  You can also display the Data Window 
by clicking the Data Window button on the toolbar.  The Data Window 
continually updates to reflect the numerical values at the mouse pointer's 
location. 
The name of the security being displayed is shown in the title bar of the 
Data Window.  If the Data Window is docked the name appears inside 
the Data Window itself.  Therefore, if you have multiple charts displayed 
on your screen, you can simply move the mouse from chart to chart and 
the Data Window will display the appropriate data. 
See page 158 for more information on using the Data Window. 

Online Indicator Interpretation 
If you need help interpreting an indicator, MetaStock Pro's help system 
contains information on every indicator.  Right-click on the plotted 
indicator and choose Help from the shortcut menu to get a help screen 
explaining the indicator and how to interpret it. 

 
See page 441 for more information on interpreting indicators. 

Indicator Parameters 
The parameters for every indicator are listed on the following pages.  The 
parameter pages for color/style and horizontal lines are identical for 
every indicator.  See page 169 for information on the Color/Style page 
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within the indicator's Properties dialog.  See page 169 for information on 
the Horizontal Lines page within the indicator's Properties dialog. 
The parameters for an indicator are specified at the time the indicator is 
plotted.  You can edit the parameters of a plotted indicator by 
double-clicking on the indicator (see page 167). 

Accumulation Swing Index 
The parameters for the Accumulation Swing index are shown below.   
These parameters are specified at the time the indicator is plotted.  You 
can edit the parameters of an existing plot by right-clicking on the 
indicator and choosing Properties from the shortcut menu.  Note that the 
Accumulation Swing Index requires open prices to calculate.   
Limit Move.  The following table lists the limit moves for several 
commodities traded on the Chicago Board of Trade: 

Commodity Limit Move 
Corn $0.10 

Heating Oil $0.04 

Soybeans $0.30 

T-bonds $3.00 

You may need to adjust the limit moves shown in the above table based 
on the position of the decimal in your data files.  For example, if the price 
of corn is quoted as $2.45, the limit move would be $0.10.  However, if 
the price of corn is quoted as $245.00, the limit move would be $10.00. 
If the security does not have a limit move (e.g., a stock or some futures), 
we suggest you enter the maximum value allowed (i.e., $30,000). 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 446 for interpretation information on the Accumulation 
Swing Index. 

Accumulation/Distribution 
There are no parameters for the Accumulation/Distribution indicator. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 446 for interpretation information on the 
Accumulation/Distribution indicator. 

Aroon 
The parameters for the Aroon indicator are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
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Time Periods.  Enter the number of time periods to use when 
calculating Aroon.  The term "time periods" refers to days if the chart 
contains daily data, weeks for weekly data, hours for hourly data, etc. 
  
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 448 for interpretation information on Aroon indicator. 

Average True Range 
The parameters for the Average True Range are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating Average True Range.  The term "time periods" refers to days 
if the chart contains daily data, weeks for weekly data, hours for hourly 
data, etc. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 449 for interpretation information on the Average True 
Range indicator. 

Bollinger Bands 
The parameters for the Bollinger Bands are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating.  The term "time periods" refers to days if the chart contains 
daily data, weeks for weekly data, hours for hourly data, etc. 
Deviations.  Enter the number of standard deviations by which to shift 
the upper and lower bands. 
Horizontal Shift.  Enter the number of periods to shift the Bollinger 
Bands.  For example, enter "5" to shift them five periods to the right; 
enter "-5" to shift them five periods to the left; etc. 
Method.  Choose the moving average calculation method (i.e., simple, 
exponential, weighted, time series, triangular, variable, or volume 
adjusted). 
Price Field.  Choose the price field (i.e., open, high, low, or close) to 
use when calculating Bollinger Bands. 
If you edit the parameters of the middle band, all three bands are affected.  
If you edit the parameters of the upper or lower bands individually, only 
that band is affected.  Therefore, if you want symmetrical bands, edit the 
parameters of the middle band only. 
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See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 449 for interpretation information on the Bollinger 
Bands. 

Chaikin A/D Oscillator 
There are no parameters for the Chaikin A/D Oscillator. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 451 for interpretation information on the Chaikin 
Oscillator. 

Chaikin Money Flow 
The parameters for the Chaikin Money Flow indicator are shown below.  
These parameters are specified at the time the indicator is plotted.  You 
can edit the parameters of an existing plot by right-clicking on the 
indicator and choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating the indicator.  The term "time periods" refers to days if the 
chart contains daily data, weeks for weekly data, hours for hourly data,  
etc. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 454 for interpretation information on the Chaikin 
Money Flow indicator. 

Chande Momentum Oscillator 
The parameters for the Chande Momentum Oscillator are shown below.  
These parameters are specified at the time the indicator is plotted.  You 
can edit the parameters of an existing plot by right-clicking on the 
indicator and choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating the indicator.  The term "time periods" refers to days if the 
chart contains daily data, weeks for weekly data, hours for hourly data,  
etc. 
Price Field.  Choose the price field (i.e., open, high, low, or close) to 
use when calculating the indicator. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 455 for interpretation information on the Chande 
Momentum Oscillator. 

Commodity Channel Index (CCI) 
The parameters for the CCI are shown below.  These parameters are 
specified at the time the indicator is plotted.  You can edit the parameters 
of an existing plot by right-clicking on the indicator and choosing 
Properties from the shortcut menu. 
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Time Periods.  Enter the number of time periods to use when 
calculating the Commodity Channel Index.  The term "time periods" 
refers to days if the chart contains daily data, weeks for weekly data, 
hours for hourly data, etc. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 456 for interpretation information on the Commodity 
Channel Index. 

Commodity Selection Index 
The parameters for the Commodity Selection Index are shown below.  
These parameters are specified at the time the indicator is plotted.  You 
can edit the parameters of an existing plot by right-clicking on the 
indicator and choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating the Commodity Selection Index.  The term "time periods" 
refers to days if the chart contains daily data, weeks for weekly data,  
hours for hourly data, etc. 
Value a $.01 Move.  In Wilder's book (see page 544), he uses $50 for 
Soybeans, $400 for Pork Bellies, and $375 for Coffee. 
Margin Requirement.  Enter the margin requirement for the contract 
in dollars. 
Commission Amount.  Enter the commission cost in dollars. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 457 for interpretation information on the Commodity 
Selection Index. 

Correlation 
Before attempting to plot the Correlation indicator, you must first select 
two plots.  This could be two price plots, an indicator and a price plot, or 
two indicators.  The first plot selected will be the independent variable 
and the second, the dependent variable. 
The parameters for the Correlation indicator are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Time Periods.  This parameter specifies the number of time periods 
that are used to "smooth" the dependent and independent variables when 
determining their correlation. 
Forward Shift.  This parameter specifies the number of time periods to 
shift the independent variable's data forward.  This can be used to 
determine whether a change in an indicator (the independent variable) 
"leads" a change in prices (the dependent variable).  For example, if you 
find that an indicator has a high positive correlation to the security's price 
when shifted forward three periods, you may assume that a change in the 
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indicator today will predict a change in the security's price three periods 
from now. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 457 for interpretation information on Correlation 
Analysis. 

To plot the Correlation indicator  
1. Select the two plots that you want to correlate (i.e., two indicators, a 

price plot and an indicator, or two price plots).  Select the first plot 
(the independent variable) by simply clicking on it.  Select the 
second plot (the dependent variable) by holding down the SHIFT key 
and clicking on it.  Small square handles will appear on the plots 
indicating that they are selected. 

2. Drag the Correlation indicator from the Indicator QuickList and drop 
it on the chart.   

Dema 
The parameters for the Dema indicator are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating the indicator.  The term "time periods" refers to days if the 
chart contains daily data, weeks for weekly data, hours for hourly data, 
etc. 
Price Field.  Choose the price field (i.e., open, high, low, or close) to use 
when calculating DEMA. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 459 for interpretation information on the Dema 
indicator. 

Demand Index 
There are no parameters for the Demand Index. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 460 for interpretation information on the Demand Index. 

Detrended Price Oscillator 
The parameters for the Detrended Price Oscillator are shown below.  
These parameters are specified at the time the indicator is plotted.  You 
can edit the parameters of an existing plot by right-clicking on the 
indicator and choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating the Detrended Price Oscillator.  The term "time periods" 
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refers to days if the chart contains daily data, weeks for weekly data,  
hours for hourly data, etc. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 461 for interpretation information on the Detrended 
Price Oscillator. 

Directional Movement 
There are five indicators comprising the Directional Movement system: 
+DI, -DI, ADX, ADXR, and DX. 
The parameters for the Directional Movement indicators are shown 
below.  These parameters are specified at the time the indicator is plotted.  
You can edit the parameters of an existing plot by right-clicking on the 
indicator and choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating Directional Movement.  The term "time periods" refers to 
days if the chart contains daily data, weeks for weekly data, hours for 
hourly data, etc. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 461 for interpretation information on the Directional 
Movement indicator. 

Dynamic Momentum Index 
The parameters for the Dynamic Momentum Index are shown below.  
These parameters are specified at the time the indicator is plotted.  You 
can edit the parameters of an existing plot by right-clicking on the 
indicator and choosing Properties from the shortcut menu. 
Price Field.  Choose the price field (i.e., open, high, low, or close) to use 
when calculating the Dynamic Momentum Index. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 462 for interpretation information on the Dynamic 
Momentum Index. 

Ease of Movement 
The parameters for the Ease of Movement are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating Ease of Movement.  The term "time periods" refers to days if 
the chart contains daily data, weeks for weekly data, hours for hourly 
data, etc. 



 

 
 

MetaStock Professional Working with Indicators • 181 

 

 

 

Method.  Choose the moving average calculation method (i.e., simple, 
exponential, weighted, time series, triangular, variable, or volume 
adjusted). 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 463 for interpretation information on the Ease of 
Movement indicator. 

Envelope 
The parameters for Envelopes are shown below.  These parameters are 
specified at the time the indicator is plotted.  You can edit the parameters 
of an existing plot by right-clicking on the indicator and choosing 
Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating the envelopes.  The term "time periods" refers to days if the 
chart contains daily data, weeks for weekly data, hours for hourly data, 
etc. 
Vertical Shift %.  Enter the percentage to shift the upper and lower 
envelopes from the base moving average.  For example, enter "10" to  
shift the envelopes 10 percent above and below the base moving average. 
Horizontal Shift.  Enter the number of periods to shift the envelopes.  
For example, enter "5" to shift the envelopes five periods to the right; 
enter "-5" to shift the envelopes five periods to the left; etc. 
Method.  Choose the moving average calculation method (i.e., simple, 
exponential, weighted, time series, triangular, variable, or volume 
adjusted). 
Price Field.  Choose the price field (i.e., open, high, low, or close) to 
use when calculating the envelopes. 
When you initially plot envelopes, the above options affect the upper and 
lower envelopes equally.  However, after the envelopes are plotted, you 
can edit the parameters of each band separately. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 464 for interpretation information on Envelopes. 

Forecast Oscillator 
The parameters for the Forecast Oscillator are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating the indicator.  The term "time periods" refers to days if the 
chart contains daily data, weeks for weekly data, hours for hourly data, 
etc. 
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Price Field.  Choose the price field (i.e., open, high, low, or close) to 
use when calculating the indicator. 
Signal Moving Average Time Periods.  Enter the number of time 
periods to use when calculating the Forecast Oscillator's signal line.  The 
term "time periods" refers to days if the chart contains daily data, weeks 
for weekly data, hours for hourly data, etc. 
Style.  Choose the line style for the signal line.  Note that the style for the 
Forecast Oscillator line itself is changed from the Color/Style page in the 
MACD Properties dialog. 
Color.  Choose the color for the signal line.  Note that the color for the 
Forecast Oscillator line itself is changed from the Color/Style page of the 
MACD Properties dialog. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 467 for interpretation information on the Forecast 
Oscillator. 

Fourier Transform 
The parameters for the Fourier Transform are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Interpreted.  Choose this option if you want MetaStock Pro to interpret 
the Fourier data and display the information in an easily understood 
format. 
Raw.  Choose  this option if you want MetaStock Pro to display the raw 
(i.e., more detailed and complex) Fourier data. 
If you select Raw, you will be prompted for the following additional 
parameters:   
Time Periods.  Enter the number of time periods to analyze. 
Sample Length.  The Fourier Transform can group a number of data 
values together and analyze them as a "set of sets."  For example, 
selecting 5 will group the data into sets of 5 periods.  The maximum 
value for the sample length is 1/4 the number of time periods loaded, but 
the maximum useful sample length is around 5. 
Price Field.  Choose the price field (i.e., open, high, low, or close) to 
use when calculating the Fourier Transform. 
Method.  Choose the type of analysis, either Amplitude (strength) or 
Spectrum. 
Smoothing.  Choose the smoothing method to remove trends from the 
data (normalization method).  The choices are Detrend (linear regression) 
and Mean (averaging) . 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 468 for interpretation information on Fourier Transform. 
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Herrick Payoff Index 
The parameters for the Herrick Payoff Index are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu.  Note that the Herrick Payoff 
Index requires open interest to calculate. 
One Cent Move.  According to Herrick, the recommended input for 
"the value of a one cent move" is "100" for most commodities.  The only 
exception is for Silver, which should be "50." 
Multiplying Factor.  The multiplying factor is part of a complex 
smoothing mechanism.  However, the results are similar to the smoothing 
obtained by a moving average.  For example, a multiplying factor of ten 
produces results similar to a 10-period moving average. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 470 for interpretation information on the Herrick Payoff 
Index. 

Inertia 
The parameters for the Inertia indicator are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating the indicator.  The term "time periods" refers to days if the 
chart contains daily data, weeks for weekly data, hours for hourly data,  
etc. 
RVI Periods.  Enter the number of periods to use for the Relative 
Volatility Index (RVI) which the Inertia indicator is based on. 
Price Field.  Choose the price field (i.e., open, high, low, or close) to use 
when calculating the indicator. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 471 for interpretation information on the Inertia 
indicator. 

Intraday Momentum Index 
The parameters for the Intraday Momentum Index are shown below.  
These parameters are specified at the time the indicator is plotted.  You 
can edit the parameters of an existing plot by right-clicking on the 
indicator and choosing Properties from the shortcut menu.  Note that the 
Intraday Momentum Index requires open prices to calculate.   
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Time Periods.  Enter the number of time periods to use when 
calculating the indicator.  The term "time periods" refers to days if the 
chart contains daily data, weeks for weekly data, hours for hourly data,  
etc. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 472 for interpretation information on the Intraday 
Momentum Index. 

Klinger Oscillator 
The parameters for the Klinger Oscillator are shown below.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when calculating 
the oscillator's signal line.  The term "time periods" refers to days if the 
chart contains daily data, weeks for weekly data, hours for hourly data, 
etc. 
Style.  Choose the line style for the signal line.  Note that the style for the 
oscillator itself is changed from the Color/Style page of the Klinger 
Oscillator Properties dialog. 
Color.  Choose the color for the signal line.  Note that the color for the 
oscillator itself is changed from the Color/Style page in the Klinger 
Oscillator Properties dialog. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 474 for interpretation information on the Klinger 
Oscillator. 

Linear Regression Indicator 
The parameters for the Linear Regression indicator are shown below.  
These parameters are specified at the time the indicator is plotted.  You 
can edit the parameters of an existing plot by right-clicking on the 
indicator and choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating the indicator.  The term "time periods" refers to days if the 
chart contains daily data, weeks for weekly data, hours for hourly data, 
etc. 
Price Field.  Choose the price field (i.e., open, high, low, or close) to use 
when calculating the indicator. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 476 for interpretation information on the Linear 
Regression indicator. 
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Linear Regression Slope 
The parameters for the Linear Regression Slope are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating the indicator.  The term "time periods" refers to days if the 
chart contains daily data, weeks for weekly data, hours for hourly data, 
etc. 
Price Field.  Choose the price field (i.e., open, high, low, or close) to use 
when calculating the indicator. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 476 for interpretation information on the Linear 
Regression Slope. 

MACD 
The parameters for the MACD are shown below.  You can edit the 
parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
In order to maintain the mathematical integrity of the MACD as 
prescribed by Gerald Appel, MetaStock Pro does not allow the time 
periods in the MACD to be changed.  The MACD is actually the 
difference between   0.075 and 0.15 exponential moving averages.  No 
exact time periods (using whole numbers) correspond with these 
percentages.  If you want to plot an MACD-like indicator using moving 
averages other than the ones recommended by Gerald Appel, use the 
Price Oscillator (see page 191). 
Signal Time Periods.  Enter the number of time periods to use when 
calculating the MACD's signal line.  The term "time periods" refers to 
days if the chart contains daily data, weeks for weekly data, hours for 
hourly data, etc. 
Style.  Choose the line style for the signal line.  Note that the style for 
the MACD line itself is changed from the Color/Style page in the MACD 
Properties dialog. 
Color.  Choose the color for the signal line.  Note that the color for the 
MACD line itself is changed from the Color/Style page of the MACD 
Properties dialog. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 478 for interpretation information on the MACD. 

Market Facilitation Index 
There are no parameters for the Market Facilitation Index. 
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See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 479 for interpretation information on the Market 
Facilitation Index. 

Mass Index 
The parameters for the Mass Index are shown below.  These parameters 
are specified at the time the indicator is plotted.  You can edit the 
parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating the Mass Index.  The term "time periods" refers to days if the 
chart contains daily data, weeks for weekly data, hours for hourly data, 
etc. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 481 for interpretation information on the Mass Index. 

Median Price 
There are no parameters for the Median Price. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 481 for interpretation information on the Median Price 
indicator. 

MESA Sine Wave Indicator 
The parameters for the MESA Sine Wave indicator are shown below.  
These parameters are specified at the time the indicator is plotted.  You 
can edit the parameters of an existing plot by right-clicking on the 
indicator and choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating the MESA Sine Wave indicator.  The term "time periods" 
refers to days if the chart contains daily data, weeks for weekly data, 
hours for hourly data, etc. 
Mesa Lead Sine.  Choose the style and color for the lead sine plot. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 482 for interpretation information on the MESA Sine 
Wave indicator. 

Momentum 
The parameters for the Momentum indicator are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating Momentum.  The term "time periods" refers to days if the 
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chart contains daily data, weeks for weekly data, hours for hourly data, 
etc. 
Price Field.  Choose the price field (i.e., open, high, low, or close) to 
use when calculating Momentum. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 483 for interpretation information on the Momentum 
indicator. 

Money Flow Index 
The parameters for the Money Flow Index are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating the Money Flow Index.  The term "time periods" refers to 
days if the chart contains daily data, weeks for weekly data, hours for 
hourly data, etc. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 483 for interpretation information on the Money Flow 
Index. 

Moving Average 
The parameters for a moving average are shown below.  These 
parameters are specified at the time the moving average is plotted.  You 
can edit the parameters of an existing moving average by right-clicking 
on the moving average and choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating the moving average.  The term "time periods" refers to days if 
the chart contains daily data, weeks for weekly data, hours for hourly 
data, etc. 
Vertical Shift %.  Enter the percentage to shift the moving average up 
or down.  For example, enter "10" to  shift the moving average upward 
by 10 percent; enter "-5"  to shift the moving average downward by 5 
percent. 
Horizontal Shift.  Enter the number of periods to shift the moving 
average.  For example, enter "5" to shift the moving average five periods 
to the right; enter "-5" to shift the moving average five periods to the left; 
etc. 
Method.  Choose the moving average calculation method (i.e., simple, 
exponential, weighted, time series, triangular, variable, and volume 
adjusted. 
Price Field.  Choose the price field (i.e., open, high, low, close, median 
price, or typical price) to use when calculating the moving average.  The 
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median price (see page 481) is defined as the "(high + low) / 2" and the 
typical price (see page 532) is defined as the "(high + low + close) / 3." 
 
When plotting a moving average on an existing indicator, there may be 
times that you want to hide the indicator and just show the moving 
average.  If you delete the indicator, the moving average will also 
disappear since it is dependent on the indicator for the calculation.  
However, you can hide the indicator, by choosing the Invisible Style 
from  the indicator's Properties dialog. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 488 for interpretation information on moving averages. 

Negative Volume Index 
The parameters for the Negative Volume Index are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Price Field.  Choose the price field (i.e., open, high, low, or close) to 
use when calculating the moving average. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 490 for interpretation information on the Negative 
Volume Index. 

On Balance Volume 
The parameters for the On Balance Volume are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Price Field.  Choose the price field (i.e., open, high, low, or close) to 
use when calculating the moving average. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 493 for interpretation information on On Balance 
Volume. 

Open Interest 
There are no parameters for Open Interest.  Note that your security files 
must contain open interest in order to plot open interest. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 494 for interpretation information on the Open Interest. 

Option Expiration 
There are no parameters for the Option Expiration indicator. 
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See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 495 for interpretation information on the Option 
Expiration indicator. 

Option Delta, Gamma, Price, Theta, Vega 
The parameters for the Option indicators are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Put or Call.  Choose the type of option. 
Equity or Future.  Choose the underlying security type.  The Black-
Scholes model must be adjusted for options on futures, because no initial 
investment (other than a margin deposit) is required to open a future 
position.  You should choose Equity if you are analyzing an index option. 
Expiration Date.  Enter the date the option contract expires.  In the 
USA, this is usually the third Friday of the expiration month. 
Strike Price.  Enter the option's strike price. 
Interest Rate.  Enter the short-term "risk free" interest rate (e.g., 13-
week T-bills).  The interest rate should be entered as a percentage (e.g., 
4.75). 
Annual Dividend.  Enter the total of the most recent four quarters of 
dividend payments per share (e.g., 3.00).  If no dividends were paid, 
enter 0. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 494 for interpretation information on Option indicators. 

Option Life 
The parameters for the Option Life are shown below.  These parameters 
are specified at the time the indicator is plotted.  You can edit the 
parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Expiration Date.  Enter the date the option contract expires.  In the 
USA this is usually the third Friday of the expiration month. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 495 for interpretation information on Option Life. 

Option Volatility 
There are no parameters for Option Volatility. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 496 for interpretation information on Option Volatility. 
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Parabolic SAR 
The parameters for the Parabolic SAR are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Step.  As a trade makes new highs/lows, the Parabolic SAR will rise/fall 
according to the SAR step size.  For example, if the trade makes new 
highs for three consecutive days, then the SAR step increases by 0.02 
each day (i.e., 0.02 to 0.04 to 0.06, etc.).  The author (Welles Wilder) 
recommends a step size of 0.02 for most securities. 
Maximum.  Enter the maximum value the SAR Step can obtain.  The 
author recommends an SAR Maximum of 0.20 for most securities. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 496 for interpretation information on the Parabolic SAR. 

Performance 
The parameters for the Performance are shown below.  These parameters 
are specified at the time the indicator is plotted.  You can edit the 
parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Price Field.  Choose the price field (i.e., open, high, low, or close) to 
use when calculating the Performance indicator. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 497 for interpretation information on the Performance 
indicator. 

Polarized Fractal Efficiency 
The parameters for the Polarized Fractal Efficiency indicator (PFE) are 
shown below.  These parameters are specified at the time the indicator is 
plotted.  You can edit the parameters of an existing plot by right-clicking 
on the indicator and choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating the indicator.  The term "time periods" refers to days if the 
chart contains daily data, weeks for weekly data, hours for hourly data, 
etc. 
Smoothing Periods.  Enter the number of periods to use when 
smoothing the PFE. 
Price Field.  Choose the price field (i.e., open, high, low, or close) to 
use when calculating the PFE. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 498 for interpretation information on the Polarized 
Fractal Efficiency indicator. 
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Positive Volume Index 
The parameters for the Positive Volume Index are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Price Field.  Choose the price field (i.e., open, high, low, or close) to 
use when calculating the Positive Volume Index. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 499 for interpretation information on the Positive 
Volume Index. 

Price Channel 
The parameters for the Price Channel are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating the indicator.  The term "time periods" refers to days if the 
chart contains daily data, weeks for weekly data, hours for hourly data, 
etc. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 500 for interpretation information on the Price Channel. 

Price Oscillator 
The parameters for the Price Oscillator are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Short-term.  Enter the number of time periods in the short-term moving 
average. 
Long-term.  Enter the number of time periods in the long-term moving 
average. 
Method.  Choose the moving average calculation method (i.e., simple, 
exponential, weighted, time series, triangular, or variable). 
Percent  or Points.  Choose the method to use when displaying the 
relationship between the two moving averages.  Choose Percent to see 
the ratio (in percent) between the short- and long-term moving averages.  
Choose Points to see the point difference. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 501 for interpretation information on the Price 
Oscillator. 
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Price Rate-Of-Change 
The parameters for the Price Rate-Of-Change are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating Price Rate-Of-Change.  The term "time periods" refers to 
days if the chart contains daily data, weeks for weekly data, hours for 
hourly data, etc. 
Percent  or Points.  Choose the method to use when displaying the 
change in the prices.  Choose Percent to see the ratio (in percent) between 
the prices.  Choose Points to see the point difference. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 501 for interpretation information on the Price Rate-Of-
Change. 

Price Volume Trend 
The parameters for the Price Volume Trend are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Price Field.  Choose the price field (i.e., open, high, low or close) to use 
when calculating the Price Volume Trend. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 503 for interpretation information on the Price Volume 
Trend. 

Projection Bands 
The parameters for the Projection Bands are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating the indicator.  The term "time periods" refers to days if the 
chart contains daily data, weeks for weekly data, hours for hourly data, 
etc. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 504 for interpretation information on Projection Bands. 

Projection Oscillator 
The parameters for the Projection Oscillator are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
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the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating the indicator.  The term "time periods" refers to days if the 
chart contains daily data, weeks for weekly data, hours for hourly data, 
etc. 
Slowing Periods.  Enter the number of time periods used in the 
moving average trigger line. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 504 for interpretation information on the Projection 
Oscillator. 

Qstick  
The parameters for the Qstick indicator are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu.  Note that the Qstick 
requires open prices to calculate.   
Time Periods.  Enter the number of time periods to use when 
calculating the indicator.  The term "time periods" refers to days if the 
chart contains daily data, weeks for weekly data, hours for hourly data, 
etc. 
Method.  Choose the method used to calculate the moving average of 
the difference between opening and closing prices.  
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 505 for interpretation information on the Qstick 
indicator. 

r-squared 
The parameters for the r-squared indicator are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating the indicator.  The term "time periods" refers to days if the 
chart contains daily data, weeks for weekly data, hours for hourly data, 
etc. 
Price Field.  Choose the price field (i.e., open, high, low, or close) to 
use when calculating the indicator. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 506 for interpretation information on the r-squared 
indicator. 
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Random Walk Index 
The parameters for the Random Walk Index are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu.  
The Random Walk Index automatically determines the optimum time 
periods to use in the calculation.  You can control the range of time 
periods analyzed by setting the minimum and maximum values.  The 
author of the indicator recommends values of 8 and 64 (the defaults) for 
long-term analysis, and 2 and 7 for short-term. 
Minimum Time Periods.  Enter the minimum number of time periods 
to consider when calculating the indicator.  The term "time periods" 
refers to 5 minutes if the chart contains 5-minute data, days if the chart 
contains daily data, weeks if the chart contains weekly data, etc. 
Maximum Time Periods.  Enter the number of maximum number of 
time periods to consider when calculating the indicator.  The term "time 
periods" refers to 5 minutes if the chart contains 5-minute data, days if 
the chart contains daily data, weeks if the chart contains weekly data, etc. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 509 for interpretation information on the Random Walk 
Index. 

Range Indicator 
The parameters for the Range Indicator are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating the indicator.  The term "time periods" refers to days if the 
chart contains daily data, weeks for weekly data, hours for hourly data, 
etc. 
Smoothing Periods.  Enter the number of periods to use when 
smoothing the Range Indicator. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 509 for interpretation information on the Range 
Indicator. 

Relative Momentum Index 
The parameters for the Relative Momentum Index are shown below.  
These parameters are specified at the time the indicator is plotted.  You 
can edit the parameters of an existing plot by right-clicking on the 
indicator and choosing Properties from the shortcut menu. 
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Time Periods.  Enter the number of time periods to use when 
calculating the indicator.  The term "time periods" refers to days if the 
chart contains daily data, weeks for weekly data, hours for hourly data, 
etc. 
Momentum.  Enter the number of periods to use when calculating the 
momentum component of  the Range Indicator. 
Price Field.  Choose the price field (i.e., open, high, low, or close) to 
use when calculating the indicator. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 510 for interpretation information on the Relative 
Momentum Index. 

Relative Strength Comparative 
The parameters for the Relative Strength Comparative indicator are 
shown below.  These parameters are specified at the time the indicator is 
plotted.  You can edit the parameters of an existing plot by right-clicking 
on the indicator and choosing Properties from the shortcut menu. 
Security and Folder.  Click the Browse button to select the security 
with which to compare the chart's base security.  This is usually a market 
index like the S&P 500.  The chart's base security is divided by the 
selected security. 
Normalize To Start At Zero.  Check this box if you want the indicator 
to be "normalized" to start at zero.  This is done by subtracting the 
beginning Relative Strength ratio (for the first bar loaded in the chart) 
from every subsequent value.  This is helpful for comparing one security's 
Relative Strength with another's. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 511 for interpretation information on the Relative 
Strength Comparative indicator. 

Relative Strength Index (RSI)  
The parameters for the RSI are shown below.  These parameters are 
specified at the time the indicator is plotted.  You can edit the parameters 
of an existing plot by right-clicking on the indicator and choosing 
Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating the Relative Strength Index.  The term "time periods" refers to 
days if the chart contains daily data, weeks for weekly data, hours for 
hourly data, etc. 
Price Field.  Choose the price field (i.e., open, high, low, or close) to use 
when calculating the Relative Strength Index. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 512 for interpretation information on the Relative 
Strength Index. 
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Relative Volatility Index 
The parameters for the Relative Volatility Index are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit  
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating the indicator.  The term "time periods" refers to days if the 
chart contains daily data, weeks for weekly data, hours for hourly data, 
etc. 
Price Field.  Choose the price field (i.e., open, high, low, or close) to use 
when calculating the indicator. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 513 for interpretation information on the Relative 
Volatility Index. 

Spread 
The parameters for the Spread indicator are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Security and Folder.  Click the Browse button to select the security 
with which to spread against the chart's base security.  The selected 
security is subtracted from the chart's base security. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 516 for interpretation information on the Spread 
indicator. 

Standard Deviation 
The parameters for the Standard Deviation indicator are shown below.  
These parameters are specified at the time the indicator is plotted.  You 
can edit the parameters of an existing plot by right-clicking on the 
indicator and choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating the Standard Deviation.  The term "time periods" refers to 
days if the chart contains daily data, weeks for weekly data, hours for 
hourly data, etc. 
Deviations.  Enter the number of standard deviations by which to shift 
the plot upward. 
Price Field.  Choose the price field (i.e., open, high, low, or close) to use 
when calculating the Standard Deviation. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 516 for interpretation information on Standard 
Deviation. 
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Standard Error 
The parameters for the Standard Error indicator are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating the indicator.  The term "time periods" refers to days if the 
chart contains daily data, weeks for weekly data, hours for hourly data, 
etc. 
Price Field.  Choose the price field (i.e., open, high, low, or close) to use 
when calculating the indicator. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 518 for interpretation information on Standard Error. 

Standard Error Bands 
The parameters for the Standard Error Bands are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating the indicator.  The term "time periods" refers to days if the 
chart contains daily data, weeks for weekly data, hours for hourly data, 
etc. 
Standard Error.  Enter the number of standard errors by which to shift 
the upper and lower bands. 
Horizontal Shift.  Enter the number of periods to shift the Standard 
Error Bands.  For example, enter "5" to shift them five periods to the 
right; enter "-5" to shift them five periods to the left; etc. 
Price Field.  Choose the price field (i.e., open, high, low, or close) to use 
when calculating the indicator. 
Smoothing Periods.  Enter the number of periods to use for the 
smoothing (i.e., the moving average calculation). 
Smoothing Method.  Choose the moving average calculation method 
(i.e., simple, exponential, weighted, time series, triangular, variable, or 
volume adjusted). 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 519 for interpretation information on Standard Error 
Bands. 

Stochastic Momentum Index 
The parameters for the Stochastic Momentum Index are shown below.  
These parameters are specified at the time the indicator is plotted.  You 
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can edit the parameters of an existing plot by right-clicking on the 
indicator and choosing Properties from the shortcut menu. 
%K Time Periods.  Enter the number of time periods used in the %K 
calculation. 
%K Smoothing Periods.  Enter the number of time periods used in the 
internal smoothing of the %K value. 
Double Smooth Periods.  Enter the number of time periods used in 
the double smoothing component of the %K value. 
%D Time Periods.  Enter the number of time periods used in the 
moving average signal line of %K.  This is plotted as a dotted line 
(default) on top of %K.   
Method.  Choose the method (i.e., exponential, simple, weighted, time 
series, triangular, or variable) used to calculate %D. 
Style.  Choose the line style (i.e., solid, dashed, etc.) used for the %D. 
Color.  Choose the color used for the %D. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 521 for interpretation information on the Stochastic 
Momentum Index. 

Stochastic Oscillator 
The parameters for the Stochastic Oscillator are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
%K Time Periods.  Enter the number of time periods used in the 
stochastic calculation. 
%K Slowing.  Enter the number of time periods used in the internal 
smoothing of the %K value.  A value of 1 is considered a fast stochastic; 
the default value of 3 is considered a slow stochastic. 
%D Time Periods.  Enter the number of time periods used in the 
moving average of %K.  This is plotted as a dotted line (default) on top 
of %K.   
%D Method.  Choose the method (i.e., exponential, simple, weighted, 
time series, triangular, or variable) used to calculate %D. 
%D Style.  Choose the line style (i.e., solid, dashed, etc.) used for the 
%D. 
%D Color.  Choose the color used for the %D. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 522 for interpretation information on the Stochastic 
Oscillator. 
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Swing Index 
The parameters for the Swing Index are shown below.  These parameters 
are specified at the time the indicator is plotted.  You can edit the 
parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu.  Note that the Qstick requires 
open prices to calculate.   
Limit Move.  The table below lists the limit moves for several 
commodities traded on the Chicago Board of Trade: 
 

Commodity Limit Move 
Corn $0.10 

Heating Oil $0.04 

Soybeans $0.30 

T-bonds $3.00 

You may need to adjust the limit moves shown in the above table based 
on the position of the decimal in your data files.  For example, if the price 
of corn is quoted as $3.45, the limit move would be $0.10.  However, if 
the price of corn is quoted as $345.00, the limit move would be $10.00. 
If the security does not have a limit move (e.g., a stock or some futures), 
we suggest you enter the maximum value allowed (i.e., $30,000). 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 525 for interpretation information on the Swing Index. 

TEMA 
The parameters for the TEMA indicator are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating the TEMA indicator.  The term "time periods" refers to days 
if the chart contains daily data, weeks for weekly data, hours for hourly 
data, etc. 
Price Field.  Choose the price field (i.e., open, high, low, or close) to use 
when calculating the indicator. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 525 for interpretation information on the TEMA 
indicator. 

Time Series Forecast 
The parameters for the Time Series Forecast are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
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the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating the Time Series Forecast.  The term "time periods" refers to 
days if the chart contains daily data, weeks for weekly data, hours for 
hourly data, etc. 
Price Field.  Choose the price field (i.e., open, high, low, or close) to 
use when calculating the Time Series Forecast. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 527 for interpretation information on the Time Series 
Forecast. 

Trade Volume Index 
The parameters for the Trade Volume Index are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Minimum Tick.  This controls when volume switches from the buy side 
to the sell side.  If the absolute value of the uptick or downtick is less 
than the Minimum Tick Value, MetaStock Pro will continue to assign the 
volume to the current side (i.e., buy or sell side).  If the absolute value of 
the price change is greater than the Minimum Tick Value and the price 
changes direction, MetaStock Pro will switch and begin assigning 
volume to the opposite side. 
Price Field.  Choose the price field (i.e., open, high, low, or close) to 
use when calculating the Trade Volume Index. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 529 for interpretation information on the Trade Volume 
Index. 

TRIX 
The parameters for the TRIX are shown below.  These parameters are 
specified at the time the indicator is plotted.  You can edit the parameters 
of an existing plot by right-clicking on the indicator and choosing 
Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating TRIX.  The term "time periods" refers to days if the chart 
contains daily data, weeks for weekly data, hours for hourly data, etc. 
Price Field.  Choose the price field (i.e., open, high, low, or close) to use 
when calculating TRIX. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 532 for interpretation information on the TRIX 
indicator. 
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Typical Price 
There are no parameters for Typical Price. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 532 for interpretation information on Typical Price. 

Ultimate Oscillator 
The parameters for the Ultimate Oscillator are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
First Cycle.  Enter the number of time periods in the short-term cycle.   
Second Cycle.  Enter the number of time periods in the intermediate-
term cycle.  
Third Cycle.  Enter the number of time periods in the long-term cycle.   
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 533 for interpretation information on the Ultimate 
Oscillator. 

Vertical Horizontal Filter (VHF)  
The parameters for the VHF are shown below.  These parameters are 
specified at the time the indicator is plotted.  You can edit the parameters 
of an existing plot by right-clicking on the indicator and choosing 
Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating the Vertical Horizontal Filter.  The term "time periods" refers 
to days if the chart contains daily data, weeks for weekly data, hours for 
hourly data, etc. 
Price Field.  Choose the price field (i.e., open, high, low, or close) to use 
when calculating the Vertical Horizontal Filter. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 533 for interpretation information on the Vertical 
Horizontal Filter. 

Volatility (Chaikin's)  
The parameters for the Chaikin's Volatility indicator are shown below.  
These parameters are specified at the time the indicator is plotted.  You 
can edit the parameters of an existing plot by right-clicking on the 
indicator and choosing Properties from the shortcut menu. 
Moving Average.  Enter the number of time periods to use when 
smoothing the differences between the high and low prices.  The author 
(Marc Chaikin) recommends a value of 10. 
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Rate-of-Change.  Enter the number of time periods to use when 
calculating the percent rate-of-change of the moving average.  The author 
(Marc Chaikin) recommends a value of 10. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 534 for interpretation information on Chaikin's 
Volatility. 

Volume 
The parameters for the Volume indicator are shown below.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu.   Note that your security files 
must contain volume in order to plot volume. 
Zero-Based.  Check this box if you want the volume bars to be scaled 
with a base of zero.  If the box is unchecked, the volume is scaled using 
the lowest volume bar as a base. 
Some real-time data vendors do not provide volume with every tick.  If 
this is the case, MetaStock Pro will automatically assign a volume value 
of "1" for every incoming  tick.  This allows you to see the number of 
"ticks" that have come in during a specified period.  For example, if the 
volume on a 1-minute bar is 22, 22 trades came in during that minute. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 535 for interpretation information on Volume. 

Volume Oscillator 
The parameters for the Volume Oscillator are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Short-term.  Enter the number of time periods in the short-term moving 
average. 
Long-term.  Enter the number of time periods in the long-term moving 
average. 
Method.  Choose the moving average calculation method (i.e., simple, 
exponential, weighted, time series, triangular, variable, or volume 
adjusted). 
Percent or Points.  Choose the method to use when displaying the 
relationship between the two moving averages.  Choose Percent to see the 
ratio (in percent) between the short- and long-term moving averages.  
Choose Points to see the point difference. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 535 for interpretation information on the Volume 
Oscillator. 
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Volume Rate-Of-Change 
The parameters for the Volume Rate-Of-Change are shown below.  These 
parameters are specified at the time the indicator is plotted.  You can edit 
the parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating the Volume Rate-Of-Change.  The term "time periods" refers 
to days if the chart contains daily data, weeks for weekly data, hours for 
hourly data, etc. 
Percent or Points.  Choose the method to use when displaying the 
change in the volume.  Choose Percent to see the ratio (in percent) 
between the volume figures.  Choose Points to see the point difference. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 536 for interpretation information on the Volume Rate-
Of-Change. 

Weighted Close 
There are no parameters for Weighted Close. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 537 for interpretation information on the Weighted 
Close indicator. 

Wilder's Smoothing 
The parameters for the Wilder's Smoothing indicator are shown below.  
These parameters are specified at the time the indicator is plotted.  You 
can edit the parameters of an existing plot by right-clicking on the 
indicator and choosing Properties from the shortcut menu. 
Time Periods.  Enter the number of time periods to use when 
calculating the Wilder's Smoothing indicator.  The term "time periods" 
refers to days if the chart contains daily data, weeks for weekly data, 
hours for hourly data, etc. 
Price Field.  Choose the price field (i.e., open, high, low, or close) to use 
when calculating the Wilder's Smoothing indicator. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 537 for interpretation information on the Wilder's 
Smoothing indicator. 

Williams' %R 
The parameters for the Williams' %R are shown below.  These parameters 
are specified at the time the indicator is plotted.  You can edit the 
parameters of an existing plot by right-clicking on the indicator and 
choosing Properties from the shortcut menu. 
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Time Periods.  Enter the number of time periods to use when 
calculating the Williams' %R.  The term "time periods" refers to days if 
the chart contains daily data, weeks for weekly data, hours for hourly 
data, etc. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 538 for interpretation information on Williams' %R. 

Williams' Accumulation/Distribution 
There are no parameters for Williams' Accumulation/Distribution. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 539 for interpretation information on Williams' 
Accumulation/Distribution. 

Zig Zag 
The parameters for the Zig Zag are shown below.  These parameters are 
specified at the time the indicator is plotted.  You can edit the parameters 
of an existing plot by right-clicking on the indicator and choosing 
Properties from the shortcut menu. 
Price Field.  Choose the price field (i.e., open, high, low, or close) to use 
when calculating the Zig Zag. 
Reversal Amount.  Enter the amount that will cause a reversal.  For 
example, if you enter "5," a five percent move is required to cause a bend 
(i.e., zig or zag) in the Zig Zag indicator. 
Percent or Points.  Choose the calculation method to use for the 
reversal amount.  Choose Percent if you want the Reversal Amount 
calculated in percent.  Choose Points if you want the Reversal amount 
calculated in points. 
See page 167 for information on the Color/Style and Horizontal Lines 
pages.  See page 539 for interpretation information on the Zig Zag 
indicator. 
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Working with Line Studies 

What is a Line Study? 
Line studies are plots that you draw or place on a chart to help interpret 
price or indicator movement.  Examples are trendlines, Fibonacci Arcs, 
ellipses, Gann Angles, vertical lines, etc.  Although not officially 
designated as line studies, text and symbols are very similar to line studies 
in the way they are placed on a chart.  Text and symbols are also covered 
in this chapter. 
Every line study is an object containing its own set of parameters that can 
be accessed by right-clicking directly on the study. 
Most line studies are contained within a single inner window.  However, 
some lines studies (e.g., cycle lines, Fibonacci Time Zones, and vertical 
lines) can span vertically across all inner windows within a chart. 
There are two types of line studies--those that are line based and those  
that aren't.  Line studies that are line based require you to click and drag a 
line between a starting and ending point to draw the line study.  Those  
that aren't line based appear as soon as the mouse pointer is inside an  
inner window.  A mouse click anchors the line study. 
Linear Regression Lines, Quadrant Lines, Speed Resistance Lines, Raff 
Regression Channels, and Tirone Levels require actual pricing data to  
plot.  When these line studies are plotted on Kagi, Point & Figure, Three 
Line Break, or Renko charts, they use all the data in all the columns. 

Drawing a Line Study 
Line studies are drawn on a chart by either selecting the desired button on 
the appropriate drawing toolbar or by choosing the line study from the 
Insert menu. 
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Line studies are attached to the closest plot to the mouse pointer when 
you first click to begin drawing.  You can change the plot a line study is 
attached to from the Select Plot dialog.  Right-click on the line study and 
choose Scaling to display the Select Plot dialog.  

 

To draw a line study  
1. Choose the desired line study from the appropriate drawing toolbar or 

the Insert menu. 
2. If the line study is trendline based, position the mouse at the starting 

point, click and hold the left mouse button, and drag the line study to 
an ending point. 

3. If the line study is not trendline based, simply position the mouse at 
the location you want to anchor it and click the left mouse button. 
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The Five Groups of Line Studies 
The following illustrations show the five toolbars of line studies 
available. 

                              
Data     Gann    Text     Channel    Trendline 
The Studies toolbar combines the Data, Gann, Channel, and Text groups 
of tools.  Use the rotate buttons to rotate between these five groups of 
lines studies.  The Trendline toolbar is always displayed. 

 

Select Mode versus Drawing Mode 
 
 
 
 
 

 
Select Mode button 

When you choose a line study, the mouse pointer changes appearance to 
indicate that you have switched from "select" mode to "drawing" mode.  
When you are in drawing mode, you can draw the chosen line study, but 
you cannot select other objects on the chart (e.g., price plots or line 
studies).   
To return to select mode after drawing a line study, click the Select Mode 
button on the trendline toolbar.  An Application property (see page 31) 
controls whether you return to select mode immediately after drawing a 
line study or remain in drawing mode. 

Helpful Feedback from the Status Bar 
The status bar provides helpful feedback when drawing line studies.  It 
tells you where the mouse pointer is positioned by showing the date/time 
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and the y-axis value as you are drawing, which can be very helpful on a 
crowded chart. 

 

Modifying a Line Study 
After a line study is drawn, you can modify any of its properties (e.g., 
start/end date, color, etc.) with the line study's Properties dialog.  Line 
studies can also be copied or moved to a new inner window in the same 
chart or in a different chart.  You can also reposition line studies. 
A line study's Properties dialog can be accessed three ways: 
• You can right-click directly on the line study and choose Properties 

from the shortcut menu. 
• You can double-click directly on the line study. 
• You can click the line study to select it and then choose Selected 

Object from the Format menu. 
You can press the TAB 
key to cycle through all 
selectable objects on a 
chart. 

When you are clicking (either double-clicking or right-clicking) on a line 
study and the line study is closely surrounded by other plots (i.e., prices, 
moving averages, etc.), an ambiguity menu may pop up prompting you to 
choose the desired line study. 
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The following Properties dialog for a Fibonacci Arc is typical of many  
line studies. 

 

To modify the properties of a line study  
1. Position the mouse on the plotted line study and right-click. 
2. Choose  Properties. 
3. Make the desired changes from the line study's Properties dialog. 
4. Click the OK button. 

Properties Common to Many Line Studies 
Every line study Properties dialog contains two pages--a Parameters and a 
Color/Style page.  The Color/Style page for every line study is identical, 
although the Parameters page is unique to each line study.  Several 
controls are common to many line studies as explained below. 

Parameters Page 
The Parameters page for many line studies includes one (or more) of the 
seven controls shown in the Trendline Parameters page below.   
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Start Date.  This is the date/time the line study starts.  You can modify 
this date/time by typing in a new one or by selecting the line study and 
dragging the leftmost handle left or right.  Click the "D" button to enter 
dates.  Click the "T" button to enter times. 
Start Value.  This is the y-axis value at the starting point of the line 
study.  You can modify this value by typing in a new one or by selecting 
the line study and dragging the leftmost handle up or down. 
End Date.  This is the date/time the line study ends.  You can modify 
this date/time by typing in a new one or by selecting the line study and 
dragging the rightmost handle left or right.  Click the "D" button to enter 
dates.  Click the "T" button to enter times. 
End Value.  This is the y-axis value at the ending point of the line study.  
You can modify this value by typing in a new one or by selecting the line 
study and dragging the rightmost handle up or down. 
Left Extension.  Check this box if you want the line study extended to 
the left before the Start Date.  Even though a line study is extended, it 
retains its original start and end dates so that the original rendering of the 
trendline can be restored (if desired).  
Right Extension.  Check this box if you want the line study extended 
to the right beyond the End Date.  Even though a line study is extended, 
it retains its original start and end dates. 
Snap to Price.  Check this box if you want the line study's ending 
points to automatically snap to the open, high, low, or close prices when 
plotting and dragging.  Line studies snap to the high price if the mouse 
pointer is above the price bar. The end points snap to the low price when 
the mouse pointer is below the price bar.  If the mouse pointer is between 
the high and low, the line study's end point snaps to either the open or 
close price depending on which one it's closest to. 

Color/Style Page 
The Color/Style page is used to modify the selected line study only.  If 
you want to change the color/style for all new line studies, use the 
Default Colors & Styles command in the Tools menu (see page 170). 
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You can also change the color and line style of the line study by using the 
color and line style toolbars (see page 25). 

 
Color.  This drop-list is used to choose the line study's color. 
Style.  This drop-list is used to choose the line study's line style. 
Weight.  This drop-list is used to choose the thickness of the line study.  
If you select a heavier weight, the Style will always appear as a solid line. 

Adjusting, Copying, Deleting, and Moving Line Studies 
Just as price plots and indicators can be moved around using drag and 
drop techniques, so can line studies.  Perhaps you want to copy a 
trendline to make parallel channels above and below the price plot.  Or 
maybe you'd like to adjust the range of the Fibonacci Retracements a bit.  
Or maybe you'd like to remove an old trendline from your chart.  This 
can easily be done using common Windows techniques (i.e., click, drag 
and drop). 
Sometimes when you are trying to click on a line study that is crowded 
among other plots,  a pop-up "ambiguity" menu appears from which you 
can select the desired line study.  See page 147 for more information. 
You can select multiple line studies for copying, moving, or deleting by 
holding down the SHIFT key as you click your left mouse button. 

Copying and Moving Line Studies 

 
Move cursor 

Copying and moving a line study involves basic drag and drop 
techniques.  The only difference between copying and moving is that you 
hold the CTRL key down when copying.  When the mouse pointer is 
positioned over a line study, the mouse pointer displays a four-sided 
arrow (i.e., the move cursor) indicating that the line study can be moved.  
A line study can be dragged to a new location anywhere within the 
current chart or a different chart. 
When a line study (or any object) is being copied, a small plus sign 
appears next to the mouse pointer while dragging. 
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When you drag a line study and drop it into an existing inner window, the 
Scaling Options dialog may appear prompting you to decide how to 
handle the scaling (see page 156). 
Copying a trendline is an excellent way to create channel lines above and 
below a price plot. 

 
You can select multiple 
plots by holding down 
the  SHIFT key as you 
click.  

A unique characteristic of line studies is that they can be copied along 
with an indicator.  For example, if you have a trendline drawn on an 
indicator, you can select both the indicator and trendline and drag them to 
a new location.   

To move (or copy) a line study  
1. Position the mouse over the line study you want to move or copy.   
2. Hold the CTRL key down (for copying only).  Click and hold the left 

mouse button and drag the line study to another location within the 
inner window. 

3. Release the mouse button. 
4. Choose the desired option from the Scaling Options dialog (see page 

156) and click OK. 

Adjusting Line Studies 
Line studies are adjusted directly on the chart by selecting the line study,  
positioning the mouse pointer over one of the square handles and 
dragging.  When the mouse pointer is positioned on a handle, a closed 
hand appears next to the mouse indicating that the line study can be 
adjusted. 
The following illustrations show how a line study is adjusted. 
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To adjust a line study  
1. Position the mouse pointer over the line study you want to adjust and 

click the left mouse button.   
2. Position the mouse pointer over one of the small square handles on 

the line study. 
3. Click and hold the left mouse button and drag the handle to another 

location.   
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4. Release the mouse button. 

Deleting Line Studies 
You can delete a line study by right-clicking on the line study and 
choosing Delete from the shortcut menu.  You can also delete a line study 
by selecting the line study and pressing the DEL key.  An option in the 
Application Properties dialog (see page 32) controls whether or not you 
are asked to confirm the deletion. 

 
If you want to quickly delete all line studies from a chart, choose Delete 
All from the Edit menu (see page 109). 

To delete a line study  
1. Position the mouse on the desired line study. 
2. Click the right mouse button. 
3. Choose Delete from the shortcut menu. 

To delete all line studies from a chart  
1. Select the chart from which you want to delete the line studies. 
2. Choose Delete All from the Edit menu.  Click the Line Studies box 

and click OK. 
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Line Study Parameters 

Andrews' Pitchfork 
The parameters for Andrews' Pitchfork are shown below.  You can edit 
the parameters of an Andrews' Pitchfork that's already plotted by right-
clicking on it and choosing Andrews' Pitchfork Properties from the 
shortcut menu. 
First Date.  This is the date/time of the first marked point. 
First Value.  This is the y-axis value of the first marked point. 
Second Date.  This is the date/time of the second marked point. 
Second Value. This is the y-axis value of the second marked point. 
Third Date. This is the date/time of the third marked point. 
Third Value. This is the y-axis value of the third marked point. 
See page 209 for information on the other controls in this page. 
For general information on line studies, see page 205.  For interpretation 
information on Andrews' Pitchfork, see page 447. 

Drawing Tips 
The Andrews' Pitchfork line study requires that you mark three separate 
points on your chart.  The first point is usually a major peak or trough on 
the left side of the chart.  The second and third points are drawn at a 
major peak and major trough to the right of the first point. 

Cycle Lines 
The parameters for Cycle Lines are shown below.  You can edit the 
parameters of Cycle Lines that are already plotted by right-clicking on 
them and choosing Cycle Lines Properties from the shortcut menu. 
Date.  This is the date/time on which the dotted "reference" line is 
drawn.  The remaining cycle lines are drawn on either side of the 
reference line at the specified spacing interval. 
Spacing.  This is the number of periods between cycle lines.  The initial 
spacing is set by positioning the mouse pointer at a starting point and 
clicking and dragging the mouse until the lines are the desired distance 
apart. 
Show Lines in All Windows.  Check this box if you want the cycle 
lines to extend vertically across all inner windows within the chart. 
For general information on line studies, see page 205.  For interpretation 
information on Cycle Lines, see page 458. 

Drawing Tips 
When drawing cycle lines, remember to click the mouse (don't release) 
and drag to control the spacing of the cycle lines.   
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Ellipse 
The parameters for an Ellipse are shown below.  You can edit the 
parameters of an Ellipse that's already plotted by right-clicking on it and 
choosing Ellipse Properties from the shortcut menu. 
Force Circular.  Check this box if you want the ellipse to maintain a 
circular shape at all times (even when resizing). 
See page 209 for information on the other controls in this page. 
For general information on line studies, see page 205.  

Equidistant Channel Trendlines 
The parameters for Equidistant Channel Trendlines are shown below.  
You can edit the parameters of Equidistant Channel Trendlines that are 
already plotted by right-clicking on them and choosing Equidistant 
Channel Trendlines Properties from the shortcut menu. 
Distance. This is the distance between the two lines, expressed as a y-
axis value. 
Up. When this box is checked, the channel appears above the line you 
draw. When the box is unchecked, the channel appears below the line 
you draw. 
Reflections. This number determines how many channels appear in 
addition to the first one you draw. 
See page 209 for information on the other controls in this page. 
For general information on line studies, see page 205.  

Fibonacci Arcs 
You can edit the parameters of a Fibonacci Arc that's already plotted by 
right-clicking on it and choosing Fibonacci Arcs Properties from the 
shortcut menu. 
See page 209 for information on the controls in this page.  For general 
information on line studies, see page 205.  For interpretation information 
on Fibonacci Arcs, see page 466. 

Drawing Tips 
Fibonacci Arcs are based on a trendline that you draw between a 
significant trough and peak.  If the trendline is rising, the arcs will point 
upward; if the trendline is falling, the arcs will point downward. 
Fibonacci Arcs are drawn to appear circular on the average screen 
regardless of the number of periods displayed.  This means the locations 
at which the arcs cross the data will vary depending on the number of 
periods displayed and the shape of the window; it also means that the 
arcs may appear oblong on some laptop computers. 
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Fibonacci Fans 
You can edit the parameters of a Fibonacci Fan that's already plotted by 
right-clicking on it and choosing Fibonacci Fans Properties from the 
shortcut menu. 
See page 209 for information on the controls in this page.  For general 
information on line studies, see page 205.  For interpretation information 
on Fibonacci Fans, see page 466. 

Drawing Tips 
Fibonacci Fans are based on a trendline that you draw between a 
significant trough and peak.  If the trendline is rising, the fan lines point 
upward; if the trendline is falling, the fan lines will point downward. 

Fibonacci Retracements 
You can edit the parameters of a Fibonacci Retracement that is already 
plotted by right-clicking on it and choosing Fibonacci Retracements 
Properties from the shortcut menu. 
See page 209 for information on the controls in this page.  For general 
information on line studies, see page 205.  For interpretation information 
on Fibonacci Retracements, see page 466. 
Show Retracement Labels.  Check this box if you want the percent 
labels to be displayed next to the retracement lines. 

Drawing Tips 
Fibonacci Retracements are based on a trendline that you draw between a 
significant trough and peak.  If the trendline is rising, the retracement 
lines will project downward; if the trendline is falling, the retracement 
lines will project upward. 
The number of Fibonacci Retracement levels appearing on the chart 
depends on the range of the y-axis.  If you want to see all nine 
retracement levels, you may need to manually adjust the minimum and  
maximum values of the y-axis (see page 124). 

Fibonacci Time Zones 
The parameters for Fibonacci Time Zones are shown below.  You can edit 
the parameters of Fibonacci Time Zones that are already plotted by right-
clicking on them and choosing Fibonacci Time Zones Properties from the 
shortcut menu. 
Date.  This is the date/time on which the dotted "reference" line is drawn.  
The remaining time zone lines are drawn to the right of the reference line 
at the predefined Fibonacci intervals. 
Show Lines in All Windows.  Check this box if you want the time 
zones to extend vertically across all inner windows within the chart. 
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For general information on line studies, see page 205.  For interpretation 
information on Fibonacci Time Zones, see page 467. 

Gann Fans, Grids, and Lines 
The parameters for Gann studies are shown below.  You can edit the 
parameters of a Gann study that is already plotted by right-clicking on it 
and choosing Properties from the shortcut menu. 
Rise.  This is the number of y-axis points to rise for every Run interval. 
Run.  This is the number of time periods to run (extend) for every Rise 
interval.  If you want a Gann Line to project to the left, enter a negative 
value. 
Snap to Integer Ratio.  Check this box if you always want the ratio of 
the Rise and Run to be an integer value (i.e., 4 x 1, 3 x 1, 1x1, etc.). 
Extend.  Check this box if you want the Gann Line to extend in both 
directions. 
For general information on line studies, see page 205.  For interpretation 
information on Gann Studies, see page 469. 

Drawing Tip 
Gann studies are anchored on the chart by clicking the left mouse button.  
When a Gann study is selected, two handles (i.e., small squares) appear 
directly on the study.  Click and drag the anchored handle to move the 
study; click and drag the other handle to change the angle. 

Horizontal Line 
The parameters for Horizontal Lines are shown below.  You can edit the 
parameters of a Horizontal Line that is already plotted by right-clicking 
on it and choosing Horizontal Line Properties from the shortcut menu. 
Value.  This is the location on the y-axis of the horizontal line. 
For general information on line studies, see page 205. 

Drawing Tip 
Look at the y-axis value on the status bar to help you position your 
horizontal line at the desired position. 

Linear Regression Trendline 
The parameters for Linear Regression are shown below.  You can edit the 
parameters of a Linear Regression line that is already plotted by right-
clicking on it and choosing Linear Regression Properties from the 
shortcut menu. 
Price Field.  This is the price field (i.e., open, high, low, or close) to use 
when calculating the Linear Regression trendline. 
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Linear Regression requires actual pricing data to plot.  When it is plotted 
on Kagi, point & figure, Three Line Break, or Renko charts, it uses all the 
data in all the columns. 
You can easily draw a parallel line next to a Linear Regression line by 
choosing Parallel Trendline from the Linear Regression shortcut menu.  
The shortcut menu is displayed by right-clicking directly on the Linear 
Regression line plotted on the chart. 
See page 209 for information on the other controls in this page.  For 
general information on line studies, see page 205.  For interpretation 
information on Linear Regression, see page 477. 
 

ODDS Probability Cones 
The parameters for the ODDS™ Probability Cones are shown below.  
You can edit the parameters of the cones that are already plotted by right-
clicking on them and choosing Properties from the shortcut menu. 
A warning appears if you attempt to plot ODDS Probability Cones on a 
tick chart.  This is because tick charts have an undeterminable number of 
periods in one year.  However, if you compress the tick chart (1-minute, 
5-minute, etc.) the cones will plot. 
Probability.  Enter the probability percentage.  The higher the 
percentage the wider the cones.  The default value is 68.26% is equal to 
one standard deviation.   Given the volatility, this means there is a 
68.26% chance that prices will remain within the cones. 
Use Historic Volatility.  Choose this button if you want MetaStock Pro 
to calculate the volatility over the number of periods specified in the box 
to the right.  The calculation is based on the Bookstaber method--the same 
formula used by the Option Volatility indicator (see page 496).  Note that 
the width of the cones will fluctuate (due to changing volatility) if you 
choose this method and you drag the cones around the chart.   
You also can change the number of periods used in the calculation of the 
historic volatility directly on the chart by selecting the Probability Cones 
and then dragging the handles on the horizontal line protruding from the 
left of the cone's apex. 
Use Specific Volatility.  Choose this button if you want MetaStock Pro 
to used a fixed volatility as specified in the box to the right.  Note that the 
width of the cones will remain constant if you choose this method and you 
drag the cones around the chart. 
See page 209 for information on the controls in this page.  For general 
information on line studies, see page 205.  For interpretation information 
on ODDS Probability Cones, see page 491.   
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Quadrant Lines 
You can edit the parameters of a Quadrant Line that is already plotted by 
right-clicking on it and choosing Quadrant Lines Properties. 
Quadrant Lines require actual pricing data to plot.  When it is plotted on 
Kagi, Point & Figure, Three Line Break, or Renko charts, it uses all the 
data in all the columns. 
See page 209 for information on the controls in this page.  See page 205 
for information on the Select Plot dialog.  For general information on line 
studies, see page 205.  For interpretation information on Quadrant Lines, 
see page 506. 

Raff Regression Channels 
The parameters for Raff Regression Channels are shown below.  You can 
edit the parameters of Raff Regression Channels that are already plotted 
by right-clicking on them and choosing Properties from the shortcut 
menu. 
You can easily draw a parallel line next to a Raff Regression Channel by 
choosing Parallel Trendline from the Raff Regression Channel shortcut 
menu.  The shortcut menu is displayed by right-clicking directly on the 
Raff Regression Channel plotted on the chart. 
Price Field.  This is the price field (i.e., open, high, low, or close) to use 
when calculating the Raff Regression Channels.   
Raff Regression Channels require actual pricing data to plot.  When it is 
plotted on kagi, point & figure, three line break, or renko charts, it uses 
all the data in all the columns. 
See page 205 for information on the Select Plot dialog.  See page 209 for 
information on the other controls in this page.  For general information 
on line studies, see page 205.  For interpretation information on Raff 
Regression Channels, see page 508. 

Rectangle 
You can edit the parameters of a Rectangle that is already plotted by 
right-clicking on it and choosing Rectangle Properties from the shortcut 
menu. 
See page 209 for information on the controls in this page.  For general 
information on line studies, see page 205. 

Speed Resistance Lines 
You can edit the parameters of Speed Resistance Lines that are already 
plotted by right-clicking on them and choosing Speed Resistance Lines 
Properties from the shortcut menu. 
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See page 209 for information on the controls in this page.  For general 
information on line studies, see page 205.  For interpretation information 
on Speed Resistance Lines, see page 515. 

Standard Deviation Channel 
The parameters for the Standard Deviation Channel are shown below.  
You can edit the parameters of Standard Deviation Channels that are 
already plotted by right-clicking on them and choosing Properties from 
the shortcut menu. 
You can easily draw a parallel line next to a Standard Deviation Channel 
by choosing Parallel Trendline from the shortcut menu.  The shortcut 
menu is displayed by right-clicking directly on the Standard Deviation 
Channel plotted on the chart. 
Price Field.  This is the price field (i.e., open, high, low, or close) to use 
when calculating the Standard Deviation Channels.  
Units.  Enter the number of standard deviations to shift the upper and 
lower channel lines. 
Standard Deviation Channels require actual pricing data to plot.  When it 
is plotted on kagi, point & figure, three line break, or renko charts, it uses 
all the data in all the columns. 
See page 205 for information on the Select Plot dialog.  See page 209 for 
information on the other controls in this page.  For general information on 
line studies, see page 205.  For interpretation information on Standard 
Deviation Channels, see page 517. 

Standard Error Channel 
The parameters for the Standard Error Channel are shown below.  You 
can edit the parameters of Standard Error Channels that are already 
plotted by right-clicking on them and choosing Properties from the 
shortcut menu. 
You can easily draw a parallel line next to a Standard Error Channel by 
choosing Parallel Trendline from the shortcut menu.  The shortcut menu 
is displayed by right-clicking directly on the Standard Error Channel 
plotted on the chart. 
Price Field.  This is the price field (i.e., open, high, low, or close) to use 
when calculating the Standard Error Channels.  
Units.  Enter the number of standard errors to shift the upper and lower 
channel lines. 
Standard Error Channels require actual pricing data to plot.  When it is 
plotted on kagi, point & figure, three line break, or renko charts, it uses all 
the data in all the columns. 
See page 205 for information on the Select Plot dialog.  See page 209 for 
information on the other controls in this page.  For general information on 
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line studies, see page 205.  For interpretation information on Standard 
Error Channels, see page 520. 

Symbols 
The Symbols Properties dialogs contains two pages--one for controlling 
the size and color of the symbol, the other for specifying a label to attach 
to the symbol. 
For general information on line studies, see page 205. 

To stamp a symbol on a chart  
1. Choose Symbols from the Insert menu or text toolbar. 
2. Click a symbol from the Symbol palette. 
3. Position the mouse pointer where you want the symbol to appear on 

the chart. 
4. Click the mouse to stamp the symbol on the chart. 

To remove the symbol palette from the screen  
Click the Close button in the upper-right corner of the palette. 

Symbol Page 
The Symbol page is located in the Symbol Properties dialog.  This dialog 
is displayed by right-clicking on a symbol and choosing Symbol 
Properties from the shortcut menu. 
Color.  Choose the color for the symbol.  You can choose the default 
color for all new symbols from the Line Studies page of the Default 
Colors and Styles dialog (see page 170). 
Size.  Choose the size (i.e., small, medium, or large) for the symbol.  You 
can choose the default size for all new symbols from the Text/Symbols 
page of the Default Colors and Styles dialog (see page 170). 

Label Page 
The Label attached to a Symbol and the Symbol itself make up one 
object.  So to edit a Symbol's label, you should right click on the Symbol, 
choose Symbol Properties from the shortcut menu, and choose the Label 
tab. 
Label.  Type the text to attach to the symbol.   
Position.  Choose whether you want the label to appear above or below 
the symbol.  
Font.  This button displays the font dialog where you can change the font 
style of the label.  See page 171 for more information on fonts.  

Deleting All Symbols 
You can quickly delete all symbols (and arrows) from a chart by choosing 
Delete All from the Edit menu.  If you have enabled the "Confirm 
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Deletion of Objects" option in the Application Options dialog (see page 
32), you will be asked to confirm the deletion. 

Drawing Tip 
The default size of new symbols is controlled from the Default Colors and 
Styles dialog (see page 170). 

Text 
The parameters for Text are shown below.  You can edit the Text 
parameters by right-clicking on the text and choosing Text Properties 
from the shortcut menu. 
Text.  Use this box to edit the text. 
Font.  This button displays the font dialog where you can change the font 
style of the text.  See page 171 for more information on fonts. 
Anchor to Date.  Check this box if you want the text to stay at the 
specified x-axis position.  If it is unchecked the text remains at the relative 
screen position.  For example, if the text was positioned at the center of 
the chart, it remains at the center of the chart regardless of any scrolling, 
resizing, etc. 
Choose the Frame/Fill page to control the fill color of the boxed area 
around the text or to change the color, style, and weight of the frame 
around the text. 
For general information on line studies, see page 205. 

To write text on a chart  
1. Choose Text from the Insert menu or text toolbar. 
2. Position the mouse pointer where you want the text to appear on the 

chart. 
3. Click the mouse to display the text box and cursor.  Begin typing.  

You can press ENTER to write multiple lines. 
4. Click the mouse outside the text box (or press CTRL+ENTER) to end 

the writing and anchor the text. 

Drawing Tip 
The initial default font is controlled from the Default Color and Styles 
dialog (see page 170). 

Tirone Levels 
The parameters for Tirone Levels are shown below.  You can edit the 
parameters of Tirone Levels that are already plotted by right-clicking on 
them and choosing Tirone Levels Properties from the shortcut menu. 
Midpoint or Mean.  Choose the calculation method for the Tirone 
Levels.  The Midpoint method displays three lines that divide the highest 
high and lowest low of the range into symmetrical segments.  The Mean 
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method displays five lines ranging between the extreme high and lows and 
the adjusted mean price. 
Tirone Levels require actual pricing data to plot.  When it is plotted on 
kagi, point & figure, three line break, or renko charts, it uses all the data 
in all the columns. 
See page 209 for information on the other controls in this page.  See page 
205 for information on the Select Plot dialog.  For general information on 
line studies, see page 205.  For interpretation information on Tirone 
Levels, see page 528. 

Drawing Tip 
When using the Mean method, it is common for the extreme high and/or 
the extreme low to be so extreme that they do not display with the current 
scale.  Before displaying Mean Tirone Levels, you may want to change 
the y-axis scaling (see page 123)  so that all of the Tirone Levels are 
visible. 

Trendline 
You can edit the parameters of a Trendline that is already plotted by right-
clicking on it and choosing Trendline Properties from the shortcut menu. 
See page 209 for information on the controls in this page. 
For general information on line studies, see page 205.  For interpretation 
information on trendlines, see page 529. 

Trendline By Angle 
The parameters for Trendline By Angle are shown below.  You can edit 
the parameters of a Trendline By Angle that is already plotted by right-
clicking on it and choosing Trendline By Angle Properties from the 
shortcut menu. 
Angle.  This is the angle (in degrees) of the trendline. 
See page 209 for information on the other controls in this page.  For 
general information on line studies, see page 205.  For interpretation 
information on trendlines, see page 529. 

Drawing Tip 
When using the Trendline by Angle line study, the angle of the trendline 
is shown and continually updated on the status bar (see page 27). 

Triangle 
The parameters for a Triangle are shown below.  The Triangle line study 
requires that you mark three separate points on your chart.  You can edit 
the parameters of an Triangle that's already plotted by right-clicking on it 
and choosing Triangle Properties from the shortcut menu. 
First Date.  This is the date/time of the first marked point. 
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First Value.  This is the y-axis value of the first marked point. 
Second Date.  This is the date/time of the second marked point. 
Second Value. This is the y-axis value of the second marked point. 
Third Date. This is the date/time of the third marked point. 
Third Value. This is the y-axis value of the third marked point. 
For general information on line studies, see page 205. 

Vertical Line 
The parameters for Vertical Lines are shown below.  You can edit the 
parameters of a Vertical Line that is already plotted by right-clicking on it 
and choosing Vertical Line Properties from the shortcut menu. 
Date.  This is the date/time on which the vertical line is drawn. 
Show In All Windows.  Check this box if you want the vertical line to 
extend across all inner windows in the chart. 
For general information on line studies, see page 205. 

Drawing Tips 
Look at the date on the status bar to help you position your vertical line at 
the desired position. 
The inner window in which the vertical line is displayed is determined by 
where the vertical line was dropped (i.e., the inner window the mouse 
pointer was in). 
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Working with the Internet 

Internet Integration 
The Internet can be a useful source of information, if you know where to 
look.  MetaStock Pro is seamlessly integrated with the Internet, providing 
instant access to many exclusive resources that help you make more 
informed trading decisions.   
Some of the many things you can do with MetaStock Pro and the Internet 
are: 
• Collect data from an online data vendor using DataOnDemand™ 
• Collect local data from an end-of-day vendor 
• E-mail a bitmap graphic of a chart directly from MetaStock Pro 
• Save the active chart as an HTML document 
• Request a current intraday quote for the active chart 
• Read current company news for the active chart 
• Research fundamental information for the active chart 
• Display option chains for the active chart 
• Launch the Equis International home page 
• Learn about technical analysis with the online version of Technical 

Analysis from A to Z 
• Find a MetaStock user group in your area 
• Get help from Equis technical support 
• Update MetaStock Pro automatically. 
…and more. 
Many of these Internet resources are accessed from your chart's shortcut 
menu.  To access information relevant to your current chart, right-click 
the background of the chart.  Sharing your charts with others through e-
mail or HTML is done through the File menu.  Other Internet resources 
are available by choosing Equis on the Web from the Help menu. 
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Collecting Data through the Internet 
Collecting price data is quick and easy with the Internet.  Some data 
vendors compatible with The DownLoader (see page 58) can be accessed 
through the Internet which provides a faster download with fewer errors.  
Check your DownLoader User's Manual to see if your data vendor 
provides Internet collection. 
The fastest way to view a chart is with DataOnDemand™.  You just type 
or select a symbol and the data flows instantly from your data vendor to 
your chart.  MetaStock Pro typically goes through the Internet to your 
online data vendor to get the data.   See page 42 for more information on 
DataOnDemand™. 

Updating MetaStock Pro 
Updating MetaStock Pro with the latest patches and Symbol Database 
files is easy with the Internet.  Simply choose Update Symbol Database 
or MetaStock Updates from the Tools menu. 
See page 49 for more information on updating the Symbol Database. 

E-mailing Charts with the Send Command 
You can use the Send command in the File menu to send charts via e-
mail.  You must have one of the following e-mail systems to use this 
feature: 
• MAPI.  Microsoft Exchange (or other mail systems compatible with 

the Messaging Application Programming Interface). 
• VIM. Lotus cc:Mail (or other mail system compatible with Vendor 

Independent Messaging). 

To send a chart via e-mail  
1. Open the chart you want to send.  Make sure it is the selected chart. 
2. At this point, you may want to add text or analysis. 
3. Choose Send from the File menu. 
Your MAPI or VIM compatible e-mail software will run.  A bitmap file 
of the MetaStock Pro chart will automatically be inserted into a new 
message. 

Saving Charts as HTML 
Documents published on the World Wide Web and those on corporate 
intranets are usually written in a special scripting language called 
Hypertext Markup Language (HTML).  MetaStock Pro allows you to 
create a simple HTML file containing a chart and data that is readable by 
web browser software.   
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When a chart is saved as HTML, two files are created —an HTML file 
containing the data, and a graphical image of the chart.  The image can be 
saved in either JPEG, which is more widely supported, or PNG format, 
which is smaller.   The data is the same data that would be displayed in 
MetaStock Pro's Data Window (see page 158) for the last day (or column) 
on the chart. 
You can view an HTML file by opening it in a web browser such as 
Microsoft Internet Explorer or Netscape Navigator. 

To save a chart as an HTML file  
1. Choose Save As HTML from the File menu. 
2. Type a name for the HTML file in the File name box.  All HTML 

files are automatically assigned an HTM extension.  Be sure to save 
the file in a folder you will remember. 

3. Choose the graphic format that you prefer. 
4. Click the Save button. 

Internet Shortcut Menus 
Equis International has arranged exclusive Internet access to current 
quotes, news, options data, financial statements, insider trading, and more 
for MetaStock Pro users.  This free information is "chart-centric"—
meaning that if you right-click on your chart of "Intel," choose 
"Research," and click "Company News" from the shortcut menu, news on 
Intel will be retrieved.  Of course, to take advantage of this feature, the 
computer on which you installed MetaStock Pro must be connected to the 
Internet. 
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The Internet functionality built into MetaStock Pro is designed to be 
flexible enough that you can easily update MetaStock Pro to add new 
Internet-specific features as they become available from Equis.  
The choices that appear in the Internet shortcut menus are controlled by a 
file named  "ms80menu.dta".  This file is located in your MetaStock 
program folder.  The latest version of this file can be downloaded from 
the Equis web site at www.equis.com.  We encourage you to check the 
web site periodically for the availability of a new version of  the 
"ms80menu.dta" file. 
When you choose one of the Internet features from the shortcut menu, 
MetaStock Pro automatically launches your default web browser software  
(e.g., Netscape Navigator, Microsoft Internet Explorer) and displays the 
web page containing the information. 

The Quotes Menu 
Current quotes and Option Chains are available from the Quotes menu. 
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Current price data for the active chart is displayed by choosing Current 
Quote from the Quotes shortcut menu.  

 
The prices shown are based on a 20-minute delayed intraday price quote.  
To view company news for this security, you may choose the News link 
from this page. 
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A list of the put or call options available for the current chart can be 
displayed by choosing Option Chain from the Quotes shortcut menu.  This 
information is provided by Reuters, and is a MetaStock Pro exclusive. 

 

The Research Menu 
News and fundamental data are available from the Research menu. 

 
Current company news for the active chart is displayed by choosing 
Company News from the Research menu.    Click on a headline to view 
the news story. 
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Free Broker Recommendations and Research and a variety of 
fundamental data is also available, including Financial Highlights, 
Financial Statements, Insider Trading, Institutional Ownership, 
Performance/Short Interest, and Ratio Comparison. 
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Equis on the Web 
The information on the Equis International web site is available with just  
a few mouse clicks in MetaStock Pro.  Choose Equis on the Web from the 
Help menu. 

 
Select Equis Home Page from the Equis on the Web menu to launch the 
main Equis International web site.   
Choose Technical Analysis from A to Z to read the online version of this  
book by the founder of Equis, Steve Achelis. 
Choose Free Investment Services to view a list of free resources available 
at www.equis.com. 
Choose Investment Products from the Equis on the Web menu to learn 
more about the family of products available from Equis International. 
Choose Equis Customer Resources to find a MetaStock Users Group in 
your area, check the Equis Events calendar for investment-related events 
in your area, read the quarterly Equis newsletter, find other investment-
related web sites, or locate MetaStock-compatible data vendors. 
Choose Latest Files to view a list of the free downloads and patches 
available for Equis products. 
The Equis Technical Support staff is available through the Internet.  
Choose Technical Support from the Equis on the Web menu. 
Select Reuters Money Network to launch the Reuters MoneyNet web site 
where you can manage your portfolio, read category and market news,  
view quotes and charts, and more. 
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The MetaStock Formula Language 

What is the MetaStock Formula Language? 
The MetaStock formula language is a special programming language used 
to define and create custom indicators, system tests, explorations, and 
experts.  It is patterned after popular spreadsheet languages.   
In its simplest form, the MetaStock formula language is comprised of 
high-level functions (e.g., mov(), rsi(), abs() ), mathematical operators 
(e.g., +, -, /, *), and parameters (open, high, low, close, etc.).  Each of 
these basic components can be combined to create your own indicators 
with the Indicator Builder, backtest your trading ideas with the System 
Tester, rank and filter your securities with The Explorer, and generate 
chart-specific feedback with the Expert Advisor. 
In order to effectively use the Indicator Builder, System Tester, Explorer, 
or Expert Advisor, you need to be familiar with the MetaStock formula 
language.  The MetaStock formula language is the foundation and 
common link for each of these four tools. 
 
Custom  
Indicators 

System  
Tests 

Explorations Experts 

   MetaStock Formula Language 

 
The Indicator Builder will be used in this chapter to teach the MetaStock 
formula language.   For specific tutorials on each of the four formula-
based tools, refer to their specific chapters. 
For information on the Equis Solution Provider program and the 
MetaStock developers Kit, go to www.equis.com. 

Price Array Identifiers 
One of the most basic building blocks of a formula is called a price array 
identifier.  A price array identifier "identifies" specific price fields that the 
formula should operate on.  The valid price array identifiers are open, 
high, low, close, volume, open interest, and indicator. 
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Price array identifiers can be abbreviated as shown in the following table.  
Note that these are not case-specific. 
 

Long Name Abbreviation 
Open O 

High H 

Low L 

Close C 

Volume V 

Open Interest OI 

Indicator P 

Previous Value PREV 

 
Examples of the use of price array identifiers in formulas are shown 
below.  The actual price array identifier component of the formulas are in 
bold for these examples. 
mov( close,10, simple ) 
 
if (h > ref(h,-1), mov(h,20,s), mov(c,20,s) ) 
 
stdev( volume, 20 ) 

Mathematical Operators 
Mathematical operators are the "glue" that binds formulas.  Formulas can 
contain the following mathematical operators.  (They also can contain 
advanced operators such as square root, as explained later.) 
 + Addition 
 - Subtraction (or negative) 
 * Multiplication 
 / Division 
The following formulas illustrate the use of operators (bolded) in a 
formula: 
( H + L ) / 2 
 
mov(c,10,s)-mov(c,20,s) / (h + l + c) 
 
close + ((1.02 * high)-high) 

Operator Precedence 
Parentheses were used in many of the preceding formulas in this chapter to 
control the operation precedence (the order in which the operators are  
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calculated).  MetaStock Pro always does operations within the innermost 
parentheses first. 
When parentheses are not used, the precedence is as follows: 
- Negative values 
* Multiplication 
/ Division 
+ Addition 
- Subtraction 
< Less than 
> Greater than 
<= Less than or equal to 
>= Greater than or equal to 
= Equal to 
<> Not equal to 
And Logical "And" 
Or Logical "Or" 
:= Variable assignment operator 
The expression "H + L / 2" (without parenthesis) would be calculated by 
MetaStock Pro as "L / 2" plus "H," since division has a higher 
precedence.  This would result in a much different value than "(H + L) / 
2." 
For ease of reading, we recommend that you always use parenthesis to 
control precedence. 

Formula Functions 
In addition to the four mathematical operators, MetaStock Pro contains 
over 200 "functions" that perform mathematical operations.  See page 252 
for a complete listing of all built-in functions. 
The following formula consists of a single function that plots the square 
roots of the closing prices. The names of the actual functions in the 
following examples are in bold. 
sqrt( CLOSE ) 

The following formula consists of a single function that plots a 14-period 
RSI indicator. 
rsi(14) 

The following formula consists of a single function that plots a 10-period 
simple moving average. 
mov(c,10,s) 

The following formula consists of two functions.  The result is the 
difference between the MACD indicator and a 9-period exponential 
moving average of the MACD. 
macd()- mov(macd(),9,exponential) 
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As you've probably noticed, this syntax is very similar to the syntax used 
to enter formulas in spreadsheets. 
All functions must be followed by a pair of parentheses.  If an opening 
parenthesis is not the first character after a function name, an error 
message will be displayed. 

Function Parameters 
Parameters provide a function the necessary information required to 
calculate.  For example, the sqrt() function requires a single "parameter" 
within the parentheses.  Other functions, such as macd(), do not require 
any parameters.  Others, like the Volume Oscillator require four 
parameters.  
The following formula calculates a 14-period Money Flow Index.  The 
actual parameters are in bold in the following examples. 
mfi(14) 

Some functions require multiple parameters within the parentheses.  For 
example, the moving average function (shown below) requires three 
parameters. 
mov(rsi(14),30,simple) 

In the above formula, the parameters instruct MetaStock Pro to calculate 
a 30-period simple moving average of a 14-period RSI.  Note that 
another function (i.e., rsi(14) ) serves as one of the parameters. 
If you forget to insert the proper parameter, MetaStock Pro will display a 
window reminding you of the expected parameter. 

Locating Errors in Formulas 
MetaStock Pro does an excellent job of reporting errors in formulas.  In 
fact, it is impossible to enter an invalid formula.  This doesn't mean your 
formulas will always work as you expect them to, because MetaStock Pro 
does not know what you are trying to create.  However, it does mean that 
the syntax of the formula (e.g., function names, parameters, operators, 
parentheses, etc.) will always be valid. 
When you enter a formula, MetaStock Pro tests the formula's syntax.  If 
an error is found, the formula will be redisplayed, the cursor will be 
positioned at the error location, and a message explaining the error will 
be displayed. 
The effect of this error-reporting technique is that MetaStock Pro helps 
you enter valid formulas.  This is illustrated in the following example. 
Suppose you want to plot a formula containing a 10-period exponential 
moving average of the closing price and all you can remember is that the 
moving average function is "mov" (see page 305 if you don't remember a 
function name). 
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1. Enter what you do know in the Formula box of the Indicator Editor 
dialog: 
 
mov 
 
and click the OK button. 
 
The cursor will be positioned after the "mov" function name and the 
message "A '(' must immediately follow a function name" will be 
displayed.   

2. Now add an opening parenthesis 
 
mov( 
 
and click OK.  
 
This time, the cursor will be positioned after the "(" and the message 
"Price array (e.g., HIGH, LOW, CLOSE, etc.) or function expected" 
will be displayed.   

3. Enter the price array identifier "CLOSE."  
 
mov(CLOSE 
 
and click OK. 

If you continue this process (i.e., enter partial formulas and then respond 
to the error message), MetaStock Pro will prompt you through the 
formula entry process until the formula's syntax is correct (shown below). 
mov(CLOSE,10,EXPONENTIAL) 
This is a valuable technique!  Any time you are not sure of the syntax of a 
formula or function, click OK. 

Inserting Functions 
The preceding section explained how MetaStock Pro helps you correct 
syntax errors within formulas.  This section explains how MetaStock Pro 
can help you remember (and enter) the 200+ functions. 
Clicking the Functions button while editing a formula displays the Paste 
Functions dialog.  This dialog lists the categories of the available  
functions on the left-hand side and the function names within the category 
on the right-hand side. 
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Exploring the Paste 
Functions dialog is an 
excellent way to learn 
more about formulas. 

Clicking OK when the Paste Functions dialog is displayed will insert the 
function that is currently highlighted into your formula (at the location of 
the cursor).  The function can be inserted with a description of the 
required arguments (if required) by checking the Paste Arguments 
checkbox.  The list on the right side of the dialog can display the actual 
function names or the English names of the functions by 
checking/unchecking the Show English Names checkbox. 
See page 305 for more information on pasting functions into formulas. 

Writing Comments 
When writing long, complex formulas, it is helpful to make comments 
throughout the formula to describe what is going on.   Experienced 
programmers will attest to the fact that the prudent use of comments 
makes programming code much easier to debug and work with.   
Comments can be entered in a formula by surrounding them with "{" and 
"}" braces.  The following formula contains two comments (shown in 
bold). 
macd() {the MACD times} * ((H+L+C) / 3) {the 
average price} 
Note that comments within comments will cause an error message to be 
displayed. 

Nesting Functions 
As has been eluded to in earlier examples, a function can be "nested" 
within a function.  The nested function can serve as the main function's 
data array parameter.  The following examples show functions nested 
within functions.  The nested functions are in bold. 
stdev( stoch(5,3), 10 ) 
mov( rsi(15), 10, SIMPLE) 
mov( mov( rsi(15), 20, W), 10, SIMPLE) 
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The first example calculates a stochastic oscillator and then calculates a 
10-period standard deviation of the stochastic oscillator. 
The second example calculates a 10-period simple moving average of a 
15-period Relative Strength Index (RSI). 
The third example calculates a 20-period weighted moving average of a 
15-period RSI, and then calculates a 10-period simple moving average of 
this moving average. 
This technique (placing functions within functions) is referred to as the 
"nesting of functions." 

The if() function 
The if() function is used to create conditional (i.e., "if-then") statements.  
It is perhaps the most used function in the MetaStock formula language.  
It contains three parameters as shown in the following example. 
if( close > mov(c,10,s), rsi(9), rsi(14) ) 

The above "if" statement reads (in English) as follows:  If today's close is 
greater than today's 10-day simple moving average of the close, then plot 
a 9-day RSI, otherwise, plot a 14-day RSI. 
The next formula plots “positive volume” if the close is greater than the 
median price.  Otherwise, "negative volume" is plotted. 
if( CLOSE > (HIGH+LOW)/2, +V, -V ) 
A good example of the if() function can be found in the On Balance 
Volume example (see page 310). 
If you simply want an expression to be evaluated as either true or false, it 
can be done without the use of the if() function.  The following formula 
will result in either a 1 (true) or a 0 (false). 
rsi(14) > 70 

 
If the 14-period RSI is greater than 70, then this formula will evaluate to 
"true" and return the number 1.  If it is below 70, the formula will 
evaluate to "false" and return the number 0.  This is done without the if() 
function being used.  The formula below uses the if() function and will 
return the same results, but it is longer. 
if(rsi(14) > 70, 1, 0 ) 

Using "And" and "Or" Operators 
If a formula requires multiple conditions, you can combine the conditions 
with "and" and "or" operators.  For example, maybe you'd like to plot a  
+1 when the MACD is greater than zero and the RSI is greater than 70.  
The formula could be written two ways: 
macd() > 0 AND rsi(14) > 70 

or  
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if(macd() > 0 and rsi(14) > 70, +1, 0) 

You can add as many conditions within a formula as space allows.  For 
example: 
If(macd() > 0 AND rsi(14) > 70 AND CCI(14) > 100 AND 
close > mov(close,10,e), +1, 0) 
You can even combine AND and OR operators within the same formula 
as follows: 
If((macd() > 0 OR close > mov(close,10,e)) AND rsi(14) 
> 70, +1, 0) 
The formula above says to plot a "+1" if either the MACD is greater than 
zero or the close is above its moving average, and the RSI is greater than 
70.  
Note that parentheses were placed around the OR condition because 
precedence specifies that the AND condition be evaluated first (see page 
236).  If the parentheses were not placed around the OR condition, the 
moving average and the RSI would have been grouped together with the 
AND condition, which is not how we want the formula evaluated. 
 

Referencing Existing Custom Indicators 
You can reference other custom indicators using the fml() function.  For 
example, the function "fml( "My MACD")" is the value of the formula 
that contains the text "My MACD" in its name.  The entire name is not 
required--only enough of the name to make it unique.  However, 
preference is given to the formula name that exactly matches.  So if 
another formula named "MyMACD2" existed, "MyMACD" would be 
used since it matches exactly. 
The following formula plots the value of the formula named "Down Day" 
if the close is less-than-or-equal-to a 10-period exponential moving 
average of the closing prices.  Otherwise, it plots the value of the formula 
named "Up Day." 
if( close <= mov(close, 10, E), fml("Down Day"), 
fml("Up Day") ) 
This technique (referencing formulas from within formulas) is referred to 
as the "nesting of formulas."  Using nested formulas is an excellent way 
to simplify long and/or complex formulas. 
Also note, that nested formulas may reference nested formulas that 
reference nested formulas (etc.).  However, circular references (e.g., 
formula "My MACD" calls formula "My RSI" that calls formula "My 
MACD") will cause an error message to be displayed when the formula is 
plotted. 
If a multiplot formula is referenced, only the value of  last plot in the 
multiplot formula is returned.   
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If you need to reference the value of a specific variable in a custom 
indicator rather than the value of the custom indicator itself, use the 
fmlvar() function (see page 246). 

Referencing Securities with the Security Data Function 
The Security Data function allows a formula to access price data for any 
online or local security.  This function can be used in any of MetaStock 
Pro's formula tools. 
Online securities are referenced by including "ONLINE:" before the 
symbol.  Local securities are referenced by including the full path to the 
security file.  If the security exists in the same folder as the base security, 
the path does not need to be included.  The symbol, including the path or 
online reference, is enclosed in quotation marks. 
To reference Microsoft's close as an online security: 
Security("ONLINE:MSFT",C) 

To reference Microsoft's close as a local security using the full path: 
Security("C:\Metastock Data\Sample\MSFT",C) 
To reference Microsoft's close as a local security in the same folder as the 
base security: 
Security("MSFT",C) 
The last type of reference is particularly useful if you use local data 
exclusively, and store all of your securities in the same local data folder. 
For example, the following indicator displays a 30-day moving average 
of Microsoft's close on any chart, if your online data vendor is active. 
Mov(Security("ONLINE:MSFT",C),30,S) 

The same formula could be written as: 
Security("ONLINE:MSFT",Mov(C,30,S)) 

Performance Tips 
• Use Tick or 1-minute data for optimum results when plotting an 

indicator on a chart which references online intraday securities.  
Intervals higher than 1-minute must be compressed before the 
indicator can be recalculated, which slows calculation time. 

• The Live Bars option found on the Real-time page of Application 
Properties (see page 36) causes all indicators on a chart to recalculate 
with each incoming tick.  The Security Data function is particularly 
slow when this option is enabled.  Disabling this option will cause all 
indicators, including the Security Data function, to recalculate only 
when the full bar has been completed. 

• Retrieving data from an online source is slower than referencing data 
in a local data file.  Any formula using the Security Data function to  
 



 

 
 

244 • The MetaStock Formula Language MetaStock Professional 

 

 

 

access online data will take longer to calculate than when accessing 
only local data. 

Using Variables to Enhance and Simplify 
In order to shorten, simplify, enhance, and make the maintenance of 
complex formulas easier, you may want to use variables.  A variable is an 
alphanumeric name (up to 20 characters) that is assigned to an expression 
or a single value.  Up to 20 variables can be used in a formula.  Variables 
must be assigned before the variable is used in the formula.   A semi-
colon must be used at the end of the variable assignment line.  Variables 
cannot be assigned within a function. 

Naming of Variables 
The following rules apply to the naming of variables: 
• Variable names cannot contain commas, parenthesis, spaces, 

underscores, etc.  
• Variable names cannot duplicate names already used by functions 

(e.g., mov, rsi, cci, if, etc.).   
• A variable cannot be assigned a name that matches the parameters 

reserved for use in formulas (e.g., open, high, low, close, simple, o, c, 
l, h, s, e, w, etc.).   
 
The following would produce an error, since the letter "s" is reserved 
for the moving average function, mov(), to mean "simple." 
 
s:= (h+l+c)/3; 

• Variable names must contain at least one alpha letter (e.g., T1234). 
• Variable names are not case sensitive (e.g., "PERIODS" is the same 

as "periods"). 

Using Variables to Represent Numbers 
Suppose you would like to be able to quickly adjust the time periods 
throughout a formula without having to edit each use of the time periods 
individually.   This could be accomplished by assigning the time periods 
to a variable—in this case, a variable named "periods". 
periods := 10; 
c > mov(c,periods, s) and ref(c,-1) > 
ref(mov(c,periods,s),-1) and h > mov(h,periods,s) and 
ref(h,-1) > ref(mov(h,periods,s),-1) 

In the above formula, the number "10" will be substituted wherever the 
variable named "periods" appears in the formula.  When you want to 
adjust the time periods in this formula, simply edit the number assigned to 
the "periods" variable.   If you change "10" to "20," the number "20" will 
be substituted throughout the formula.  
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Of course, you could also assign multiple variables to represent multiple 
numbers as follows: 
periods1 := 10; 
periods2 := 20; 
c > mov(c,periods1, s) and ref(c,-1) > 
ref(mov(c,periods1,s),-1) and h > mov(h,periods2,s) 
and ref(h,-1) > ref(mov(h,periods2,s),-1) 

 

In this case, the variables "periods1" and "periods2" represent two 
different values that can be used as many times as desired throughout the 
formula. 

Using Variables to Represent Mathematical 
Expressions 
Variables can be assigned to represent a mathematical expression (i.e., 
formula).   Perhaps this is the most useful benefit of variables.  Assigning 
variables to represent formulas (especially long, complex ones) makes 
formulas easier to read, easier to modify, and faster to calculate. 
For example, the following formula (designed to spot securities locked 
between support and resistance levels), is quite complex and difficult to 
read.  It can be simplified by using variables.  It was originally written 
before variable support was added to MetaStock's formula language. 
(If(Abs((Trough(1,L,1)-
Trough(2,L,1))/Trough(2,L,1))<.015 AND 
Abs((Trough(2,L,1)-
Trough(3,L,1))/Trough(3,L,1))<.015,{then} 
(Trough(1,L,1)+Trough(2,L,1)+Trough(3,L,1))/3,0))<>0  
and  
(If(Abs((Peak(1,H,1)-Peak(2,H,1))/Peak(2,H,1))<.015 
AND Abs((Peak(2,H,1)-
Peak(3,H,1))/Peak(3,H,1))<.015,{then} 
(Peak(1,H,1)+Peak(2,H,1)+Peak(3,H,1))/3,0))<>0  
and  
c>=(If(Abs((Trough(1,L,1)-
Trough(2,L,1))/Trough(2,L,1))<.015 AND 
Abs((Trough(2,L,1)-
trough(3,L,1))/Trough(3,L,1))<.015,{then} 
(Trough(1,L,1)+Trough(2,L,1)+Trough(3,L,1))/3,0)) and  
c<=(If(Abs((Peak(1,H,1)-Peak(2,H,1))/Peak(2,H,1))<.015 
AND Abs((Peak(2,H,1)-
Peak(3,H,1))/Peak(3,H,1))<.015,{then} 
(Peak(1,H,1)+Peak(2,H,1)+Peak(3,H,1))/3,0) 

By defining two variables (in bold) to represent the two expressions that 
are used repeatedly, you can simplify the formula substantially.  In 
addition to being easier to read, the simplified formula also calculates 
quicker since the support and resistance expressions now only need to 
calculate once. 
 
Support:= (If(Abs((Trough(1,L,1)-
trough(2,L,1))/Trough(2,L,1))<.015 AND 
Abs((Trough(2,L,1)-
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trough(3,L,1))/Trough(3,L,1))<.015,{then} 
(Trough(1,L,1)+Trough(2,L,1)+Trough(3,L,1))/3,0)); 

 

Resistance:= (If(Abs((Peak(1,H,1)-
Peak(2,H,1))/Peak(2,H,1))<.015 AND Abs((Peak(2,H,1)-
Peak(3,H,1))/Peak(3,H,1))<.015, 
{then}(Peak(1,H,1)+Peak(2,H,1)+Peak(3,H,1))/3,0)); 

Support <> 0 and Resistance <> 0 and close >= Support 
and close <= Resistance 

 

Note that you could also create individual custom indicators named 
"support" and "resistance" to do the calculations.  (See page 242 for more 
information on using the fml() function.)   These custom indicators could 
then be called using the fml() function as follows: 
fml("support") <> 0 and fml("resistance") <> 0  and 
close >= fml("support") and close <= fml("resistance") 

However, using variables is generally more desirable than using the fml() 
function for several reasons—the most important being calculation speed 
and self-containment (i.e., the entire function can be read and edited in 
one place). 

Referencing Variables within Custom Indicators 
Since custom indicators can contain variables, you can reference a 
specific variable within a custom indicator rather than the entire custom 
indicator.  The fmlvar() function is used to do this.  
For example, if the custom indicator named "MyMACD" contains a 
variable named "SignalLine," and you only want to reference the 
SignalLine variable, it could be done as follows using the fmlvar() 
function: 
fmlvar("MyMACD", "SignalLine" ) 

If the variable does not exist within the custom indicator, you will receive 
an error message. 
See page 244 for more information on using variables within formulas.  
See page 261 for more information on the fmlvar() function. 

Self Referencing Formulas Using PREV 
The PREV constant allows you to create self-referencing formulas.  A 
self referencing formula is one that is able to reference the “previous” 
period’s value of itself. 
For example, the following is an example of a self referencing formula: 
((H+L+C)/3) + PREV 

This simple formula divides the high, low, and closing prices by 3 and 
then adds this value to yesterday’s value of the ((H+L+C)/3). 
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The calculation of the popular indicator On Balance Volume illustrates 
the use of the PREV function. 
(if(c>ref(c,-1),1,-1)*volume)+PREV 

Although On Balance Volume can be calculated without the use of the 
PREV function, an exponential moving average cannot (other than using 
the mov() function).  The following formula shows how a 18% 
exponential moving average (approximately 10-periods) is calculated 
using the PREV function. 
(close*0.18)+(PREV*0.82) 

The “P” Data Array Identifier 
A special data array identifier (i.e., "P" variable) is used to reference any 
indicator or price plot.  With custom indicators, the "P" variable 
represents the plot the custom indicator is dropped on.   
With system tests and explorations, the "P" variable represents the 
selected plot.  This may be useful if you want an indicator, exploration, 
system test, or expert to calculate on a plot other than the chart's base 
security.   
If you drop a custom indicator containing the "P" variable on 
high/low/close price bars, the close is used for the "P" variable.  For 
example, the following custom indicator plots an "MACD-type" indicator 
(i.e., the difference between 12- and 26-period exponential moving 
averages) of the plot it is dropped on. 
mov( P, 12, E) - mov( P, 26, E) 
If you plot the predefined Accumulation/Distribution indicator and then 
drop the above custom indicator on it from the QuickList, the result will 
be an MACD of the Accumulation/Distribution indicator.  
Of course, you could write the preceding formula without using the "P" 
identifier as shown below, but you would have to modify it if you wanted 
an MACD of an indicator other than the Accumulation/ Distribution.  By 
using the "P" identifier, the formula becomes more versatile. 
mov( ad(), 12, E) - mov( ad(), 26, E) 
In a custom indicator, the values for HIGH, LOW, CLOSE, VOLUME, 
OPEN, and OPEN INTEREST always come from the base security.  For 
example, if you drop the custom indicator "HIGH - LOW / P" on a price 
plot that is not the chart's base security, the HIGH and LOW values will 
still come from the base security.  The "P" value will represent the 
CLOSE of the security it was dropped on. 

To plot a custom indicator with the "P" variable  
1. Write a custom indicator using the "P" variable in place of the data 

array identifier (e.g., mov(p,10,e), sum(p,25), stdev(p,12), etc.). 
2. Drag the custom indicator from the QuickList and drop it on the plot 

you want the "P" variable to calculate on. 
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To run a system test, exploration, or expert that 
contains a "P" variable  
1. Write a system test, exploration, or expert using the "P" variable in 

place of the data array identifier (e.g., mov(p,10,e), sum(p,25), 
stdev(p,12), etc.). 

2. Select the plot (i.e., indicator or price plot) to use for the "P" variable 
by clicking directly on the plot.  The plot is selected when small 
square "handles" appear on the plot. 

3. Run the system test or exploration. 

Formula Tips 
General 
The two most important "formula tips" have already been mentioned:  (1) 
use the Paste Formula dialog (see page 239) and (2) click OK when 
entering a formula to check its syntax (see page 238). 
Multiple Indented Lines 
When writing long custom indicators, you should try to use multiple lines 
and consistent indentation for ease of reading.  You can indent a line of 
the formula by typing CTRL+TAB.  For example, the formula… 
cum(if(close > ref(close,-1),+V, if(close < 
ref(close,-1),-V,0))) 
is easier to read on multiple indented lines as follows: 
cum( 
   if(close > ref(close,-1), 
     +v, 
   if(close < ref(close,-1), 
     -v, 
   0)) 
   ) 
Upper versus Lower-case Characters 
The case used when entering formulas does not matter (e.g., "c" and "C" 
are treated the same).  When MetaStock Pro checks for syntax errors, it 
automatically modifies the case to make the formula easier to read.  The 
case within comments is not altered. 
Comments 
The prudent use of comments makes formulas easier to read.  
(Remember, comments are any text enclosed in braces, i.e., {}.) 
You can use comments while developing formulas to "comment out" 
sections of the formula.  For example, the second half of the following 
formula has been commented out so the first half can be tested.  After the 
first half of the formula has been tested, you can remove the comments 
and test the entire formula. 
( mov(fml("MA1"),10,S) / fml("MA2") ) { * stoch(5,3) } 
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Spacing 
Blank spaces within formulas are optional.  However, the prudent use of 
spaces can make formulas easier to read. 
Clipboard Commands 
You can use the standard clipboard command accelerator keys while 
editing custom indicators to transfer formulas from one custom indicator 
to another.  To copy the highlighted text, press CTRL+C;  to cut, press 
CTRL+X;  to paste, press CTRL+V. 
Variables  
Use variables to speed up the calculation of formulas.  Rather than 
repeating an expression or formula over and over, assign it to a variable 
and then reference the variable. 

Using the Formula Organizer to Import and Export 
The Formula Organizer is a wizard that allows you to import and export 
any MetaStock formula-based files including custom indicators, system 
tests, explorations, and experts.  For example, you can use the Formula 
Organizer to import a set of add-on custom indicators, experts, etc. 
purchased from a third party.  You could also create a set of add-on 
indicators, explorations, etc. to distribute to your colleagues, and even 
protect your formulas with a password. 
Starting with your custom indicators, the Formula Organizer wizard will 
walk you through the steps necessary to import and/or export your files.  
To protect your formulas with a password, choose the export option, then 
enter a password when prompted. 

To import/export custom indicators, system tests, 
explorations, and/or experts  
1. Run MetaStock Pro. 
2. Choose Indicator Builder from the Tools menu. 
3. Click the Organize button to launch the Formula Organizer Wizard. 
4. Follow the on-screen instructions. 

Glossary 
This glossary defines the terms used with the MetaStock formula 
language.  Understanding (or remembering) these terms is not required, 
however, adding these terms to your vocabulary will make discussion 
easier with other MetaStock analysts. 
COMMENT:  Text within a formula that is not part of the formula.  A 
comment must be surrounded by the characters { and }. 
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CONSTANT:  A specific type of parameter that is required by a function.  
Constants can be subdivided into the following groups:  
CALCULATION METHOD CONSTANT:  Used to define the mode of 
calculation.  Defined as PERCENT or POINTS.  (PERCENT and 
POINTS can be abbreviated to % or $.)  
COMPARISON CONSTANT:  Used in the if() function to define the 
comparison operation.  Defined by >, >=, <, <=, <>, or =.  
FORMULA CONSTANT:  Used within the fml() function to reference 
another formula.  A formula constant is specified as the name of another 
formula enclosed in quotation marks (e.g., fml( "My Formula" ) ). 
MOVING AVERAGE TYPE CONSTANT:  Used to define the moving 
average calculation method.  Defined as EXPONENTIAL, SIMPLE, 
TIME SERIES, TRIANGULAR, VARIABLE, or WEIGHTED.  (These 
can be abbreviated as E, S, T, TRI, VAR, and W.)  
NUMERIC CONSTANT:  A single numeric value.  A function requiring 
a numeric constant cannot accept a data array since a data array may 
contain multiple, rather than single, numeric values.  An example of a 
numeric constant is the "10" in the formula "mov(C,10,E)." 
DATA ARRAY:  A data array defines a specific set of information (data) 
that is used within a formula.  Data arrays can be subdivided into more 
specific definitions:  
FUNCTION RESULT ARRAY:  A data array that is created as the result 
of the execution of a function. 
LITERAL ARRAY:  A data array defined using a single numeric 
constant. 
PRICE ARRAY:  An array containing the information stored in the high, 
low, close, etc., data arrays.  
FORMULA:  A combination of comments, constants, functions, 
mathematical operators and/or price array identifiers. 
FUNCTION:  A pre-defined mathematical operation that can be 
performed on a set of parameters to produce a desired data array.  
OPERATOR, MATHEMATICAL:  The +, -, *, and / operators. 
OPERATOR, LOGICAL:   The <, >, <=, >=, =, <>, AND, and OR 
operators. 
PARAMETER:  An item contained within a function.  When a function 
has multiple parameters, they are separated by commas. 
PRECEDENCE:  The order in which a formula is evaluated (see page 
236).  
PRICE ARRAY IDENTIFIERS:  The letters or words used to reference 
price arrays (Open, High, Low, Close, Volume, Open Interest, PREV, and 
the selected Plot). 
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Error Messages 
Most of the error messages that are displayed when you enter and plot 
custom indicators are self-explanatory.  This section clarifies some of the 
more common error messages. 
A reference to a formula name is no longer valid. 
This error occurs when a formula is plotted containing a reference (i.e., 
"fml()") to a non-existent formula name.  
Does not contain an executable formula.  
An attempt was made to execute a custom indicator that does not contain 
a valid formula. 
Formula too complex.  
This error is caused by functions (not formulas) being nested too deeply  
or by a complex mathematical expression that uses numerous 
mathematical operators that are not grouped using parentheses. 
Grouping operators with parentheses may fix this problem.  However, a 
better solution is to split the too-complex formula into smaller formulas 
and then nest the smaller formulas using the fml() function (see page 
261).  
Insufficient memory to continue formula execution.  
MetaStock Pro ran out of memory to store temporary values. 
This can be alleviated by reducing the number of periods of data currently 
loaded or by reducing references to nested formulas. 
Overflow in function.  
The result of a formula calculation generated a value that was too large to 
store. 
The formula must be modified to produce results with smaller values 
(e.g., divide certain data arrays or function results by 100). 
Too many numeric constants defined in formula.  
A maximum of 20 different numeric constants (see page 249) may be 
used in each formula. 
This error can be eliminated by splitting the formula that received the 
error into smaller formulas and then nesting the smaller formulas using 
the fml() function (see page 261). 
Value out of valid range in function.  
A parameter in a function is invalid.   
Examples:  
The formula "mov(C, -5, E)" will always generate this message, because 
-5 is not a valid moving average time period. 
The formula "mov(C, 200, E)" will generate this message if fewer than 
200 time periods of data are loaded. 
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The formula "mov(macd(), 74, E)" will generate this message if fewer 
than 100 time periods are loaded.  This is because the MACD does not 
plot until the 26th day, which leaves fewer than 74 periods to calculate a 
74-day moving average. 
You should edit the formula and change the invalid parameter, or load 
more time periods. 

Functions 
The following list of functions can be used to create custom indicators 
(see page 299), explorations (see page 369), system tests (see page 319), 
and experts (see page 397). 
Candlestick functions begin on page 288. 
Some of the pattern finding functions (i.e., Inside, Outside, Rally, and 
Reaction) are based on information provided in the pamphlet Using the 
Volume Reversal Survey in Market Analysis by Mark A. Leibovit (520-
282-1275). 

Simulation Functions 
New as of version 8.0, these functions let you use values that occur in a 
system test simulation to determine rules for buying and selling. For 
example, if you want the simulation to place a Sell Order when the equity 
dips below 5,000, you could write:  
 
if(Simulation.AccountCash < 5000,1,0) 
 
Note that these functions only work in the Buy Order, Sell Order, Sell 
Short Order and Buy to Cover Order rules in the Enhanced System Tester 
Dialog. Also, the CurrentPosition simulation functions only work in the 
Sell Order and Buy to Cover rules. 

 

For explanations of what each simulation represents, check the Show 
English Names box at the bottom of the Paste Functions dialog. 

Standard Functions 
Absolute Value 

SYNTAX abs( DATA ARRAY ) 
FUNCTION Calculates the absolute value of the DATA 

ARRAY. 
EXAMPLE The formula "abs( -10 )" will return +10; the 

formula "abs( 10 )" also returns +10. 

Accumulation/Distribution 
SYNTAX ad() 
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FUNCTION Calculates the predefined Accumulation/ 
Distribution indicator. 

Accumulation Swing Index 
SYNTAX aswing( LIMIT MOVE ) 
FUNCTION Calculates the predefined Accumulation 

Swing Index.  The Swing Index requires 
opening prices. 

EXAMPLE aswing( 3.0 ) 
SEE ALSO The swing() function (see page 281). 

Addition 
SYNTAX add( DATA ARRAY, DATA ARRAY ) 
FUNCTION Adds the two parameters together. 
EXAMPLE The formula "add( H, 10.7 )" adds 10.7 to the 

high prices (this formula also could be written 
as "H + 10.7"). 

SEE ALSO The sub() function (see page 281). 

Alert 
SYNTAX alert( EXPRESSION, PERIODS ) 
FUNCTION Extends a "true" result of EXPRESSION for 

the specified number of periods.  This true 
result is held true over the number of periods 
specified even if a "false" result is generated.  

EXAMPLE alert( cross(rsi(14),70),5 ) 
SEE ALSO See page 366 for information on using the 

Alert function within a system test. 

Arc Tangent 
SYNTAX atan( Y DATA ARRAY, X DATA ARRAY ) 
FUNCTION Returns the arc tangent of Y/X.  The value is 

returned in degrees from 0 to 359.9.  The 
degrees are returned as shown below: 

 
EXAMPLE The formula "atan( 10, 0 )" returns 90. 
SEE ALSO The cos() function (see page 256) ; the sin() 

function (see page 280). 

Aroon Down 
SYNTAX aroondown( PERIODS ) 
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FUNCTION Calculates the Aroon Down component of 
the Aroon indicator. 

EXAMPLE aroondown( 14 ) 

Aroon Up 
SYNTAX aroonup( PERIODS ) 
FUNCTION Calculates the Aroon Up component of the 

Aroon indicator. 
EXAMPLE aroonup( 14 ) 

Average Directional Movement 
SYNTAX adx( PERIODS ) 
FUNCTION Calculates the predefined Average 

Directional Movement indicator. 
EXAMPLE adx( 14 ) 
SEE ALSO The adxr() function (see page 258); the csi() 

function (see page 256); the dx() function 
(see page 258); the mdi() function (see page 
270) ; the pdi() function (see page 274) . 

Average True Range 
SYNTAX atr( PERIODS ) 
FUNCTION Calculates the predefined Average True 

Range indicator. 
EXAMPLE atr( 20 ) 

Bars Since 
SYNTAX barssince( DATA ARRAY ) 
FUNCTION Calculates the number of bars (time periods) 

that have passed since DATA ARRAY was 
true.  
 
Important:  When using the barssince() 
function in an exploration, you must 
choose the "Load ___ Records" button in 
the Explorer Options dialog (see page 
371) and specify a value equal to the 
number of bars loaded in your chart; 
otherwise, the exploration results may 
not be accurate. 

EXAMPLE barssince( macd() < 0 ) 

Bollinger Band Bottom 
SYNTAX bbandbot( DATA ARRAY, PERIODS, 

METHOD, DEVIATIONS ) 
FUNCTION Calculates the bottom Bollinger Band of 

DATA ARRAY using METHOD calculation 
method and shifted downward DEVIATION 
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standard deviations.  Valid methods are 
SIMPLE, EXPONENTIAL, WEIGHTED, 
TIMESERIES, TRIANGULAR, and 
VARIABLE  (these can be abbreviated as S, 
E, W, T, TRI, and VAR). 

EXAMPLE bbandbot( close, 10, S, 2 ) 

Bollinger Band Top 
SYNTAX bbandtop( DATA ARRAY, PERIODS, 

METHOD, DEVIATIONS ) 
FUNCTION Calculates the top Bollinger Band of DATA 

ARRAY using METHOD calculation method 
and shifted upward DEVIATION standard 
deviations.  Valid methods are SIMPLE, 
EXPONENTIAL, WEIGHTED, TIMESERIES, 
TRIANGULAR, and VARIABLE (these can 
be abbreviated as S, E, W, T, TRI, and 
VAR). 

EXAMPLE bbandtop( close, 10, S, 2 ) 

Buying Pressure 
SYNTAX buyp() 
FUNCTION Calculates the buying pressure component 

of the Demand Index (see page 459).  
Buying pressure is a measurement of the 
amount of volume related to buying. 

Ceiling 
SYNTAX ceiling( DATA ARRAY ) 
FUNCTION Calculates the lowest integer that is greater 

than DATA ARRAY.  
EXAMPLE The formula "ceiling( 7.2 )" returns 8; the 

formula "ceiling(-7.2)" returns -7. 
SEE ALSO The floor() function (see page 260); the int() 

function (see page 265). 

Chaikin A/D Oscillator 
SYNTAX co() 
FUNCTION Calculates the predefined Chaikin Oscillator. 

Chaikin's Money Flow 
SYNTAX cmf( PERIODS ) 
FUNCTION Calculates the predefined Chaikin Money 

Flow indicator over the last PERIOD number 
of periods. 

EXAMPLE cmf(14) 

Chande Momentum Oscillator 
SYNTAX cmo( DATA ARRAY, PERIODS ) 
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FUNCTION Calculates the predefined Chande 
Momentum Oscillator of DATA ARRAY over 
the last PERIOD number of periods. 

EXAMPLE cmo( c,14 ) 

Commodity Channel Index (EQUIS) 
SYNTAX ccie( PERIODS ) 
FUNCTION Calculates the predefined Commodity 

Channel Index (EQUIS). 
EXAMPLE ccie( 14 ) 

Commodity Channel Index (Standard) 
SYNTAX cci( PERIODS ) 
FUNCTION Calculates the predefined Commodity 

Channel Index (Standard). 
EXAMPLE cci( 14 ) 

Commodity Selection Index 
SYNTAX csi( PERIODS, VALUE, MARGIN, 

COMMISSION ) 
FUNCTION Calculates the predefined Commodity 

Selection Index. 
EXAMPLE csi(14, 50, 2500,25) 
SEE ALSO The adx() function (see page 254); the adxr() 

function page 258); the dx() function (see 
page 258); the mdi() function (see page 
270); the pdi() function (see page 274). 

Correlation Analysis 
SYNTAX correl( INDEPENDENT, 

DEPENDENT,PERIODS, SHIFT) 
FUNCTION Calculates the predefined Correlation 

indicator. Compares the correlation of 
DEPENDENT to INDEPENDENT over 
PERIODS time periods, after shifting 
DEPENDENT to the right SHIFT-periods. 

EXAMPLE The formula "correl( macd(), CLOSE, 5, 10 )" 
compares the MACD indicator to the closing 
price 10-periods in the future, after 
statistically averaging each data array over 
the preceding 5-periods. 

SEE ALSO The tsf() function (see page 282); the stdev() 
function (see page 280). 

Cosine 
SYNTAX cos( DATA ARRAY ) 
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FUNCTION Returns the cosine of DATA ARRAY. 
Assumes that the DATA ARRAY values are 
in degrees. 

EXAMPLE cos( C ) 
SEE ALSO The atan() function (see page 253); the sin() 

function (see page 280). 

Cross 
SYNTAX cross( DATA ARRAY 1, DATA ARRAY 2 ) 
FUNCTION Plots a "+1" on the day that DATA ARRAY 1 

crosses above DATA ARRAY 2.  Otherwise, 
"0" is plotted. 
 
If you want to know when DATA ARRAY 1 
crosses below DATA ARRAY 2, use the 
formula "cross( DATA ARRAY 2, DATA 
ARRAY 1)" 

EXAMPLE cross( close, mov(close,9,e) ) 

Cumulate 
SYNTAX cum( DATA ARRAY ) 
FUNCTION Calculates a cumulative sum of the DATA 

ARRAY from the first period in the chart.  
EXAMPLE The formula "cum( 1 )" calculates an 

indicator that rises one point for each day 
since the beginning of the chart; the formula 
"cum( C )" calculates the cumulative total of 
all closing prices from the beginning of the 
chart. 

SEE ALSO The sum() function (see page 281).  

Day Of Month 
SYNTAX dayofmonth() 
FUNCTION Plots the day of the month.  If today was July 

15th, "15" would be plotted. 

Day Of Week 
SYNTAX dayofweek() 
FUNCTION Plots the day of the week.  1=Monday, 

2=Tuesday, 3=Wednesday, 4=Thursday, 
5=Friday, 6=Saturday, 7=Sunday. 

Delta 
SYNTAX delta( TYPE, DATE, PRICE, INTEREST, 

DIVIDEND ) 
FUNCTION Calculates the predefined Delta indicator.  

See the option() function (page 273) for a 
description of the parameters used in the 
delta() function. 
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EXAMPLE delta( EC, 961220, 125, 7.50, 4.75 ) 
SEE ALSO The gamma() function (see page 262); the 

life() function (see page 272) ; the option() 
function (see page 276); the theta() function 
(see page 282); the vega() function (see 
page 284); and the volo() function (see page 
285). 

Dema 
SYNTAX dema( DATA ARRAY, PERIODS ) 
FUNCTION Calculates the predefined DEMA indicator 
EXAMPLE dema( c,14 ) 
SEE ALSO The tema() function (see page 282). 

Demand Index 
SYNTAX di() 
FUNCTION Calculates the predefined Demand Index. 

Detrended Price Oscillator 
SYNTAX dpo( PERIODS ) 
FUNCTION Calculates the predefined Detrended Price 

Oscillator. 
EXAMPLE dpo( 25 ) 

Directional Movement Index 
SYNTAX dx( PERIODS ) 
FUNCTION Calculates the predefined Directional 

Movement Index. 
EXAMPLE dx( 14 ) 
SEE ALSO The adx() function (see page 254); the adxr() 

function page 258); the csi() function (see 
page 256); the mdi() function (see page 
270); the pdi() function (see page 274) 

Directional Movement Rating 
SYNTAX adxr( PERIODS ) 
FUNCTION Calculates the predefined Directional 

Movement Rating. 
EXAMPLE adxr( 14 ) 
SEE ALSO The adx() function (see page 254); the dx() 

function (see page 258); the csi() function 
(see page 256); the mdi() function (see page 
270); the pdi() function (see page 274) 

Divergence 
SYNTAX divergence( DATA ARRAY 1, DATA ARRAY 

2, % MINIMUM CHANGE ) 
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FUNCTION Plots a +1 if DATA ARRAY 1 diverges from 
DATA ARRAY 2 (i.e., DATA ARRAY 1 is 
increasing and DATA ARRAY 2 is 
decreasing).  Plots a -1 if DATA ARRAY 1 
converges from DATA ARRAY 2 (i.e., DATA 
ARRAY 1 is decreasing and DATA ARRAY 2 
is increasing).  A zero is plotted if they are 
moving in the same direction.  Movements in 
DATA ARRAY 1 less than % MINIMUM 
CHANGE are ignored. 
 
The Divergence function is based on the Zig 
Zag formula.  First, a % MINIMUM CHANGE 
Zig Zag is calculated for DATA ARRAY 1.  
Next, a Zig Zag is calculated for DATA 
ARRAY 2 using the % MINIMUM CHANGE 
required to match the number of Zig Zag 
segments in DATA ARRAY 1 over the data 
range loaded.  The two Zig Zags are then 
compared for divergence and convergence. 

EXAMPLE The formula “divergence( close, rsi(21), 3 )” 
looks for divergences between the close and 
a 21-period RSI.  Movements in the close 
less than 3% are ignored. 

Division 
SYNTAX div( DATA ARRAY, DATA ARRAY ) 
FUNCTION Divides the first parameter by the second.  

Division by zero produces a result of zero. 
EXAMPLE The formula "div( 10, 2 )" returns 5 (this 

formula also could be written as "10 / 2"). 
SEE ALSO The mul() function (see page 272).   

Dynamic Momentum Index 
SYNTAX dmi( DATA ARRAY ) 
FUNCTION Calculates the predefined Dynamic 

Momentum Index. 
EXAMPLE dmi( CLOSE ) 

Ease of Movement 
SYNTAX emv(PERIODS, METHOD)  
FUNCTION Calculates a PERIODS moving average of 

the Ease of Movement value using METHOD 
calculation method.  Valid methods are 
SIMPLE, EXPONENTIAL, WEIGHTED, 
TIMESERIES, TRIANGULAR, and 
VARIABLE.  (These can be abbreviated as 
S, E, W, T, TRI, and VAR.)  
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EXAMPLE The formula "emv(14,S)" returns the value of 
the Ease of Movement indicator smoothed 
with a 14-period simple moving average. 

Exponent 
SYNTAX exp( DATA ARRAY ) 
FUNCTION Calculates e raised to the DATA ARRAY 

power. 
SEE ALSO The log() function (see page 267). 

External Formula 
SYNTAX ExtFml("DLL NAME.FUNCTION 

NAME",argument 1,…,argument n) 
FUNCTION Returns the values of the function contained 

in an MSX DLL.  This is only available if an 
MSX DLL is present.   

EXAMPLE ExtFml("MyDLL.MyFunction",close) would 
reference a function called MyFunction 
contained in the MSX DLL called MyDLL, 
and use the closing price of the security in its 
calculation. 
 
 

 
For more information on the Equis Solution 
Provider program and the MetaStock 
Developers Kit go to www.equis.com 

Fast Fourier Transform 
SYNTAX fft( DATA ARRAY, PERIODS, LENGTH, 

DETREND or MEAN, AMPLITUDE or 
POWER ) 

FUNCTION Calculates the PERIODS time period Fourier 
indicator of the DATA ARRAY, given sample 
LENGTH using the DETREND or MEAN 
method, and displays the AMPLITUDE or 
POWER spectrum. 

EXAMPLE The formula "fft( CLOSE, 100, 1, DETREND, 
POWER )" returns the default Fast Fourier 
indicator. 

Floor 
SYNTAX floor( DATA ARRAY ) 
FUNCTION Calculates the highest integer that is less 

than DATA ARRAY.   
EXAMPLE The function "floor( 13.9 )" returns 13.  The 

formula "floor( -13.9 )" returns -14. 
SEE ALSO The ceiling() function (see page 255); the 

int() function (see page 265). 
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Forecast Oscillator 
SYNTAX forecastosc( DATA ARRAY, PERIODS ) 
FUNCTION Calculates the predefined Forecast 

Oscillator.   
EXAMPLE forecastosc( close, 14 ) 

Formula Call 
SYNTAX fml("FORMULA_NAME" ) 
FUNCTION Calculates the value of another formula.  The 

formula can be referenced using the 
FORMULA_NAME in quotes. 
 
When referencing a formula's name, the 
name must be contained in quotation marks 
(e.g., fml( "Secret A")). 
 
If you change a formula's name, you must 
also change any fml() calls that reference 
that formula. 

EXAMPLE The formula "fml("Secret A") * 
fml("MyMACD")" calculates the value of the 
formula named "Secret A" multiplied by 
"MyMACD." 

SEE ALSO See page 242 for more details on using the 
fml() function. 

Formula Variable Call 
SYNTAX fmlvar( "FORMULA_NAME", 

"VARIABLE_NAME") 
FUNCTION Calls the custom indicator named 

FORMULA_NAME and returns the value 
contained in the custom indicator's variable 
named VARIABLE_NAME. 
 
Both the formula's name and the variable's 
name must be contained in quotation marks 
(e.g., fmlvar( "Secret A", "MyVar")). 
 
If you change a formula or variable name, 
you must also change any fmvarl() calls that 
reference that formula and variable. 

EXAMPLE fmlvar("MyIndicator", "MyVariableA" ) 
SEE ALSO See page 246 for more details on using the 

fmlvar() function. 

Fraction 
SYNTAX frac( DATA ARRAY ) 
FUNCTION Eliminates the integer portion of DATA 

ARRAY and returns the fractional part.  
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EXAMPLE The formula "frac( 10.7 )" returns 0.7; the 
formula "frac(-19.8 )" returns -0.8. 

SEE ALSO The int() function (see page 265). 

Gamma 
SYNTAX gamma( TYPE, DATE, PRICE, INTEREST, 

DIVIDEND ) 
FUNCTION Calculates the predefined Gamma indicator.  

See the option() function (page 276) for a 
description of the parameters used in the 
gamma() function. 

EXAMPLE gamma( EC, 961220, 125, 7.50, 4.75 ) 
SEE ALSO The delta() function (see page 257); the life() 

function (see page 272) ; the option() 
function (see page 276); the theta() function 
(see page 282); the vega() function (see 
page 284); and the volo() function (see page 
285). 

Gap Down 
SYNTAX gapdown() 
FUNCTION Plots a "+1" on the day a security's prices 

gap down.  Otherwise a "0" is plotted.  A gap 
down occurs if yesterday's low is greater 
than today's high. 

Gap Up 
SYNTAX gapup() 
FUNCTION Plots a "+1" on the day a security's prices 

gap up.  Otherwise a "0" is plotted.  A gap up 
occurs if yesterday's high is less than  
today's low. 

Herrick Payoff Index 
SYNTAX hpi( CENTS, MULTIPLYING FACTOR ) 
FUNCTION Calculates the predefined Herrick Payoff 

Index. 
EXAMPLE hpi(100, 10) 

Highest 
SYNTAX highest( DATA ARRAY ) 
FUNCTION Calculates the highest value in the DATA 

ARRAY since the first day loaded in the  
chart. 

EXAMPLE The formula "highest( rsi(14) )" returns the 
highest Relative Strength Index value since 
the first day loaded in the chart ; "highest ( 
close )" returns the highest closing price 
since the first day loaded in the chart. 
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SEE ALSO The hhv() function page 263; the llv() 
function (see page 268); the lowest()  
function (see page 267). 

Highest Bars Ago 
SYNTAX highestbars( DATA ARRAY ) 
FUNCTION Calculates the number of periods that have 

passed since the DATA ARRAY’s highest 
value.  This includes all data loaded in the 
chart. 

EXAMPLE The formula "highestbars( close )" returns 
the number of periods that have passed 
since the closing price reached its highest 
peak. 

Highest High Value  
SYNTAX hhv( DATA ARRAY, PERIODS ) 
FUNCTION Calculates the highest value in the DATA 

ARRAY over the preceding PERIODS 
(PERIODS includes the current day). 

 
EXAMPLE The formula "hhv( CLOSE, 5 )" returns the 

highest closing price over the preceding five 
periods; "hhv(H,7)" returns the highest high 
price over the preceding seven periods. 

SEE ALSO The Stochastic Oscillator example (see page 
311); the llv() function (see page 268). 

Highest High Value Bars Ago 
SYNTAX hhvbars( DATA ARRAY, PERIODS ) 
FUNCTION Calculates the number of periods that have 

passed since the DATA ARRAY reached its 
PERIODS period peak. 

EXAMPLE The formula "hhvbars( close,50 )" returns  
the number of periods that have passed 
since the closing price reached its 50-period 
peak. 

Highest Since 
SYNTAX highestsince ( Nth, EXPRESSION, DATA 

ARRAY ) 
FUNCTION Returns the highest value of DATA ARRAY 

since the Nth most recent occurrence of 
EXPRESSION was true.  This includes all 
data loaded in the chart. 

EXAMPLE The formula "highestsince( 2, 
cross(c,mov(c,10,s), close )" returns highest 
value of the close since the second most 
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recent occurrence of the close crossing 
above its 10-day moving average. 

Highest Since Bars Ago 
SYNTAX highestsincebars( Nth, EXPRESSION, DATA 

ARRAY ) 
FUNCTION Calculates the number of periods that have 

passed from the highest value of DATA 
ARRAY (after the Nth most recent 
occurrence of EXPRESSION was true).  This 
includes all data loaded in the chart. 
 
Put another way, this function returns the 
number of periods that have passed since 
the highestsince() function returned its value. 

EXAMPLE The formula "highestsincebars( 2, 
cross(c,mov(c,10,s), close )" returns the 
number of periods that have passed since 
the highest value of the close (after the 
second most recent occurrence of the close 
crossing above its 10-day moving average). 

 

Hour 
SYNTAX hour() 
FUNCTION On an intraday chart, plots the number of 

hours that have passed during the day using 
a 24 hour clock.  For example, if the current 
time is recorded as 13:15:22, the hour() 
function will return "13" . 

If 
SYNTAX if( DATA ARRAY  > >= < <= <> =  DATA 

ARRAY, THEN DATA ARRAY, ELSE DATA 
ARRAY ) 

FUNCTION A conditional function that returns the second 
parameter (THEN) if the conditional 
expression defined by the first parameter is 
true; otherwise, the third parameter is 
returned (ELSE). 

EXAMPLE The formula "if(1<2,3,4)" will always return 
the value three. 

SEE ALSO The On Balance Volume example (see page 
310); The Indicator Builder Tutorial (see 
page 300).   For more details on using the if() 
function, see page 241. 

Inertia 
SYNTAX inertia( REGRESSION PERIODS, RVI 

PERIODS) 
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FUNCTION Calculates the predefined Inertia indicator.  
The RVI PERIODS is the number of periods 
used for the Relative Volatility Index 
component of the indicator. 

EXAMPLE inertia(20,14) 

Input 
SYNTAX input( "PROMPT TEXT", MINIMUM VALUE, 

MAXIMUM VALUE, DEFAULT VALUE) 
FUNCTION This function instructs MetaStock Pro to 

prompt for input when a custom indicator is 
plotted.  This function is only supported by 
the Custom Indicator Builder. 
 
prompt text.  This defines the text displayed 
next to the input box.  This is used to 
describe what should be entered. 

 minimum value.  This argument is the 
smallest value that can be entered.  If you 
attempt to enter a value smaller than this 
value, MetaStock Pro displays a message. 

 maximum value.  This argument is the 
largest value that can be entered.  If you 
attempt to enter a value larger than this 
value, MetaStock Pro displays a message. 

 default value.  This argument defines the 
default value (i.e., the value that will appear 
in the box when the dialog is initially 
displayed.) .  Note that the default value is 
used if another formula using the fml() 
function calls the custom indicator. 

EXAMPLE input("Enter the number of periods",1,50,9) 

Inside 
SYNTAX inside() 
FUNCTION Plots a "+1" when an inside day occurs.  An 

inside day occurs when today's high is less 
than yesterday's high and today's low is 
greater than yesterday's low.  A range is 
determined by the first Inside Day and is only 
broken by a Rally, Reaction, or Outside day. 

Integer 
SYNTAX int( DATA ARRAY ) 
FUNCTION Removes the fractional portion of DATA 

ARRAY and returns the integer part. 
EXAMPLE The formula "int( 10.7 )" returns 10; the 

formula "int(-19.8 )" returns -19. 
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SEE ALSO The ceiling() function (see page 255); the 
floor() function (see page 260); the frac() 
function (see page 261). 

Intraday Momentum Index 
SYNTAX imi( PERIODS ) 
FUNCTION Calculates the predefined Intraday 

Momentum Index. 
EXAMPLE imi( 14 ) 

 

IsDefined() 
SYNTAX isdefined(DATA ARRAY) 
FUNCTION Returns 1 if all data necessary to calculate 

the formula is available, 0 if not. 
EXAMPLE The formula "isdefined(mov(c,20,s))"  

will return a 0 if there are less than 20 
periods of data loaded in the chart. 

IsUndefined() 
SYNTAX isundefined(DATA ARRAY) 
 
FUNCTION Returns 0 if all data necessary to calculate 

the formula is available, 1 if not. 
EXAMPLE The formula "isundefined(mov(c,20,s))"  

will return a 1 if there are less than 20 
periods of data loaded in the chart. 

 

Klinger Oscillator 
SYNTAX kvo() 
FUNCTION Calculates the predefined Klinger Oscillator. 
EXAMPLE The formula "kvo()" returns the value of the 

Klinger Oscillator (i.e., the solid line).  The 
formula "mov(kvo(),13,E)" returns the value 
of the KVO's trigger line (i.e., the dotted line). 

 

Last Value in Data Array 
SYNTAX lastvalue(DATA ARRAY) 
FUNCTION This function loads an entire data array with 

the last calculated value of the specified 
DATA ARRAY.  The result of this function 
can be used in place of a constant in any 
function argument. 
 
If DATA ARRAY is undefined (e.g., only 100-
days loaded and you request the last value 
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of a 200-day moving average) then the 
lastvalue function returns zero. 
 
Since this function loads an entire data array 
with the last value of another array, it allows 
a formula to look into the future.  This is 
unacceptable for most indicators, but is very 
beneficial for things like pattern recognition. 

EXAMPLE  The formula 
"mov(close,lastvalue(fml("Determine 
Periods")),s)" calculates a moving average 
using the number of periods returned by the 
indicator named "Determine Periods". 

Linear Regression Indicator 
SYNTAX linearreg( DATA ARRAY, PERIODS ) 
FUNCTION Calculates the predefined Linear Regression 

indicator. 
EXAMPLE linearreg( c, 50 ) 

Linear Regression Slope 
SYNTAX linregslope( DATA ARRAY, PERIODS ) 
 
FUNCTION Calculates the predefined Linear Regression 

Slope indicator. 
EXAMPLE linregslope(c, 50 ) 

Logarithm (natural) 
SYNTAX log( DATA ARRAY ) 
FUNCTION Calculates the natural logarithm of DATA 

ARRAY.  
SEE ALSO The exp() function (see page 260). 

Lowest 
SYNTAX lowest( DATA ARRAY ) 
FUNCTION Calculates the lowest value in the DATA 

ARRAY since the first day loaded in the 
chart. 

EXAMPLE The formula "lowest( rsi(14) )" returns the 
lowest Relative Strength Index value since 
the first day loaded in the chart; "lowest ( 
close )" returns the lowest closing price since 
the first day loaded in the chart. 

SEE ALSO The hhv() function (see page 263); the llv() 
function (see page 268); the highest() 
function (see page 262). 

Lowest Bars Ago 
SYNTAX lowestbars( DATA ARRAY ) 
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FUNCTION Calculates the number of periods that have 
passed since the DATA ARRAY’s lowest 
value.  This includes all data loaded in the 
chart. 

EXAMPLE The formula "lowestbars( close )" returns the 
number of periods that have passed since 
the closing price reached its lowest point. 

Lowest Low Value 
SYNTAX llv( DATA ARRAY, PERIODS ) 
FUNCTION Calculates the lowest value in the DATA 

ARRAY over the preceding PERIODS 
(PERIODS includes the current day). 

EXAMPLE The formula "llv( CLOSE, 14 )" returns the 
lowest closing price over the preceding 14 
periods. 

SEE ALSO The Stochastic Oscillator example (see page 
311); the hhv() function (see page 263). 

Lowest Low Value Bars Ago 
SYNTAX llvbars( DATA ARRAY, PERIODS ) 
FUNCTION Calculates the number of periods that have 

passed since the DATA ARRAY reached its 
PERIODS period trough. 

EXAMPLE The formula "llvbars( close,50 )" returns the 
number of periods that have passed since 
the closing price reached its 50 period 
trough. 

Lowest Since 
SYNTAX lowestsince ( Nth, EXPRESSION, DATA 

ARRAY ) 
FUNCTION Returns the lowest value of DATA ARRAY 

since the Nth most recent occurrence of 
EXPRESSION was true.  This includes all 
data loaded in the chart. 

EXAMPLE The formula "lowestsince( 2, 
cross(c,mov(c,10,s), close )" returns lowest 
value of the close since the second most 
recent occurrence of the close crossing 
above its 10-day moving average. 

Lowest Since Bars Ago 
SYNTAX lowestsincebars( Nth, EXPRESSION, DATA 

ARRAY ) 
FUNCTION Calculates the number of periods that have 

passed from the lowest value of DATA 
ARRAY (after the Nth most recent 
occurrence of EXPRESSION was true).  This 
includes all data loaded in the chart. 
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Put another way, this function returns the 
number of periods that have passed since 
the lowestsince() function returned its value. 

EXAMPLE The formula "lowestsincebars( 2, 
cross(c,mov(c,10,s), close )" returns the 
number of periods that have passed since 
the lowest value of the close (after the 
second most recent occurrence of the close 
crossing above its 10-day moving average). 

MACD 
SYNTAX macd() 
FUNCTION Calculates the predefined MACD indicator. 
EXAMPLE The formula "macd()" returns the value of the 

MACD indicator (i.e., the solid line).  The 
formula "mov(macd(),9,E)" returns the value 
of the MACD's signal line (i.e., the dotted 
line). 

Market Facilitation Index 
SYNTAX marketfacindex() 
FUNCTION Calculates the predefined Market Facilitation 

Index. 
EXAMPLE marketfacindex() 

Mass Index 
SYNTAX mass( PERIODS ) 
FUNCTION Calculates the predefined Mass Index. 
EXAMPLE mass( 25 ) 

Maximum 
SYNTAX max( DATA ARRAY, DATA ARRAY ) 
FUNCTION Returns the largest of the two parameters. 
EXAMPLE The formula "max( CLOSE, 10 )" returns 

either the closing price or 10, whichever is 
greater.  The formula "max(-14, 13)" always 
returns 13. 

Median Price 
SYNTAX mp() 
FUNCTION Calculates the predefined Median Price 

indicator. 
SEE ALSO The typ() function (see page 283). 

MESA Lead Sine 
SYNTAX mesaleadsine( CYCLE LENGTH ) 
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FUNCTION Calculates the predefined MESA Lead Sine 
indicator that plots along with MESA Sine 
Wave indicator (see page 482). 

EXAMPLE mesaleadsine( 20 ) 
SEE ALSO The mesasinewave() function (see page 

270). 

MESA Sine Wave 
SYNTAX mesasinewave( CYCLE LENGTH ) 
FUNCTION Calculates the predefined MESA Sine Wave 

indicator (see page 482). 
EXAMPLE mesasinewave( 20 ) 
SEE ALSO The mesaleadsine() function (see page 269). 

Midpoint 
SYNTAX mid( DATA ARRAY, PERIODS ) 
FUNCTION Returns the midpoint of the DATA ARRAY 

over the specified time PERIOD.  The 
midpoint is the value halfway between the 
highest and lowest DATA ARRAY values 
during the specified PERIOD. 

 
EXAMPLE The formula "mid( CLOSE, 7 )" is equivalent 

to "llv(C,7) + ((hhv(C,7) 12/10/2002- 
llv(C,7)) / 2)." 

SEE ALSO The hhv() function (see page 263); the llv() 
function (see page 268). 

Minimum 
SYNTAX min( DATA ARRAY, DATA ARRAY ) 
FUNCTION Returns the smallest of the two parameters. 
EXAMPLE The formula "min( CLOSE, 10 )" returns the 

closing price or 10, whichever is less.  The 
formula "min(-14, 13)" always returns -14. 

SEE ALSO The max() function (see page 269). 

Minus Directional Movement 
SYNTAX mdi( PERIODS ) 
FUNCTION Calculates the predefined Minus Directional 

Movement indicator. 
EXAMPLE mdi( 14 ) 
SEE ALSO The adx() function on page 254; the adxr() 

function on page 258; the csi() function on 
page 256; the dx() function on page 258; the 
pdi() function on page 274. 
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Minute 
SYNTAX minute() 
FUNCTION On an intraday chart, plots the number of 

minutes that have passed during the current 
hour.  For example, if the current time is 
recorded as 10:15:22, the minute() function 
will return "15". 

Modulus 
SYNTAX mod( DATA ARRAY, DATA ARRAY ) 
FUNCTION Calculates the remainder (i.e., the fractional 

portion) of DATA ARRAY divided by DATA 
ARRAY.  A division by zero produces a zero 
result. 

EXAMPLE The formula "mod( 10, 3 )" returns 1.0; the 
formula "mod( -10.7, 3 )" returns -1.7.  You 
could write an equivalent formula as "-10.7 - 
(int(-10.7 / 3) * 3)." 

Momentum 
SYNTAX mo( PERIODS ) 
FUNCTION Calculates the predefined Momentum 

indicator. 
EXAMPLE mo( 12 ) 

Money Flow Index 
SYNTAX mfi( PERIODS ) 
FUNCTION Calculates the predefined Money Flow Index. 
EXAMPLE mfi( 14 ) 
SEE ALSO The rsi() function (see page 279). 

Month 
SYNTAX month() 
FUNCTION Plots the month of the year for the price.  If a 

bar was plotted on 10/15/96, "10" would be 
plotted. 

Moving Average 
SYNTAX mov( DATA ARRAY, PERIODS, METHOD) 
FUNCTION Calculates a PERIODS moving average of 

DATA ARRAY using METHOD calculation 
method.   
 
Valid methods are  EXPONENTIAL, 
SIMPLE, TIMESERIES, TRIANGULAR, 
WEIGHTED, VARIABLE, AND 
VOLUMEADJUSTED  (these can be 
abbreviated as E, S, T, TRI, W, VAR, and 
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VOL). 
 

EXAMPLE The formula "mov( CLOSE, 25, 
EXPONENTIAL )" returns the value of a 25-
period exponential moving average of the 
closing prices. 

Multiplication 
SYNTAX mul( DATA ARRAY, DATA ARRAY ) 
FUNCTION Calculates DATA ARRAY multiplied by 

DATA ARRAY.  
EXAMPLE The function "mul( CLOSE, 2)" returns the 

closing price multiplied by two.  (This function 
also could be written as "C * 2.") 

SEE ALSO The div() function (see page 259). 

Negative 
SYNTAX neg( DATA ARRAY )  
FUNCTION Calculates the negative of DATA ARRAY.  
EXAMPLE The formula "neg( 10 )" returns -10; the 

formula "neg( -12 )" returns +12.  This 
formula also could be written "-(-12)." 

 
 

Negative Volume Index 
SYNTAX nvi()  
FUNCTION Calculates the predefined Negative Volume 

Index.  
SEE ALSO The pvi() function (see page 274). 

On Balance Volume 
SYNTAX obv() 
FUNCTION Calculates the predefined On Balance 

Volume indicator. 
SEE ALSO The example formula (see page 310). 

Option Expiration 
SYNTAX optionexp() 
FUNCTION Calculates the predefined Next Option 

Expiration indicator. 
SEE ALSO The Option Life function (see page 272). 

Option Life 
SYNTAX life( EXPIRATION DATE ) 
FUNCTION Calculates the predefined Option Life 

indicator. 
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EXAMPLE life( 970121 ) displays the number of days 
until January 21, 1997. 

SEE ALSO The delta() function (see page 257); the 
gamma() function (see page 262); the 
option() function (see page 276); the theta() 
function (see page 282); the vega() function 
(see page 284); and the volo() function (see 
page 285). 

Outside  
SYNTAX outside() 
FUNCTION Plots a "+1" when an outside day occurs.  An 

outside day occurs when today's high is 
greater than yesterday's high and today's low 
is less than yesterday's low.  A range is 
determined by the first Outside Day and is 
only broken by a Rally, Reaction, or Inside 
day. 

Parabolic SAR 
SYNTAX sar( STEP, MAXIMUM )  
FUNCTION Calculates the predefined Parabolic SAR 

indicator.  
EXAMPLE sar( 0.02, 0.20 ) 

Peak Bars Ago 
SYNTAX peakbars( Nth, DATA ARRAY, % MINIMUM 

CHANGE) 
FUNCTION Plots the number of bars that have passed 

from the Nth peak.  This uses the Zig Zag 
function (see page 287) to determine the 
peaks.  N=1 would return the number of bars 
that have passed since the most recent 
peak.  N=2 would return the number of bars 
that have passed since the 2nd most recent 
peak.  Etc. 

EXAMPLE peakbars(1,close,5) 

Peak Value 
SYNTAX peak( Nth, DATA ARRAY, % MINIMUM 

CHANGE ) 
FUNCTION Plots the value of DATA ARRAY Nth peak(s) 

ago.  This uses the Zig Zag function (see 
page 539) to determine the peaks.  N=1 
would return the value of the most recent 
peak.  N=2 would return the value of the 2nd 
most recent peak.  Etc. 

EXAMPLE peak(1,close,5) 
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Performance 
SYNTAX per() 
FUNCTION Calculates the predefined Performance 

indicator.  

Plus Directional Movement 
SYNTAX pdi( PERIODS ) 
FUNCTION Calculates the predefined Plus Directional 

Movement indicator.  
EXAMPLE pdi( 14 ) 
SEE ALSO The adx() function on page 254; the adxr() 

function on page 258; the csi() function on 
page 256; the dx() function on page 258. 

Polarized Fractal Efficiency 
SYNTAX pfe( DATA ARRAY, PERIODS, 

SMOOTHING PERIODS) 
FUNCTION Calculates the predefined Polarized Fractal 

Efficiency indicator. 
EXAMPLE pfe( c,10,5 ) 
 

 

Positive Volume Index 
SYNTAX pvi()  
FUNCTION Calculates the predefined Positive Volume 

Index.  
SEE ALSO The nvi() function (see page 272). 

Power 
SYNTAX power( DATA ARRAY, POWER )  
FUNCTION Calculates DATA ARRAY raised to the 

POWER power.  A negative DATA ARRAY 
value raised to a non-integer POWER 
causes an error message to be displayed. 

EXAMPLE The formula "power( 10, 3 )" returns 1,000. 

Precision 
SYNTAX prec( DATA ARRAY, PRECISION )  
FUNCTION Truncates DATA ARRAY to PRECISION 

decimal places. 
EXAMPLE The formula "prec( 10.12981, 2 )" returns 

10.120.  The formula "prec( 10.12981, 4 )" 
returns 10.12980.  Small binary rounding 
errors may cause some minor distortion in 
the decimal portion of any number stored in 
a computer. 
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Price Channel High 
SYNTAX pricechannelhigh( PERIODS ) 
FUNCTION Calculates the top channel line of the Price 

Channel indicator. 
EXAMPLE pricechannelhigh( 14 ) 

 
 

Price Channel Low 
SYNTAX pricechannellow( PERIODS ) 
FUNCTION Calculates the bottom channel line of the 

Price Channel indicator. 
EXAMPLE pricechannellow( 14 ) 

Price Oscillator 
SYNTAX oscp( PERIODS, PERIODS, MA_METHOD, 

DIFF_METHOD )  
FUNCTION Calculates the PERIODS/PERIODS 

predefined Price Oscillator indicator 
calculated using the MA_METHOD moving 
average method expressed in 
DIFF_METHOD.   
 
Valid MA_METHODs are SIMPLE, 
EXPONENTIAL, WEIGHTED, TIMESERIES, 
TRIANGULAR, and VARIABLE  (these can 
be abbreviated as S, E, W, T, TRI, VAR).   
 
Valid DIFF_METHODs are PERCENT and 
POINTS (these can be abbreviated as % and 
$). 

EXAMPLE The formula "oscp(1, 25, E, $)" returns a 1-
period/25-period exponential price oscillator 
expressed in points. 

SEE ALSO The oscv() function (see page 285). 

Price Volume Trend 
SYNTAX pvt()  
FUNCTION Calculates the predefined Price Volume 

Trend indicator.  

Projection Band Bottom 
SYNTAX Projbandbot( PERIODS ) 
FUNCTION Calculates the bottom Projection Band. 
EXAMPLE projbandbot( 21 ) 
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Projection Band Top 
SYNTAX Projbandtop( PERIODS ) 
FUNCTION Calculates the top Projection Band. 
EXAMPLE projbandbot( 21 ) 

Projection Oscillator 
SYNTAX Projosc( REGRESSION PERIODS, 

SLOWING PERIODS ) 
FUNCTION Calculates the predefined Projection 

Oscillator. 
EXAMPLE projosc( 21,3 ) 

Put/Call Price 
SYNTAX option( TYPE, DATE, PRICE, INTEREST, 

DIVIDEND ) 
FUNCTION Calculates the predefined Put/Call Price 

indicator. 
EXAMPLE The formula "option( EC, 961231, 125, 8.5, 

6.31 )" calculates the fair market value of an 
equity call that matures on December 31, 
1996, at a strike price of $125.  The current 
market interest rates are 8.5% and the 
security paid an annual dividend of $6.31. 

 
TYPE specifies whether the security is an 
Equity or a Future (i.e., E or F) and if a Put or 
Call price (i.e., P or C) should be calculated.  
Valid TYPEs are EC, EP, FC, and FP.  
(These types also can be spelled out as 
CALL, PUT, FUTURECALL, and 
FUTUREPUT.) 
 
The DATE is the date that the option expires.  
The DATE must be entered as a number in 
the YYMMDD format.  For example, 
December 31, 1996, should be entered as 
961231.  This date format is used regardless 
of the date format specified in the 
Configuration section. 
 
The PRICE parameter specifies the option's 
strike price. 
 
The INTEREST parameter specifies a "risk 
free" market interest rate (e.g., 8.75). 
 
The DIVIDEND parameter specifies the total 
dividends received over the last 12 months. 

SEE ALSO The delta() function (see page 257); the 
gamma() function (see page 262); the life() 
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function (see page 272); the theta() function 
(see page 282); the vega() function (see 
page 284); and the volo() function (see page 
285). 

Qstick 
SYNTAX qstick( PERIODS ) 
FUNCTION Calculates the predefined Qstick indicator. 
EXAMPLE qstick( 21 ) 

 

r-squared 
SYNTAX rsquared( DATA ARRAY, PERIODS ) 
FUNCTION Calculates the predefined Rsquared 

indicator. 
EXAMPLE rsquared( c, 21 ) 

 

Rally 
SYNTAX rally() 
FUNCTION Plots a "+1" when a rally day occurs.  

Otherwise, a "0" is plotted.  A rally day 
occurs when today's high is greater than the 
previous rally day's high and today's low is 
greater than or equal to the previous rally 
day's low. 

Rally With Volume 
SYNTAX rallywithvol() 
FUNCTION Plots a "+1" when a rally with volume day 

occurs.  Otherwise, a "0" is plotted.  A rally 
with volume occurs when today's high is 
greater than the previous rally day's high and 
today's low is greater than or equal to the 
previous rally day's low.  Today's volume 
must be greater than the previous rally day's 
volume. 

Random Walk Index of Highs 
SYNTAX rwih( MINIUMUM PERIODS, MAXIMUM 

PERIODS ) 
FUNCTION Calculates the predefined Random Walk 

Index of the highs indicator. 
EXAMPLE rwih( 6,39 ) 

Random Walk Index of Lows 
SYNTAX rwil(MINIUMUM PERIODS, MAXIMUM 

PERIODS ) 
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FUNCTION Calculates the predefined Random Walk 
Index of the lows indicator. 

EXAMPLE rwil( 6,39 ) 

Range Indicator 
SYNTAX rangeindicator( PERIODS, SMOOTHING 

PERIODS ) 
FUNCTION Calculates the predefined Range Indicator. 
EXAMPLE rangeindicator( 10,3 ) 

Rate of Change 
SYNTAX roc( DATA ARRAY, PERIODS, 

DIFF_METHOD )  
FUNCTION Calculates the PERIODS rate-of-change of 

DATA ARRAY expressed as 
DIFF_METHOD. 
 
Valid DIFF_METHODs are PERCENT and 
POINTS (these can be abbreviated as % and 
$). 

EXAMPLE The formula "roc( CLOSE, 12, PERCENT )" 
returns the 12-period percent rate-of-change 
of the closing prices. 

 

Reaction 
SYNTAX reaction() 
FUNCTION Plots a "+1" when a reaction day occurs.  

Otherwise, a "0" is plotted. A reaction day 
occurs when today's high is less than or 
equal to the previous reaction day's high and 
today's low is less than the previous reaction 
day's low. 

Reaction With Volume 
SYNTAX reactionwithvol() 
FUNCTION Plots a "+1" when a reaction day occurs.  

Otherwise, a "0" is plotted. A reaction day 
occurs when today's high is less than or 
equal to the previous reaction day's high and 
today's low is less than the previous reaction 
day's low.  Today's volume must be greater 
than the previous reaction day's volume. 

Reference 
SYNTAX ref( DATA ARRAY, PERIODS )  
FUNCTION References a previous or subsequent 

element in a DATA ARRAY.  A positive 
PERIOD references "n" periods in the future; 
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a negative PERIOD references "n" periods 
ago. 

EXAMPLE The formula "ref( CLOSE, -12 )" returns the 
closing price 12 periods ago.  Thus, you 
could write the 12-day price rate-of-change 
(expressed in points) as "C 12/10/2002- ref( 
C, -12 )."  The formula "ref( C, +12 )" returns 
the closing price 12 periods ahead. 

Relative Momentum Index 
SYNTAX rmi( DATA ARRAY, PERIODS, 

MOMENTUM PARAMETER ) 
FUNCTION Calculates the predefined Relative 

Momentum Index.  
EXAMPLE rmi( c,20,20 ) 

Relative Strength Index (RSI) 
SYNTAX rsi( PERIODS ) 
FUNCTION Calculates the predefined RSI indicator.  
EXAMPLE rsi( 14 ) 

Relative Volatility Index 
SYNTAX rvi( PERIODS ) 
FUNCTION Calculates the predefined Relative Volatility 

Index.  
EXAMPLE rvi( 21 ) 

Round 
SYNTAX round( DATA ARRAY ) 
FUNCTION Rounds DATA ARRAY to the nearest 

integer.  
EXAMPLE The formula "round( +10.5 )" returns +11.  

The formula "round( -10.4 )" returns -10. 
SEE ALSO The ceiling() function on page 255; the floor() 

function on page 260; the int() function on 
page 265. 

Security Data 
SYNTAX security("SYMBOL",DATA ARRAY) 
FUNCTION Returns the value of DATA ARRAY for the 

specified security.  If the security is in the 
same folder as the base security, a path is 
not required.  You may also specify online 
data by using ONLINE: as the path. 

EXAMPLES security("c:\MetaStock Data\Sample\IBM",C) 
 security("ONLINE:IBM",C) 
 security("IBM",C) 
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Selling Pressure 
SYNTAX sellp() 
FUNCTION Calculates the selling pressure component of 

the Demand Index (see page 459).  Selling 
pressure is a measurement of the amount of 
volume related to selling. 

Sine 
SYNTAX sin( DATA ARRAY ) 
FUNCTION Returns the sine of DATA ARRAY.  This 

function assumes that the DATA ARRAY 
values are in degrees.  

EXAMPLE You can plot a sine wave using the formula 
"sin(cum(5))."  Increasing the value in this 
formula (i.e., "5") will increase the frequency 
of the sine wave. 

SEE ALSO The atan() function (see page 253); the cos() 
function (see page 256). 

Square Root 
SYNTAX sqrt( DATA ARRAY )  
FUNCTION Calculates the square root of DATA ARRAY.  

The square root of a negative number always 
returns a zero result.  

EXAMPLE The formula "sqrt( 16 )" returns 4. 
SEE ALSO The Standard Deviation example formula 

(31008). 

Standard Deviation 
SYNTAX stdev( DATA ARRAY, PERIODS ) 
FUNCTION Calculates the predefined Standard 

Deviation indicator.  
EXAMPLE stdev( CLOSE, 21 ) 

Standard Error 
SYNTAX ste( DATA ARRAY, PERIODS ) 
FUNCTION Calculates the predefined Standard Error 

indicator. 
EXAMPLE ste( CLOSE, 21 ) 

Standard Error Band Bottom 
SYNTAX stebandbot( DATA ARRAY, PERIODS, 

ERRORS ) 
FUNCTION Calculates the bottom Standard Error Band 

of DATA ARRAY shifted downward 
ERRORS standard errors. 

EXAMPLE stebandbot( close, 21, 2 ) 



 

 
 

MetaStock Professional The MetaStock Formula Language • 281 

 

 

 

Standard Error Band Top 
SYNTAX stebandtop( DATA ARRAY, PERIODS, 

ERRORS ) 
FUNCTION Calculates the bottom Standard Error Band 

of DATA ARRAY shifted upward ERRORS 
standard errors. 

EXAMPLE stebandtop( close, 21, 2 ) 

Stochastic Momentum Index 
SYNTAX stochmomentum( PERIODS, SMOOTHING, 

DOUBLE SMOOTHING ) 
FUNCTION Calculates the predefined Stochastic 

Momentum Index.  
EXAMPLE stochmomentum( 10,40,3 ) 

Stochastic Oscillator 
SYNTAX stoch( %K PERIODS, %K SLOWING )  
FUNCTION Calculates the predefined Stochastic 

Oscillator.  
EXAMPLE The formula "stoch( 5, 3 )" returns the value 

of a 5-period %K slowed 3-periods. 
SEE ALSO The Stochastic example formula (see page 

311). 

Subtraction 
SYNTAX sub( DATA ARRAY, DATA ARRAY ) 
FUNCTION Calculates DATA ARRAY minus DATA 

ARRAY.  
EXAMPLE The formula "sub( 10, 2 )" returns eight.  

(This formula also could be written as "10 - 
2.") 

SEE ALSO The add() function (see page 253). 

Summation 
SYNTAX sum( DATA ARRAY, PERIODS ) 
FUNCTION Calculates a cumulative sum of the DATA 

ARRAY for the specified number of lookback 
PERIODs (including today).  

EXAMPLE The formula "sum( CLOSE, 12 )" returns the 
sum of the preceding 12 closing prices.  A 
12-period simple moving average could be 
written "sum(C,12) / 12." 

SEE ALSO The cum() function (see page 257). 

Swing Index 
SYNTAX swing( LIMIT MOVE ) 
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FUNCTION Calculates the predefined Swing Index 
indicator.  The Swing Index requires opening 
prices. 

EXAMPLE swing( 3.0 ) 
SEE ALSO The aswing() function (see page 253). 

Tema 
SYNTAX tema( DATA ARRAY, PERIODS ) 
FUNCTION Calculates the predefined TEMA indicator 
EXAMPLE tema( c,14 ) 
SEE ALSO The dema() function (see page 258). 

Theta 
SYNTAX theta( TYPE, DATE, PRICE, INTEREST, 

DIVIDEND ) 
FUNCTION Calculates the predefined Theta indicator.  

See the option() function (page 276) for a 
description of the parameters used in the 
theta() function. 

EXAMPLE theta( EC, 961220, 125, 7.50, 4.75 ) 
SEE ALSO The delta() function (see page 257); the 

gamma() function (see page 262); the life() 
function (see page 272); the option()  
function (see page 276); the vega() function  

 (see page 284); and the volo() function (see 
page 285). 

Tick 
SYNTAX tick() 
FUNCTION Plots the number of ticks that have come in 

during the current minute.  For example, if 
the current tick is recorded as 10:15:22, "22" 
represents the tick count in the 15th minute  
of the 10th hour.  At the start of the 16th 
minute, the tick count will reset to "0."  Note 
that this function only works on charts with 
an intraday interval set to "0" (i.e., tick 
charts).     
 
When plotted on tick charts, the value will 
range from 0 to 999—meaning up to 999 
ticks can be recorded in one minute.  Using 
this function on bar charts (e.g., 1-minute, 5-
minute, etc) will result in a value of zero.   

Time Series Forecast 
SYNTAX tsf( DATA ARRAY, PERIODS ) 
FUNCTION Calculates the predefined PERIODS Time 

Series Forecast indicator of DATA ARRAY.  
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EXAMPLE The formula "tsf( CLOSE, 10 )" returns a 10-
period Time Series Forecast of the closing 
prices. 

SEE ALSO The correl() function (see page 256). 

Trade Volume Index 
SYNTAX tvi( MINIMUM TICK ) 
FUNCTION Calculates the predefined Trade Volume 

Index.  
EXAMPLE tvi( 0.125 ) 
SEE ALSO The obv() function (see page 272) . 

TRIX 
SYNTAX trix( PERIODS )  
FUNCTION Calculates the predefined TRIX indicator.  
EXAMPLE trix( 12 ) 

Trough Bars Ago 
SYNTAX troughbars( Nth, DATA ARRAY, % 

MINIMUM CHANGE) 
FUNCTION Plots the number of bars that have passed 

from the Nth trough.  This uses the Zig Zag 
function (see page 287) to determine the 
troughs.  If Nth is 1, then this will return the  

 number of bars that have passed since the 
most recent trough.  If Nth is 2, this will 
return the number of bars that have passed 
since the 2nd most recent trough.  Etc. 

  EXAMPLE troughbars(1,close,5) 

Trough Value 
SYNTAX trough( Nth, DATA ARRAY, % MINIMUM 

CHANGE ) 
FUNCTION Plots the value of DATA ARRAY Nth 

trough(s) ago.  This uses the Zig Zag 
function (see page 287) to determine the 
troughs.  N=1 would return the value of the 
most recent trough.  N=2 would return the 
value of the 2nd most recent trough.  Etc. 

EXAMPLE trough( 1,close,5 ) 

Typical Price 
SYNTAX typical()  
FUNCTION Calculates the predefined Typical Price 

indicator.  

Ultimate Oscillator 
SYNTAX ult( CYCLE1, CYCLE2, CYCLE3 ) 
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FUNCTION Calculates the predefined Ultimate Oscillator 
indicator using the three cycle lengths 
supplied as parameters.  Note that each of 
the three parameters must be greater than 
the preceding parameter or an error 
message will be displayed (e.g., "ult( 5, 5, 5)" 
is not valid). 

EXAMPLE The formula "ult( 7, 14, 21 )" returns the 
default Ultimate Oscillator. 

Value When 
SYNTAX valuewhen ( Nth, EXPRESSION, DATA 

ARRAY ) 
FUNCTION Returns the value of the DATA ARRAY when 

the EXPRESSION was true on the Nth most 
recent occurrence.  This includes all data 
loaded in the chart. 

EXAMPLE The formula "valuewhen( 2, 
cross(c,mov(c,10,s), rsi(20) )" returns the 
value of the RSI on the 2nd most recent 
occurrence of the closing price crossing 
above its 10-day moving average. 

Variance 
SYNTAX var( DATA ARRAY, PERIODS ) 
FUNCTION Calculates the statistical variance of DATA 

ARRAY over the specified time PERIOD. 
EXAMPLE var( CLOSE, 20 ) 
SEE ALSO The stdev() function (see page 280) ; the 

Standard Deviation example (see page 310). 

Vega 
SYNTAX vega( TYPE, DATE, PRICE, INTEREST, 

DIVIDEND ) 
FUNCTION Calculates the predefined Vega indicator.  

See the option() function (page 2763) for a 
description of the parameters used in the 
vega() function. 

EXAMPLE vega( EC, 961220, 125, 7.50, 4.75 ) 
SEE ALSO The delta() function (see page 257); the 

gamma() function (see page 262); the life() 
function (see page 272); the option() function 
(see page 276); the theta() function (see 
page 282); and the volo() function (see page 
285). 

Vertical Horizontal Filter 
SYNTAX vhf( DATA ARRAY, PERIODS ) 
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FUNCTION Calculates the predefined Vertical Horizontal 
Filter of DATA ARRAY over the specified 
time PERIOD.  

EXAMPLE vhf( C, 28 ) 

Volatility, Chaikin's 
SYNTAX vol( MA PERIODS, ROC PERIODS ) 
FUNCTION Calculates the predefined Chaikin's Volatility 

indicator.  
EXAMPLE vol( 10, 10 ) 
 

Volatility, Option 
SYNTAX volo() 
FUNCTION Calculates the predefined Option Volatility 

indicator. 
EXAMPLE volo() 
SEE ALSO The delta() function (see page 257); the 

gamma() function (see page 262); the life() 
function (see page 272); the option()  
function (see page 276); the theta() function 
(see page 282); and the vega() function (see 
page 284). 

 

Volume Oscillator 
SYNTAX oscv( PERIODS, PERIODS, MA_METHOD, 

DIFF_METHOD) 
FUNCTION Calculates the PERIODS/PERIODS 

predefined Volume Oscillator indicator 
calculated using the MA_METHOD moving 
average method expressed in 
DIFF_METHOD.   
 
Valid MA_METHODs are SIMPLE, 
EXPONENTIAL, WEIGHTED, TIMESERIES, 
TRIANGULAR, and VARIABLE  (these can 
be abbreviated as S, E, W, T, TRI, and 
VAR).   
 
Valid DIFF_METHODs are PERCENT and 
POINTS (these can be abbreviated as % and 
$). 

EXAMPLE oscv( 1, 25, SIMPLE, $ ) 
SEE ALSO The oscp() function (see page 275). 

Weighted Close 
SYNTAX wc() 
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FUNCTION Calculates the predefined Weighted Close 
indicator. 

Wilder's Smoothing 
SYNTAX wilders( DATA ARRAY, PERIODS ) 
FUNCTION Calculates the predefined Wilder's 

Smoothing indicator.  
EXAMPLE wilders( CLOSE, 14 ) 
SEE ALSO The mov() function (see page 271). 

Williams' %R 
SYNTAX willr( %R PERIODS ) 
FUNCTION Calculates the predefined Williams' %R 

indicator.  
EXAMPLE willr( 14 ) 

Williams' A/D 
SYNTAX willa() 
FUNCTION Calculates the predefined Williams A/D 

indicator.  

Writeif 
SYNTAX writeif( EXPRESSION, "TRUE TEXT", 

"FALSE TEXT" ) 
 
FUNCTION This function can only be used within an 

expert commentary.  If EXPRESSION 
evaluates to "true", then the TRUE TEXT 
string is displayed within the commentary.  If 
EXPRESSION evaluates to "false", then the 
FALSE TEXT string is displayed. 

EXAMPLE writeif( c > mov(c,200,s), "The close is above 
the 200-period moving average.","The close 
is below the 200-period moving average." ) 

SEE ALSO For more detailed Information on using the 
writeif() function within an expert 
commentary, see page 408. 

Writeval 
SYNTAX writeval( DATA ARRAY ) 
 or 
 writeval( DATA ARRAY , FORMAT ) 
FUNCTION This function can only be used within an 

expert commentary.  It is used to display the 
numeric value and decimal format of DATA 
ARRAY.  The decimal format is X.Y where X 
is the total number of digits, and Y is the 
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number of digits to the right of the decimal 
point. 

EXAMPLE writeval( stoch(39,3) - stoch(12,3) ,5.2) 
SEE ALSO For more detailed Information on using the 

writeval() function within an expert 
commentary, see page 409. 

Year 
SYNTAX year() 
FUNCTION Plots the year.  If a bar was plotted on 

10/15/96, the function will return "1996." 

Zig Zag 
SYNTAX zig( DATA ARRAY, MINIMUM CHANGE, 

DIFF_METHOD ) 
FUNCTION Calculates the MINIMUM CHANGE 

predefined Zig Zag indicator of DATA 
ARRAY using the DIFF_METHOD method of 
calculation. 
 
Valid DIFF_METHODs are PERCENT and 
POINTS (these can be abbreviated as % and 
$). 

EXAMPLE zig( CLOSE, 5, PERCENT ) 



 

 
 

288 • The MetaStock Formula Language MetaStock Professional 

 

 

 

Candlestick Functions 
The Candlestick functions allow you to locate specific Japanese 
Candlestick patterns.  Each function plots a "+1" when the pattern is 
found; otherwise a "0" is plotted.  
The brief interpretations provided for the patterns shown on the following 
pages were taken from two books written by Steve Nison.   For more in-
depth coverage on these and other Japanese Candlestick patterns and 
charting techniques, Equis International recommends Mr. Nison's books:  
Japanese Candlestick Charting Techniques and Beyond Candlesticks.  See 
page 544 for more information on these books. 
Please note that candlestick pattern recognition is subjective.  What one 
person calls a "Big Black Candle" may not qualify as such for someone 
else.  To find these patterns on a chart, MetaStock Pro must rely on  
predefined rules.  These rules were defined based upon our own 
experience and with Steve Nison's assistance. 

Important:  When using the Candlestick functions in an exploration, 
you must choose the "Load __ Records" button in the Explorer Options 
dialog (see page 378) and specify at least “10”; otherwise the 
exploration results may be inaccurate. 

Bearish 3 Method Formation 
SYNTAX bear3formation() 

PATTERN  
 A long black body followed by three small, 

usually white, bodies and another long black 
body.  The three white bodies are contained 
within the first black body's range. 

INTERPRETATION A bearish continuation pattern.   

Bearish Harami 
SYNTAX bearharami() 

PATTERN       
A small black body is contained within an 
unusually large white body. 

INTERPRETATION A bearish pattern when preceded by an 
uptrend.   
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Bearish Harami Cross 
SYNTAX bearharamicross() 

PATTERN       
A Doji contained within a large white body. 

INTERPRETATION A top reversal signal. 

Big Black Candle 
SYNTAX bigblack() 

PATTERN       
An unusually long black body with a wide 
range between high and low, and prices 
open near the high and close near the low. 

INTERPRETATION A bearish pattern. 

Big White Candle 
SYNTAX bigwhite() 

PATTERN       
An unusually long white body with a wide 
range between high and low, and prices 
open near the low and close near the high. 

INTERPRETATION A bullish pattern. 

Black Body 
SYNTAX black() 

PATTERN       
A candlestick formed when the closing price 
is lower than the opening price. 

INTERPRETATION A bearish signal.  More important when part 
of a pattern. 

Bullish 3 Method Formation 
SYNTAX bull3formation() 
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PATTERN       
A long white body followed by three small, 
usually black, bodies and another long white 
body.  The three black bodies are contained 
within the first white body's range. 

INTERPRETATION A bullish continuation pattern. 

Bullish Harami 
SYNTAX bullharami() 

PATTERN       
A small white body is contained within an 
unusually large black body. 

INTERPRETATION A bullish pattern when preceded by a 
downtrend.   

Bullish Harami Cross 
SYNTAX bullharamicross() 

PATTERN       
A Doji contained within a large black body. 

INTERPRETATION A bottom reversal signal.   

Dark Cloud Cover 
SYNTAX darkcloud() 

PATTERN       
A long white candlestick is followed by a 
black candlestick.  The black candlestick 
opens above the white candlestick's high and 
closes well into the white candlestick's body. 

INTERPRETATION A bearish reversal signal during an uptrend. 
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Doji 
SYNTAX doji() 

PATTERN       
The open and close are the same. 

INTERPRETATION Doji lines are usually components of many 
important candlestick patterns. 

Doji Star 
SYNTAX dojistar() 

PATTERN       
A Doji which gaps above or below a white or 
black candlestick. 

INTERPRETATION A reversal signal with confirmation during the 
next trading day. 

Engulfing Bearish Line 
SYNTAX engulfingbear() 

PATTERN       
A small white body followed by and 
contained within a large black body. 

INTERPRETATION A major top reversal signal. 

Engulfing Bullish Line 
SYNTAX engulfingbull() 

PATTERN       
A small black body followed by and 
contained within a large white body. 

INTERPRETATION A major bottom reversal signal. 

Evening Doji Star 
SYNTAX eveningdojistar() 
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PATTERN       
A large white body followed by a doji that 
gaps above the white body.  The third 
candlestick is a black body that closes well 
into the white body. 

INTERPRETATION A major top reversal signal, more bearish 
than the regular evening star pattern 
because of the Doji. 

Evening Star 
SYNTAX eveningstar() 

PATTERN       
A large white body followed by a small body 
(white or black) that gaps above the white 
body.  The third candlestick is a black body 
that closes well into the white body. 

INTERPRETATION A major top reversal signal. 

Falling Window 
SYNTAX fallingwindow() 

PATTERN       
A window (i.e., gap) between the low of the 
first candlestick and the high of the second 
candlestick.  This produces the same results 
as the Gap Down function (see page 262). 

INTERPRETATION A rally to the window is highly probable.  The 
window should provide resistance. 

Gravestone Doji 
SYNTAX gravestonedoji() 
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PATTERN       
The open and close are at the low of the 
period. 

INTERPRETATION A market top reversal signal.  The longer the 
upper shadow the more bearish the signal. 

Hammer 
SYNTAX hammer() 

PATTERN       
A small body (white or black) near the high 
with a long lower shadow with little or no 
upper shadow. 

INTERPRETATION A bullish pattern during a downtrend. 

Hanging Man 
SYNTAX hangingman() 

PATTERN       
A small body (white or black) near the high 
with a long lower shadow with little or no 
upper shadow.  The lower shadow should be 
two or three times the height of the body. 

INTERPRETATION A bearish pattern during an uptrend.   

Inverted Black Hammer 
SYNTAX invblackhammer() 

PATTERN       
An upside-down hammer with a black body. 

INTERPRETATION A bottom reversal signal with confirmation 
the next trading day. 

Inverted Hammer 
SYNTAX invhammer() 

PATTERN       
An upside-down hammer (white or black). 

INTERPRETATION A bottom reversal signal with confirmation 
the next trading day. 

Long Legged Doji 
SYNTAX longleggeddoji() 
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PATTERN       
A Doji pattern with very long upper and lower 
shadows. 

INTERPRETATION A market top reversal signal. 

Long Lower Shadow 
SYNTAX longlowershadow() 

PATTERN       
A candlestick (black or white) with a lower 
shadow that has a length 2/3 or more of the 
total range of the candlestick. 

INTERPRETATION A bullish signal, particularly when around 
price support levels. 

Long Upper Shadow 
SYNTAX longuppershadow() 

PATTERN       
A candlestick (black or white) with an upper 
shadow that has a length 2/3 or more of the 
total range of the candlestick. 

INTERPRETATION A bearish signal, particularly around price 
resistance levels. 

Morning Doji Star 
SYNTAX morningdojistar() 

PATTERN       
A large black body followed by a doji that 
gaps below the black body.  The third 
candlestick is a white body that closes well 
into the black body. 

 



 

 
 

MetaStock Professional The MetaStock Formula Language • 295 

 

 

 

INTERPRETATION A major bottom reversal signal, more bullish 
than the regular morning star pattern 
because of the Doji. 

Morning Star 
SYNTAX morningstar() 

PATTERN       
A large black body followed by small body 
(white or black) that gaps below the black 
body.  The third candlestick is a white body 
that closes well into the black body. 

INTERPRETATION A major bottom reversal signal. 

On Neck-Line 
SYNTAX onneckline() 

PATTERN       
A black candlestick in a downtrend followed 
by a small white candlestick with its close 
near the low of the black candlestick. 

INTERPRETATION A bearish pattern where the market should 
move lower when the white candlestick's low 
is penetrated. 

Piercing Line 
SYNTAX piercingline() 

PATTERN       
A black candlestick followed by a white 
candlestick that opens lower than the black 
candlestick's low, but closes more than 
halfway into the black body. 

INTERPRETATION A bottom reversal signal. 

Rising Window 
SYNTAX risingwindow() 
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PATTERN       
A window (i.e., gap) between the high of the 
first candlestick and the low of the second 
candlestick.  This produces the same results 
as the Gap Up function (see page 262). 

INTERPRETATION A selloff to the window is highly probable.  
The window should provide support. 

Separating Lines 
SYNTAX separatinglines() 

PATTERN       
In an uptrend, a black candlestick is followed 
by a white candlestick with the same opening 
price. 

      
In a downtrend, a white candlestick is 
followed by a black candlestick with the 
same opening price. 

 
INTERPRETATION A continuation pattern.  The prior trend 

should resume. 

Shaven Bottom 
SYNTAX shavenbottom() 

PATTERN       
A candlestick (white or black) with no lower 
shadow. 

INTERPRETATION See Inverted Hammer (see page 293) 
interpretation. 

Shaven Head 
SYNTAX shavenhead() 
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PATTERN       
A candlestick (white or black) with no upper 
shadow. 

INTERPRETATION See Hammer (see page 293) and Hanging 
Man (see page 293) interpretations. 

Shooting Star 
SYNTAX shootingstar() 

PATTERN            
A candlestick (white or black) with a small 
body, long upper shadow, and little or no 
lower shadow.   

INTERPRETATION A bearish pattern in an uptrend. 

Spinning Top 
SYNTAX spinningtop() 

PATTERN       
A candlestick (white or black) with a small 
body.  The size of the shadows is not 
important. 

INTERPRETATION A neutral pattern.  Spinning tops are more 
important when part of other formations. 

Three Black Crows 
SYNTAX 3blackcrows() 

PATTERN       
Three long black candlesticks with 
consecutively lower closes that close near or 
at their low prices. 

INTERPRETATION A top reversal signal. 

Three White Soldiers 
SYNTAX 3whitesoldiers() 

PATTERN       
Three white candlesticks with consecutively 
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higher closes that close near or at their high 
prices. 

INTERPRETATION A bottom reversal signal. 

Tweezer Bottoms 
SYNTAX tweezerbottoms() 

PATTERN       
Two or more candlesticks with matching 
bottoms.  The size or color of the candlestick 
does not matter.  The candlesticks do not 
have to be consecutive. 

INTERPRETATION Minor reversal signal that is more important 
when the candlesticks form another pattern. 

Tweezer Tops 
SYNTAX tweezertops() 

PATTERN       
Two or more candlesticks with matching 
tops. 

INTERPRETATION Minor reversal signal that is more important 
when the candlesticks form another pattern.  
The candlesticks do not have to be 
consecutive. 

White Body 
SYNTAX white() 

PATTERN       
A candlestick formed when the closing price 
is higher than the opening price. 

INTERPRETATION A bullish signal.  More important when part of 
a pattern. 
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Creating Your Own Indicators 

What is the Indicator Builder? 
With all the built-in indicators that MetaStock Pro offers, you may be 
wondering why you'd ever need to create your own indicators.  Well, 
technical analysis is constantly evolving.  The hot new indicator of today 
is soon overshadowed by another.  For this reason, MetaStock Pro 
provides a powerful tool called the Indicator Builder that lets you create 
indicators. 
Maybe you've read about a new indicator in a trade magazine or a new 
book.  Chances are, you'll be able to create the indicator with the 
Indicator Builder.   
The Indicator Builder is considered a "power tool, " that is, it is not 
considered a mainstream, basic feature of the program.  To effectively 
use the Indicator Builder, you'll need to understand basic mathematical 
concepts and logical expressions. 
Due to the inherent complexity in the design and creation of custom 
indicators, trading systems, explorations, and experts, Equis cannot 
provide free support for this process.  However, support is available for 
a reasonable fee.  Call Equis at 801-265-9998 for details or fill-out the 
FORMULA HELP.DOC file found in the MetaStock Pro folder.  This 
file is viewable with Wordpad.   
For information on the Equis Solution Provider program and the 
MetaStock Developer's Kit, go to www.equis.com. 
Indicators created with the Indicator Builder are plotted exactly like  
built-in indicators.  They can be dragged from the Indicator QuickList or 
plotted from the Indicators dialog. 
If you are familiar with writing formulas in spreadsheet programs (i.e., 
Microsoft Excel, Lotus 1-2-3, etc.), this probably looks familiar to you.  
You may be able to start writing your own indicators immediately.  If this 
looks foreign to you, don't worry--the Indicator Builder Tutorial will help 
you get up to speed. 
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Indicator Builder Tutorial 

The Basics 
In addition to the predefined indicators listed in the Indicator QuickList 
(see page 165), MetaStock Pro provides a robust collection of tools that 
you can use to create your own indicators.  This chapter explains how to 
create and plot these "custom indicators."   
In order to create a custom indicator, you need to be familiar with the 
MetaStock formula language.  For more detailed information on the 
MetaStock formula language, see page 235. 
You can create up to 2,000 different custom indicators.  The indicators 
are automatically stored by MetaStock Pro so that you do not have to re-
enter them each time you want to plot the formula. 
The formulas created at the Indicator Builder menu and the formulas used 
to calculate the built-in indicators (i.e., Stochastics, RSI, etc.)  are 
completely independent of each other.  Changes made to the custom 
indicators will not affect the predefined indicators. 

The Indicator Builder Dialog 
With a chart on the screen, choose Indicator Builder from the Tools 
menu.  The Indicator Builder dialog will appear (the custom indicators 
appearing in your list will be different than the ones shown below).  The 
Indicator Builder dialog is the jumping off point for creating new custom 
indicators and/or editing existing custom indicators. 

 

Creating a New Custom Indicator 
1. With the Indicator Builder dialog displayed, click the New button.  

Type the name of the formula as "Tutorial."   
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2. Click the Display in QuickList checkbox so that the custom 
indicator will appear in the Indicator QuickList on the standard 
toolbar. 

3. Click in the Formula edit box where you can begin writing the actual 
formula. 

 
4. Type the following formula in the Formula edit box.  

 
close - mov(close,20,simple) 
 
This formula simply subtracts a 20-period simple moving average 
from the close.  For more detailed information on the MetaStock 
formula language, see page 235. 

5. Click the OK button to save the new "Tutorial" custom indicator. 

Plotting a Custom Indicator 
1. Click on the Indicator QuickList (see page 165) to display the built-

in and custom indicators. 
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2. Drag the custom indicator named "Tutorial" from the QuickList and 

drop it on a chart's title bar.  A new inner window will open and plot 
the results of the custom indicator. 

 
Custom indicator icon 

You can distinguish a custom indicator from other indicators in the 
QuickList by the unique icon to the left of the custom indicator's name.   

Indicator Builder Dialog 

 
Indicator Builder button 

The Indicator Builder dialog is displayed by choosing Indicator Builder 
from the Tools menu or the Indicator Builder button on the standard 
toolbar. 

 
New.  This displays the Indicator Editor dialog from which you can 
name and define a new custom indicator.   
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Edit.  This displays the Indicator Editor dialog from which you can edit 
the selected custom indicator.   
Copy.  This makes a copy of the selected custom indicator in the 
Indicator Editor dialog.  After making any changes, press the OK button 
to save a copy of the custom indicator.  See page 304 for more 
information on copying custom indicators. 

You can select multiple 
custom indicators by 
holding down the SHIFT 
or CTRL key as you click 
the mouse. 

Delete.  This deletes the selected custom indicators.  See page 304 for 
more information on deleting custom indicators. 
 
Print.  This prints the selected custom indicators.  See page 304 for more 
information on printing custom indicators. 
Organize.  Use this to display the Formula Organizer Wizard from which 
you can import and export explorations, system tests, custom indicators, 
and experts.  This is normally used if you have purchased add-on products 
from Equis or a third party.  See page 249 for more information on the 
Formula Organizer Wizard. 

Indicator Editor Dialog 
The Indicator Editor dialog is used to create new custom indicators and to 
edit existing custom indicators. 

 
Name.  You can enter a name with up to 50 characters.  The name you 
enter will appear in the inner window title bar when plotted.  The list of 
custom indicators in the Indicator Builder dialog is sorted by name. 
Display in QuickList.  Check this box if you want the name of the 
custom indicator to appear in the QuickList.  Once in the QuickList, it  
can be dragged and dropped just like any other indicator (see page 165). 
Formula.  Enter the formula for the custom indicator here.  A formula 
can contain up to 2,500 characters on multiple lines.  Press ENTER to 
place a line break.  See page 248 for tips on using multiple lines.  See 
page 235 for more information on the MetaStock formula language. 
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Functions.  This displays the Paste Functions dialog where you can 
choose from a list of available functions and have the function pasted in 
the formula.  This button is disabled unless your cursor is in the Formula 
edit box.  See page 305 for more information. 
You can use the standard clipboard commands (accelerator keys only) 
while editing a formula (see page 249).  

Copying and Deleting Custom Indicators 
You can make a copy of the selected custom indicator in the Indicator 
Builder dialog using the Copy button.  This is useful when you want to 
design a new custom indicator that is very similar to another.   
For example, if Custom Indicator A was very similar to a new indicator 
you want to create, you could save time by using the Copy command in 
the Indicator Builder dialog to make a copy rather than rewriting it.  You 
could then make the minor modifications necessary and give it a new 
name.   
You delete the selected custom indicators from the Indicator Builder 
dialog using the Delete button.  The Delete button displays the Delete 
Custom Indicator dialog. 

Printing Custom Indicators 
You can print the names and/or formulas of the selected custom 
indicators to the default printer using the Print dialog.  The Print dialog is 
accessed by choosing Print from the Indicator Builder dialog. 

 
Print What.  Choose whether you want to print the Names Only or the 
Names and Formulas for the selected custom indicators. 
Copies.  Choose the number of copies to print. 
Print Range.  Choose whether you want to print the Selected Custom 
Indicator(s) or All Custom Indicators. 
Printer.  This displays a dialog from which you can select the desired 
printer, orientation, and paper size. 
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Pasting Functions Into Formulas 
Use the Functions button at the bottom of the Indicator Editor dialog to 
paste functions directly into the formula you are editing.  Not only does 
this feature save time, but it also relieves you from having to memorize  
the functions (or refer to the manual) and their parameters.  (See page 252 
for information on the specific functions available.) 

 
The Paste Functions dialog breaks the functions down into 12 categories.  
The categories are listed in the Function Category list on the left side of 
the dialog.  The functions for the selected category are listed to the right 
either by their English name or their function name, depending on 
whether the Show English Names checkbox is checked.  MSX DLL's will 
also be listed as categories, with their included functions.  For more 
information on creating MSX DLL's using the MetaStock Developer's 
Kit, go to www.equis.com. 
As you scroll the Paste Function list, the syntax of the highlighted 
function is displayed near the bottom of the dialog.  If you want the 
arguments of the function pasted, check the Paste Arguments checkbox. 
Clicking the OK button (or double-clicking the function name) pastes the 
selected function into the formula at the cursor location. 

To paste a function in a formula  
1. While editing a formula in the Indicator Editor dialog, click the 

Functions button. 
2. Click on a category from the Functions Category list.  
3. Double-click the name of the function to paste. 
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Creating Custom Indicators with Multiple Plots 
Many indicators require two or more plots for their correct interpretation.  
One such indicator is the MACD.  The MACD uses a moving average 
(called the signal line) to generate crossover signals.   
Every unassigned expression (i.e., those expressions not assigned to a 
variable) in a custom indicator will result in a separate plot on the chart.  
For example, the following formula entered as a custom indicator will 
result in two plots: 
DiffOfAvg:= mov(c,39,s)-mov(c,200,s); 
DiffOfAvg; 
mov(DiffOfAvg, 9,s); 

The first statement assigns the expression "mov(c,39,s)-mov(c,200,s)" to 
a variable named "DiffOfAvg."  The second statement results in a plot of 
DiffOfAvg.  The third statement results in a plot of a 9-period moving 
average of DiffOfAvg.  Notice that each expression must end with a 
semi-colon. 
If you use the fml() function (see page 242)  to call a custom indicator 
containing multiple plots, only the last plot in the custom indicator will 
be returned by the fml() function. 
For example, if a formula using the fml() function called the following 
custom indicator, only the 10-period moving average would be returned, 
since it is the last plot. 
mov(close,30,s); 
mov(close,20,s); 
mov(close,10,s);   

To change the color of the individual plots of a multiple plot indicator, 
plot the indicator, then change the properties of each plot. 

To change the colors of a multiple plot indicator 
1. Plot the indicator from the QuickList or the Indicators dialog. 
2. Right click the plot that you would like to change. 
3. Choose Properties from the shortcut menu. 
4. Change the color, then click OK. 

Creating Custom Indicators that Prompt for Input 
Most of the pre-defined indicators in MetaStock Pro prompt you for input 
to use during the calculation (e.g., time periods, percent, points, etc.).  
You can also instruct custom indicators to prompt for input by using a 
special function called input(). 
The input() function uses the following syntax: 
input("prompt text",minimum value, maximum value, 
default value); 
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Prompt text.  This defines the text that is displayed next to the input box.  
This is used to describe what should be entered. 
Minimum value.  This is the smallest value that can be entered.  If you 
attempt to enter a value smaller than this value, MetaStock Pro displays a 
message. 
Maximum value.  This is the largest value that can be entered.  If you 
attempt to enter a value larger than this value, MetaStock Pro displays a 
message. 
Default value.  This is the default value (i.e., the value that will appear in 
the box when the dialog is initially displayed).  Note that the default 
value is always used when another formula calls the custom indicator 
using the fml() function. 
A maximum of six input() functions can be used within a custom 
indicator.   MetaStock Pro prompts for all inputs before the custom 
indicator is calculated, regardless of where the input() functions appears 
in the custom indicator.  You can only use the input() function in custom 
indicators.  System tests, explorations, and experts will not accept the 
input() function.   
If you use the fml() function (see page 261) to call a custom indicator that 
uses the input() function, you will not be prompted for the inputs in the 
referenced custom indicator.  All inputs in a referenced custom indicator 
automatically use their default values. 
The following custom indicator will prompt you for the number of time 
periods to use for the moving average (i.e., smoothing periods) of the RSI 
indicator: 
SmoothingPeriods:= input("Enter the number of RSI 
smoothing periods",1,9,3); 
mov(rsi(14), SmoothingPeriods,s); 

When the custom indicator is plotted, the following input dialog appears 
prompting you to "Enter the number of RSI smoothing periods".  Note 
that if your custom indicator required multiple inputs, all of the inputs 
would appear in this dialog. 
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In almost all cases you will want to assign the input() function to a 
variable (as shown in the previous example); otherwise it has very limited 
use.  The input() function cannot be embedded within other functions.  
For example, the following use of the input() function is not valid: 
 
mov(close, input("Enter periods",1,39,10), simple); 

 

However, this can be rewritten using a variable as follows: 
 
maperiods:= input("Enter periods",1,39,10); 
mov(close,maperiods,simple); 
 
The only potential use of the input() function as a stand-alone expression 
is to plot a horizontal line at a specified value: 
 
Input("Plot a horizontal line at ",1,10000,5); 

This custom indicator will plot a horizontal line at the input value.  This 
may prove useful for those that desire more precision (than the horizontal 
line study) when drawing support/resistance lines. 

Sample Custom Indicators 
This section provides samples of several popular indicators written with 
the MetaStock formula language.  These are simply provided as 
examples; all of these indicators are standard predefined indicators in 
MetaStock Pro (i.e., you don't need to create these to plot them).  
However, these do provide good examples of the MetaStock formula 
language.  
For information on interpreting these indicators, see page 441. 

Accumulation/Distribution 
This Accumulation/Distribution formula uses the cum() function (see 
page 257 ) to keep a running total of the daily values. 
 
cum( (((C-L) - (H-C)) / (H-L)) * V) 

Bollinger Bands 
Bollinger Bands use the stdev() function (see page 280) to calculate the 
upper and lower bands.  The middle band is a 20-period simple moving 
average. 
 
Periods:=input("Enter the number of periods:  
",5,50,20); 
mov(C, Periods, S); 
mov( C, Periods, S ) + ( 2 * stdev( C, Periods )); 
mov( C, Periods, S ) - ( 2 * stdev( C, Periods ))  
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Chaikin A/D Oscillator 
The Chaikin Oscillator can reference the predefined Accumulation/ 
Distribution indicator using the ad() function as shown below. 
ShortMA:= input("Enter shorter moving average 
periods",3,10,3); 
LongMA:= input("Enter longer moving average 
periods",10,30,10); 
mov( ad(), ShortMA, E) - mov( ad(), LongMA, E); 
Or, it can include the actual Accumulation/Distribution formula as shown 
below. 
mov(cum((((C-L)-(H-C))/(H-L))*V),3,E)-mov(cum((((C-L)-
(H-C))/(H-L))*V),10,E) 

Median Price 
(high + low) / 2 

Momentum 
The Momentum formula uses the ref() function (see page 278) to 
reference the closing price 12 periods ago. 
(close / ref( close, -12 )) * 100 

Moving Average MACD 
Most analysts (including Equis International's) say that the MACD 
indicator is "the difference between 12-day and 26-day exponential 
moving averages."  However, the indicator is really the difference 
between 0.15 and 0.075 exponential moving averages (whereas, when 
expressed in decimal form, the 12- and 26-day exponential moving 
averages are actually 0.153846 and 0.076923 exponential moving 
averages).  See page 484 for more information on exponential moving 
average calculation methods. 
Due to these minor differences in the exponential values, the following 
formula is slightly different than the predefined MACD indicator.  
Remember that you can plot the true MACD indicator using the macd() 
function (see page 269). 
mov( close, 12, E) - mov( close, 26, E) 
The MACD's trigger (which is a 9-day exponential moving average of 
the MACD indicator) can be calculated as shown below: 
mov( macd(), 9, E) 

Negative Volume Index 
You must use the nvi() function to calculate the predefined Negative 
Volume Index.  However, a similar indicator can be calculated using the 
following formula: 
cum( if( V < ref(V,-1), roc(C,1,%), 0 )) 
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On Balance Volume 
The following formula calculates the On Balance Volume indicator: 
( If( C > Ref( C, -1), 1, If( C < Ref( C, -1 ), -1, 0 
) ) * VOLUME )   PREV 

Note that the PREV constant (see page 246) represents the value of the 
indicator on the previous day. 

Positive Volume Index 
You must use the pvi() function to calculate the predefined Positive 
Volume Index.  However, a similar indicator can be calculated using the 
following formula: 
cum( if( V > ref(V,-1), roc(C,1,%), 0)) 

Price Oscillator 
The following formula calculates a 10-period/20-period exponential Price 
Oscillator expressed in points: 
mov( close, 10, E) - mov( close, 20, E) 
The following formula calculates a 10-period/20-period exponential Price 
Oscillator expressed in percent:  
(( mov(C,10,E) - mov(C,20,E) )/mov(C,20,E)) * 100 

Price Rate-Of-Change 
The following formula calculates the 12-period Price Rate-Of-Change: 
(( C - ref(C,-12)) / ref(C,-12)) * 100 
The 12-period rate-of-change can also be written using the roc() function 
shown below: 
roc( close, 12, % ) 
The 12-period rate-of-change can be expressed in "points" using the 
following formula: 
close - ref(close, -12) 

Price Volume Trend 
The following formula uses the cum() function (see page 257) to 
calculate the Price Volume Trend: 
cum( ((C - ref(C,-1)) / ref(C,-1)) * V) 
This formula also can be written using the roc() function (see page 278) 
as shown below: 
cum( roc(close, 1, %) * volume ) 
Standard Deviation 
A 4-period Standard Deviation indicator can be written as follows.  The 
first statement assigns a 4-period simple moving average to the variable 
named "4PeriodMA".   The second statement sums the squares of the 
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differences between the moving average and the closing prices on each of 
the preceding four periods.  It then calculates the square root of this total. 
4PeriodMA:= Mov( CLOSE, 4, S ); 
Sqrt(( Power(4PeriodMA - C, 2) + 
Power((4PeriodMA)- Ref(C,-1), 2) + 
Power((4PeriodMA)- Ref(C,-2), 2) + 
Power((4PeriodMA)- Ref(C,-3), 2) ) / 4 ) 

An easier method is to take the square root of the variance function as 
shown below: 
sqrt( var( close, 4 ) ) 
Of course, the easiest way is to write the Standard Deviation formula 
using the predefined stdev() function (see page 280). 

Stochastic Momentum Index 
The following formula calculates a 13,25,2 Stochastic Momentum Index. 
100 * ( Mov( Mov(C - (0.5 * ( HHV(H,13) + 
LLV(L,13))),25,E),2,E) / (0.5*Mov( Mov( HHV(H,13) - 
LLV(L,13),25,E),2,E))) 

Stochastic Oscillator 
The following formula calculates a 5-period %K Stochastic Oscillator 
with 3-period slowing: 
(sum( C - llv(L,5), 3 ) / sum(hhv(H,5) - llv(L,5), 3) 
) * 100 
This next formula calculates a 3-period %D of the %K in the preceding 
formula. 
mov( stoch(5,3), 3, S ) 

Volatility, Chaikin 
The Volatility formula shown below uses 10-periods in the moving 
average and 12-periods in the rate-of-change: 
roc( mov( high-low, 10, E), 12, %) 

Volume Oscillator 
The following formula calculates a 10-period/20-period exponential 
Volume Oscillator expressed in points. 
mov( volume, 10, E) - mov( volume, 20, E) 
This next formula calculates a 10-period/20-period exponential Volume 
Oscillator expressed in percent.  
(( mov(V,10,E) - mov(V,20,E))/mov(V,20,E)) * 100 

Volume Rate-Of-Change 
The following formula a 12-period Volume Rate-Of-Change indicator. 
(( V - ref(V,-12)) / ref(V,-12)) * 100 
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This also can be written using the roc() function as shown below: 
roc( volume, 12, % ) 

Weighted Close 
The Weighted Close formula multiplies the closing price by two, adds the 
value of the high and low, and then divides by four. 
((close * 2) + high + low ) / 4 

Williams' Accumulation/Distribution 
To simplify the explanation of this formula, we will enter it as three 
formulas.  The first statement assigns the "true range" of the high to a 
variable.  Similarly, the second formula assigns the "true range" of the 
low to a variable.  The third statement calculates Williams' A/D indicator. 
TrueRangeHigh:=max( ref(close,-1), high ); 
TrueRangeLow:=min( ref(close,-1), low ); 
cum(if(C  > ref(C,-1),C-TrueRangeLow, if(C < ref(C,-
1),C-TrueRangeHigh,0))) 

Williams' %R 
This formula calculates the Williams %R indicator.  Notice that the 
formula is inverted by multiplying it by -100. 
NumPeriods:= Input("Enter the number of 
periods:",3,50,14); 

((HHV(H,NumPeriods) - C)/(HHV(H,NumPeriods) - 
LLV(L,NumPeriods))) * -100; 

Achelis Binary Waves 
This section explains how custom indicators can be used to create 
"Binary Wave" indicators that display your rating of a security's technical 
position.  Steven Achelis, President of Equis International, developed this 
Binary Wave concept. 
The Binary Wave concept is somewhat complicated.  You should be very 
familiar with custom indicators before reading this section. 

The Binary Wave 
A Binary Wave plots +1 or -1, depending on whether the indicator it 
interprets is bullish or bearish.  (The term "Binary Wave" is based on this 
±1 concept.)  The real power of Binary Waves occurs when multiple 
Waves are combined into composite Binary Waves. 
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Binary Waves are the opposite of black box trading systems (although 
both are considered "expert systems").  You don't know the rules or 
indicators that are used to analyze securities in a black box.  Conversely, 
you specify the rules and indicators in a Binary Wave. 

Example Binary Waves 
The following table shows the rules used in four Binary Wave indicators. 
(In an effort to keep these examples understandable, we only use four 
Waves and fairly simple criteria.  However, you could, and probably 
should modify the criteria based on your own expertise.) 

Indicator Bullish Bearish 
MACD > signal line <= signal line 

Moving Average close > Moving Avg. Close <= Moving Avg. 

Rate-Of-Change Rate-Of-Change > 0 Rate-Of-Change <= 0 

Stochastic > 50 <= 50 

As shown in this table, we consider the MACD bullish when it is above 
its signal line and bearish when it is equal to, or falls below, its signal 
line.  Thus, the MACD Binary Wave will plot ±1 depending on whether 
the MACD is above or below its signal line.  This same concept is used 
to develop three additional Binary Waves that plot ±1 based on the action 
of the other indicators. 
We will then combine the four Binary Waves into a composite Binary 
Wave.  When all four Binary Waves are bullish, the value of this 
composite Binary Wave will be +4; when all four Binary Waves are 
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bearish, its value will be -4; when two are bullish and two are bearish, its 
value will be zero. 

Entering the Example 
The individual Binary Waves should be assigned to variables in one 
custom indicator (named "Total Wave")  and then summed together as 
shown below. 
MACDWave:=if(macd() > mov(macd(),9,E), +1, -1); 
MovWave:=if(C > mov(C,20,E), +1, -1); 
ROCWave:=if(roc(C,12,%) > 0, +1, -1); 
StochWave:=if(stoch(5,3) > 50, +1, -1); 
MACDWave + MovWave + ROCWave + StochWave 

The first statement assigns the value "+1" if the MACD indicator is above 
its 9-period signal line.  Otherwise, it assigns "-1".  The second statement 
assigns "+1" if the close is above its 20-period exponential moving 
average.  Otherwise, it assigns "-1".  The third statement assigns "+1" if 
the 12-period percent rate-of-change of the closing prices is greater than  
0.  Otherwise, it assigns "-1".  The fourth statement assigns "+1" if the 
Stochastic Oscillator is above 50.  Otherwise, it assigns "-1".  The fifth 
statement combines the preceding four Binary Wave variables into a 
composite Binary Wave. 
The following chart shows the resulting plot: 

 
Note that a good composite Binary Wave will yield results that are 
superior to the results generated by the individual Binary Waves it 
incorporates. 
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Interpreting a Binary Wave 
The interpretation of a Binary Wave is fairly obvious:  high values are 
bullish and low values are bearish.  (Remember that individual Binary 
Waves plot as either +1 or -1; the range of composite Binary Waves 
depends on the number of individual Waves it combines.) 
The "Total Wave" system test (shown below) enters long when the 
indicator rises above zero and sells short when it falls below zero.  See 
page 320 for more information on creating system tests.  
Name  :  Total Wave 
Enter Long :  fml("Total Wave") < 0 
Close Long :  fml("Total Wave") > 0 
Enter Short :  fml("Total Wave") > 0 
Close Short :  fml("Total Wave") < 0 
You also could create an "MACD-type" formula by plotting the 
difference between two moving averages of a composite Binary Wave.  
Such a formula could be written as follows (name the formula "Smooth 
Total Wave"): 
mov(fml("Total Wave"), 12, E) - mov(fml("Total Wave"), 
26, E) 
To give you an idea of what a system test for this formula could look 
like, the Enter Long rule is shown below: 
Enter Long :  fml("Smooth Total Wave") > 0  

Enhancements 
Many enhancements can be made to Binary Wave formulas.  Several of 
these are discussed below. 
• The example composite Binary Wave presented on the preceding 

pages combines four individual Waves.  However, you may choose 
to include many more individual Waves to create your own expert 
system. 

• Rather than plotting ±1, you could weight the Binary Waves 
according to their forecasting ability.  For example, one component 
in a composite Binary Wave could plot ±5 while another component 
could plot ±0.75. 

• You can include a long-term component within a composite Binary 
Wave.  For example, you could add the following Binary Wave to 
the composite "Total Wave" previously presented: 
 
if(CLOSE > mov(CLOSE, 200, EXPONENTIAL),+10, -
10) 

The above formula would add ±10, depending on whether the closing 
price was above its 200-day moving average.  Thus the composite Binary 
Wave would range between +6  and +14 when this long-term component 
was bullish, and would range between -6 and -14 when it was bearish.  
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You could then buy long when the composite Binary Wave rose above 
+10, close your long positions when the composite fell below +10, sell 
short when the composite fell below -10, and cover your short positions 
when the composite rose above -10. 
• You may choose to have composite Binary Wave formulas return 

multiple values, rather than just ±1.  The following formula returns -2 
when the Stochastic Oscillator is less than 20, -1 when it is between 
20 and 40, 0 when it is between 40 and 60, +1 when it is between 60 
and 80, and +2 when it is above 80. 
if( stoch(5,3) < 20, {then} -2, 
  {else} if( stoch(5,3) < 40, {then} -1, 
    {else} if( stoch(5,3) < 60, {then} 0, 
      {else} if( stoch(5,3) < 80, {then} +1, 
        {else} +2))))   

• You may want to smooth a binary wave using a formula similar to the 
"Smooth Total Wave" and then plot a moving average signal line of 
the result.  A system test could be written to test for crossovers 
between the indicator and the moving average signal line. 

• Composite Binary Waves provide a method of rating a security's 
technical health based on your criteria.  For example, you might 
consider a composite Wave moderately bullish when it is between 0 
and +2. 

• You can plot the rate-of-change of a composite Binary Wave using 
the formula shown below: 
 
roc( fml("Total Wave"), 1, $) 

Each time this indicator spikes above zero, it signifies that at least one of 
the individual Binary Waves has turned bullish.  Similarly, spikes below 
zero show that an indicator has turned bearish. 

Summary 
Binary Waves display your evaluation of an indicator (e.g., "it is bullish 
when the MACD is above its 9-period moving average") as a ±1 
indicator.  Composite Binary Waves combine multiple Binary Wave 
indicators to illustrate your analysis of a security based on the actions of 
numerous indicators. 

Errors 

Math Errors 
If you attempt to plot (or execute) a formula that contains math errors, the 
following dialog will appear prior to plotting the indicator.  The dialog 
shows the number of occurrences for each error. 
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Division by zero.  A formula is dividing a value by zero.  For example,  
the formula "(ref(close,-1)-open)/(high-low)" will produce a division by 
zero error if the high and low are equal. 
Invalid exponentiation.  A formula produced a math error from the 
improper use of exponents. 
Invalid log.  A formula attempted to calculate the log of zero or the log 
of a negative number.  For example, the formula "log(high-low)" will 
produce the error if the high and low are equal. 
Invalid power.  A formula is attempting to calculate a negative number 
raised to a power less than one. 
Modulus by zero.  The second data array of the mod() function results 
in zero.  For example, the formula "mod(close, high-low)" will produce 
the error if the high and low are equal. 
Negative square root.  Your formula is attempting to calculate the 
square root of a negative number.  For example, the formula "sqrt(open-
close)" will produce an error if the close is higher than the open. 

Custom Indicator Error 
The Custom Indicator Error dialog will appear if a run-time error occurs 
while calculating a custom indicator.  Any error that is not a "math" error 
qualifies as a run-time error. 
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Remove this indicator from the chart.  The indicator is removed 
from the chart so that it will not calculate again. 
Keep this indicator in the chart.  The indicator will calculate again 
with the next data update of the chart and any errors that occur will be 
reported. 
Don't show future errors for this indicator in this chart.  The 
indicator will calculate again with the next data update of the chart.  Any 
errors that occur will not be reported.  Note that the errors will be 
suppressed only for the indicator in the current chart.  
 
Note that this dialog may also appear if you have changed the folder 
listed in the File Locations page in the Application Options dialog (see 
page 33). 
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Testing Your Trading Ideas 

What is a System Test? 
System testing involves the development and testing of trading systems to 
determine the systems' historical profitability.  System testing helps 
answer the question, "If I had traded this security using these trading 
rules, how much money would I have made or lost?" 
You can use MetaStock Pro to: 
• Write trading systems using your own trading rules. 
• Test your trading systems. 
• Examine the test results by plotting buy/sell arrows and equity lines, 

and by examining tabular reports. 
• Automatically optimize parameters within your trading rules to 

improve the results. 
• Compare trading systems to find out which trading system works 

best on a particular security. 
It is very important that you read the System Tutorial that begins on the 
following page before developing your own trading systems. 
Due to the inherent complexity in the design and creation of custom 
indicators, trading systems, explorations, and experts, Equis cannot 
provide free support for this process.  However, support is available for 
a reasonable fee.  Call Equis at 801-265-9998 for details or fill-out the 
FORMULA HELP.DOC file found in the MetaStock Pro folder.  This 
file is viewable with Wordpad.   
System trading rules use the same syntax as custom indicators.  If you are 
unfamiliar with the MetaStock formula language, see page 235. 
When developing trading systems, please keep in mind that technical 
analysis is a dynamic tool (possibly an art) and as such, no mechanical 
system is flawless.  Don't let yourself get caught in the trap of 
"overfitting" your system to a specific set of data.  For tips on system 
development, see page 359.   
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Enhanced System Tester Tutorial 
 

This short tutorial introduces several terms and concepts relating to 
system testing.  It is important that you read this tutorial before you create 
your own trading systems.  You should also be familiar with the 
MetaStock formula language (see page 235) and custom indicators (see 
page 300). 

Step 1 - Open The Enhanced System Tester 

 
Enhanced System Tester 
button 

Choose Enhanced System Tester from the Tools menu or click the 
Enhanced System Tester button on the standard toolbar.   

 
The Enhanced System Tester lets you create, test, compare, print, and 
report your system tests.   

Step 2 - Create Two New Systems  
1. With the Enhanced System Tester displayed, click the New System 

button in the upper left corner. The System Editor dialog appears. 
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The General page of the System Editor dialog has text entry boxes 
for the system's name and notes, and three options. Don’t worry 
about the three options for now; they’re explained in detail later in 
this chapter (page 331). 

2. In the Name field, type the system name, "My First System" (do not 
enter the quotation marks in this or the remaining examples). 

3. Click the Buy Order tab and enter the following trading rule for 
entering a long position(buy order) in the Formula text box: 
 
cross(close, mov(close,25,simple)) 
 

The preceding rule, as with most trading rules in MetaStock Pro, can 
be read in English.  It says, "Buy the security" when the close 
crosses above a 25-period simple moving average of the close."  (As 
with custom indicators,  you can abbreviate "close" to "c" and 
"simple" to "s".)  
Trading rules (see page 365) are very similar to custom indicators 
(see page 299). 
Just ignore the other options on the Buy Order page; they’ll be 
explained later in this chapter. 

4.  Enter the following information for the next three trading rules.  
Remember to click on the corresponding tabs (i.e., Sell Order, Sell 
Short Order, and Buy to Cover Order) to enter each of the rules. 
 
Sell Order: cross(mov(close,25,simple),close) 
Sell Short Order: cross(mov(close,25,simple),close) 
Buy to Cover Order: cross(close,mov(close,25,simple)) 
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If a syntax error exists in your trading rules, a message explaining 
the error will appear.  Click the OK button to acknowledge the error.  
The System Editor will reappear with the cursor placed at the 
position where the error exists.  You should then correct the error 
and reselect OK.  

5. When the four trading rules have been entered correctly, click the 
OK button. 

6. With My First System highlighted, click the Copy button at the top 
of the screen.  A Copy of My First System appears at the top of the 
system list. 

7. Click the Copy of My First System to highlight it, then click the Edit 
button. 

8. In the General page, change the name to "My Second System". 
9. In the trading rules (Buy Order, Sell Order, Sell Short Order, Buy to 

Cover Order), change the 25's to 50's. 
10. Click OK. 

Step 3 - Test the Systems 
1. When the Enhanced System Tester reappears (and "My First System" 

is highlighted), click the New Simulation button. The Perform 
Trading Simulation wizard appears. 

2. The first dialog in the wizard is the Select Systems dialog. Find “My 
First System” in the list and highlight it.  

3. Hold the Ctrl key and click "My Second System" to select it also. 
4. Click Next. The Select Securities dialog appears. 
5. Click the Add Securities button. The Add Securities dialog appears, 

where you can select any number of local or online securities. 
6. Select ten securities (using the Ctrl key), then click Open. You 

return to the Select Securities dialog. 
7. Click Next. The System Testing Options dialog appears. We're not 

changing any options for this tutorial, but this dialog is described on 
page 341. 

8. In the System Testing Options dialog, click Next. The Begin Trading 
Simulation dialog appears. 

9. Type "My First Simulation" in the field under the words "The 
System Tester will now perform the simulation". 

10. Click Start. The Perform System Test wizard closes, and a small 
window appears, showing you details about the simulation's 
progress. A blue bar next to a dollar sign in the lower right corner of 
the MetaStock workspace also indicates the test’s progress.  

11. When the test is complete, click View Results. 
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Step 4 - View the Results 
1. When you click the View Results button, the Enhanced System 

Tester's Test View appears. 
 

 
Since we tested more than one system, this screen compares the 
systems' performance. The graph at the top shows each system's 
average net profit. You can also sort the systems in the list below the 
graph by clicking the Avg. Net Profit column (or any other column 
in the list).  

2. In this example, "My Second System" had the highest average net 
profit. In the lower pane, double-click on "My Second System." 
Another version of the Test View appears. 
 

 
This screen is also divided into two main sections. The graph in the 
top section shows what each security's equity would have been if the 
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system had been followed. The bottom section shows a list of all the 
securities the system tested, with more detailed information about 
their data and their performance in the simulation. You can sort the 
securities in the list by clicking any of the column headings (like Net 
Profit). 
 

3. In the list, click a security that performed well in the simulation (had 
a high net gain or profit/loss ratio) and click the View button to 
display the Result Details View. (If none of the securities were 
profitable, select the one that lost the least money, then click View.) 

 
 

Five reports are available from the Details View dialog. For more 
information about what these reports tell you, see page 345. 

Step 5 - Optimizing 
Optimizing involves replacing components of trading rules or stops with 
"OPT" variables and then specifying the range of values to be tested.  
MetaStock Pro then performs multiple tests, replacing the OPT variables 
with values from the range you specified. 
"My First System" in this tutorial tested the buy/sell signals generated by 
a 25-period moving average.  We will now have MetaStock Pro optimize 
our trading rules to determine the optimum number of periods to use for 
the moving average. 

Entering The Optimization Variable 
1. With the Enhanced System Tester displayed, select "My First 

System" and click the Edit... button.  In the four trading rules we 
created in Step 2 - Create Two New Systems, replace the "25" with 
"OPT1" (for optimization variable number 1).  This is shown for the 
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Buy Order rule in the following illustration: 
 

 
 

2. Click the Optimization tab.  The Optimization page appears. 

System Editor

CancelOK Help

General Buy Order Sell Order Sell Short Buy to Cover Stops Optimization

Optimization Variables

Name Description Minimum Maximum Step Status New...

Edit...

Delete...

OPT1 Periods in moving average 10 200 1 In Use

Total Tests: 191

 

3. Click OPT1 in the list. 
4. Click the Edit button.  The Variable Properties dialog appears. 

We want to test the moving average from 10-periods to 50-periods, 
by five period increments (i.e., 10, 15, 20, etc.). 
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5. Enter "Moving average periods" as OPT1's description.  Type a 
Minimum value of 10, a Maximum value of 50, and a Step value of 5 
(as shown in the following illustration). 

 
6. Click OK. 
7. Look at the Total Tests value at the bottom of the Optimization 

Variables dialog.  This value shows the total number of tests (nine in 
this case) that will be performed.  It's always wise to check this value 
after editing the optimization variables, as it is very easy to create a 
system that will generate thousands of tests. 

8. Click OK in the System Editor dialog to return to the Enhanced 
System Tester dialog. 

Step 6 - Test the Optimization System 
In the Enhanced System Tester, with "My First System" still highlighted, 
click the New Simulation... button. Complete the New Simulation 
wizard (as described on page 320). Name this simulation "My Optimized 
Simulation" and click Start. 
During the optimizing, MetaStock Pro displays information regarding the 
number of tests to be performed, the elapsed hours of testing, and the best 
and worst gains/losses.  When the test is complete, click View Results.  
Note that only the five most profitable results will appear, by default. To 
see more results, you can change the number in the Results section of the 
System Testing Options dialog (see page 341). 

Step 7 - Display the Optimization Reports 
1. When the "System Test Completed" message appears, click the View 

Results button.  The Enhanced System Tester appears. 
2. Click "My Optimized Simulation" in the lower right portion of the 

Enhanced System Tester. 
3. Click View. The Enhanced System Tester's Test View appears. The 

five most profitable results are displayed. (You can change how 
many results are displayed in the System Testing Options dialog.) 
The tests are arranged in the report by their average net profit.  Click 
any column heading (Avg. Net Profit, Total Profit, etc.) to sort the 
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results according to that column's value. 
Note that the optimization variable's value appears in the far right 
column for each result. 

4. In the list, click a security that performed well in the simulation (had 
a high net gain or profit/loss ratio) and click the View button to 
display the Result Details View. 

5. Five reports are available from the Result Details View dialog. For 
more information about what these reports tell you, see page 345. 
 

Tutorial Summary 
You have completed the Enhanced System Tester Tutorial.  In an attempt 
to keep this tutorial as concise as possible, we did not fully explore 
MetaStock Pro's system testing capabilities.  However, you should now 
be somewhat familiar with the process of creating a trading system.  The 
remainder of this chapter provides detailed information on system testing. 
If you will be testing futures and commodities, see page 364 for special 
instructions. 

The Enhanced System Tester 
 
The System Test Manager is the starting screen for all Enhanced System 
Tester activities. From here you can: 

• View all your systems 
• Create, copy, edit and delete systems 
• View all the tests run against any systems 
• Create, perform and repeat tests 
• View test details 

 
The Systems Test Manager is divided into three sections: The Systems 
List (left side), the Report Summary (top right), and the Trading 
Simulations List (bottom right). 
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New System. Opens the System Editor dialog where you can create 
your own custom system using MetaStock’s Formula Language. For 
more information on the System Editor dialog, see page 331. 
Edit ... Opens the System Editor, where you can modify the selected 
system test. See page 331 for more information on the System Editor 
dialog. 
Copy ... Makes a copy of the selected system. The copy is named "Copy 
of <system>" and appears alphabetically in the list.  
Delete. Removes the selected system test from the list. 
Organizer. Opens the Organizer wizard, where you can import or 
export formula files. See page 249 for more information about the 
Organizer wizard. 
Options. Opens the Enhanced System Tester Options dialog, described 
below. 
Print. Opens the print dialog. 
Help. Opens the help system. 

The System Tester Options Dialog 
You can open this dialog by clicking the Options button in the upper 
right corner of the Enhanced System Tester. 



 

 
 

MetaStock Professional Testing Your Trading Ideas • 329 

 

 

 

 
Buy Arrow, Sell Arrow, Stop Sign, Exit Sign. Choose a color for 
each of these symbols here.  
Once you've run a test and you've selected a security that worked well 
with that test, you can open a chart for that security. If the system 
generated any signals (buy, sell, stop, or exit), the chart will show when 
those signals were generated. By default, buy signals are represented by a 
green arrow; sell signals are represented by a red arrow; exit signals are 
represented by a red exit sign; and stops are represented by a red stop 
sign. 
Display Trading Signals. Uncheck this box to plot the tested 
security's chart without the buy and sell arrows and stop and exit signs. 
Note that when this box is unchecked, the next two options are disabled. 
Label Signals. When this box is checked, two numbers appear above 
each trading signal. The first number indicates how many shares were 
bought or sold. The second number (in parentheses) is the order number. 
Replace Existing Signals. If the security you're plotting from the 
Enhanced System Tester already has signals, this option will replace the 
old signals with the test's new signals. 
Plot Equity Line. Uncheck this box to plot the tested security without 
an equity line. 
Replace Existing Lines. If the security you're plotting from the 
Enhanced System Tester already has an equity line, this option will 
replace the old equity line with the test's new line. 
Prompt for Cleanup after ____ Simulations. Once you've run this 
number of simulations, MetaStock will ask you if you want to run the 
cleanup wizard (described below). This wizard deletes old analyses and 
unprofitable results.  
Clean Now. Click this button to open the cleanup wizard (described 
below). 
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The Cleanup Wizard 

 
The cleanup wizard frees up space on your hard drive by deleting old 
analyses and unprofitable results.  
Discard simulations older than ___ days. Enter a number in the 
field to determine how old a simulation has to be in order to delete it. 
Discard unprofitable results. When this box is checked the Cleanup 
Wizard deletes results that lost money or broke even. 
Compact results database. Frees up some space on your hard drive 
by compressing the files that contain your test results. 
When you're ready, click Clean to delete the selected analyses and/or 
results. 

The Systems List 
The Systems List (on the left side of the Enhanced System Tester) shows 
all the available systems. Single click on a system to see all the tests run 
on that system (in the Trading Simulations List section). Double click on 
a system to open the System Editor dialog for that system. Right click on 
a system to open the pop-up menu, which contains options to create a 
new system, create a new simulation, and to edit, copy or delete a system. 
Click the All Systems folder at the top of the list to see all the results in 
the Trading Simulations List for all systems tested. 
Note that if a system has results from a simulation, it will look like this: 

. Systems with no results look like this:  

The Report Summary 
The Report Summary (in the upper right section of the Enhanced System 
Tester) lists the securities that returned the most profitable results in the 
simulations that were run. The Report Summary also contains a pie chart 
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that tells you how much space on your hard drive is taken up with system 
test results, how much free space is available on the hard drive, and how 
much space is taken up by other files. 

The Trading Simulations List 
The Trading Simulations List shows all the tests run on the selected 
system or systems, as well as currently running tests. If a test has multiple 
results, they are summarized here.  
Note that you can see all the results for all systems tested by clicking the 
All Systems folder in the Systems List.  
Double click on a test to view its results (if it is complete) or its status (if 
it is running).  
The Trading Simulations List has its own set of buttons, described below. 
New Simulation. Opens the Perform System Test wizard, where you 
can create and initiate a new test. See page 322 for more information on 
creating a new test. 
View. When a test is selected, this button opens the Test View dialog, 
where you can see all the simulations performed for a given test. For 
more information on the Test View dialog, see page 343. 
Cancel. Stops the currently running test. This button is only available 
when a test is running. 
Discard. Removes the selected test from the Trading Simulations List. 
 

Creating a System Test 
Every system test contains four trading rules.  The trading rules specify 
when Buy/Sell positions should be opened/closed.  System tests may also 
have optimization variables and stops. 
To create a new system,  click the New button in the System Tester 
dialog.  MetaStock Pro can store up to 1,000 system tests. 
After you choose New System, the System Editor dialog appears. 
 

The System Editor  
The System Editor Dialog lets you name the system test, store notes 
regarding the system, and define several trading rules. 
To open the Enhanced System Tester Editor, either double-click on a 
system in the Systems List, or click the Edit... button in the upper left 
corner of the Enhanced System Tester. 
The System Editor dialog is divided into seven pages; each page is 
selected by clicking its tab. The pages are described below. 
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General 

 
You can edit a system’s name here, as well as read and edit any notes 
associated with the system. You can also set three rules to govern how 
the system executes trades under certain circumstances: 
Order Bias. Sometimes a system produces long and short signals 
simultaneously. This rule tells MetaStock which to choose when long and 
short signals appear at the same time. 
Portfolio Bias. You can instruct MetaStock to close all existing 
positions for an existing bias (long or short) when an opposite position 
opening order is placed. For example, if you want MetaStock to close all 
short positions when it places a new long position, select the Single 
option. If you want to let MetaStock place long and short orders 
simultaneously, select the Multiple option. 
Position Limit. Check this option to close any open positions before 
new positions are opened. You can specify that only one position can be 
open at a time, or you can allow up to 65,536 simultaneous open 
positions by unchecking this box. 

Buy/Sell Signals 
The System Editor offers four rules for initiating buy/sell signals: 

Buy Order 
This rule specifies when the system should purchase a given number of 
shares of the current security.  
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Sell Order 
This rule specifies when the system should sell one or more existing long 
positions. 

Sell short 
This rule specifies when the system should borrow a given number of 
shares of the current security and to sell them on the market. 

Buy to Cover 
This rule specifies when the system should close one or more existing 
short positions by repurchasing and returning the borrowed shares. 
The buy/sell rules use the options and fields described below: 

Formula The system’s formula appears here. For more 
information on the MetaStock formula language, see page 235. 
Functions This button opens the Paste Functions dialog, where 
you can view all the functions (and their parameters) available in 
the MetaStock formula language. See page 239 for more 
information on the Paste Functions dialog. 

Order Type If you want the test to use limit, stop, or stop limit 
orders, indicate that here. 
Market This order executes at the Trade Price selected in System 
Tester Options - Trade Execution (see page 342). 
Limit The order seeks the best price available above or below 
(depending on the Order Type) a given limit price. 
Stop The order seeks the best market price available once a given 
limit price has been met or exceeded in a direction defined by the 
Order Type. 
Stop Limit The order seeks the best price available above or 
below (depending on the Order Type) a given limit price once that 
limit has been met or exceeded in a direction also defined by the 
Order Type. 
Limit or Stop Price The price used when a non-market order is 
generated.  
Entry Size Enter the number of shares you want the test to 
purchase or sell when opening a long or short position. The 
number can be a dollar amount, a number of units, a percentage of 
available equity, or a number of units defined by a formula. Note 
that if you're expressing this number as a percentage, the number 
should be a decimal value. 
Expiration Tell the system to close the order at the end of the day 
or leave it open until another rule closes it. 
Strategic Delay By default, systems test data as if it were 
downloaded and analyzed in real time. But some data providers 
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only provide data 20 minutes after it's actually updated. If this is 
the case, you could tell the Enhanced System Tester to delay its 
trades by 20 minutes to more accurately test your method of 
trading. Also, you may only download end of day data. In that 
case, you could delay all the system's trades by one day. 

 

Stops

 
In addition to trading rules, each trading system can have up to five 
"stops." Stops are set by clicking the Stops tab in the System Editor 
dialog.  Stops are used to close long and/or short positions based on the 
position's gains/losses.  For example, the Maximum Loss stop will close a 
position if the position loses more than a specified amount. 
When a stop is triggered, the position is closed regardless of the current 
status of your trading rules.  The price at which the position is closed is  
the actual stop price or the specified exit price.   
If the price gaps below a stop level on a long position, MetaStock Pro 
exits at the open price of the next bar.  If no open price is available, the 
high price of the next bar is used.  Likewise, if the price gaps above a 
stop level on a short position, MetaStock Pro exits at the open price of 
the next bar.  If no open price is available, the low price of the next bar is 
used. 
Stops automatically take entry and exit commissions into account.  For 
example, the Maximum Loss stop knows the amount of your "exit" 
commission and will attempt to close the position so the maximum loss 
will not be exceeded after you pay the exit commission.   
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If two stops are triggered on the same bar, the more conservative stop 
takes precedence (i.e., the stop that generates the most losses).  The 
precedence of stops is: Maximum Loss, Breakeven, Trailing, Profit 
Target, and Inactivity. 
For information on optimizing stops, see page 356. 

Breakeven 
This stop closes an open position when the closed-out value of the 
position would fall below the current equity amount (i.e., the equity 
amount at the time the current trade was opened).  The stop is placed at 
the price where the trade could be closed and the proceeds generated 
would equal the current equity amount. 
To prevent this stop from being executed every time a position is opened 
(because commissions ensure there is never a profit when a trade is first 
opened), the Breakeven stop is enabled only after the profit for the trade 
meets or exceeds the user specified "floor level."  The value you enter in 
the Floor Level box depends on the Method specified (points or percent).  
The floor level uses the high price for a long trade and the low price for a 
short trade. 
This stop takes a minimum of two bars to trigger.  One bar for the floor 
level and another bar for the breakeven amount.   
Tip:  If the floor level is set to zero, the Breakeven stop will become 
enabled only after the security's price increases to the point where the 
position could be closed without incurring a loss. 

Maximum Loss 
This stop closes an open position when the losses resulting from the trade 
exceed the specified Maximum Loss amount. 
Example:  If you set the Maximum Loss to 5%, positions will be closed 
when losses exceed 5% of your current equity (including commissions). 
Warning:  If you set the Maximum Loss to a value that is less than or 
equal to the Entry Commission, every trade will be closed immediately 
after opening the position, because all trades will have a loss the moment 
they are entered (due to commissions). 

Profit 
This stop closes an open position when a specified Profit level is reached.   
Example:  If you specify 10% as the profit, open positions will be closed 
when they generate a 10% increase in your current equity (after 
considering the effect of commissions). 

Inactivity Minimum Change 
This stop closes an open position when the security's price does not 
generate a minimum positive price change within a specified time period.  
(A "positive price change" is defined by an upward price movement while 
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in a long position and a downward price movement while in a short 
position.) 
Type the Minimum Change and the number of Periods.  The Method to 
use when calculating the Minimum Change can be specified in Percentage 
or Points. 
Example:  If you specify 1% as the Minimum Change and 20 as the 
number of Periods, MetaStock Pro will automatically close any long 
(short) positions where the security's price has not increased (decreased) 
by at least 1% within any 20-period time frame. 
This stop analyzes changes in price, not equity, and therefore ignores 
commissions. 

Trailing 
This stop closes an open position when a specified amount (i.e., Profit 
Risk) of the current position's profits are lost. 
Each time a position's profits reach a new high, the Trailing stop is placed 
at a level that allows a specified portion of the position's profits to be lost.  
You specify the amount of the loss in the Profit Risk box (using either 
Percent or Points method). 
MetaStock Pro allows you to specify the number of periods to ignore.   
For example, if you specify "4" for the Periods, then the Trailing stop will 
lag by four periods.  This means that the last four periods' profits or losses 
will be ignored when determining the current stop level.  This filters out 
any price swings (up or down) that occur during the last four periods.   
This stop is designed to lock in profits, not to limit losses.  The Trailing 
stop only limits the amount of profits that can be lost.  Losses are limited 
by the Maximum loss stop (see page 335 ). 
Since trailing stops are determined by the profit level, not the price level, 
no special considerations exist for short positions. 
Example:  5% is specified for the Profit Risk, 0 for the Periods, and your 
current position has a profit of $100.00.  The stop would be triggered if 
the change in the security's price caused your profits to drop to $95.00 (or 
less). 
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Optimizations 

 
New. Opens the Variable Properties dialog where you can create a new 
optimization variable. 
Edit. Opens the Variable Properties dialog where you can change an 
existing optimization variable. 
Delete. Removes the selected optimization variable. 
 

Copying and Deleting System Tests 
You can make a copy of the selected system test(s) in the Enhanced 
System Tester dialog using the Copy button. Just select the system you 
want to copy, and click the Copy button. A system named "Copy of 
<system name>" appears in the list (sorted alphabetically). This is useful 
when you want to design a new system test that is very similar to another.   
For example, if System A was very similar to a new system you want to 
create, you could use the Copy command in the Enhanced System Tester 
dialog to make a copy rather than rewriting it.  You could then make the 
minor modifications necessary and name it System B.  
You delete the selected system tests from the Enhanced System Tester 
dialog using the Delete button.   
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Testing Systems 
When you click the New Simulation button in the Enhanced System 
Tester dialog, the Perform Trading Simulation wizard appears. This 
wizard takes you through four steps: 

Select Systems 

 
Select the system you want to test and click Next. To select multiple 
tests, hold down the Ctrl key while you click the tests you want to 
include. Or click a test, then hold down the Shift key and click another 
test. All the tests between the two you click will be selected. 
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Select Securities 

 
Click Add Securities... to select the securities you want to include in the 
test and click Next for more options, or click Start to begin the 
simulation. 
After you've added securities to the test, you can click the Dates... button 
to specify a date range or number of periods to test. 

System Testing Options 

 
Set the following options here: 
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Trading 
Points Only Test Check this box if you are trading futures or 
commodities and want to track the number of points gained or lost 
instead of the currency values. See page 364 for more information on 
points only system testing.  
 
Important: When running points-only tests on more than one security, 
make sure the securities show similar levels of volatility. For example, if 
one security in a test shows 1000-point intraday swings and another 
security in the same test never changes more than a few points in a single 
day, the test's results may be skewed.  
 
Initial Equity This is the starting balance of the account. Note that this 
option is unavailable when Points Only Test is selected. 
Default Size You can tell the system to place each order based on a 
number of shares, total transaction cost, or percentage of equity available. 
Note that this option is unavailable when Points Only Test is selected.  

Portfolio 
Long/Short/Both Determine what type(s) of positions are allowed: 
Long, Short, or Both. 
Close all positions on the last bar If this is unchecked, any open 
positions will remain open after the test is complete. 

Results 
The checkbox in this section lets you run the simulation as a Quick Test. 
A Quick Test takes less time to run than a normal simulation, and the 
results take up less disk space. However, Quick Tests don't generate the 
Positions, Equity and Orders reports that normal simulations do. Quick 
Tests are highly recommended when you're running a system that 
generates several tests. 
You can also determine how many results you want to see for systems 
that use optimization variables in this section. 
More... This button opens the System Testing Options dialog. For more 
information about System Testing Options, see page 341. 
When you've entered all your options, click Next to see a summary of the 
simulation, or click Start to begin. 
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Ready to Begin Test 

 
This dialog summarizes the selections you made in the previous dialogs. 
Click Back to change any options, or click Start if you’re ready. 

System Testing Options Dialog 
This dialog contains several options divided into two sections: Broker 
and Trade Execution. Note that some options will be disabled if the 
Points Only option is selected. 

Broker 

 
Margin This interest rate is used to calculate the annual interest applied 
to all debit balances. 
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Money Market This interest rate is used to calculate the annual interest 
applied to all credit balances. 
Long Initial This percentage is used to calculate the initial equity 
necessary to open a long position on margin.  
Long Maintenance This percentage is used to calculate the initial equity 
necessary to maintain a long position on margin.  
Short Initial This percentage is used to calculate the equity necessary to 
open a short position on margin. The percentage can be as low as 101% 
and as high as 200%. For example, if the account balance is $5,000 and 
the Short Initial is set to 150%, the system would allow a short sell of 
$10,000. At 110% and $5,000, it would allow a short sell of $50,000. At 
200% and $5,000, it would only allow a short sell of $5,000. 
Short Maintenance This percentage is used to calculate the equity 
necessary to maintain a short position on margin. 
Type Choose how your broker’s commission will be calculated here. 
Choose either Points per Transaction, Points per Unit, or Percentage of 
Transaction Value. 
Entry Enter your broker’s entry commission here (based on the 
commission type). 
Exit. Enter your broker’s exit commission here (based on the commission 
type) 
 

Trade Execution 

 
 
Realistic Market Prices When this box is checked, any triggered order 
executes at the open of the next bar. When it's unchecked, the Buy, Sell, 
Sell Short and/or Buy to Cover Prices execute at the specified values 
(Open, Close, High or Low). 
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Delay order opening ____ bars. Enter a number here to execute orders 
"x" bars after the trade is signaled. 
Slippage (Points, Percentage, Buy, Sell, Sell Short, Buy to Cover) 
These options let you introduce a degree of loss to the system by 
simulating delayed executions. For example, you see your stock has 
reached $20, so you call your broker and tell him to sell 100 shares. By 
the time the trade executes, the price may have changed. Slippage 
conservatively simulates this phenomenon by lowering all types of trades 
by a specific percentage or number of points.  
 

The Test View Screen 
There are three "versions" of the Test View screen. If you tested multiple 
systems, the Test View screen shows the most profitable systems based 
on the average net profit of all the securities each system tested. And if 
you tested multiple securities, the Test View Screen shows the securities 
that returned the highest net profit when the system was applied. Finally, 
if you tested multiple systems and multiple securities, you can compare 
one security's performance in all the systems tested (View All Results). 
 
 
The Test View Screen for Multiple Systems 

 
The top half of the above screen shows the average net profit of the most 
profitable systems tested. The list at the bottom of the screen shows more 
information about the most profitable systems in the test. You can sort 
the list of systems by clicking any column heading (like Avg. Net Profit).  
Back Returns you to the Enhanced System Tester. 
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View All Results Select any single security in the list and click this 
button to see how the security performed in the other systems in the test 
(if you tested multiple systems). 
Back Returns you to the Enhanced System Tester (or the Test View 
screen for multiple systems, if you tested multiple systems). 
View Opens the Result Details dialog, described in the next section 
below. 
View All This button is only available if an optimized result is selected. 
Clicking the View All button displays all the test results, not just the most 
optimal. 
Plot on Chart Opens the smart chart for the security used in the 
selected test. (The chart appears behind the Enhanced System Tester, so 
you'll need to close the Enhanced System Tester to see it.) The resulting 
equity line and buy/sell arrows appear on the chart. You can change the 
color of the arrows and other details in the Enhanced System Tester 
Options dialog, described on page 328.  
Discard Removes the selected result from the list. 

The Test View Screen - View All Results 

 
If you tested multiple systems, you can select a single security and see 
how it performed in each of the systems tested. The graph shows the 
selected security's net profit for each system tested. The list shows more 
information about the security's performance in each of the systems 
tested. 
Back Returns you to the Test View for multiple securities. 
View Opens the Result Details dialog, described in the next section 
below. 
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Plot on Chart Opens the smart chart for the security used in the 
selected test. (The chart appears behind the Enhanced System Tester, so 
you'll need to close the Enhanced System Tester to see it.) The resulting 
equity line and buy/sell arrows appear on the chart. You can change the 
color of the arrows and other details in the Enhanced System Tester 
Options dialog, described on page 328.  
Discard Removes the selected result from the list. 

The Results Detail View Dialog 

 
When you test a typical system, MetaStock Pro keeps track of tens of 
thousands of test details.  This information is stored in a series of reports.  
Each of the reports provides different information about the test. 
• The Summary Report provides a brief summary of the system tests.   
• The Orders Report lists all the potential orders that were considered 

and gives details about them. 
• The Positions Report shows details about every position that 

occurred during the test. 
• The Equity Report shows details about the test's account from the 

beginning of the test to the test's end. 
• The System Report lists all the information the system used, 

including all the options you can change. 
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Summary Report 

 
This report provides a detailed analysis of how a security performed with 
a given system. It includes several categories of information, described 
below. 
 
Summary 
Lists the security tested, the system used, the date and time the test was 
run, the number of bars included in the test and the date range tested. 

 
Performance 

• Profit - How much money this stock earned when traded with 
the selected system. If this is a negative number, it indicates a 
loss. 

• Performance - A percentage measure of how much profit or loss 
the system generated based on its initial equity. For example, if 
you start with $1000 and you end up with $1100 performance is 
10%. 

• Annualized Performance - Calculates what the Performance 
described above would be if the simulation took one year. This 
value is reached by dividing a year (365 days) by the number of 
days in the simulation, then multiplying that number times and 
the performance.  

• Buy & Hold Profit - The profit resulting from a buy and hold 
strategy.  A buy and hold strategy assumes that you buy on the 
first day loaded in the chart and hold the position.  The profit is 
calculated by using the price on the first day and the price on the 
last day.  Entry commissions are taken into account.   
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• Buy & Hold Performance - The percentage difference between 
the initial equity and the final equity if you were to buy the first 
bar and sell the last. It's just like Buy & Hold Profit (described 
above), but it's expressed as a percentage. 

• Buy & Hold Annualized Performance - Shows how much the 
system would have made or lost if they bought on the first day 
of the year and sold on the last day of the year.   

 
Trade Summary 
Total Trades - The total number of trades that were generated by the test. 
This number only shows closed trades and does not include the open 
position that may have existed at the end of the test. Therefore, it is 
possible for this value to be zero if there was a single unclosed trade in 
the test. 
Trade Efficiency - Your average total trade efficiency. Trade efficiency is 
the percent of the potential profit your trades realized, and is explained in 
more detail below. 
Average Profit/Average Loss - Lists the test's average profit and average 
loss. 
 
Profitable Trades 
Shows you how many profitable trades you had, and how many were 
longs and how many were shorts. Also lists your profitable trades' 
average profit, highest profit, lowest profit and longest consecutive run. 
 
Unprofitable Trades 
Shows you how many unprofitable trades you had, and how many were 
longs and how many were shorts. Also lists your unprofitable trades' 
average loss, highest loss, lowest loss, and longest consecutive run. 
 
Maximum Position Excursions 

• Long Favorable - The most profit made by any single long 
position. 

• Short Favorable - The most profit made by any single short 
position. 

• Long Adverse - The most equity lost by any single long 
position. 

• Short Adverse - The most equity lost by any single short 
position. 

 
Trade Efficiency 
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The percentage of the total possible profit realized by the trade.  There 
are three types of trade efficiencies: long, short, and total. All three apply 
to both long and short trades. 
 
Long Trade Entry Efficiency is the highest price minus the entry price, 
divided by highest price minus the lowest price. 
 
Long Trade Exit Efficiency is the exit price minus the lowest price, 
divided by highest price minus the lowest price. 
 
Long Trade Total Efficiency is the exit price minus the entry price, 
divided by highest price minus the lowest price. 
 
Short Trade Entry Efficiency is the entry price minus the lowest price, 
divided by highest price minus the lowest price. 
 
Short Trade Exit Efficiency is the highest price minus the exit price, 
divided by highest price minus the lowest price. 
 
Short Trade Total Efficiency is the entry price minus the exit price, 
divided by highest price minus the lowest price. 

• Average Entry - The sum of the entry efficiencies for all trades 
divided by the number of trades. 

• Average Exit - The sum of the exit efficiencies for all trades 
divided by the number of trades. 

• Average Total - The sum of the total efficiencies for all trades 
divided by the number of trades. 

• Average Long Entry - The sum of the long entry efficiencies for 
all trades divided by the number of long entries. 

• Average Long Exit - The sum of the long exit efficiencies for all 
trades divided by the number of long exits. 

• Average Long Total - The sum of the long efficiencies for all 
trades divided by the number of long trades. 

• Average Short Entry - The sum of the short entry efficiencies for 
all trades divided by the number of short entries. 

• Average Short Exit - The sum of the short exit efficiencies for 
all trades divided by the number of short exits. 

• Average Short Total - The sum of the short efficiencies for all 
trades divided by the number of short trades. 

 
Performance Indices 

• Buy & Hold Index - This index shows the percentage of the 
system's profits as compared to a buy and hold strategy's profits.  
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A value of "-50" means that the system's profits were one-half 
(i.e., 50%) of the buy/hold's.  A value of "25" means that the 
system's profits were 25% greater than the buy/hold's.  A value 
of "0" means they were equal. 
Ideally you want your system test to produce higher profits than 
a buy/hold strategy (i.e., Buy/Hold Index is greater than zero); 
otherwise the trading may not be worth the time and effort. 

• Profit/Loss Index  - This index compares the Amount of 
Winning Trades to the Amount of Losing Trades.   
The Profit/Loss Index combines Winning Trades and Losing 
Trades into one value that ranges from -100 (worst) to +100 
(best). 
A negative index value indicates that the trading system 
produced a net loss.  The higher the index value, the higher the 
Amount of Profitable Trades compared to the Amount of Losing 
Trades. 

 
Index Profit/Loss 
+100 High Profits/No Losses 
+50 Profits > Losses 
0 Profits = Losses 
-50 Profits < Losses 
-100 No Profits/High Losses 

 
• Reward/Risk Index - This index compares risk to reward.  In 

this index, risk is defined as the System Open Drawdown (i.e., 
the lowest point of the equity line below the initial investment).  
Reward is defined as the Total Net Profits (i.e., the final point on 
the equity line). 
The Reward/Risk Index combines Reward and Risk into one 
value that ranges from -100 (riskiest) to +100 (safest).  A 
Reward/Risk Index value of zero means that risk and reward 
exactly offset each other. 

 
Index Reward Risk 
+100 High None 
+50 Medium Medium 
0 None None 
-50 Low Medium 
-100 Very Low High 
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Accounting 

• Initial Equity - The amount of hypothetical money the system 
started with. 

• Trade Profit - How much equity all the profitable trades earned. 
• Trade Loss - How much equity all the unprofitable trades lost. 
• Commissions - How much you paid to execute all the trades 

generated by the system. 
• Interest Credited - The amount of interest the system's account 

earned during the test. 
• Interest Charged - The amount of interest the system paid for 

borrowing money during the test. 
• Open Positions  - The dollar value for any positions still open at 

the end of the test. 
• Final Equity - How much equity existed at the end of the test. 

 
Account Variation 

• Highest Account Balance - The most equity ever present during 
the test. 

• Lowest Account Balance - The lowest value of the cash account. 
• Highest Portfolio Value - The most your open positions were 

worth simultaneously during the test. 
• Highest Open Drawdown - The largest equity dip (relative to the 

initial investment) based on open positions.  This shows the 
maximum distance the equity line fell below the initial 
investment when a position was still open. 

• Highest Closed Drawdown - The largest equity dip (relative to 
the initial investment) based on closed out positions.  This 
shows the maximum distance a closed-out position fell below 
the initial investment amount. 

 
Account Events 
Shows you how many Margin Calls and Overdrafts occurred during the 
test. 
 
Profitable Timing 
Details, measured in bars, about the length of the profitable trades that 
happened during the test Average, Longest, Shortest, and Total. 
 
Unprofitable Timing 
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Details, measured in bars, about the length of the unprofitable trades that 
happened during the test: Average, Longest, Shortest, and Total. 
 
Out of Market Timing 
The Longest and Average number of bars during which the test didn't 
have any open trades. 
 
Optimization Variables 
If you used any optimization variables (OPT1, OPT2, etc.), their values 
during this test appear here. 

Orders Report 

 
The Orders Report shows details about all the trades that were 
considered, opened, executed or cancelled.  
There are eleven columns in the Orders Report: 
Bar. This number indicates on what bar the activity occurred, based on 
the first date of the date range used when the simulation was run. For 
example, if this number is 6, the corresponding activity happened on the 
sixth bar of the tested data.  
Date. Tells you the date when the activity occurred. 
Number. Tells you when this order happened, consecutively. If this 
number is 4, this order was the fourth order to happen in the test. 
Event. Each order can involve several events. This column tells you 
what events occurred in each trade. Events include Considered, Opened, 
Placed and Executed.  
Type. Lists the type of order being considered, opened or executed. 
Types include Buy to Cover, Buy Long, Sell Long, Buy Short, and Sell 
Short. 
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Size. Indicates how many shares the order is considering, buying or 
selling. 
Terms. Indicates if the order is Money Market or Margin. 
Price. Shows what the security's price was when the corresponding 
event occurred. 
Price Field. Displays which price field the order was executed on. 
Position. Displays a number that maps to the Positions Report. This is 
helpful when you have more than one position open at a time. 
Source. What initiated the order. Possible sources are Signals, Stops, 
Margin Call, Last Bar, and Bias Change. 

Positions Report 

 
This report summarizes details about each position that occurred during 
the test, starting with whether the position was long or short and how 
many units it traded. The graph at the top of this report represents the 
distribution of trade efficiency over all of the profitable trades that 
occurred in this simulation. Basically, if all the peaks appear to the right 
of zero, the system is well tuned. If all the peaks appear to the left of 
zero, the system is poorly tuned. 
The rest of the information is organized in categories, described below. 
Opening  

• Price - The security's price when the position was opened. 
• Bar - The position opened on this bar.  
• Date - The position opened on this date. 
• Efficiency - This is the percentage of possible profit this 

position made. For example, say you bought a stock for $10. If 
the stock fluctuates between $20 and $10 while the position is 
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open, and you sell at $15, your efficiency is 50%. If you sell at 
$20, your efficiency is 100%.  

• Commission - How much your broker charged to place the 
order. 

• Value - What the securities in the position were worth when 
they were bought, plus commission. 

Closing  
• Price - The security's price when the position was closed. 
• Bar - The position closed on this bar.  
• Date - The position closed on this date. 
• Efficiency - This is the percentage of possible profit this 

position made. For example, say you bought a stock for $10. If 
the stock fluctuates between $20 and $10 while the position is 
open, and you sell at $15, your efficiency is 50%. If you sell at 
$20, your efficiency is 100%.  

• Commission - How much your broker charged to place the 
order. 

• Value - What the securities in the position were worth when 
they were sold, plus commission. 

Most Favorable  
• Price - The best price the security reached during the test 

(highest for long positions, lowest for short positions). 
• Bar - The bar in which the most favorable price occurred. 
• Profit - How much money the position would have earned if it 

had closed with the most favorable price. 
Most Adverse  

• Price - The worst price the security reached during the test 
(lowest for long positions, highest for short positions). 

• Bar - The bar in which the most adverse price occurred. 
• Profit - How much money the position would have lost if it had 

closed with the most adverse price. 
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Equity Report 

 
The Equity Report includes a graph that displays the account's equity 
during the entire test. The numbers across the bottom of the graph 
indicate bars. More details about the account appear in the table below 
the graph. Those details are described here: 
Bar. The bar in the test that corresponds to the rest of the information on 
that row. 
Date. The date on which the bar and its equity account information 
occurred. 
Cash. The equity account's balance. 
Reserved. Money set aside for orders that aren't executed immediately, 
like limit, stop, and stop limit orders. The Reserved column also includes 
funds held in the maintenance margin. 
Margin. The total amount of funds borrowed from the broker to execute 
margined trades.  
Overdraft. If the account is overdrawn, the amount below zero appears 
here. 
Portfolio. The value of all the securities in an open position. 
Interest. How much interest the test's equity earned during this bar. 
Commissions. How much money was paid in commissions for this 
bar. 
Total Equity. The value of the entire equity account during this bar. 

System Report 
The System Report summarizes all the details about the system that was 
tested, including all the options you selected during the New Simulation 
wizard (described on page 338). 
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Printing Reports 
You can print the reports generated by system tests by choosing the Print 
button on the report. 

 
Name.  Choose the desired printer from the drop-list. 
Print Range.  Choose All to print the entire report.  The Pages radio 
button is always disabled. 
Print to File.  Check this box to send the printer output to a specified 
filename.  The file can be directed to the printer at a later time by right-
clicking on the filename in the Microsoft Explorer and choosing Print. 
Copies.  Type the number of copies to print. 
Collate Copies.  Separate each page of the document when printing 
multiple copies (if the printer supports this feature). 

Copying Reports to the Windows Clipboard 
You can copy the contents of a system test report to the Windows 
Clipboard for use in other Windows applications.    

To copy a report to the clipboard  
1. Display a report. 
2. Right click anywhere within the report and choose "Select All" from 

the list. 
3. Right click again and select copy 
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Optimization 
Optimizing a system involves performing multiple tests while varying 
one or more parameters within the trading rules or stops. 
The Enhanced System Tester Tutorial (see page 320) gives an example of 
optimizing the number of time periods used to calculate a moving 
average in a simple trading system.  In that example, tests are run using 
10- to 50-period moving averages, by 5-period increments.  We 
recommend that you go through this tutorial to more clearly understand 
the principle of optimization.  
Each trading system can have up to 10 optimization variables (referred to 
as OPT1 through OPT10).  (The OPT variables are not valid in custom 
indicators.)   To optimize a system, you replace numeric constants within 
the trading rules or stops with OPT variables.   
The following is an example of an OPT variable specified within a 
trading rule.  In this rule, "opt1" replaces the time period parameter in the 
moving average function. 
C > Mov(C,opt1,E) 
OPT variables specified for a stop are placed directly in the Parameters 
section of the Stops dialog. 

 

You then specify the OPT variable's range (minimum, maximum, and 
step).  When you test a system that contains OPT variables, MetaStock 
Pro will automatically perform multiple tests using each of the possible 
optimization combinations. 
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Specifying the Optimization Variables 
To specify the ranges for the optimization variables in your trading rules 
or stops, click the Optimization tab in the System Editor dialog. 

System Editor

CancelOK Help

General Buy Order Sell Order Sell Short Buy to Cover Stops Optimization

Optimization Variables

Name Description Minimum Maximum Step Status New...

Edit...

Delete...

OPT1 Periods in moving average 10 200 1 In Use

Total Tests: 191

 

New.  This lets you add a new OPT variable and edit its properties. 

Edit.  Displays the Variable Properties  where you can edit the minimum, 
maximum, and step of the selected OPT variable. 
Delete.  Deletes the selected OPT variable.  Note that you cannot delete 
an OPT variable that is in use. 
Total Tests.  Displays the total number of tests that the optimized 
system test will perform. 

Variable Properties Dialog 
The Variable Properties dialog is used to specify the range of the OPT 
variables. 

 

Name.  This shows the OPT variable you are editing. 
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Description.  You can enter an optional description of the variable in 
this box. 
Minimum.  Type the minimum value for the OPT variable. 
Maximum.  Type the maximum value for the OPT variable. 
Step.  Type the step size by which to increment the OPT variable.  For 
example, if the minimum/maximum range was 10 to 50 and the step size 
was 10, the OPT variable would be replaced with the values of 10, 20, 
30, 40, and 50. 

Example Optimizations 
The following Buy Order trading rule buys when the close is above a 10-
period moving average: 
Buy Order: CLOSE > mov(CLOSE, 10, SIMPLE) 
If you don't know the optimum number of time periods to use for the 
moving average, you could replace the "10" in the above rule with an 
optimization variable as shown below: 
Buy Order:  CLOSE > mov(CLOSE, OPT1, SIMPLE) 
The range for OPT1 (e.g., 5 to 20 by steps of 5) is specified by selecting 
the Optimizations tab from the System Editor dialog.  When you test this 
system, MetaStock Pro will perform multiple tests, each time replacing 
the OPT1 variable with the next optimization value (as shown below). 
Buy Order: CLOSE > mov(CLOSE, 5, SIMPLE){Test #1) 
Buy Order: CLOSE > mov(CLOSE, 10, SIMPLE){Test #2) 
Buy Order: CLOSE > mov(CLOSE, 15, SIMPLE){Test #3) 
Buy Order: CLOSE > mov(CLOSE, 20, SIMPLE){Test #4) 
After testing this system, there will be four reports (one for each 
optimization value). 
When optimization variables are used, the number of tests required to test 
every combination of optimization values can be determined by 
multiplying the number of tests for each OPT variable together. 
The following example demonstrates the use of multiple optimization 
variables: 
Buy Order: rsi(14) > OPT1 
Sell Order: rsi(14) < OPT2 
Sell Short Order: rsi(14) < OPT2 
Buy to Cover Order: rsi(14) > OPT1 
OPT1:  minimum = 20, maximum = 40, step = 10 {3 tests} 
OPT2:  minimum = 70, maximum = 80, step = 10 {2 tests}  
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In the above example, OPT1 has three possible values (i.e., 20, 30, and 
40) whereas OPT2 has two possible values (i.e., 70 and 80).  This 
combination requires that six (three multiplied by two) tests be performed 
as shown below: 

Test # OPT1 OPT2 
1 20 70 

2 30 70 

3 40 70 

4 20 80 

5 30 80 

6 40 80 

The number of tests can quickly grow enormous.  For example, consider 
the following moving average crossover system: 
Buy Order: cross(C, mov(C, OPT2, E)) 
Sell Order: cross(mov(C, OPT1, E),C) 
Sell Short Order: cross(mov(C, OPT1, E),C) 
Buy to Cover Order: cross(C, mov(C, OPT2, E)) 
OPT1:  minimum = 1, maximum = 100, step = 1 {100 tests} 
OPT2:  minimum = 1, maximum = 100, step = 1 {100 tests} 
In the above example, OPT1 and OPT2 each have 100 possible values.  
This combination requires 10,000 (100 multiplied by 100) tests to be 
performed!  Even on a fast computer, this relatively simple (yet heavily 
optimized) system may take hours to test. 
A more appropriate method to optimize this system would be to decrease 
the ranges and/or increase the steps to reduce the number of tests. 
 

System Development Tips 
Developing profitable trading systems is difficult.  Even after many years 
of experience with systems development, we still find ourselves getting 
sidetracked on the wrong system.  Here are some of the tips we've 
learned. 

Is Testing/Optimizing Valid? 
One of the most common mistakes made in system testing and 
optimization is over-fitting the trading rules to a specific set of data.  
Before you get too excited when you think you've found the "holy grail" 
of trading systems, check the following. 
• Check the equity line (see page 361).  It should gradually slope 

upward.  Abrupt spikes indicate inconsistent profits. 
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• Test the system on different time frames.  The results should be 
similar to those on the original data tested. 

• Test the system on different securities, across different industries. 
• Optimize again using only half of the original data tested.  Then test 

the remaining data using the optimum values.  If the system is valid, 
the results of the two tests should be similar.  

• Test the system on different types of markets (e.g., upward trending, 
downward trending, and sideways).  A good system should work in 
all types of markets, since you won't always know when a market 
changes from trending to trading or vice versa. 

• Remember that human expectations control the prices of securities.  
Therefore, it may not be realistic to expect a mechanical system to 
consistently predict changes in their expectations.  We suggest you 
use trading systems in conjunction with other investment analysis 
techniques. 

Commissions 
Pay close attention to the number of trades generated by a system test.  If 
there are a large number of trades and large profits, be sure you specified 
realistic commissions.  The results of the test may be much different once 
commissions are factored in. 

Winning Trades Versus Losing Trades 
It is easy to be too concerned with the number of winning versus losing 
trades.  Although this can be important, you should also pay attention to 
the Average Profit compared to the Average Loss (from the Summary 
Report, described on page 346).  Some good systems generate more 
losing trades than winning.  This can happen if the average winning trade 
is much higher than the average losing trade. 

Interest 
If your system specifies that interest is earned when you are out of a trade 
(see page 339), optimization may lead you to the system that is out of the 
market the most.  This means that a system test that lost on every trade 
could turn out to be the best system, if it was out of the market more than 
the other tests.   
This is easily witnessed by setting the Money Market interest rate very 
high (e.g., 100%) in the System Testing Options dialog and then 
optimizing.   

The Zig Zag and Lastvalue()Trap 
The Zig Zag indicator (see page 539) uses 20/20 hindsight to filter out 
fluctuations.  It shows only price movements that are equal to or greater 
than the amount specified.  However, the Zig Zag indicator determines 
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this "after the fact" (an advantage a trader doesn't have).  With that said, 
be careful about using the Zig Zag indicator in a system test.  It will 
produce results that are not attainable in real trading. 
The Lastvalue() function (see page 266) can see into the future in that it 
returns the last value of a data array.  For example, a system test could be 
written that bases a trade on a future price or indicator value—something 
unattainable in real-life.  Although it has value for things like pattern 
recognition, it should rarely (if ever) be used in a system test, as it will 
provide the system test with unattainable information. 

Using The Equity Line 
The equity line is a valuable tool.  A quick glance at the equity line can 
show a lot about the performance of a trading system.   
The ideal equity line should slope upward.  Large spikes may indicate that 
the system is inconsistent and risky.  A system that generates huge profits 
on one trade (e.g., it was short during the crash of 1987) is uncertain at 
best. 
The following is an example of the effects on an equity line by a system 
test which generated very erratic (volatile) profits.  A system that 
generates these results should be avoided.  
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The following is an example of an equity line that has a consistent upward slope.   
This is the type of results a good system generates. 

 

Use the Cut/Copy/Paste Commands 
To speed the writing of system tests, you may find the Cut/Copy/Paste 
helpful (see page 8).  More often than not, trading rules within a system 
are very similar except for the operators.  Consider the following trading 
rules for a simple moving average crossover. 
Buy Order:  c > mov(c, 39, s)  
Sell Order:  c < mov(c, 39, s)  
Note that the only difference between the two rules is the operator (i.e., > 
and < ). 
Instead of typing both rules, you could type the Buy Order rule, block it 
(SHIFT+RIGHT ARROW ), copy it (CTRL+C), and then paste it (CTRL+V) in 
the Sell Order text box.  Of course, the real usefulness of cut and paste 
comes when you are entering much longer rules than the ones illustrated 
above.    

Technical Reference 
This section explains technical details relating to the system testing 
process.   

General 
During the testing process, a system is always in a long, short, or an out 
position. 
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The current position is determined by the system's trading rules (see page 
334), the optimization values (see page 324), and stop settings (see page 
334). 
During the testing process, MetaStock Pro keeps track of numerous 
(typically tens of thousands) of pieces of information dealing with the 
transactions. 

Commissions 
When reviewing system test results, remember that commissions are 
deducted from your equity account when you enter a position, and from 
your profit when you exit a position (assuming it's profitable).  
For example, if you buy 100 shares of a stock valued at $10 per share, 
and your entry commission is $20, $1020 is deducted from your equity 
account. If you sell those shares when the stock reaches $20 per share, 
and your exit commission is $30, your profit is $970 ($1000 minus $30). 

Margin Requirement 
The Margin Requirement field in the System Testing Options dialog (see 
page 341) specifies the percent of funds that you must deposit in order to 
place a trade.  This allows you to leverage your transactions. 
For example, if you trade a security with a 20% margin requirement (i.e., 
where you are required to deposit only 20% of the actual cost of the 
security), then a 10% move in the security's price will create a 50% gain.  
Consider the following example. 
If the initial equity was $1,000 when a long position was entered, and the 
security's price increased 10% before the long position was exited, the 
profit would normally be $100 (i.e., 10% of $1,000).  However, if you 
place this trade using a 20% margin requirement, then you are able to buy 
$5,000 worth of the security (your $1,000 is the 20% margin requirement, 
plus $4,000, or 80%, of borrowed funds).  Thus, the 10% increase in the 
security's price would create a $500 dollar gain (i.e., 10% of $5,000).   
This $500 gain represents a 50% gain on your $1,000 investment. 

Earning Interest 
When neither a long nor a short position is open (i.e., an "out" position 
exists), interest is earned on the equity balance at the interest rate 
specified in the System Testing Options dialog (see page 341). 
When a long or short position is opened following an out position, the 
interest earned during the out position is posted to the equity balance.
  

Other Accounting Issues 
If the equity ever drops to, or below, zero (dropping below zero is only 
possible when commissions are specified using points rather than 
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percentages), no interest can be earned and no trades can be entered for 
the remainder of the test.  (Note, this does not apply to "points only" 
system tests.) 
When a Strategic Delay is specified (see page 331), all other signals and  
stops are ignored until the delay period has passed.   

Testing Futures and Commodities  
System testing on futures and commodities is done by performing a 
"points only" system test.  A points only system test simply means to 
ignore any currency values and only track the number of "points" 
gained/lost.   
To perform a points only system test, check the Points Only box in the 
System Testing Options dialog (see page 341) before running the test.  
The initial equity, margin requirement and annual interest rate are ignored 
when a points only test is performed. 
When performing a points only test, the Enhanced System Tester will 
allow the equity line to drop below the zero line. 
Stop parameters can still be expressed in points or percent when 
performing a points only system test.  Percent value calculations will be 
based on the entry price for a trade rather than the equity level when the 
trade was entered. 
In a points only test, commissions are calculated only under the following 
conditions: 
• The "Points" option in the System Testing Options dialog must be 

selected. 
• The commission value must be less than or equal to 1.  The 

commission value should be entered in the equivalent number of 
points.  For example, if your commission rate is $30.00 and a 
one-tick move on the future you are testing is 0.03125 (or $31.25 per 
contract), you would enter 0.03 ($30.00 point equivalent) for the 
commission rate. 

Speed 
System testing involves a huge amount of processing, so obviously a faster 
processor in your computer will result in quicker results.  
A large amount of testing time is spent writing reports to disk.  Thus you 
can decrease the time it takes to perform tests by using a faster hard disk. 

Disk Space 
System tests can generate a very large amount of data, all of which gets 
stored on your computer's hard disk. To minimize the amount of space 
taken up by system test results, you should discard tests you don't need, 
and run the Cleanup Wizard (see page 330) periodically.  
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Input() Function, Variables, and Multi-plot 
Indicators 
The Enhanced System Tester will accept assigned variables in the trading 
rules.  For example, the following is a valid Sell Order rule: 
myvar:=10; 
c>mov(c,myvar,s); 

A system test cannot use the input() function directly (see page 265).  
This function is reserved for custom indicators only.  However, if a rule 
uses the fml() function (see page 261) to call the results of a custom 
indicator, and the custom indicator uses the input() function, the fml() 
function will only use the assigned default input value—the Enhanced 
System Tester will not prompt for input. 
If a system test contains or references (using the fml() function) a multi-
plot indicator, only the last plot is used in the calculation of the system 
test. 

 
 

 

Trading Rule Syntax 
Trading rules are entered using the MetaStock formula language (see 
page 235).  This syntax is very similar to the syntax used to enter 
formulas in spreadsheets.  Each trading rule may contain up to 1024 
characters. 
A trading rule always returns a "true" or "false" signal.  When the trading 
rule condition is true, the corresponding trade (e.g., buy, sell, etc.) is 
taken.  When the condition is false, no action is taken. 
The following example illustrates a trading rule: 
Buy Order: cross(CLOSE, mov(CLOSE,12,Simple)) 
If this were entered as the Buy Order rule, the system would enter a long 
position when the close crossed above a 12-period moving average of the 
close. 
Similarly, the following trading rule would be triggered if the MACD is 
greater than zero.  (The "macd()" in this rule is a function, see page 269). 
Buy Order: macd() > 0  
All custom indicator functions (e.g., macd()) can be used in trading rules.  
A specific custom indicator can be referenced using the fml() formula 
(see page 261) as shown below: 
Sell: fml("My Formula") > 0 
You can combine multiple functions within a trading rule using the AND 
and OR operators as shown below.  See page 241 for more information 
on using AND and OR operators. 
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Buy Order: macd() > 0 AND CLOSE > mov(CLOSE,12,S) 
The above rule requires that the MACD be above zero and that the close 
be above its 12-period moving average. 
The following rule uses the OR operator to generate a trade when the 
MACD falls below zero, or when the close falls below its moving 
average. 
Sell Order: macd() < 0 OR CLOSE < mov(CLOSE,12,S) 
Multiple ANDs and ORs can exist within a trading rule.  The best way to 
control the precedence (i.e., the order of operation) of multiple ANDs and 
ORs within a trading rule is by using parentheses as shown in the 
following trading rule: 
Buy Order: (macd() > 0 AND C > 100) OR H-L>5 
The preceding trading rule will generate a trade when either of the 
following conditions are met:  
• The MACD is above zero and the close is above 100 (i.e., both of 

these conditions are met).  
• The high minus the low is greater than five. 
You can click the Functions button (see page 305) when editing the 
trading rules (you must be editing the trading rules, not the name or 
notes).  The Paste Functions dialog with a list of the available functions 
will then be displayed.  Double-clicking on a function name will insert 
the function into the trading rule at the current cursor location. 
Trading rules may be left blank.  However, blank rules never generate 
trades. 
Trading rules may only access the security's price data (e.g., high, low, 
close, etc.) and custom indicator functions (see page 252).  Trading rules 
may not reference the trading system itself (e.g., the number of days since 
the last trade).  However, several of the stops (page 334) perform this 
functionality. 
A special variable called the "P" variable can be used to reference any 
selected price or indicator plot.  See page 247 for more information on 
the "P" variable. 
Variables can be used within the rules of a system test (see page 244).  
Multiple plot formulas (i.e., those that would result in multiple plots if 
plotted as a custom indicator) are allowable, but only the last one will be 
recognized by the Enhanced System Tester. 

Using the Alert() Function 
The alert() function is used in conjunction with other functions to extend 
a true signal for a specified number of periods.  The signal is held true 
over the specified number of periods even if another trade is generated. 
The following example illustrates the use of the alert() function: 
Buy Order: RSI(14) < 30 AND alert(VOLUME > 500,3) 
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If this were entered as the Buy Order rule, the system would enter a long 
position when the RSI was less than 30 and the volume had been greater 
than 500 at any time over the previous three time periods.  The 
"VOLUME > 500" condition holds true over the entire three time periods 
even if the volume drops below 500 during that three period time span. 
If  you removed the alert() function in the above example, both 
conditions (i.e., RSI(14) < 30 and VOLUME > 500) would have to be 
true simultaneously in order for the Buy Order signal to be generated.  By 
using the alert() function, a true condition generated by the "VOLUME > 
500" condition is extended over a three period time span.  
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Ranking and Screening Securities 

What is The Explorer? 
The Explorer is a powerful, multi-purpose analysis tool that can perform 
in-depth "explorations" on multiple securities across multiple folders.   
The Explorer can perform a number of unique tasks, including comparing, 
filtering, listing multiple indicator values for multiple securities, ranking, 
searching, showing securities with current "buy/sell" signals, sorting, etc.   
You can use The Explorer to do such things as: 
• Discover which securities have just generated a "buy" (or "sell") 

signal. 
• Discover the securities that have just crossed above their 200-day 

moving average on increased volume. 
• Discover which securities rank highest by Wilder's RSI. 
• Discover which securities are above their 10-week moving average, 

with a Stochastic of 80 or higher, and are at a level of four on a 
customized binary wave. 

• Generate a performance report of all your mutual funds. 
• Generate a list of every security along with the values of your favorite 

six indicators for each security. 
• Copy only those securities which meet your personal criteria from 

the MetaStock Data CD to your hard drive for updating. 
• …and more. 
This is just a small sampling of what The Explorer can do for you. 
Due to the inherent complexity in the design and creation of custom 
indicators, trading systems, explorations, and experts, Equis cannot 
provide free support for this process.  However, support is available for 
a reasonable fee.  Call Equis at 801-265-9998 for details or fill-out the 
FORMULA HELP.DOC file found in the MetaStock folder.  This file is 
viewable with Wordpad.   
The rules and criteria that define this process are called an "exploration."  
Up to six columns and a "filter" can be specified in an exploration.  The 
criteria that define the columns and filter are written in MetaStock's 
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formula language (see page 235).  A list of securities can be screened for 
those candidates that meet your criteria by applying a filter.  A report 
showing the results of an exploration can be viewed on screen or printed. 
The Explorer is designed to be simple and straightforward, yet extremely 
powerful.  By combining the MetaStock formula language (see page 235) 
and System Tester syntax, designing an exploration is just a matter of 
using the skills you may already possess.  You will find the MetaStock 
formula language section (see page 235), the Indicator Builder Tutorial 
(see page 300), and the Enhanced System Tester Tutorial (see page 320) 
helpful in getting you up to speed. 
Please note that the performance of The Explorer is significantly slower 
when exploring intraday data while collecting real-time data.   
Therefore, you may want to wait until after market hours to run 
explorations on intraday data. 
Before you attempt to write your own explorations, we encourage you to 
take a few minutes to go through the following short tutorial.  Doing this 
will provide you with a solid foundation on which to build your skills. 

The Explorer Tutorial 
This tutorial provides a brief introduction to the process of creating an 
exploration and viewing the resulting reports.  It is important that you 
follow this tutorial before you create your own explorations.  You should 
also be familiar with the Indicator Builder (see page 299) and Enhanced 
System Tester (see page 327) syntax. 

Quick Start (The Basics) 
In its simplest form, creating an exploration involves the following steps: 
1. Choose The Explorer from the Tools menu. 
2. From The Explorer dialog choose New. 
3. Fill out the Exploration Editor dialog by typing a Name and up to six 

column formulas and a filter (if desired) using the MetaStock formula 
language (see page 235).  Note that the column criteria and the filter 
criteria are independent--one can exist without the other. 

4. Choose OK at the bottom of the dialog and choose Explore from 
The Explorer dialog. 

5. Select the folder and securities to explore from the Select Securities 
dialog, then click OK to start the exploration. 

That's it!  Although there are other features that increase the power of 
The Explorer, creating an exploration involves just the five steps.   
The next several sections of the tutorial provide more details on the five 
basic steps shown above.  Please follow each step carefully, since each 
step is dependent on the previous one.   
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The Explorer Dialog 

 
The Explorer button 

Choose The Explorer from the Tools menu or click The Explorer button 
on the standard toolbar to access The Explorer dialog.  

 
You use The Explorer dialog to create, manage, and print explorations.  
The explorations listed in your dialog will be different than the ones 
shown above. 

Creating a New Exploration 
1. With The Explorer dialog displayed, choose New.  The Exploration 

Editor dialog appears. 

 
The Exploration Editor dialog is the heart of an exploration.  You use this 
dialog to specify the name, column, and filter information. 
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2. Enter the exploration name as "My First Exploration" (do not enter 
the quotation marks in this, or the remaining, examples). 

3. Click the Column A tab and type the following in the box: 
 
CLOSE 

4. Type the following into the Column Name box: 
 
CLOSE 

Note that you can enter anything you want for the name.  For this tutorial, 
however, enter the name as shown above. 
5. Click the Column B tab and type the following in the box below all 

the column headings: 
 
mov(CLOSE,20,SIMPLE) 

6. Type the following into the Col. Name box: 
 
MOV-20 

7. Click the Column C tab and type the following in the box: 
 
rsi( 14 ) 

8. Enter the following into the Col. Name box: 
 
RSI-14 
 

 
 

 
Note that the column formulas use the identical syntax as MetaStock Pro's 
custom indicators.  You can even reference existing formulas by using the 
"FML" function (e.g.,  fml("MYMACD") ).  This saves you from having 
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to retype formulas that you have already defined in the Indicator Builder 
dialog. 
 
If you want to paste in a custom indicator formula, choose the Functions 
button.  See page 305 for information on using the Paste Functions dialog. 
9. Choose OK to return to The Explorer dialog. 
10. Choose Explore to begin the exploration. 
11. The Select Securities dialog appears, where you choose the securities 

to explore.   
 

 
 

12. Click the Add Securities... button. The Add Securities dialog 
appears. 

13. This dialog looks a lot like the Open dialog, and works just like it. 
(The Open dialog is described on page 67.)You can select one or 
more local or online securities.  

14. Double-click the “Stocks – Common” folder. 
15. For this tutorial, select all the stocks that begin with the letter A. 

(Select the stock at the top of the list, then hold the Shift key and 
select the last stock on the list that begins with “A”.) 
 

16. Click Open. 
 
For this tutorial, just choose OK.  Every security in the selected 
folder will be included in the exploration.  However, you could have 
selected specific securities and additional folders. 

As the exploration is being calculated, the Exploration Status window is 
displayed. 
17. When MetaStock Pro has completed calculating the exploration, 

choose Reports from the Exploration Completed dialog.  
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A report showing the results will appear. 
 

 
 
The Exploration Report shows the name of each security and the 
calculated results of each of the columns.  The values shown in the 
columns represent the closing price (i.e. close), a 20-day moving 
average (i.e., mov(close,20,simple) ), and a 14-day RSI (i.e., 
rsi(14)) for the most recent day of data.  The sort order can be changed 
using the Sort command (see page 390). 

Adding a Filter 
A filter narrows your list to securities that meet specific criteria.  You can 
write a filter based on the existing column formulas, or you can write one 
that is completely independent of the column formulas.  In fact, you could 
write an exploration with the columns left empty with just a filter.   
In this tutorial, we will write a filter that lists securities that are below a 
20-day moving average and have a 14-day RSI below 40.  Since we have 
already written these two indicators in columns A and B, we can save 
time by referencing them directly within the filter. 
1. Choose Close to exit the report. 
2. With "My First Exploration" selected, choose Edit. 
3. Choose the Filter tab. 
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Enter the following into the Filter box: 
(colA < colB ) and (colC < 40) 
 
Note that the filter could also be written as follows: 
(CLOSE < mov(CLOSE,20,SIMPLE))and(rsi(14)< 40) 
 
If your filter is based on the column formulas directly (as shown above), 
you can save yourself some typing by simply referencing the columns 
using the "COL" variable (e.g., colA and colB).  This is particularly 
handy if the column formulas are long. 
 
The filter formulas use the identical syntax as MetaStock Pro's Enhanced 
System Tester.  You can even reference existing custom indicators by 
using the "FML" function (e.g., fml("MYMACD") ).  This saves you 
from having to retype formulas that you have already defined in the 
Indicator Builder dialog. 
4. Choose Options in the Exploration Editor dialog.  Check the Use 

Filter box in the Exploration Options dialog to enable the filter.  For 
the filter to take effect, this box must be checked.  Choose OK. 

5. Choose OK to exit the Exploration Editor dialog. 
6. To perform the exploration with the newly added filter, choose 

Explore.  
7. When MetaStock Pro has finished calculating the exploration, choose 

Reports from the Exploration Completed dialog.  A report showing 
the results will appear.   
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Note that only those securities that are below their 20-day moving average 
and have a 14-day RSI less than 40 will appear in the Results report. 
If you wanted to narrow the list down even further, you could go back to 
the Exploration Editor dialog and make the filter more restrictive: 
8. Choose Close to exit the report. 
9. With "My First Exploration" selected, choose Edit. 
10. Make the filter more restrictive by editing the filter box to appear as 

follows: 
 
(colA < colB) and (colC < 30) 

11. Choose OK to return to The Explorer dialog. 
12. To perform the exploration with the more restrictive filter, choose 

Explore. 
13. When MetaStock Pro has finished calculating the exploration, 

choose Reports from the Exploration Completed dialog.  A report 
showing the results will appear. 

Note that the number of securities appearing in the report is probably less 
than the last report, since we made the RSI portion of the filter more 
restrictive. 
14. To display a report showing the historical column values for a 

security, select a security in the Results report and choose Inspect. 

Tutorial Summary 
• The Explorer provides tremendous power and flexibility by giving 

you a multi-purpose analysis tool that lets you perform in-depth 
explorations of your securities. 

• An exploration is comprised of columns and/or a filter.  Although 
they are entered in the same dialog and can be combined in a single 



 

 
 

MetaStock Professional Ranking and Screening Securities • 377 

 

 

 

exploration, the columns and filter are separate and distinct 
functions. 

• Column formulas and filter rules are written with the MetaStock 
formula language (see page 235).  They can reference existing 
custom indicators using the "FML" function (e.g., fml("My MACD") 
). 

• A filter can reference the column formulas directly using the "COL" 
variable (e.g., colA). 

• The results of an exploration are shown in the Results report (see 
page 388).  Each security along with the designated column values 
are displayed in the specified sort order. 

• Historical column values for individual securities can be displayed by 
choosing the Inspect button in the Results report. 

The Explorer Dialog 

 
The Explorer button 

The Explorer dialog is displayed by choosing The Explorer from the 
Tools menu or clicking The Explorer button on the standard toolbar.  The 
Explorer dialog lists the names of all your explorations.  You can create 
up to 1,000 explorations.  The selected exploration can be edited, copied, 
deleted, printed, and tested.  Explorations that have an "R" next to the 
name have reports available from the most recent exploration. 

 
New.  Use this to display the Exploration Editor dialog in which you can 
specify the name, columns, and filter for a new exploration.  See page 379 
for more information on creating new explorations. 
Edit.  Use this to display the Exploration Editor dialog in which you can 
edit the selected exploration. 
Copy.  Use this to make a copy of the selected exploration.  See page 
384 for more information on copying explorations. 
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You can select multiple 
explorations by holding 
down the CTRL key as 
you click the mouse. 

Delete.  Use this to delete the selected explorations.  See page 384 for 
more information on deleting explorations. 
Print.  Use this to print the selected explorations.  See page 384 for more 
information on printing explorations. 
Organize.  Use this to display the Formula Organizer Wizard from which 
you can import and export explorations, system tests, custom indicators, 
and experts.  This is normally used if you have purchased add-on products 
from Equis or a third party.  See page 249 for more information on the 
Formula Organizer Wizard. 
Explore.  Use this to start the exploration process for the selected 
exploration(s).  See page 385 for more information on exploring. 
Reports.  This button displays the reports for the selected exploration.  
This button is grayed out unless an exploration with an "R" next to it 
(signifying "reports available") is selected.  See page 388 for more 
information on reports. 
Options.  This button displays the Explorer Options dialog from which 
you can control data and reporting options.   

Explorer Options 
The Explorer Options dialog is used to specify options that affect all 
explorations.  To display the Explorer Option dialog, click the Options 
button in The Explorer dialog. 
This dialog controls options that affect all explorations.  To control 
options that affect single explorations, see page 380. 

 
Load ___ Records.  Enter the number of periods to use when 
calculating the exploration results.  Entering a value equal to the number 
of periods loaded in the chart provides increased precision between 
cumulative type indicators (see below) calculated on your charts and 
those calculated in your explorations.  You should also choose this if 
your exploration uses any of the Candlestick functions (see page 288) or 
the barssince() function (see page 254). 
Some indicators are referred to as "cumulative" type indicators.  The 
results of a cumulative type indicator depend on the amount of data 
loaded.  For example, the results of a 10-day exponential moving average 
calculated with 40 days of data loaded will be slightly different than one 
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calculated with 500 days of data loaded.  This is because an exponential 
moving average retains a small portion of all previous data.   
Load Minimum Records.  Choose this to optimize the calculation of 
the exploration for speed.  Certain "cumulative" type indicators may not 
exactly match the results displayed on your charts (see above). 
Notify When Exploration is Done.  Check this box if you want the 
Exploration Completed dialog to appear when an exploration is done. 

Creating an Exploration 
An exploration performs two separate and distinct tasks.  It displays your 
securities with up to six columns of indicator values.  It can also filter 
your securities.  You can create up to 1,000 explorations. 
To run The Explorer, choose The Explorer from the Tools menu or click 
The Explorer button on the standard toolbar. 
To create a new exploration, choose New from The Explorer dialog.  The 
Exploration Editor dialog appears.  This dialog is used to enter the criteria 
for the exploration.  Up to six column formulas and one filter can be 
included in an exploration. 

 
Name.  Enter the name of the exploration in the Name box.   
Notes.  Enter any descriptive notes in the Notes box. 
Columns.  Columns A-F specify the values to display in the Results 
report (see page 388).  A separate page is provided for each column.  As 
you click a column's tab, a new page appears where a formula can be 
typed.  Each of the columns represents a unique calculated value.  The 
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column formulas are written in MetaStock's formula language (see page 
235).  Each column formula can be up to 2,500 characters long. 
Functions.  This is used to display the Paste Functions dialog.  This 
dialog is used to select from a list of over 190 functions.  The selected 
function can be inserted directly into your exploration.  See page 305 for 
more detailed information on this dialog. 
Securities.  This button gives you access to the Select Securities dialog 
from which you can choose the securities to include in your exploration.  
See page 382 for more detailed information on this dialog. 
Options.  You use this to display the Exploration Options dialog in 
which you can set options for the selected exploration.   

Exploration Options 
The Exploration Options dialog is used to specify options that affect only 
the selected exploration.  To display the Exploration Options dialog, click 
the Options button in the Exploration Editor dialog. 
This dialog controls options for a specific exploration.  To control 
options that affect all explorations, see page 378. 

 
Most Recent Date.  Click this button if you want to use the most 
recent date in each security file for the exploration calculations.   
Specific Date.  Click this button to enter the date on which you want 
the exploration calculated.  The most recent date for each security equal 
to or prior to the date you enter will be used in the exploration. 
Periodicity.  Select the desired periodicity for the securities in the 
exploration.  Security data will be compressed (if necessary) to match 
your selection.  For example, daily security files can be compressed to 
weekly or monthly.  Note that if you select "daily" periodicity, weekly, 
monthly, and yearly security files will be rejected since files cannot be 
compressed to a shorter periodicity. 



 

 
 

MetaStock Professional Ranking and Screening Securities • 381 

 

 

 

Use Filter.  Check this box to enable the filter.  See page 381 for 
information on specifying a filter for your exploration. 

Column Formula Syntax 
Column formulas are written using MetaStock's formula language (see 
page 235).  All custom indicator functions can be used in The Explorer's 
columns.  This includes the "FML" function, which allows you to 
reference an existing custom indicator with a simple function call.  For 
example, if you wanted to use one of your custom indicators, 
"Combination Wave" (a complex binary wave) in an exploration column, 
you could use the FML function instead of retyping it (e.g., 
fml("Combination Wave") ). 
The following shows an example of a column formula that will display the 
values of the difference between a 10- and 50-day moving average in the 
Exploration report: 
mov(CLOSE,10,SIMPLE)- mov(CLOSE,50,SIMPLE) 
The following shows an example of a column formula that displays a 
basic 14-day RSI in the Exploration report: 
rsi(14) 
The following shows an example of a column formula that will display the 
difference between formula "ROC1" and formula "ROC2" in the 
Exploration report: 
fml("ROC1") - fml("ROC2") 

Filter Syntax 
A filter is written in the identical syntax as the rules in MetaStock Pro's 
Enhanced System Tester.  An additional variable that is unique to the filter 
criteria is "COL".  The COL variable references the exploration columns 
directly.  This keeps you from having to retype the entire column formula 
and makes the filter more readable.  For example, suppose you've defined 
column A as follows: 
mov( rsi( 20 ), 9, SIMPLE) 
Now you want to display only those securities whose moving average is 
less than 40.  A filter could be written as follows: 
mov( rsi( 20 ), 9, SIMPLE) < 40  
However, to save yourself some typing and make the filter more 
readable, you could use the COL variable as follows: 
colA < 40  
Both filters accomplish the same thing, but the second filter requires less 
typing.  This is particularly true when your filter involves long and 
complex formulas. 
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Stand-alone Filters 
Although a filter can be based on the exploration columns directly, a 
filter can also be completely independent of the columns.  In fact, the 
exploration columns can be left completely empty.  Perhaps you simply 
want to list the securities that meet your filter criteria without any column 
values displayed in the report. 
For example, your entire exploration could be a filter written as follows: 
cci(9) < -90 and mfi(6) < 50 
In a report, note that the columns are empty when only a filter is 
specified.  Only the security names are displayed. 

Input() Function, Variables, and Multi-plot 
Indicators 
The Explorer will accept assigned variables (see page 244) in the column 
formula and filter rules.  For example, the following is a valid column 
rule: 
myvar:=200; 
mov(c,myvar,s); 

An exploration cannot use the input() function directly (see page 306).  
This function is reserved for custom indicators only.  However, if a rule 
uses the fml() function (see page 261) to call the results of a custom 
indicator, and the custom indicator uses the input() function, the fml() 
function will only use the assigned default input value—the Explorer will 
not prompt for input. 
If an exploration contains or references (using the fml() function) a multi-
plot indicator, only the last plot is used in the calculation of the 
exploration. 

Selecting Securities to Explore 
MetaStock Pro can explore virtually unlimited local securities across 
multiple folders, as well as online securities, using the Add Securities 
dialog.  This dialog is accessed by choosing Securities from the 
Exploration Editor dialog, or by clicking Add Securities in the Select 
Securities dialog.  If no securities have been specified for an exploration, 
The Explorer displays the Select Securities dialog automatically, 
prompting you to make your selections. 
The Add Securities dialog is almost identical to the Open dialog. 
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History.  Choose the History shortcut from the Shortcut Bar to select 
from the list of securities you have most recently accessed.  You can 
adjust the size of the history by choosing Limit History Items from the 
Tools menu. 
Local Data.  Choose the Local Data shortcut from the Shortcut Bar to 
open an existing Smart Chart located on a local disk drive.  The local data 
folder from which you last viewed a security is displayed. 
Favorites.  Choose the Favorites shortcut from the Shortcut Bar to 
choose from your list of pre-defined favorite securities, and charts.  To 
add an item to Favorites, choose Add to Favorites from the Tools menu. 
<Online Data Vendor>.  If you are using an online data vendor, you 
may select from a list of securities available from your vendor by 
choosing this shortcut from the Shortcut Bar.   
Look in.  Use the drop-list to select the folder that contains the desired 
Smart Chart, or chart.  Traverse the folders until the desired folder is 
listed. 
Security name / Symbol / File Name. The chart you select from the 
underlying list appears in this box.  This is the chart that will be opened.  
You can select multiple charts to open by holding down the SHIFT or 
CTRL key as you make your selections.  See page 68 for information on 
filtering securities in the Open dialog. 
 

Maintaining Lists of Securities with Favorites 
The Favorites feature lets you load and save predefined lists of securities 
to perform explorations on.  To add a list of securities to your Favorites, 
click the Save... button in the Select Securities dialog. To load a list of 
securities from your Favorites, click the Favorites button in the Add 
Securities dialog. 
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Perhaps you want to divide your securities into specific categories.  To 
do this, you could create a list that includes only computer stocks, 
another that contains only commodities, another that contains only 
automobile stocks.  Instead of having to select these individually each 
time for different explorations, you can group them into easily accessible 
folders.  You can also save the list of securities generated by an 
Exploration as a list (see page 388). 
NOTE: Explorations and system tests can be run on a list that has been 
created in The DownLoader, but the lists that are saved to the favorites 
folder after running a system test or exploration can't be used in The 
DownLoader. 
The list "Results of Last Exploration" is automatically generated by 
MetaStock Pro.  This includes only the securities from the last 
exploration that were not rejected.  This list can be used, but it cannot be 
deleted or modified.   

Copying and Deleting Explorations 
You can make a copy of a selected exploration from The Explorer dialog 
using the Copy button.  This is useful when you need to design a new 
exploration that is very similar to an existing one.   
For example, if Exploration A was similar to a new exploration you want 
to create, you could use the Copy command in the Explorer dialog to 
make a duplicate rather than rewriting it.  You could then make the minor 
modifications necessary and name it Exploration B.  

You can select multiple 
explorations by holding 
down the CTRL or SHIFT 
key as you click the mouse. 

You can delete the selected explorations from The Explorer dialog using 
the Delete button.  The Delete button displays the Delete Exploration 
dialog. 

 
Choose whether you want to delete the explorations or the explorations' 
reports.  If you delete the explorations, the reports are also deleted. 

Printing Explorations 
You can print the names and/or formulas of your explorations with the 
Print dialog.  To access the Print dialog, choose Print from The Explorer 
dialog.   



 

 
 

MetaStock Professional Ranking and Screening Securities • 385 

 

 

 

 
Print What.  Choose Names Only if you want to print only the names of 
the explorations.  Choose Names and Formulas if you want to print the 
names and formulas. 
Copies.  Enter the number of copies to print. 
All.  Choose this button if you want to print all explorations. 
Selection.  Choose this button if you want to print only the selected 
explorations. 

Running the Exploration 
To run an exploration, highlight the exploration name and choose the 
Explore button from The Explorer dialog. 

 
The time required to complete an exploration depends on the complexity 
of the exploration and if you've chosen to use the minimum or maximum 
amount of data for the calculations (see page 378).  Your computer 
hardware (i.e., processor, hard disk, etc.) also has a big impact on speed.   

Exploration Status Dialog 
During the execution of an exploration, the Exploration Status dialog 
appears.  This dialog keeps you informed on the progress of the 
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exploration.  You can also use it to run the exploration in the background, 
allowing you to perform other tasks while the exploration is executing. 

 
Most of the information in this window is self-explanatory.  Several of the 
items are explained below.   
Estimated Completion Time.  This is based on the average time to 
explore each security.  The estimated completion time is adjusted after 
each security.    
Execution Priority.  This drop-list allows you to control the amount of 
processor time devoted to the computation of the exploration.  You will 
normally leave this set to "Medium."  Set this to "Low" if the program 
seems "jerky" or unresponsive while an exploration is running in the 
background (i.e., the exploration is minimized). 
Minimize.  Use this button to minimize the Exploration Status dialog.  
When an exploration is minimized, you are free to use any other feature in 
the program.  You can even perform a system test, which can also be 
minimized (see page 319).  
When minimized, double-click the exploration icon to redisplay the 
Exploration Status dialog. 
Cancel.  You can cancel the exploration process by pressing the Cancel 
button.  There may be a slight delay after you choose Cancel.  A window 
appears asking you to confirm the Cancel.  Reports for the securities that 
were completed before pressing Cancel will be available for your 
inspection.   
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To run an exploration in the background  
1. Start an exploration. 
2. When the Exploration Status dialog appears, click the Execution 

Priority drop-list to choose the desired execution priority.  If you are 
planning on using other calculation intensive features in this or other 
programs while the exploration runs in the background, choose 
Medium or Low. 

3. Click the Minimize button. 

Running Multiple Explorations 
There may be times when you wish to run more than one exploration on 
the same list of securities, run an exploration on the results of another 
exploration, or run several explorations on separate lists of securities 
without having to start each exploration separately.  Each of these 
scenarios is possible using the Multiple Explorations dialog. 
To run more than one exploration, hold down the CTRL or SHIFT key  
while selecting the explorations, then choose the Explore button from The 
Explorer dialog.  The Multiple Explorations dialog will appear allowing 
you to specify how each exploration is run. 

 
The explorations are listed in numerical order.  Use the arrows to the 
right of the list to change the order of the explorations. 
Use the results from the preceding exploration.  Choose this 
option to run each subsequent exploration on the results of the previous 
exploration.  The first exploration uses the list of securities selected in the 
Select Securities dialog (see page 382).   
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Use a single security list for all Explorations.  Choose this option 
to run all explorations on the same list of securities. 
Use a separate security list for each Exploration.  This option 
allows you to choose a separate list of securities for each exploration. 
Automatically print results.  Check this box to send the exploration 
results directly to your printer as each exploration is completed. 
Print.  Click this button to select a printer. 

Speed of Calculation 
The speed of the exploration can be increased by: 
• Decreasing the number of periods used in the formulas. 
• Selecting "Load Minimum Records" in the Explorer Options dialog 

(see page 378). 
• Reducing the number of references to formulas (i.e., the FML() 

function). 
• Adding a faster CPU. 
• Adding a faster disk drive. 
• Using local data instead of data stored in the online cache folder (see 

page 38). 

Viewing the Reports 
Exploration reports can be accessed two ways.  You can choose the 
Reports button from the Exploration Completed dialog.  This dialog 
appears immediately after an exploration has completed (the "Notify 
When Exploration is Done" box must be checked in Explorer Options, 
see page 378).  You can also view a report by selecting an exploration in 
The Explorer dialog and choosing Reports.  An "R" must be displayed 
next to the selected exploration. 
There are three reports available for an exploration; each is available by 
choosing the corresponding tab from the Reports dialog. 
The Results report displays every security (that was not rejected) in the 
exploration and its accompanying column values.  The folder from which 
each security came is displayed in the last column. 
The Rejects report shows every security that was rejected and the reason 
(see page 392). 
The Exploration Security Column Data report shows the historical column 
values for the selected security (see page 391). 

Results Report 
The Results report displays the results of the exploration.  Every security 
that passed the filter (if enabled), along with all of the defined columns 
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will appear.  The name assigned to the exploration along with the 
calculation date is displayed at the top of the report. 
The width of a column in the Results report can be adjusted by dragging 
the vertical separator between the column headings with the mouse until 
the column is the desired width. 

 
Inspect.  This displays the Exploration Security Column Data report for 
the selected security.  This report displays historical values required to 
calculate each column for the highlighted security.  See page 391 for 
more information on this report. 
Open Chart.  Click this button to display a chart of the selected 
security. 
Sort.  Use this to sort the report on any of the columns.  Note that you 
can also click directly on the column headings to sort.  Click repeatedly 
to change between ascending and descending order.  See page 390 for 
more information on sorting.   
Print.  Choose this to print the contents of the Results report.  See page 
355 for information on printing reports. 
Save List.  Choose this option to save the results as a list that you can 
use in The Explorer and The DownLoader. 

Using the Shortcut Menu 
You can also add to favorites, copy, delete, or edit the securities in the 
results report.  First, select the desired securities, then right click on one 
of the highlighted securities. A menu appears for you to choose from. 
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Copy.  Choose this to copy the entire report onto the Windows clipboard 
so it can be pasted into another Windows document. 
Save to file.  Choose this to save the list as a text file. 
Edit data.  Choose this to open the selected security(s) in a datasheet in 
The DownLoader where the data may be edited. 
Delete security.  Choose this to delete the selected security(s). 
Copy security.  Choose this to copy the selected security(s) to another 
folder on a local drive.  The Copy Securities dialog will appear.  Enter the 
new folder in the Destination folder box, or click the Browse button to 
find the folder you want to copy to.  If you want the Smart Chart for that 
security to be copied also, check the Copy Smart Chart box.  If you want 
to delete the security from the current folder, check the Delete source 
security box. 

 
Add to favorites.  Choose this to add the selected security(s) to your 
favorites.  See page 71 for more information about favorites. 

Sorting the Results Report 
You can sort the Results report on any of the columns (including the 
Security name column) in either ascending or descending order.  Simply 
click the column heading on which you want to sort.  Click repeatedly to 
toggle between ascending and descending order.  When you sort on the 
security name column, the report is sorted alphabetically.  
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To control the primary, secondary, and tertiary sort columns, use the 
Exploration Column Sort dialog.  This dialog is accessed by clicking the 
Sort button in the Results report. 

 
Sort by.  Choose the primary column on which the report is sorted from 
the drop-list.   
Then by.  Choose the column on which duplicates from the previous 
"sort" should be sorted.  For example, if the security named "IBM" 
appeared five times in the report, these five occurrences of IBM would 
then be sorted by the column you choose here.  
The sort order of the report is affected the most by the sort column 
specified in the "Sort by" box.  The sort columns specified in the "Then 
by" boxes only take effect when there are duplicates. 
Ascending.  Choose this to change the sort order of the column to 
ascending (i.e., the values increase as you go down the report). 
Descending.  Choose this to change the sort order of the column to 
descending (i.e., the values decrease as you go down the report). 

Exploration Security Column Data Report 
This report is accessed by selecting a security in the Results report and 
choosing Inspect.  This report lets you view the column values for every 
time period used in the calculation of the exploration.  
The amount of data displayed in this report is determined by the Data 
Loading option setting in the Explorer Options dialog (see page 378). 
The width of a column in this report can be adjusted by dragging the 
vertical separator between the column headings with the mouse until the 
column is the desired width. 
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Print.  Choose this to print the contents of the report.  See page 355 for 
information on printing reports. 

Rejects Report 
This report displays the securities that were not included in the Results 
report.  Each security that was rejected from the report will be listed, with 
a brief description of why it was rejected. 
If your exploration contains a filter, this report will list all securities that 
were filtered out.  Securities that were rejected due to an error are also 
listed.  For example, if your exploration calculates a 200-period moving 
average and your IBM data file only contains 100 days of data, IBM 
would appear in the Reject report. 
Print.  Choose this to print the contents of the Rejects report.  See page 
355 for information on printing reports. 
Save List.  Choose this option to save the results as a list that you can 
use in The Explorer and The DownLoader. 

Exploration Page 
The Exploration page displays the column formulas, the filter rule, 
periodicity and other information used for the exploration.  Having this 
information available with the reports lets you view this information 
without having to close the reports. 
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Copying Reports to the Windows Clipboard 
You can copy the contents of an exploration report to the Windows 
Clipboard for use in other Windows applications.    

To copy a report to the clipboard  
1. Display a report. 
2. Right-click anywhere within the report's page. 
3. Choose Copy to copy the contents of the report to the clipboard.  

You can then paste the contents into another Windows application. 

Sample Explorations 
This section shows the column and filter formulas for six example 
explorations.  Several pre-defined explorations are also included with 
MetaStock Pro. 

Long-term Bearish 
This exploration shows securities that are below their 200-day moving 
average. 
Column A: close 
Column B: mov(close,200,exponential) 
Column C: ((close-mov(close, 200, exponential)) /  
Abs(Mov(close,200,exponential))) * 100 
Filter: colA < colB 
This exploration requires only a filter to produce the desired list of 
securities.  However, the exploration also includes columns for the 
closing price, the 200-day moving average value, and the percent the 
close is below its 200-day moving average. 



 

 
 

394 • Ranking and Screening Securities MetaStock Professional 

 

 

 

Long-term Bullish 
This exploration shows securities that are above their 200-day moving 
average. 
Column A: close 
Column B: mov(close,200,exponential) 
Column C: ((close-mov(close, 200, exponential)) /  
Abs(Mov(close,200,exponential))) * 100 
Filter: colA > colB 
This exploration requires only a filter to produce the desired list of 
securities.  However, the exploration includes columns for the closing 
price, the 200-day moving average value, and the percent the close is 
above its 200-day moving average. 
Note that the only difference between this exploration and the Long-term 
Bearish exploration is the "greater than" sign (i.e., ">") in the filter. 

MACD Buy Signal 
This exploration shows securities that have produced a classic MACD 
"buy" signal (i.e., when the MACD rises above its signal line). 
Column A: close 
Column B: macd() 
Column C: mov(macd(),9,exponential) 
Filter: cross(macd(),mov(macd(),9,exponential) 
This exploration only requires a filter to produce the desired list of 
securities.  However, the exploration also includes columns for the 
closing price, the MACD value, and the 9-day signal line value. 

Indicators, 5 popular 
This exploration shows the column formulas that will show each 
security's close along with five popular indicators. 
Column A: close 
Column B: macd() 
Column C: Stoch(5,3) 
Column D: cci(14) 
Column E: obv() 
Column F: rsi(14) 

This exploration does not require a filter.  This exploration could be 
easily modified to include your favorite indicators. 

Performance, Daily 
This exploration shows the short-term performance of each security. 
Column A: close 
Column B: roc(close,1, percent) 
Column C: roc(close,5, percent) 
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Column D: roc(close,10, percent) 
Column E: roc(close,30, percent) 
Column F: roc(close,60, percent) 

This exploration does not require a filter since we want to see every 
security's performance ranking.  The Exploration Report has been written 
to include columns for five performance criteria including a one-day, five-
day, 10-day, 30-day, and 60-day percentage rate-of-change. 
You may want to use the Sort button in the Results report to sort on one 
of the performance columns.  For example, you could sort the report so 
that securities with the highest 60-day performance appear at the top of 
the column. 

Price and Volume Breakout 
The following exploration produces a report listing all securities that have 
risen more that 5% in the last day on at least 50% greater than average 
volume. 
Column A: close 
Column B: ref(close,-1) 
Column C: roc(close,1,percent) 
Column D: volume 
Column E: mov(volume,50,exponential) 
Column F: ((volume - mov(volume,50,exponential)) / 
mov(volume, 50, exponential)) * 100 
Filter: (colC >= 5) and (colD >= (colE*1.5)) 
This exploration requires only a filter to produce the desired list of 
securities.  However, the exploration also includes columns for the 
closing price, the previous day's closing price, the percent rate-of-change, 
volume, average volume, and the percent the volume is above its average. 

Exploration Tips 
• Due to the way the Performance indicator is calculated, you may 

notice that the column values displayed on the Results report for the 
Performance indicator are not consistent.  We recommend that you 
avoid using the Per() function in explorations. 

• The Explorer will not include composite securities in an exploration.  
If an exploration folder contains composite securities, they will be 
ignored. 

• Exploring data stored in the online cache folder is very slow.  If you 
plan to run explorations regularly, you should consider using local 
data instead. 

• Remember to use the COL variable within your filter to directly 
reference the columns.  Using the COL variable is especially 
beneficial when the column formulas are long. 
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• For your explorations to be valid, it is important that your data be 
accurate and date-aligned.  Date-aligned means that the dates for each 
of the securities included in the exploration match.  If data is missing 
for a security (even a single day), the values shown in the reports may 
not be accurate. 

• You may want to include a broad-based market index in your 
exploration to see how it compares to your other securities.   
Including an index is especially helpful when you are using The 
Explorer to rank your securities by performance.  Several pre-defined 
performance explorations are included with MetaStock Pro. 

• You can reference an indicator in a chart by selecting the indicator 
(i.e., clicking on it so handles appear) and then substituting the "P" 
variable in place of a formula's data array.  For example, the formula 
"mov(p,10,s)" would calculate a 10-period moving average of the 
selected indicator.  

• You should avoid using the "ref()" function to reference column 
formulas (e.g., ref(colA, -1) ).  The Explorer only calculates values 
for the "calculation date."  The ref() function returns the value for 
this date only. 

• You should avoid using the "cross()" function to reference column 
formulas (e.g., cross(colB, colC) ).  The cross() function requires 
data for two days in order to determine if the "cross" actually 
occurred.  The Explorer only calculates the column values for the 
specified "calculation date." 

• When doing an exploration with the Exploration Periodicity set to 
"weekly," you may receive a "period value out of range" error 
message due to there not being enough data.  For example, there may 
be enough data to calculate a 200-day moving average, but not 
enough for a 200-week moving average. 
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Getting Expert Advice on Your 
Securities 

What is the Expert Advisor?  
The Expert Advisor is a collection of powerful tools that keep you 
informed of the current technical state of a chart.  When attached to a 
chart, an Expert can inform you on the state of these conditions by 
various methods: 
• descriptive text (called Commentaries) 
• colored bars (called Highlights)  
• a symbol in the bottom corner of the chart (called the Expert Corner)  
• a special inner window (called a Ribbon)   
• symbols on the chart (called Symbols)  
• pop-up messages, sound or video (with Alerts) 
• e-mail and pager messages (with Alerts) 
Most people will simply use experts that are pre-packaged with 
MetaStock Pro, or purchased from Equis or a third party.  For example, if 
you want to see Bill William's expert commentary on any chart you 
display, simply right-click on the chart, choose Expert Advisor, Attach, 
then choose Bill William's pre-packaged expert. 
Due to the inherent complexity in the design and creation of custom 
indicators, trading systems, explorations, and experts, Equis cannot 
provide free support for this process.  However, support is available for 
a reasonable fee.  Call Equis at 801-265-9998 for details or fill-out the 
FORMULA HELP.DOC file found in the MetaStock folder.  This file is 
viewable with Wordpad.  
For information on the Equis Solution Provider program and the 
MetaStock Developer's Kit, go to www.equis.com. 
If you are willing to invest a little time, you can create your own experts.  
For example, you could create your own customized commentary.  You 
could create alerts that will sound and display a message when certain 
conditions are met.  Perhaps you would like to have your price bars 
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colored red when the RSI is above 50 and black when they're below 50.  
The possibilities are endless. 
If you want to create your own experts, you must be familiar with the 
MetaStock formula language.  Please see page 235 for more information 
on the MetaStock formula language. 
Equis International is not a Registered Investment Advisory service.  
The experts included with MetaStock Pro are for educational purposes 
and are to be used at your own risk.  Equis International (or its 
partners) is not liable for the investment decisions you make based on 
information obtained from the Expert Advisor. 

Using Pre-packaged Experts 
Most people will never create their own experts.  That’s fine!  We 
designed the Expert Advisor as a tool to provide information on the 
technical status of a security.  Not only is MetaStock Pro shipped with 
many pre-packaged experts that you should find useful, other pre-
packaged offerings will be available directly from Equis and third parties. 
Therefore, if you just want to use the experts that are pre-packaged with 
MetaStock Pro (or purchased separately), this section is all you really 
need to read. 
1. Display a chart to which you would like to attach an expert. 
2. Right-click anywhere within the chart’s inner window.  The chart’s 

shortcut menu appears. 
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3. Choose Expert Advisor and then Attach. 
4. For this example, choose Equis – Stochastic Oscillator from the 

Attach Expert dialog.  Click the OK button. 
5. The appearance of your chart will now change to reflect the newly 

attached expert.  The illustration below shows some of the 
components that you may see. 

 
6. To quickly display the commentary for the attached Expert, right-

click on the chart, choose Expert Advisor and then Commentary. 
That’s it.  This simple procedure is all that is required to reap the power 
of the Expert Advisor.  
Equis International is not a Registered Investment Advisory service.  
The experts included with MetaStock Pro are for educational purposes 
and are to be used at your own risk.  Equis International (or its 
partners) is not liable for the investment decisions you make based on 
information obtained from the Expert Advisor. 
 

Expert Advisor Dialog 

 
Expert Advisor button 

The Expert Advisor dialog is displayed by choosing Expert Advisor from 
the Tools menu or clicking the Expert Advisor button on the standard 
toolbar.  The Expert Advisor dialog lists the names of all your experts 
(both those you have created and those pre-packaged with the software).  
The Expert Advisor dialog can hold up to 1,000 experts.  The selected 
expert can be edited, copied, deleted, printed, and attached.  You can also 
create new experts from this dialog.  A small triangle appears next to the 
expert that is currently attached to the selected chart. 
New.  Use this to display the Expert Editor dialog in which you can 
specify the components of a new expert.   
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Edit.  Use this to display the Expert Editor dialog in which you can edit 
the selected expert. 
Copy.  Use this to make a copy of the selected expert.  See page 436 for 
more information on copying experts. 

You can select multiple 
experts  by holding down 
the CTRL key as you click 
the mouse. 

Delete.  Use this to delete the selected expert.  See page 436 for more 
information on deleting experts. 
Print.  Use this to print the selected expert.  See page 436 for more 
information on printing experts. 
Organize.  Use this to display the Formula Organizer Wizard from which 
you can import and export explorations, system tests, custom indicators, 
and experts.  This is normally used if you have purchased add-on products 
from Equis or a third party.  See page 249 for more information on the 
Formula Organizer Wizard. 
Attach/Detach.  Use this to attach the selected expert to the current 
chart.  This button changes to Detach if the selected expert is already 
attached to your chart.  A small triangle appears next to the attached 
expert.  The Attach button is disabled if no chart is displayed.  See page 
435 for more information on attaching experts. 
Commentary.  Use this to view the corresponding commentary (if 
available) for the selected expert.  The Commentary button is disabled if 
no chart is displayed.  See page 406 for more information on 
commentaries. 

Creating an Expert 
Perhaps the most important thing to remember when creating an expert is 
that it can be as simple or complex as you like.  For example, you can 
create a very simple expert that simply sounds an alert whenever the 
close crosses above its moving average.  Another expert could be written 
to display a ribbon at the bottom of the chart showing the bullish and 
bearish zones as defined by an RSI.  Or you could write an expert that 
generates a commentary explaining the current state of the security as 
defined by five of your favorite indicators.  The possibilities are many. 

 
Expert Advisor button 

To run the Expert Advisor, choose Expert Advisor from the Tools menu or 
click the Expert Advisor button on the standard toolbar. 

To create a new expert, choose New from the Expert Advisor dialog.  The 
Expert Editor dialog appears.  You use this dialog to create the various 
components of an expert.  Again it is important to remember that an 
expert need not contain every component.  In fact most experts you 
create will probably only contain one or two components.  The only 
components required are the Name and one of the other five components 
(i.e., Trend, Commentary, Highlights, Symbols, or Alerts). 
This dialog is different from most in that you can resize it.  Position the 
mouse over the border of the dialog and click and drag the mouse until the 
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dialog is the desired size.  This is very convenient when writing 
commentaries. 

 
Name.  Enter the name of the expert in the Name box.  Type any unique 
information about the expert in the Notes box.   
You may want to use a consistent naming convention that describes the 
components used in the expert.  For example, if the only component of 
the expert is a commentary, you may want to name it “MyExpert 
(commentary)”.  If the only component was an alert, you may name it 
“MyExpert (alert).  The more descriptive the name, the easier it will be 
for you to remember what the expert does. 
Trend.  Enter the Bullish and Bearish trend rules.  The rules are written 
using MetaStock’s formula language (see page 235).  The rules are 
interpreted as either true or false.  The results of the trend rules are 
displayed in a ribbon, the expert corner, or in the Data Window.  See page 
403 for more information on writing and viewing trend rules. 
Commentary.  Enter the commentary to display.  Commentaries are 
used to tell you, in English (or German, Spanish, etc.), the technical state 
of the security.  There are two special functions and five constants 
available specifically for writing commentaries.  The built-in editor also 
has a basic word-processing like toolbar that allows you to control fonts 
and formatting.  The results of the commentary are displayed in the 
Expert Commentary dialog.  See page 406 for more information on 
writing and viewing commentaries. 
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Highlights.  The Highlight page is used to create and edit highlights.  A 
highlight colors a chart’s price bars to indicate specific conditions.  An 
unlimited number of highlights can be defined for an expert. See page 422 
for more information on creating highlights. 
Symbols.  The Symbol page is used to create and edit symbols.  A 
symbol can be placed above or below price bars to indicate specific 
conditions.  An unlimited number of symbols can be defined for an 
expert. See page 426 for more information on creating symbols. 
Alerts.  The Alert page is used to create and edit alerts.  When the  
defined conditions of the alert are met, a specified message will appear,  
an audible sound file or video will play, or an e-mail or pager notification 
will be sent.  An unlimited number of alerts can be defined for an expert. 
See page 430 for more information on using alerts. 

Components of an Expert 
An expert can be as simple or complex as you want.  The following 
illustration shows an expert that contains all five components.  In order 
for an expert to produce results, it must be attached to a chart as 
illustrated by the arrow. 

 

In most cases, an expert will only contain one or two components.  In fact 
an expert containing just one of the components will likely be the most 
common.  The illustration below shows an expert containing just two 
components being attached to a chart. 
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Defining Bullish and Bearish Trends 
Bullish and bearish trends are defined in the Trends page in the Expert 
Editor dialog.  The rules for the bullish and bearish conditions are written 
using MetaStock’s formula language (see page 235).  Each rule can 
contain up to 2,500 characters. 

 
There are three states that a trend normally falls within: 
Bullish. The trend is considered bullish if and only if the bullish trend 
rule is true. 
Bearish. The trend is considered bearish if and only if the bearish trend 
rule is true. 
Neutral.  The trend is considered neutral if neither the bullish nor 
bearish trend rules are true. 
A trend can also be in one of the following states: 
Confused.  The trend is considered confused if both the bullish and 
bearish trend rules are true simultaneously.  This usually indicates an 
error in the logic of the trend rules.  You should double-check your 
formulas to make sure they define the conditions properly. 
Undefined. The trend is considered undefined if the formula is not up to 
speed (e.g., during the first 49 periods of a 50-period moving average).  
The first few days displayed in the ribbon are usually undefined since 
most indicators take a while to get up to speed. 
 
The results of a trend are displayed in an expert ribbon, the expert corner 
or in the Data Window.The following chart shows both an expert ribbon 
and the expert corner. 
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 The expert ribbon is a small, narrow window located in the chart.  The 
color, patterns, and labels for the bullish, bearish, and neutral zones can 
be defined within the Expert Ribbon dialog.  The ribbon can be moved 
within the chart using the same drag and drop techniques as with inner 
windows (see page 114). 
The expert corner is located in the bottom corner of the chart where the 
x-and y-axes meet.  This is where a user-specified symbol is displayed.  
This symbol denotes the current condition of the security as defined by 
the trend rules (i.e., bullish, bearish, or neutral).  See page 405 for more 
information on the expert corner. 

Displaying the Trend in a Ribbon 
The ribbon is displayed at 
the bottom of the chart.  It 
shows  the bullish, 
bearish, and neutral zones 
in the chart. 

The expert ribbon provides a convenient way to view the historical bullish, 
bearish, and neutral zones of a security.  The rules that define these zones 
on a ribbon are created in the Trends page of the Expert Editor dialog (see 
page 404). 

You can control the color, patterns and labels used in the expert ribbon 
from the Expert Ribbon dialog.  This dialog is displayed by choosing the 
Ribbon button on the Trend page of the Expert Editor dialog. 
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Display Ribbon in Chart.  Check this box if you want the ribbon 
displayed in the chart. 
Display Vertical Lines.  Check this box if you want vertical lines 
displayed when the trend changes.  Choose the Ribbon's Inner Window 
radio button if you only want the lines displayed in the inner window in 
which the ribbon is located.  Choose All Inner Windows if you want the 
lines to extend through every inner window in the chart. 
Background.  Choose the background color to use for bullish, bearish, 
and neutral zones of the ribbon. 
Pattern.  Choose the pattern to use for bullish, bearish, and neutral zones 
of the ribbon. 
Label.  Type a label or choose a symbol (depending on whether you 
chose the Text or Symbols radio button) to use for the bullish, bearish, 
and neutral zones in the ribbon.  Note that text labels will not display if 
the zone is not wide enough to hold the entire label.  Therefore you may 
want to limit the number of characters used in your text labels.  If your 
zones are very narrow, you may want to use symbols rather than text-
based labels, since they occupy less space. 
Text.  Choose this radio button if you want the labels displayed using the 
specified text. 
Symbols.  Choose this button if you want the labels displayed using the 
specified symbols. 

Displaying the Trend in the Expert Corner 
The expert corner is 
displayed beneath the 
right y-axis if both axes 
are displayed. 

The expert corner is a small area located in the bottom corner of the chart 
where the x-and y-axes meet.  This area is reserved for the display of a 
symbol.  The symbol indicates the current trend (i.e., for the last bar 
loaded in the chart) of the security. The rules that define expert corner 
symbol are created in the Trend page of the Expert Editor dialog (see 
page 403).   
A user defined symbol will appear if the current state is bullish, bearish, 
or neutral.  If the state is confused (403), the symbol for neutral will 
appear.  If the state is undefined, no symbol will appear. 
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The color and style of the symbol is controlled from the Expert Corner 
dialog.  This dialog is displayed by choosing the Corner button on the 
Trend page of the Expert Editor dialog.   

 
Display Symbol in Expert Corner.  Check this box if you want 
symbols displayed in the Expert Corner area of the chart. 
Symbol.  Choose the symbol to use for the bullish, bearish, and neutral 
state of the security. 
Color.  Choose the color to use for the symbol.  Be sure to choose a color 
that is different from the background color of the expert.  Otherwise, the 
symbol will not be visible. 

Tips for Using Trends 
• If you find the vertical lines obstructive to your charts, but you’d still 

like to pinpoint the beginning and ends of trends, use highlights (see 
page 422).  Create two highlights, one that matches the bullish trend, 
and another that matches the bearish trend.  The color of the price 
bars will coincide with the ribbon. 

• If most of the labels on your ribbons aren’t showing up due to the 
narrowness of the zones, change the label to display a symbol rather 
than text.  Symbols generally take up much less space.  This is done 
from the Expert Ribbon dialog (see page 404). 

• The 200-day moving average is considered sacred to many technical 
analysts.  It is a good indicator of the long-term trend of the security.  
You may want to create an expert corner that shows a bullish symbol 
when the price is above its 200-day moving average and a bearish 
sign when it's below. 

Writing Commentaries to Summarize and Instruct 
A commentary is perhaps the most versatile and powerful component of 
the Expert Advisor.  Although many people will use pre-packaged expert 
commentaries, you may want to create your own. 
Briefly stated, a commentary allows you to write text and then control 
what text is displayed based on logical conditions.  In other words, some 
text can be displayed at all times and the display of other text can be 
dependent on whether a specified condition is true or false.  The writeif() 



 

 
 

MetaStock Professional Getting Expert Advice on Your Securities • 407 

 

 

 

and writeval() functions are the key functions used when writing 
commentaries.  These two functions are unique to the commentary syntax. 
As is the case with the other components in the Expert Advisor, 
commentaries can take full advantage of MetaStock Pro’s powerful 
formula language (see page 235).  Therefore, you should be familiar with 
custom indicators to take full advantage of commentaries. 
The following illustration shows a commentary in its native format: 

 
The following illustration shows the same commentary as it would be viewed: 

 
A great way to learn the power and flexibility of commentaries is by 
viewing the pre-packaged expert named "Equis - Instructional 
Commentary" written by Steve Achelis, founder of Equis International. 
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To view Steve Achelis' pre-packaged instructional 
commentary  
1. Display a chart. 
2. Choose Expert Advisor from the Tools menu. 
3. Choose the expert named "Equis - Instructional Commentary" from 

the dialog and click the Edit button. 
4. Click the Commentary tab. 

Displaying Conditional Text with Writeif() 
The writeif() function displays the specified text if the condition is true.  
Optionally, you can have the function display the specified text if the 
condition is false.  If the condition is true, the first text string is 
displayed.  If the condition is false, the second text string is displayed.    
The following is the syntax of the writeif() function. 
writeif(logical formula, “true text string”, “false 
text string”) 

Each text string must be contained within double quotes (" ").  If you need 
the text itself to contain quotes, they can be written as \” as shown below. 
writeif(c>mov(c,200,s),"The trend is up and remember 
\"the trend is your friend.\"", "The trend is down.") 

The length of a text string is virtually unlimited (64K or about 20 pages).  
This means that your text can wrap across multiple lines if needed.  It can 
even contain line feeds. 
The following example writes “The market is bullish” if the closing price 
is above its 200-day moving average.  It writes “The market is bearish” if 
the closing price is equal to or below its 200-day moving average. 
writeif(c > mov(c,200,s),”The market is bullish”,”The 
market is bearish”)  

The writeif() function can display numerical values using the writeval() 
function (see page 409).  For example, the following example displays 
the value of the RSI if the close crosses above a 50-day moving average. 
writeif(cross(c,mov(c,50,s)),”writeval(rsi(14))”) 

Note that in the above example, there was no text specified for a false 
condition.  You don’t have to specify the text for when the condition is 
false. 
Just like the standard if() function in the MetaStock formula language 
(see page 235), you can also nest writeif() statements as shown in the 
following example. 
writeif(v>ref(v,-1),”writeif(c>mov(c,10,s), 
”bullish”,”bearish”)”,”volume down”) 

Note that the second writeif() function is completely contained within 
quotes because it is the true text string for the first writeif() function.    
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In English, the previous statement says, "If the volume is greater than the 
previous day's volume (i.e., v>ref(v,-1) ), then check the close to see if it 
is above its 10-day moving average (i.e., c>mov(c,10,s) ).  If both of 
these are true, the word "bullish" is displayed.  If volume is greater than 
the previous day's, but the close isn't greater than the 10-day moving 
average, "bearish" is displayed.  Otherwise, if the volume is not greater 
than the previous day's volume, "volume down" is displayed."   

Clarifying with Comments 
You may want to strategically place comments within your commentaries 
to clarify and explain what is happening.  Comments can be very helpful 
when you need to debug or modify the syntax at a later time.   
Comments can be inserted into conditional statements by surrounding the 
statement in braces.  The text inside the braces will not appear when the 
commentary is viewed.  In the formula below, "{This is bullish output}" 
and "{This is neutral/bearish output}" are the comments inside the 
conditional statement. 
writeif(cross(c,mov(c,50,s)),  
{This is bullish output}"RSI is writeval(rsi(14))”, 
{This is neutral/bearish output}"RSI neutral/bearish") 

If a comment is entered on its own line, you will probably want to place a 
backslash (see page 413) after the comment so that an extra line feed 
does not show up in your commentary. 
{The following defines a support line}\ 
support:=(If(Abs((Trough(1,L,1)-
Trough(2,L,1))/Trough(2,L,1))<.015 AND 
Abs((Trough(2,L,1)-
Trough(3,L,1))/Trough(3,L,1))<.015,{then} 
(Trough(1,L,1)+Trough(2,L,1)+Trough(3,L,1))/3,0)); 

Using Variables in Commentaries 
Variables can be used within commentaries.  However, they must be 
assigned within a writeif() or writeval() function.  See page 437 for more 
information on using variables in commentaries.   

Displaying Numeric Values with Writeval() 
The writeval() function is used to display the value of a formula.  The 
formula contained in the writeval() function must be written using 
MetaStock’s formula language.  The following shows the syntax of the 
writeval() function.  
writeval( DATA ARRAY ) 

The following example displays the value of the stochastic oscillator. 
writeval(stoch(14,3)) 

The writeval() function can be nested within a writeif() function as 
shown in the following example. 
writeif(rsi(14) > 80, “writeval(rsi(14))”,”not above 
80”) 
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You can also use the standard if() function to control what value the 
writeval() function displays.  The following formula displays the value of 
the 10-period moving average if the RSI is greater than 80, otherwise the 
value of the 20-period moving average is displayed. 
writeval(if(rsi(14)>80,mov(c,10,s),mov(c,20,s))) 
Of course the same results would be generated by the following formula 
using the writeif() function.  However, the previous example is more 
concise. 
writeif(rsi(14)>80,”writeval(mov(c,10,s))”,”writeval 
(mov(c,20,s))”) 

The above method is required however, if your true/false text needs to 
combine formula values and text as shown below. 
writeif(rsi(14)>80,”The 10-period moving average is 
writeval(mov(c,10,s)).”,”The 20-period moving average 
is writeval(mov(c,20,s)).”) 

Controlling the Width and Decimal Placement 
There may be times when you would like to control the width and 
decimal placement of numbers generated by the writeval() function.  The 
most obvious use is when aligning values in columns. 
An additional parameter can be attached to the end of the writeval() 
function to control width and decimal positions.  The value to the left of 
the period controls the width and the value to the right of the period 
controls the number of places to display to the right of the decimal.  Here 
are some examples. 
10 characters wide and 3 decimal places:  writeval(macd(),10.3) 
5 characters wide and 2 decimal places:  writeval (rsi(14),5.2) 
Left-justified with 3 decimal places:  writeval(rsi(21),0.3) 
8 characters wide with no decimal places:  writeval(rsi(34),8.0) 
If the width specified is too small to display all of the digits required, the 
actual number of digits displayed will be the minimum number required 
to hold the entire value. 
If the decimals field is too small to display the total number of decimal 
digits in the value, the number of decimal digits displayed is truncated 
(not rounded) to the number requested. 
The following illustration shows the commentary to generate a table of 
indicator values. 
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The following shows the resulting commentary. 

 

Using Constants in Commentaries 
There are five constants that are used to display information about the 
security the commentary is attached to. 
<NAME>.  This displays the name of the security. 
<SYMBOL>.  This displays the ticker symbol of the security. 
<PERIODICITY>.  This displays the periodicity of the security in the 
default long format (i.e., daily, weekly, etc.).  To display the periodicity 
in the short format (i.e., day, week, etc.) append a ":S" (e.g., 
<PERIODICITY:S> ).  Note that appending a ":L" or nothing at all, 
displays the default long format. 
You can also control whether or not the first letter of the periodicity is 
capitalized.  <Periodicity> capitalizes the first letter (i.e., Daily); whereas 
<periodicity> keeps the first letter in lower-case (i.e., weekly). 
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<DATE>.  This displays the date (and time for intraday charts) for which 
the commentary is generated (i.e., the last date and time loaded in the 
chart).  To display the date in the long format (e.g., "Friday, September 
20, 1998") append an  ":L" (e.g., "<DATE:L>").  Note that appending an 
":S" or nothing at all, displays the default short format.  The format of 
your date (both long and short) is controlled from the Regional Settings 
Properties dialog in the Windows Control Panel. 
<EXPERT>.  This displays the name of the expert. 
The following commentary makes use of these constants. 

 
The following is the resulting commentary. 
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Controlling the Look of Commentaries 
You can control the way a commentary appears by using fonts, colors, 
formatting, bullets, and special control characters. 

The Backslash 
The backslash character (i.e., \ ) tells MetaStock Pro to suppress the start 
of a new line. This prevents a lot of blank lines when the conditional text 
isn't displayed.  For example, the following text will appear on five lines: 
This 
appears 
on 
five 
lines. 

Whereas, due to the backslashes, the following text appears on one line. 
This \ 
appears \ 
on \ 
one \ 
line. 

Note that a backslash must be followed by a carriage return.   
To prevent blank lines from appearing when the nested conditional 
statements are not displayed, backslashes are used in the following 
example. 
writeif(Highest(high)=high,"<Name> is making new 
highs.")\ 
writeif(Lowest(low)=low,"<Name> is making new lows.", 
"" )\ 
writeif(cross(macd(),mov(macd(),9,e)),"The MACD is 
giving a new buy signal today (<Date>).", "")\ 

Using Colors, Fonts, and Formatting 
To make your commentaries more readable, you should take advantage of 
the word-processing tools on the commentary toolbar.  You have a choice 
of multiple fonts, point sizes, colors, formatting, text alignment, and even 
bullets. 
A rather boring commentary that looks like this… 
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…can be brought to life by using the tools creatively. 
 

 
To change the fonts, colors, and formatting of text within the expert 
commentary editor, use the toolbar at the top of the dialog. 

 

Accelerator Keys 
In addition to the buttons on the commentary toolbar, the following 
accelerators are also available when editing a commentary: 
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Action Accelerator Key
Bold toggle CTRL+B 

Underline toggle CTRL+U 

Italics toggle CTRL+I 

Center align paragraph CTRL+E 

Left align paragraph CTRL+L 

Right align paragraph CTRL+R 

Increase paragraph indent CTRL+M 

Decrease paragraph indent CTRL+SHIFT+M 

Find text CTRL+F 

Find next F3 

Replace text CTRL+H 

The standard Windows Edit controls also work within a commentary.  
 

Action Accelerator Key
Cut to clipboard CTRL+X 

Copy to clipboard CTRL+C 

Paste from clipboard CTRL+V 

Select All text CTRL+A 

Undo last action CTRL+Z 

Redo last Undo CTRL+Y 

Embedding Video, Sound, and Other Files in 
Commentaries 
A great way to enhance an expert is to add multimedia and/or links to 
additional files (e.g., spreadsheets, docs, etc.) within a commentary.  
Video files, sound files, and other  files (e.g., an Excel spreadsheet, 
WordPerfect document, etc.) can be pasted directly in an expert 
commentary.  Several of the pre-packaged experts that are shipped with 
MetaStock Pro include linked video clips. 
Files that are linked within a commentary are usually displayed as icons.  
When a commentary window for a specific chart is displayed, you can 
double-click on the icon to view the file.  The necessary application to 
view (or run) the file is automatically launched. 
You can link a file within a writeif() function in a commentary, thereby 
making the display of the file's icon dependent on the condition as shown 
below. 
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Writeif(cross(c,mov(c,21,s)," ") 
 

In the above example, the video clip icon will only display in the 
commentary if the close has crossed above a 21-period moving average.  
Note that the video clip icon is contained within quotes, just as regular 
text would be. 
The following example shows an Excel spreadsheet linked within a 
writeif() function. 
Writeif(rsi(14)>80 and fml("Volatility 
Breakout")=1,"View this Excel spreadsheet for 

additional analysis, ") 

Of course, if you want the file's icon to always display in the commentary 
(several pre-packaged experts have these), simply paste link it directly in 
the commentary editor box, outside of any writeif() functions. You can 
paste link a file by right-clicking on the file in the Windows Explorer and 
choosing Copy and then right-clicking on the commentary window in 
MetaStock Pro and choosing Paste Special. 
If the linked file represented by the icon has been moved, renamed, 
deleted, etc., and you double-click the icon to view it, nothing will happen 
since MetaStock Pro does not know where the original file is located.  
Note that this will always occur if you purchased MetaStockPro on the 
floppy disks (rather than on CD-ROM) and you attempt to run any of the 
pre-packaged linked video clips (see page 417 for instructions on 
overcoming this problem).  The pre-packaged video clips are not shipped 
on floppy disks due to their large size. 

To paste a video, sound or other files into a commentary  
1. Open the Windows Explorer. 
2. Right-click on the file to copy and choose Copy from the shortcut 

menu. 
3. In MetaStock Pro, open the expert in which you want to copy the file 

and click the Commentary tab. 
4. In the Commentary editor box, right-click where you want the file to 

be inserted. 
5. Choose Paste Special from the shortcut menu. 
6. From the Paste Special dialog, choose the Paste Link radio button. 
7. If you want the file displayed as an icon in your commentary, check 

the Display As Icon box. 
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Accessing the Videos on the MetaStock Pro CD 
If you chose not to install the multimedia files on your hard disk during 
the installation of MetaStock Pro, you can still view the video clips from 
the MetaStock Pro CD by manually editing the link within the 
commentary. 

To access video directly from the MetaStock Pro CD  
1. In MetaStock Pro, edit the expert that you want to view the video in 

and click the Commentary tab. 
2. Right-click anywhere within the Commentary editor box.  You can do 

this even if it says "Formula is password protected or read-only." 
3. Choose Links from the shortcut menu. 
4. Click the Change Source button from the Links dialog and locate 

the correct AVI file from the \experts folder on the MetaStock Pro 
CD. 

5. Click the Update Now button in the Links dialog and then click the 
Close button. 

Note that the MetaStock Pro CD-ROM must be in the CD-ROM drive if 
you want to view the videos.  In addition, an operating system quirk 
prevents the path name shown with a video's icon from updating to reflect 
the new linked source. 

Finding and Replacing Text in Commentaries 
You can quickly locate text within a commentary by using the Find 
dialog.  When editing a commentary press the CTRL+F key to display the 
Find dialog.  You can press the F3 key to find the next occurrence of the 
text. 

 
Find What.  Type the text to search for. 
Match Whole Word Only.  Check this box to search for occurrences 
that are whole words and not part of a larger word. 
Match Case.  Check this box to distinguish between uppercase and 
lowercase characters. 
You can find text and replace with alternate text by using the Replace 
command.  When editing a commentary press the CTRL+H key to display 
the Replace dialog.   
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Find What.  Type the text to search for. 
Replace With.  Type the text to replace the text in the Find What box. 
Match Whole Word Only.  Check this box to search for occurrences 
that are whole words and not part of a larger word. 
Match Case.  Check this box to distinguish between uppercase and 
lowercase characters. 
Replace.  Click this button to replace the text in the Find What box with 
the text in the Replace With box. 
Replace All.  Click this button to replace all text in the commentary 
matching the text in the Find What box with the text in the Replace With 
box. 

Different Ways to View Commentaries 
The Preview button allows 
you to view the output of 
the commentary. 

There are several ways to view a commentary.  When writing your 
commentaries, you’ll want to use the Preview button in the Expert Editor 
dialog to see how things are turning out.  Clicking this button shows you 
exactly how your commentary will appear when viewed in the Expert 
Commentary Preview Window.  If there are errors in your commentary, 
you will be notified after clicking the Preview button.  Note that the 
Preview button is disabled if no chart is open. 
A chart must be open in order to view a commentary, otherwise the 
Commentary button will be disabled. 
After the expert to which the commentary belongs has been attached to a 
chart, you can view the commentary by using one of the following 
methods: 
• Right-click the chart and choose Expert Advisor, then Commentary 

from the short-cut menu.  The Commentary Window appears. 
• Choose Expert Commentary from the View menu.  The Commentary 

Window appears. 
• Click the Expert Advisor button on the standard toolbar.  Select the 

commentary to view and then click the Commentary button.  The 
Commentary Preview Window appears.  Use the Commentary 
Preview Window if you want to quickly scan through multiple 
commentaries.  If no chart is displayed, the Commentary button is 
disabled. 
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Docking the Commentary Window 
The Commentary Window (not the Commentary Preview Window) can 
be docked on the top, bottom or sides of the screen.  Drag the 
Commentary Window so that it overlaps the side of the screen by which 
you want to dock and release the mouse button.  Double-click just to the 
right of the Commentary Window's toolbar to undock. 
To change the size of a docked Commentary Window, you must change 
the size prior to docking.   If you dock the window on the left or right 
side of the screen, the width of the window (prior to docking) is retained.  
Likewise, if you dock the window on the top or bottom of the screen, the 
height of the window (prior to docking) is retained. 

Changing Analysis Dates with the Commentary Window 
Displayed 
By default the Commentary Window analyzes the last bar in the chart.  
However, you are not limited to just the last bar.  Perhaps, you'd like to 
read what the commentary said just prior to the last market selloff.  You 
can use the toolbar buttons in the Commentary Window to change from 
bar to bar, or you can click directly on the chart above or below the bar to 
analyze.  Note that this functionality is not available from the 
Commentary Preview Window which is displayed from within the Expert 
Advisor dialog. 

 
The bar that the commentary is analyzing is labeled with a small black 
triangle directly above the bar. 
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Changing from bar to bar as described above is a quick and convenient 
way to test the output of your commentaries for different market 
conditions. 

Commentaries Updating in Real-time 
An option in the Application Options dialog (see page 36) controls when 
a commentary attached to a real-time chart is updated.  You can choose 
whether the commentary should be updated with every tick, at the 
completion of each bar, or only when the Refresh button is pressed. 

 
Complex commentaries attached to active real-time charts can be a 
significant drain on system resources.  Therefore, you should be careful 
about choosing the "Update Commentary on each tick" option in the 
Application Options dialog. 

Tips for Writing Commentaries 
• Take advantage of the font, color, formatting, bullets, etc. to enliven 

your commentaries (see page 413). 
• Create columns of indicator values by using the writeval() function in 

combination with width and decimal parameters (see page 410). 
• Use the backslash at the end of nested writeif() functions to avoid 

blank lines (see page 413). 
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• Use constants to inform the reader about the security being analyzed  
(see page 411).  You may even make a standard header to appear at 
the top of every commentary. 

• When writing a commentary and you want to preview the true text 
string of the logical formula in a writeif() statement, you can force the 
condition to true by placing the words "or true" after the logical 
formula.  Likewise, the words "or false" after a logical formula will 
force the condition to false and allow you to preview the false text 
string. 

• Instead of using generic words like "bars" or "periods" in 
commentaries, use the <periodicity> constant with the letter "s" 
immediately following it (e.g., <periodicity>s ).  This will return a 
much more descriptive "days", "weeks", etc., matching the 
periodicity of the chart. 

• If you need to place quotes around a word in the true/false text of a 
writeif() statement, precede the quote with a backslash (i.e., 
\"bearish\"). 

• Comments can be inserted within a commentary by placing the text in 
braces (i.e., {} ).  You may want to use comments to clarify complex 
functions.  The text inside the braces will not display when the 
commentary is viewed. 

• If a comment is entered on its own line, you will probably want to 
place a backslash (see page 413) after the comment so that an extra 
carriage return does not show up in your commentary. 

• See the pre-packaged commentary named "Equis - Instructional 
Commentary." 

• You can jump directly from a chart to its commentary by right-
clicking on the chart, choosing Expert Advisor and then choosing 
Commentary. 

• You can increase the size of the Expert Editor dialog by clicking on 
the border of the dialog and dragging.  You may find this especially 
helpful when writing commentaries. 

• When creating columns of text or numbers, use a fixed width font 
such as Courier or Courier New to help align columns neatly. 

Using Highlights to Emphasize Specified Conditions 
Highlights are a great visual tool for analyzing a chart.  Since the focal-
point of a chart is the price bars, it only makes sense to have the display 
of the bars convey information about the technical status of the security.  
This is done with the use of color. 
The Expert Advisor allows you to define an unlimited number of 
conditions that will cause the bars to change colors.  For example, the 
bars could be colored red when the RSI is above 80, blue when its below 



 

 
 

422 • Getting Expert Advice on Your Securities MetaStock Professional 

 

 

 

20, and black when its between 20 and 80.  A simple concept, yet 
amazingly convenient and powerful. 

Creating and Editing Highlights 
Highlights are created and edited from the Highlights page of the Expert 
Advisor dialog.  Highlights are enabled by checking the box to the left of 
the highlight's name. 

 
New.  Choose this to create a new highlight.  The Expert Highlight 
Editor appears from which you can specify the name, conditions, and 
color for a highlight.   
Edit.  Choose this to edit the selected highlight.  The Expert Highlight 
Editor dialog appears.  
Delete.  Choose this to delete the selected highlights. 
Check All.  Click this button to enable (check) all highlights.  If you 
select only a portion of the highlights, only those selected are enabled. 
Uncheck All.  Click this button to disable (uncheck) all highlights.  If 
you select only a portion of the highlights, only those selected are 
disabled. 

 
Move Up button 

Move Up.  Click the Move Up button to move the selected highlight up 
the list.  The higher a highlight is on the list, the higher the priority it is 
given.  See page 430 for information on priority.  

 
Move Down button 

Move Down.  Click the Move Down button to move the selected 
highlight down the list.  The higher a highlight is on the list, the higher the 
priority it is given.  See page 430  for information on priority. 
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Specifying the Condition for a Highlight 
As with the other components in the Expert Advisor, the conditions for  
the highlights are written in the MetaStock formula language.  They are 
evaluated as either true or false.  A true condition will cause the price plot 
to be drawn (highlighted) in the specified color.  If the condition is false, 
prices are displayed in the colors specified in the Price Properties dialog 
(see page 151). 
You use the Expert Highlight Editor dialog to specify the condition and 
the color to use for a highlight.  This dialog is accessed by choosing New 
or Edit from the Highlights page of the Expert Editor dialog. 

 
Name.  Enter the name for the highlight.  You should use a name that is 
descriptive of the highlight (e.g., "RSI/Moving Average Bullish").  The 
maximum length of the name is 40 characters. 
Condition.  Enter the formula to use for the highlight.  If the formula is 
true for a given time period (i.e., day, week, month, etc.), the price plot 
will be highlighted with the selected color.  Click the Functions button if 
you need help with the MetaStock formula language.  Formulas must be 
written in the MetaStock formula language (see page 235). 
Color.  Choose the color from the drop list box.  This is the color that 
will be used when the highlight’s condition is true. 
Functions.  Click this button to display the Paste Functions dialog (see 
page 305).  Note that this button is enabled only when the cursor is 
located within the Condition box. 

Viewing the Results of Highlights 
As with all components of an expert, you must attach the expert 
containing the highlight to a chart in order to see the results. 

To view the results of a highlight  
1. Open a chart. 
2. Choose Expert Advisor from the Tools menu. 
3. Choose the expert that contains the highlights and choose Edit. 
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4. Click the Highlights tab. 
5. Check the box next to the desired highlight(s).  Click the OK button. 
6. Choose Attach from the Expert Advisor dialog.  The price plot on 

the chart should now redraw to reflect the highlight contained within 
the attached expert. 

7. Click the Close button in the Expert Advisor dialog. 

Sample Highlights 
The following illustrations show some examples of highlights. 
This highlight colors the bars blue when the close is below its 20-period 
moving average. 

 
This highlight colors the bars green when the closing price is up, the RSI 
is below 30, the CCI is below -100, and volume is twice its average. 

 
You can also combine multiple highlights.  For example, the previous 
two highlights could both be enabled simultaneously from the Highlights 
page as shown below.  Note that the checked box indicates both are 
enabled. 
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Move Up/Dn buttons 

When the conditions for these highlights are evaluated, the highlight that 
appears at the top of the list is given highest priority.  Use the Move Up 
and Move Down buttons to change the priority.  In this case, the highlight 
named “Oversold Reversal” is given the highest priority since it is listed 
first.  This means that if the conditions for both the Oversold Reversal   
and the RSI/CCI are true on the same day, the Oversold Reversal  
highlight will take precedence.  The bar would be colored green. 

Tips for Using Highlights 
• Highlights and Trend ribbons (see page 404) are very similar.  Both 

are used to place emphasis on  zones of prices when a specified 
condition is true. 

• Highlights are best used for conditions that remain true over a period 
of time.  Symbols are best to mark conditions that are triggered 
momentarily (i.e., moving average crossovers). 

Using Symbols to Identify Key Points on Charts 
Symbols provide a great way to mark points on your chart where 
specified conditions are met. 

Expert Symbols can be 
distinguished from other 
symbols by the small "e" 
that appears next to 
them. 

Conceptually, symbols are almost identical to highlights.  In fact, the only 
difference is the way the results are displayed on the chart. 
The Expert Advisor allows you to define an unlimited number of 
conditions that will cause the specified graphic or text to appear above or 
below the price bar that triggered the condition “true.”  For example, a 
bull graphic could be placed below the price bar on the day when the RSI 
crosses above 20--a bear graphic when the RSI crosses below 80.   
If you use the System Tester, this may be just the tool you’ve been 
looking for.  It's like having your chart constantly being monitored by a 
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system test.  Much like the results of the buy/sell signals of a system test 
are displayed with arrows on your chart, the Expert Advisor’s symbols 
feature can keep you up-to-date on conditions in your chart. 

Creating and Editing Symbols 
Symbols are created and edited from the Symbols page of the Expert 
Advisor dialog.  Symbols are enabled by checking the box to the left of 
the symbol's name. 

 
New.  Choose this to create a new symbol.  The Expert Symbol Editor 
appears from which you can specify the name, conditions, and 
graphic/text for a symbol.  See 428 for more information on this dialog. 
Edit.  Choose this to edit the selected symbol.  The Expert Symbol Editor 
dialog appears (see page 426). 
Delete.  Choose this to delete the selected symbol. 
Check All.  Click this button to enable (check) all symbols.  If you 
select only a portion of the symbols, only those selected are enabled. 
Uncheck All.  Click this button to disable (uncheck) all symbols.  If you 
select only a portion of the symbols, only those selected are disabled. 

 
Move Up button 

Move Up.  Click the Move Up button to move the selected symbol up in 
the list.  The higher a symbol is on the list, the higher the priority it is 
given.  See page 430 for information on priority.  

 
Move Down button 

Move Down.  Click the Move Down button to move the selected symbol 
down in the list.  The higher a symbol is on the list, the higher the priority 
it is given.  See page 430 for information on priority.  

Specifying the Condition for a Symbol 
As with the other components in the Expert Advisor, the conditions for 
symbols are written in the MetaStock formula language.  They are 
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evaluated as either true or false.  A true condition will cause the symbol 
to be drawn near the price plot using the specified graphic and/or text. 
You use the Expert Symbol Editor dialog to specify the formula condition 
and the graphic/text to use for a symbol.  This dialog is accessed by 
choosing New or Edit from the Symbol  page of the Expert Editor dialog. 

 
Name.  Enter the name for the symbol.  You should use a name that is 
descriptive of the symbol's condition (e.g., "RSI/Moving Average 
Bullish").  The maximum length of the name is 40 characters. 
Condition.  Enter the formula to use for the symbol.  If the formula is 
true for a given time period (i.e., day, week, month, etc.), the price bar  
will be marked with the selected graphic and/or text.  You may want to 
click the Functions button if you need help with the MetaStock formula 
language.  Formulas must be written in the MetaStock formula language 
(see page 235). 
Functions.  Click this button to display the Paste Functions dialog (see 
page 305).  Note that this button is enabled only when the cursor is 
located within the Condition box. 

Defining the Symbols to Display 
The Symbols page of the Expert Symbol Editor dialog is used to define 
the graphic and label to use for the symbols.  Note that a symbol does not 
have to contain both a graphic and a label. 
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Graphic.  Choose the graphic to display for the symbol from the drop-
list.  If you prefer not to have a graphic attached to the symbol, choose 
“(None)” from the drop-list. 
Size.  Choose the size of the graphic (but not the label), from the drop-
list.  Use the Font button to change the size of the label. 
Color.  Choose the color for the graphic (but not the label) from the 
drop-list.  Use the Font button to change the color of the label. 
Label.  Enter the label to display for the symbol.  A label can contain up 
to 40 characters, including line feeds.  If you prefer not to display a label, 
simply leave the box blank. 
Symbol Position.  Choose the location for the graphic. 
Label Position.  Choose the location for the label. 
Font.  Click this button to display the standard Windows Font dialog.  
This dialog is used to change the font, color, and style of the label. 

Viewing the Results of Symbols 
As with all components of an expert, you must attach the expert 
containing the symbol to a chart in order to see the results. 

To view the results of a symbol  
1. Open a chart. 
2. Choose Expert Advisor from the Tools menu. 
3. Choose the expert that contains the symbol(s) and choose Edit. 
4. Click the Symbols tab. 
5. Check the box next to the desired symbol(s).  Click the OK button. 
6. Choose Attach from the Expert Advisor dialog.  The chart will now 

redraw to reflect the symbol contained within the attached expert. 
7. Click the Close button in the Expert Advisor dialog. 
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Sample Symbols 
The following illustrations show some examples of symbols. 
This symbol draws a graphic of a bear below the price bar when the close 
crosses below its 40-period moving average.  

 
This symbol places the label “Overbought” if the Stochastic crosses 
above 80, the CCI is above 100, and volume is twice its average. 

 
You can also combine multiple symbols.  For example, the previous two 
symbols could both be enabled simultaneously from the Symbols page as 
shown below.  Note that the checked boxes indicate both are enabled. 
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Move Up/Dn buttons 

When the conditions for these symbols are evaluated, the symbol that 
appears at the top of the list is given highest priority.  Use the Move Up 
and Move Down buttons to change the order.  In this case, the symbol 
named “Moving Average Crossover” is given the highest priority since it 
is listed first.  This means that if the conditions for both Moving Average 
Crossover and the Stochastic/CCI/Volume are true on the same day, only 
the Moving Average Crossover symbol will be displayed. 

Tips for Using Symbols 
• Highlights are best used for conditions that remain true over a period 

of time.  Symbols are best to mark conditions that are triggered 
momentarily (i.e., moving average crossovers). 

• Symbols in combination with Alerts provide a great way to keep 
abreast of  the signals generated by your favorite system test.  In fact, 
you may want to copy the system test rules into the Expert Symbol 
Editor dialog and the Expert Alert Editor dialog so that they are 
constantly monitored. 

Using Alerts to Grab Your Attention 
Alerts give you the ability to ensure that you stay in touch with current 
conditions in your chart, even when you’re away from the office.  An alert 
is defined just like highlights and symbols.  However, where highlights 
and symbols are activated on all the data loaded in the chart, alerts are 
displayed only if the condition is “true” for any new bars since the chart 
was last opened.  (When you first attach an expert to a chart, alerts will be 
triggered only for the last bar in the chart.) 
The Expert Advisor allows you to define an unlimited number of alerts.  
When the alerts are triggered, you can be notified by a message box on 
your screen, play a sound or video file, or send notification to an e-mail 
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address or pager.  For example, you could define an alert that would pop-
up and play a sound file of the Star Spangled Banner whenever your U.S. 
Treasury Bond prices fall below the lower Bollinger Band.  Or maybe 
you’d like a video clip of fireworks displayed whenever IBM’s 14-day 
RSI falls below 70 on twice the average volume.  There’s nothing wrong 
with being a little creative and having some fun with these tools. 
For those that use the System Tester, this may be just the tool you’ve 
been looking for.  It's like having your chart constantly being monitored 
by a system test.  Much like the results of the buy/sell signals of a system 
test are displayed with arrows on your chart--the Expert Advisor’s Alert 
feature can be used to keep you up-to-date on conditions in your chart. 

Creating and Editing Alerts 
Alerts are created and edited from the Alerts page in the Expert Advisor 
dialog.  Alerts are enabled by checking the box to the left of the alert's 
name. 

 
New.  Choose this button to create a new alert.  The Expert Alert Editor 
appears from which you can specify the name, conditions, and define the 
pop-up message and WAV or AVI file to play.  See page 433 for more 
information on this dialog. 
Edit.  Choose this button to edit the selected alert.  The Expert Alert 
Editor dialog appears. 
Delete.  Choose this button to delete the selected alert. 
Check All.  Click this button to enable (check) all alerts.  If you select 
only a portion of the alerts, only those selected are enabled. 
Uncheck All.  Click this button to disable (uncheck) all alerts.  If you 
select only a portion of the alerts, only those selected are disabled. 
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Move Up button 

Move Up.  Click the Move Up button to move the selected alert up in 
the list.  This has no effect on the priority given to an alert.  All alerts are 
given equal priority. 

 
Move Down button 

Move Down.  Click the Move Down button to move the selected alert 
down in the list.  This has no effect on the priority given to an alert.  All 
alerts are given equal priority.  

Specifying the Conditions for an Alert  
As with the other components in the Expert Advisor, the conditions for 
alerts are written in the MetaStock formula language.  They are evaluated 
as either true or false.  A true condition on any bar more current than the 
last time the chart was opened will cause the alert to trigger and display 
the specified pop-up message, or play the accompanying sound or video 
file (if available), and send notification via e-mail or a pager.  (When you 
first attach an expert to a chart, alerts will be triggered only for the last 
bar in the chart.) 
You use the Expert Alert Editor dialog to specify the formula conditions 
and how you want to be notified that the alert has been triggered.  This 
dialog is accessed by choosing New or Edit from the Alert page in the 
Expert Editor dialog. 

 
Name.  Enter the name for the symbol.  You should use a name that is 
descriptive of the alert’s condition (e.g., RSI/Moving Average Bullish).  
The maximum length of the name is 40 characters. 
Condition.  Enter the formula to use for the alert.  When first attaching 
the expert, the alert will trigger if the formula is true for the most recent 
period loaded in the chart.  When opening the chart after the expert is 
attached, the alert will trigger if the formula is true for any bars that are 
more current than the last time you opened the chart.  You may want to 
click the Functions button if you need help with the MetaStock formula 
language.  Formulas must be written using the MetaStock formula 
language (see page 235). 
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Function.  Click this button to display the Paste Functions dialog (see 
page 305).  You may want to click the Functions button if you need help 
with the MetaStock formula language (see page 235).  Note that this 
button is enabled only when the cursor is located within the Condition 
box. 

Defining the Alert 
The Alerts page of the Expert Alert Editor dialog is used to define the 
pop-up message, WAV or AVI file to play, and whether or not to send 
notification by e-mail or pager when the alert is triggered.  Note that a 
alert does not have to contain both a message and a multimedia file. 

 
Message.  Enter the message to display when the alert triggers.  You 
can enter up to 40 characters. 
Text Only.  Choose this button if you want only the specified text 
message shown in the Message box to display when an alert is triggered. 
Play Video.  Choose this button if you want the specified video file 
shown in the Video File box  to play when an alert is triggered.   
Play Sound.  Choose this button if you want the specified sound file 
shown in the Sound File box to play when an alert is triggered.  Check the 
accompanying "Repeat Sound"  box if you want the sound file to repeat 
playing once it is triggered.  You can stop the sound from playing by 
clicking the OK button in the pop-up Expert Alert dialog. 

 
Play button 

Sound/Video File.  Enter the folder and file name of  the sound or 
video file to play. Sound files have a WAV file extension.  Video files 
have an AVI file extension.  There is no limit to the size of the sound or 
video file you can play.  Use the Browse button if you need to search 
your disk.  Once the path and file name are entered, you can click the 
play button to test the playback. 
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Send alert to e-mail recipient.  Check this box to send an e-mail 
message to the recipient listed in Application Properties (see page 37) 
when this alert is triggered.   
Send alert to pager.  Check this box to send a notification of the 
triggered alert to the pager specified in Application Properties (see page 
37).  

Viewing Triggered Alerts 
Each time a chart is opened after an alert has been attached to the chart, 
the alert conditions are checked to see if any alerts have triggered.  If an 
alert is triggered for any period that is more current than the last time the 
chart was opened, the Expert Alert dialog will pop-up. 

 
This dialog shows the date on which the alert triggered, and displays the 
message specified in the Expert Alert Editor.  E-mail and pager 
notifications associated with the alert are also sent.  If a sound or video 
file was attached to the alert, it will begin playing.  Click the OK button 
to remove the dialog and stop the sound or video. 
If other alerts remain to be displayed, you can click the “Skip all 
remaining alerts for this security” box to keep them from popping up. 
Any e-mail and pager alerts will be sent, however. 
Alerts can also be triggered if you change the periodicity (see page 120).  
For example, an alert that was not triggered on daily data may be 
triggered if the periodicity is changed to weekly. 

Tips for Using Alerts  
• When you open a chart with an expert attached, any e-mail or pager 

alerts that are triggered for any bar more current than the last time 
you opened the chart will be sent.  If you do not want these 
notifications to be sent, you can edit the Expert Advisor, or go into 
Application Properties (see page 37) and disable e-mail and pager 
alerts before opening the charts. 

• For those that have the ability to record their own sound or video 
files, you may find it useful (and even fun) to attach a multimedia file 
to your alerts.  When the alert is triggered, the sound or video file  



 

 
 

MetaStock Professional Getting Expert Advice on Your Securities • 435 

 

 

 

will begin playing—informing you in plain English (or Spanish, 
German, etc.) what has occurred. 

• You can use the Sound Recorder located in the Windows Multimedia 
folder to record your own sound files. 

 

• Symbols in combination with Alerts provide a great way to keep 
abreast of the signals generated by your favorite system test.  In fact, 
you may want to copy the system test rules into the Expert Symbol 
Editor dialog and the Expert Alert Editor dialog so that they are 
constantly monitored. 

Attaching an Expert to a Chart 
After you have created an expert, you must attach the expert to a chart in 
order for it to function.  As mentioned earlier, an expert can contain just 
one or all five of the components.  Most of your experts will probably 
contain just one or two components. 
MetaStock Pro’s Smart Chart feature automatically saves the expert that 
is attached to a chart.  So the next time you open the chart, the expert will 
automatically reevaluate your chart and display the updated results. 
The Attach button in the Expert Advisor dialog is a toggle button.  If an 
expert that is not already attached is selected, the button toggles to Attach.  
If the selected expert is already attached (i.e., a small triangle appears   
next to it), the button toggles to Detach.  If no chart is open, the button is 
disabled. 
A chart can only have one expert attached to it at a time.  However, you 
can create multiple charts of the same security using the New Window 
command in the Window menu (see page 86).  After creating a “clone” of 
the selected chart, you could then attach another expert to it. 

To attach an expert to a chart  
1. Open the chart to which you want to attach the expert. 

 
Expert Advisor button 

2. Display the Expert Advisor dialog by doing one of the following: 
• Choose Expert Advisor from the Tools menu. 
• Click the Expert Advisor button on the standard toolbar. 
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3. Choose the desired expert from the Expert Advisor dialog and click 
the Attach button. 
or 
Right-click on the chart. 

4. Choose Expert Advisor from the shortcut menu, then choose 
Attach. 

5. Choose the desired expert from the Attach Expert dialog. 

To detach an expert from a chart  
1. Open the chart that has the attached expert. 

 
Expert Advisor button 

2. Display the Expert Advisor dialog by doing one of the following: 
• Choose Expert Advisor from the Tools menu. 
• Click the Expert Advisor button on the standard toolbar. 

3. Select the attached expert from the Expert Advisor dialog (i.e., the 
one with the small triangle next to it) and click the Detach button. 
or 
Right-click on the chart’s inner window.   

4. Choose Expert Advisor from the shortcut menu, then choose 
Detach. 

Copying and Deleting Experts 
You can make a copy of a selected expert from the Expert Advisor dialog 
using the Copy button.  This is useful when you need to design a new 
expert that is similar to an existing one.   

 
 
You can select multiple 
experts by holding down 
the CTRL key as you 
click the mouse. 

For example, if Expert A was similar to a new expert you want to create, 
you could use the Copy command in the Expert Advisor dialog to make a 
duplicate rather than rewriting it.  You could then make the minor 
modifications necessary and name it Expert B (or whatever).  
You delete the selected experts from the Expert Advisor dialog using the 
Delete button.   

Printing Experts 
You can print the names and/or formulas of your experts with the Print 
dialog.  To access the Print dialog, choose Print from Expert Advisor 
dialog.   
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Printer.  Choose the desired printer from the drop-list. 
Print Range.  The All option is always enabled.  All selected experts 
will be printed. 
Copies.  Enter the number of copies to print. 

Pre-packaged Experts 
Many pre-packaged experts are included with MetaStock Pro.  The  
experts written by Equis and shipped with MetaStock Pro begin with 
“Equis” (i.e., Equis - Volatility Analysis).  The experts written by industry 
experts (e.g., Pring, Raff, Fishback, etc.) begin with their name (e.g., Don 
Fishback – ODDS™ Option Analyst). 
Equis International is not a Registered Investment Advisory service.  
The experts included with MetaStock Pro are for educational purposes 
and are to be used at your own risk.  Equis International (or its 
partners) is not liable for the investment decisions you make based on 
information obtained from the Expert Advisor. 

Input() Function, Variables, and Multi-plot Indicators 
The Expert Advisor will accept assigned variables (see page 244) in 
trends, commentaries, highlights, symbols, and alerts. 
In commentaries, however, variables must always be assigned within a 
writeif() or writeval() formula.  In other words, you cannot write a 
commentary that appears as follows: 
myvar:=mov(c,200,s); 
writeif(c>myvar,"The close is above it's 200-period 
moving average"); 
writeif(myvar>ref(myvar,-10),"The 200-period moving 
average is trending up."); 
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The syntax above is invalid because the assignment of the "myvar" 
variable is made outside of the writeif() functions.  However, this could 
be correctly rewritten as follows: 
writeif(myvar:=mov(c,200,s);c>myvar,"The close is 
above it's 200-period moving average.  ")\ 
writeif(myvar:=mov(c,200,s);myvar>ref(myvar,-10),"The 
200-period moving average is trending up.") 
 

Note that the assignment of the variable "myvar" is made inside each of 
the writeif() functions.  As is always the case when assigning variables, 
the variable assignment must be followed by a semi-colon.  Although the 
use of variables in the example above does not seem very beneficial, you 
will find that assigning variables to long, complex formulas can make the 
commentary much easier to read. 
An expert cannot use the input() function directly (see page 306).  This 
function is reserved for custom indicators only.  However, if an expert 
uses the fml() function (see page 261) to call the results of a custom 
indicator, and the custom indicator uses the input() function, the fml() 
function will only return the assigned default input value—the expert will 
not prompt for input. 
If an expert contains or references (using the fml() function) a multi-plot 
indicator, only the last plot is used in the calculation of the exploration. 

Expert Advisor Tips 
• Due to the way the Performance indicator is calculated (its values are 

dependent on the amount of data loaded in the chart), you may 
experience inconsistent results if you use it.  Therefore, we 
recommend that you avoid using the Per() function in experts. 

• You can reference an indicator in a chart by selecting the indicator 
(i.e., clicking on it so handles appear) and then substitute the "P" 
variable in place of a formula's data array.  For example, the formula 
"mov(p,10,s)" would calculate a 10-period moving average of the 
selected indicator.  Note that “P” will represent the plot selected at 
the time the expert is attached to the chart.  See page 247 for more 
information on the "P" variable. 

• If you aren't familiar with the MetaStock formula language, you 
really should learn how to use the Indicator Builder and System 
Tester.  The Indicator Builder and System Tester are the key building 
blocks for the Expert Advisor. 

• You can jump directly from a chart to its commentary by right-
clicking on the chart, choosing Expert Advisor and then choosing 
Commentary. 

• You can increase the size of the Expert Editor dialog by clicking on 
the border of the dialog and dragging.  You may find this especially 
helpful when writing commentaries. 
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• Experts are saved with templates and smart charts. 
Equis International is not a Registered Investment Advisory service.  
The experts included with MetaStock Pro are for educational purposes 
and are to be used at your own risk.  Equis International (or its 
partners) is not liable for the investment decisions you make based on 
information obtained from the Expert Advisor. 

Execution Errors in an Expert 
The Error Executing Expert dialog will appear if a run-time error occurs 
while calculating an expert.  Any error that is not a "math" error qualifies 
as a run-time error. 

 
Remove this Expert from the chart.  The expert is removed from 
the chart so that it will not calculate again. 
Keep this Expert in the chart.  The expert will calculate again with 
the next data update of the chart and any errors that occur will be 
reported. 
Don't show future errors for this Expert in this chart.  The 
expert will calculate again with the next data update of the chart.  Any 
errors that occur will not be reported.  Note that the errors will be 
suppressed only for the expert in the current chart.  
 
Note that this dialog may also appear if you changed the folder listed in 
the File Locations page in the Application Options dialog (see page 33).
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Interpretation of Indicators and Line 
Studies 

Indicator Guide 
The indicators and line studies found in MetaStock Pro can be divided 
into six categories.  The intent of this guide is to help you develop better 
trading systems.  A robust technical trading system should probably 
incorporate indicators from several of these categories.  Note that some 
indicators fall into more than one category. 

Trend Indicators 
The following indicators and line studies can be used to measure trend.  
Trend is a term used to describe the persistence of prices to move in one 
direction. 
 

Indicator Creator Page 
Reference 

Aroon Chande 449 

Commodity Selection Index Wilder 458 

DEMA Mulloy 461 

Directional Movement Wilder 463 

Forecast Oscillator Chande 469 

Linear Regression Indicator  478 

Linear Regression Slope  478 

Linear Regression Trendline  480 

MACD Appel 480 

Moving Averages (all methods)  486 

Parabolic SAR Wilder 499 

Performance  499 

Polarized Fractal Efficiency Hannula 501 

Price Oscillator  503 
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Qstick Indicator Chande 508 

r-squared  509 

Raff Regression Channel Raff 511 

Standard Deviation Channel Equis 520 

Standard Error  521 

Standard Error Bands Equis (Andersen) 521 

Standard Error Channel Equis 523 

TEMA Mulloy 528 

Time Series Forecast  530 

Trendlines  532 

Vertical Horizontal Filter White 536 

Zig Zag Merril 542 

Volatility Indicators 
The following indicators can be used to measure volatility.  Volatility is a 
general term used to describe the magnitude of day-to-day fluctuations in 
prices (independent of direction).  Generally, changes in volatility tend to 
lead changes in prices. 
 

Indicator Creator Page 
Reference 

Average True Range Wilder 450 

Bollinger Bands Bollinger 451 

Commodity Selection Index Wilder 458 

Moving Average (variable) Chande 488 

ODDS™ Probability Cones Fishback 492 

Relative Volatility Index Dorsey 516 

Standard Deviation  519 

Standard Error Bands Equis (Andersen) 521 

Volatility, Chaikin’s Chaikin 537 

Volatility, Option Bookstaber 498 

Momentum Indicators 
The following indicators can be used to measure momentum.  Momentum 
is a general term used to describe the speed at which prices move over a 
given time period.  Generally, changes in momentum tend to lead changes 
in prices. 
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Indicator Creator Page 
Reference 

Accumulation Swing Index Wilder 448 

Chande Momentum Oscillator Chande 456 

Commodity Channel Index Lambert 458 

Dynamic Momentum Index Chande 464 

Intraday Momentum Index Chande 474 

Linear Regression Slope  478 

MACD Appel 480 

Mass Index Dorsey 483 

Momentum Indicator  485 

Price Oscillator  503 

Price Rate-Of-Change Appel 504 

Random Walk Index Poulus 511 

Range Indicator Weinberg 512 

Relative Momentum Index Altman 513 

Relative Strength Index Wilder 515 

Stochastic Momentum Index Blau 523 

Stochastic Oscillator Lane 524 

Swing Index Wilder 527 

Trix unknown 534 

Ultimate Oscillator Williams 535 

Williams’ %R Williams 541 

Williams’ 
Accumulation/Distribution 

Williams 542 

Cycle Indicators 
The following indicators and line studies can be used to measure cycles.  
Many securities, particularly futures, show a tendency to move in cyclical 
patterns.  Price changes can often be anticipated at key cyclical intervals. 
 

Indicator Creator Page 
Reference 

Cycle Lines  460 

Detrended Price Oscillator  462 

Fibonacci Time Zones  469 

Fourier Transform  469 
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MESA Sine Wave Indicator Ehlers 484 

Market Strength Indicators 
The following indicators can be used to measure market strength.  Each 
of these indicators incorporate either volume or open interest, which are 
the basic ingredients to the measurement of market strength.  Generally 
higher volume and/or open interest levels indicate more participants and 
therefore more strength. 
 

Indicator Creator Page 
Reference 

Accumulation/Distribution Williams 448 

Demand Index Sibbet 462 

Chaikin Money Flow Chaikin 456 

Chaikin Oscillator Chaikin 453 

Ease of Movement Arms 465 

Herrick Payoff Index Herrick 472 

Klinger Oscillator Klinger 476 

Money Flow Index Quong/Soudack 485 

Moving Average (volume 
adjusted) 

Arms 487 

Negative Volume Index Fosback 492 

On Balance Volume Granville 495 

Open Interest  496 

Positive Volume Index Fosback 501 

Price Volume Trend  505 

Trade Volume Index Equis (Slauson) 531 

Volume  537 

Volume Oscillator  538 

Volume Rate-Of-Change  539 

Support and Resistance Indicators 
The following indicators and line studies can be used to measure support 
and resistance.  A common occurrence is for prices to repeatedly rise or 
fall to a certain level and then reverse.  This phenomenon (attributed to 
basic supply and demand) is called support and resistance. 
 

Indicator Creator Page 
Reference 
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Andrews' Pitchfork Andrews 449 

Envelope  466 

Fibonacci Arcs, Fans, 
Retracements 

 467 

Gann Lines, Fans, Grids Gann 471 

Projection Bands Widner 506 

Projection Oscillator Widner 507 

Quadrant Lines  509 

Speed Resistance Lines  518 

Tirone Levels Tirone 531 

Trendlines  532 
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Accumulation/Distribution 
The contents of the Accumulation/Distribution Line are explained in 
detail under the discussion of the Chaikin Oscillator (page 4).  Briefly, 
the indicator is: 

 
( ) ( )
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High - Low
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Where "I" is yesterday's Accumulation/Distribution value. 
See page 163 for more information on plotting indicators.  See page 175 
for more information on the Accumulation/Distribution's parameters. 

Interpretation 
The interpretation of the Accumulation/Distribution Line is similar to the 
interpretation of On Balance Volume (see page 493) wherein the 
indicator displays the flow of volume into or out of a security.  The 
discussion on the Chaikin Oscillator (see page 451) explains the 
principles behind the Accumulation/Distribution Line. 

Tips 
Please don't confuse the volume Accumulation/Distribution indicator 
with Williams' price Accumulation/Distribution indicator (see page 539). 
An example custom indicator (see page 308) shows how to calculate the 
Accumulation/Distribution line. 

Accumulation Swing Index 
The Accumulation Swing Index is a cumulative total of the Swing Index 
(see page 524).  Step-by-step instructions on calculating the Swing Index 
are provided in Wilder's book, New Concepts In Technical Trading 
Systems (see page 544). 
See page 163 for more information on plotting indicators.  See page 175  
for more information on the Accumulation Swing Index's parameters. 

Interpretation 
A breakout is indicated when the Accumulation Swing Index exceeds its 
value on the day when a previous significant high swing point was made.  
A downside breakout is indicated when the value of the Accumulation 
Swing Index drops below its value on a day when a previous significant 
low swing point was made. 
You can confirm trendline breakouts by comparing trendlines on the 
Accumulation Swing Index to trendlines on the price chart.  A false 
breakout is indicated when a trendline drawn on a price chart is 
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penetrated, but a similar trendline drawn on the Accumulation Swing 
Index is not penetrated. 

Andrews' Pitchfork 
Andrews' Pitchfork is a line study consisting of three parallel lines.  The 
lines are drawn from three points that you select. 
The three trendlines are drawn as follows:  The first trendline begins at 
the left-most point selected and is drawn so it passes directly between the 
right-most points.  This line is the handle of the pitchfork.  The second 
and third trendlines are then drawn beginning at the right-most points and 
are drawn parallel to the first line.  These lines are the tines of the 
pitchfork. 
See page 205 for more information on drawing line studies.  See page 215 
for more information on the Andrews' Pitchfork parameters. 

Interpretation 
The interpretation of a Pitchfork is based on normal trendline support and 
resistance principles (see page 529). 

Aroon 
The Aroon indicator was developed by Tushar Chande.  Aroon is Sanskrit 
word meaning “dawn’s early light” or the change from night to day.  The 
Aroon indicator allows you to anticipate changes in security prices from 
trending to trading range.  For more information on the Aroon indicator 
see the article written by Tushar Chande in the September 1995 issue of 
Technical Analysis of Stocks & Commodities magazine. 
These changes are anticipated by measuring the number of periods that 
have passed since the most recent x-period high and x-period low.  
Therefore, the Aroon indicator consists of two plots; one measuring the 
number of periods since the most recent x-period high (Aroon Up) and 
the other measuring the number of periods since the most recent x-period 
low (Aroon Down).   
The actual plotted value is a “stochastic” like scale (see page 521) ranging 
from 0 to 100.  Assuming a default time-period of 14 days, if a security 
makes a new 14-day high, the Aroon Up = 100; when the security makes a 
new 14-day low, the Aroon Down = 100. When the security has not made 
a new high for 14 days, the Aroon Up = 0; when the security has not  
made a new low for 14 days, the Aroon Down = 0.  
As explained in the interpretation section for the VHF indicator (see page 
533) the age-old problem for many trading systems is their inability to 
determine if a trending or trading range market is at hand.  Trend-
following indicators such as MACD and moving averages, tend to be 
whipsawed as markets enter a non-trending congestion phase.  On the  
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other hand, overbought/oversold oscillators (which work well during 
trading range markets) tend to overreact to price pull-backs during 
trending markets—thereby closing a position prematurely.  The Aroon 
indicator attempts to remedy this by helping you determine when trend-
following or overbought/oversold indicators are likely to succeed. 
See page 163 for more information on plotting indicators.  See page 175 
for more information on the Aroon parameters. 

Interpretation 
There are basically three conditions that you look for when interpreting 
the Aroon indicator:  extremes at 0 and 100, parallel movement between 
Aroon Up and Aroon Down, and crossovers between Aroon Up and 
Aroon Down. 
Extremes.  When the Aroon Up line reaches 100, strength is indicated.  If 
the Aroon Up remains persistently between 70 and 100, a new uptrend is 
indicated.  Likewise if the Aroon Down line reaches 100, potential 
weakness is indicated. If the Aroon Down remains persistently between  
70 and 100, a new downtrend is indicated. 
A strong uptrend is indicated when the Aroon Up line persistently 
remains between 70 and 100 while the Aroon Down line persistently 
remains between 0 and 30.  Likewise a strong downtrend is indicated 
when the Aroon Down line persistently remains between 70 and 100 
while the Aroon Up line persistently remains between 0 and 30. 
Parallel Movement.  When the Aroon Up and Aroon Down Lines move 
parallel with each other (are roughly at the same level), then 
consolidation is indicated.  Expect further consolidation until a 
directional move is indicated by an extreme level or a crossover. 
Crossovers.  When the Aroon Down line crosses above the Aroon Up 
line, potential weakness is indicated.  Expect prices to begin trending 
lower. When the Aroon Up line crosses above the Aroon Down line, 
potential strength is indicated.  Expect prices to begin trending higher. 

Average True Range 
The True Range indicator is defined by Wilder to be the greatest of the 
following for each period: 
• The distance from today's high to today's low. 
• The distance from yesterday's close to today's high. 
• The distance from yesterday's close to today's low. 
• The Average True Range is simply the average of the true ranges 

over the past x periods (where x is specified by the user). 
See page 163 for more information on plotting indicators.  See page 175 
for more information on the Average True Range parameters. 
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Interpretation 
In his book, New Concepts In Technical Trading Systems (see page 544), 
Wilder defines a trading system that uses the Average True Range.  He 
also provides details on calculating the Average True Range and the 
trading system. 
The Average True Range also can be interpreted using the same 
techniques that are used with the other volatility indicators.  Refer to the 
discussion on Standard Deviation for additional information on volatility 
interpretation (see page 516). 

Bollinger Bands 
Bollinger Bands are a type of envelope (see page 464) developed by John 
Bollinger.  However, where envelopes are plotted at a fixed percentage 
above and below a moving average, Bollinger Bands are plotted at 
standard deviation levels above and below a moving average. 
You may find the expert named "Equis - Bollinger Bands" helpful in 
interpreting Bollinger Bands.  See page 435 for more information an 
experts. 
For information on products and services offered by John Bollinger 
contact Bollinger Capital Management at 1-310-798-8855. 
See page 163 for more information on plotting indicators.  See page 176  
for more information on the Bollinger Band parameters.   

Interpretation 
When displaying Bollinger Bands in MetaStock Pro (see page 176), you 
are prompted to enter the number of periods in the bands and the number 
of standard deviations between the bands and the moving average.  Mr. 
Bollinger recommends default values of "20" for the number of periods, 
"simple" for the moving average method, and "2" deviations.  He notes 
that periods of less than 10 periods do not appear to work very well. 
MetaStock Pro plots Bollinger Bands on the security's prices or indicator.  
These interpretational comments refer to bands on the security's closing 
price. 
Because the spacing between Bollinger Bands is based on the standard 
deviation of the security, the bands widen when the security becomes 
more volatile, and contract when the security becomes less volatile. 
Mr. Bollinger notes the following characteristics of Bollinger Bands. 
• Sharp price changes tend to occur after the bands tighten, as 

volatility lessens. 
• When prices move outside the bands, a continuation of the trend is 

implied. 
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• Bottoms/tops made outside the bands followed by bottoms/tops 
made inside the bands call for reversals in the trend. 

• A move that originates at one band tends to go all the way to the 
other band.  This observation is useful when projecting price targets. 

Tip 
An example custom indicator (see page 308) shows how to calculate 
Bollinger Bands. 

Candlesticks, Japanese 
The Japanese developed a method of technical analysis in the 1600s to 
analyze the price of rice contracts.  This technique is called Candlestick 
charting. 
Candlestick charts display the open, high, low, and closing prices in a 
format similar to a modern-day bar-chart.  Articles written by Steven 
Nison that explain Candlestick charting appeared in the December, 1989 
and April, 1990 issues of Futures Magazine.  The definitive book on the 
subject is Japanese Candlestick Charting Techniques also by Steve Nison 
(see page 544). 
You may find the expert named "Equis - Candlesticks" helpful in 
interpreting Candlestick patterns.  See page 435 for more information an 
experts. 
The following illustration shows the components of the two types of 
candlesticks: 

 
Some investors are attracted to Candlestick charts by their mystique--
maybe they are the "long forgotten Asian secret" to investment analysis.  
Other investors may be turned-off by their mystique.  Regardless of your 
feelings about the mystique of Candlestick charting, we strongly 
encourage you to explore their use.  Candlestick charts dramatically 
illustrate supply/demand concepts defined by classical technical analysis 
theories. 
IMPORTANT:  Because Candlesticks display the relationship between 
the open, high, low, and closing prices, they cannot be displayed on 
securities that only have closing prices, nor were they intended to be 
displayed on securities that lack opening prices.  If you attempt to display 
a Candlestick chart on a security that does not have opening prices,  
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MetaStock Pro will use the previous period's closing prices in place of 
opening prices.  Note that this technique can create Candlestick lines and 
patterns that are not valid (e.g., the previous period's close may have been 
outside the current period's high-low range). 

Interpretation 
See page 288 for detailed information on many candlestick patterns. 
A good way to learn about candlestick patterns is to attach the expert 
named "Equis - Candlesticks" to a chart. 

Candlevolume 
Candlevolume charts are a unique hybrid of the Equivolume and 
Candlestick charting methods.  A candlevolume chart possesses the 
shadows and empty/filled body characteristics of Candlestick charts, plus 
the volume-based body width of Equivolume charts.  This combination 
gives you the unique ability to study Candlestick patterns in combination 
with their volume.   

Chaikin A/D Oscillator 
The Chaikin Oscillator is created by subtracting a 10-period exponential 
moving average of the Accumulation/Distribution Line (see page 446) 
from a 3-period moving average of the Accumulation/Distribution Line.  
The formula equivalent of the calculation is shown below: 
mov( ad(), 3, E) - mov( ad(), 10, E) 
See page 163 for more information on plotting indicators.  See page 178 
for more information on the Chaikin Oscillator parameters. 

Interpretation 
The following article on volume accumulation/distribution interpretation, 
written by Mr. Marc Chaikin, is reprinted here with his permission. 
Technical analysis of both market averages and stocks must include 
volume studies in order to give the technician a true picture of the internal 
dynamics of a given market.  Volume analysis helps in identifying internal 
strengths and weaknesses that exist under the cover of price action.  Very 
often, volume divergences versus price movement are the only clues to an 
important reversal that is about to take place.  While volume has always  
been mentioned by technicians as important, little effective volume work 
was done until Joe Granville and Larry Williams began to look at volume 
versus price in the late 1960s in a more creative way. 
For many years it had been accepted that volume and price normally rose 
and fell together, but when this relationship changed, the price action 
should be examined for a possible change of trend.  The Granville OBV 
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concept which views the total volume on an up day as accumulation and 
the total volume on a down day as distribution is a decent one, but much 
too simplistic to be of value.  The reason is that there are too many 
important tops and bottoms, both short-term and intermediate-term, where 
OBV confirms the price extreme.  However, when an OBV line gives a 
divergence signal versus a price extreme, it can be a valuable technical 
signal and usually triggers a reversal in price. 
Larry Williams took the OBV concept and improved on it.  In order to 
determine whether there was accumulation or distribution in the market or 
an individual stock on a given day, Granville compared the closing price 
to the previous close, whereas Williams compared the closing price to the 
opening price.  He [Williams] created a cumulative line by adding a per-
centage of total volume to the line if the close was higher than the opening 
and, subtracting a percentage of the total volume if the close was lower 
than its opening price.  The accumulation/distribution line improved 
results dramatically over the classic OBV approach to volume 
divergences. 
Williams then took this one step further in analyzing the Dow Jones 
Industrials by creating an oscillator of the accumulation/distribution line 
for even better buy and sell signals.  In the early 1970s, however, the 
opening price for stocks was eliminated from the daily newspaper and 
Williams' formula became difficult to compute without many daily calls to 
a stockbroker with a quote machine.  Because of this void, I created the 
Chaikin Oscillator substituting the average price of the day for Williams' 
opening and took the approach one step further by applying the oscillator 
to stocks and commodities.  The Chaikin Oscillator is an excellent tool for 
generating buy and sell signals when its action is compared to price 
movement.  I believe it is a significant improvement over the work that 
preceded it. 
The premise behind my oscillator is three-fold.  The first premise is that 
if a stock or market average closes above its midpoint for the day (as 
defined by [high+low]/2), then there was accumulation on that day.  The 
closer a stock or average closes to its high, the more accumulation there 
was.  Conversely, if a stock closes below its midpoint for the day, there 
was distribution on that day.  The closer a stock closes to its low, the 
more distribution there was. 
The second premise is that a healthy advance is accompanied by rising 
volume and a strong volume accumulation.  Since volume is the fuel that 
powers rallies, it follows that lagging volume on rallies is a sign of less 
fuel available to move stocks higher. 
Conversely, declines are usually accompanied by low volume, but end 
with panic-like liquidation on the part of institutional investors.  Thus, we 
look for a pickup in volume and then lower lows on reduced volume with 
some accumulation before a valid bottom can develop. 
The third premise is that by using the Chaikin Oscillator, you can monitor 
the flow of volume into and out of the market.  Comparing this flow to 
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price action can help identify tops and bottoms, both short-term and 
intermediate-term. 
Since no technical approach works all the time, I suggest using the 
oscillator along with other technical indicators to avoid problems.  I favor 
using a price envelope (see page 464) around a 21-day moving average 
and an overbought/oversold oscillator together with the Chaikin Oscillator 
for the best short and intermediate-term technical signals. 
1. The most important signal generated by the Chaikin Oscillator occurs 

when prices reach a new high or new low for a swing, particularly at 
an overbought or oversold level, and the oscillator fails to exceed its 
previous extreme reading and then reverses direction. 
 
Signals in the direction of the intermediate-term trend are more 
reliable than those against the trend. 
 
A confirmed high or low does not imply any further price action in 
that direction.  I view that as a non-event.  

2. A second way to use the Chaikin Oscillator is to view a change of 
direction in the oscillator as a buy or sell signal, but only in the 
direction of the trend.  For example, if we say that a stock that is 
above its 90-day moving average of price is in an up-trend, then an 
upturn of the oscillator while in negative territory would constitute a 
buy signal only if the stock were above its 90-day moving average--
not below it. 
 
A downturn of the oscillator while in positive territory (above zero) 
would be a sell signal if the stock were below its 90-day moving 
average of closing prices.   <End of Chaikin's article> 

Tips 
Advanced users can perform variations on the Chaikin Oscillator by 
changing the "3" and "10" in the following formula (see page 300). 
mov( ad(), 3, E) - mov( ad(), 10, E) 
An example custom indicator (see page 309) shows how to calculate the 
Chaikin Oscillator. 
 
 

Chaikin Money Flow 
Like the popular Chaikin A/D Oscillator developed by Marc Chaikin, the 
Chaikin Money Flow indicator is based on the Accumulation/Distribution 
line.  It is created by summing the values of the 
Accumulation/Distribution Line for 21 periods and then dividing by a 21 
period sum of the volume.  
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sum(((( C-L )-( H-C )) / ( H-L ))*V,21 ) / sum(V,21) 
See page 163 for more information on plotting indicators.  See page 177 
for more information on the Chaikin Money Flow parameters. 

Interpretation 
The interpretation of the Chaikin Money Flow indicator is based on the 
assumption that market strength is usually accompanied by prices closing 
in the upper half of their daily range with increasing volume.  Likewise, 
market weakness is usually accompanied by prices closing in the lower 
half of their daily range with increasing volume. 
If prices consistently close in the upper half of their daily high/low range 
on increased volume, then the indicator will be positive (i.e., above the 
zero line).  This indicates that the market is strong.  Conversely, if prices 
consistently close in the lower half of their daily high/low range on 
increased volume, then the indicator will be negative (i.e., below the zero 
line).  This indicates that the market is weak. 
The Chaikin Money Flow indicator provides excellent confirmation 
signals of trendline and support/resistance breakouts.  For example, if a 
security's prices have recently penetrated a downward sloping trendline 
(signaling a potential trend reversal), you may want to wait for further 
confirmation by allowing the Chaikin Money Flow indicator to cross 
above the zero line.  This may indicate an overall shift from a downtrend 
to a new uptrend. 
A divergence between the Chaikin Money Flow indicator and prices are 
also significant.  For example, if the most recent peak of the indicator is 
lower than it's prior peak, yet prices are continuing upward, this may 
indicate weakness. 

Chande Momentum Oscillator 
The Chande Momentum Oscillator (CMO) was developed by Tushar 
Chande.  A scientist, an inventor, and a respected trading system 
developer, Mr. Chande developed the CMO to capture what he calls 
“pure momentum.”  For more definitive information on the CMO and 
other indicators we highly recommend the book The New Technical 
Trader by Tushar Chande and Stanley Kroll. 
The CMO is closely related to, yet unique from, other momentum 
oriented indicators such as RSI, Stochastic, Rate-of-Change, etc.  It is 
most closely related to Welles Wilder’s RSI (see page 512), yet it differs 
in several ways: 
• It uses data for both up days and down days in the numerator, thereby 

directly measuring momentum. 
• The calculations are applied on unsmoothed data.  Therefore, short-

term extreme movements in price are not hidden.  Once calculated, 
smoothing can be applied to the CMO, if desired.  
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• The scale is bounded between +100 and -100, thereby allowing you  
to clearly see changes in net momentum using the 0 level.  The 
bounded scale also allows you to conveniently compare values across 
different securities. 

You may find the expert named "Equis - Chande Momentum Oscillator" 
helpful in interpreting the Chande Momentum Oscillator.  See page 435 
for more information on experts. 
See page 163 for more information on plotting indicators.  See page 177 
for more information on the Chande Momentum Oscillator parameters.   

Interpretation 
The CMO can be used to measure several conditions. 
Overbought/oversold.  The primary method of interpreting the CMO is 
looking for extreme overbought and oversold conditions.  As a general 
rule, Mr. Chande quantifies an overbought level at +50 and the oversold 
level at -50.  At +50, up-day momentum is three times the down-day 
momentum.  Likewise, at -50, down-day momentum is three times the up-
day momentum.  These levels correspond to the 70/30 levels on the RSI 
indicator. 
You could also establish overbought/oversold entry and exit rules by 
plotting a moving average trigger line on the CMO.  For example, if you 
are using the default 20-period CMO, a 9-period moving average may 
serve as a good trigger line.  Buy when the CMO crosses above the 9-
period trigger line; sell when it crosses below. 
Trendiness.  The CMO (much like the VHF indicator, see page 533) can 
also be used to measure the degree to which a security is trending.  The 
higher the CMO, the stronger the trend.  Low values of the CMO show a 
security in a sideways trading range. 
You may find the CMO helpful in establishing the entry and exit rules of 
a trend following system.  Enter when the CMO is high and exit when it 
moves lower. 
Divergence.  Although not specifically mentioned in Mr. Chande’s book, 
you could also look for divergence between the CMO and the price, as is 
often done with other momentum indicators.  See the discussion about 
divergence in the Interpretation section of RSI (see page 512). 
 
Other.  Although not specifically mentioned in Mr. Chande’s book, you 
may also look for chart formations (head and shoulders, rising wedges, 
etc.), failure swings, and support/resistance.  See the discussion on these 
methods in the Interpretation section of RSI (see page 512). 
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Commodity Channel Index 
The Commodity Channel Index (CCI) is calculated by first determining 
the difference between the mean price of a commodity and the average of 
the means over the time period chosen.  This difference is then compared 
to the average difference over the time period (this factors in the 
commodity's own inherent volatility).  The result is then multiplied by a 
constant that is designed to adjust the CCI so that it fits into a "normal" 
trading range of +/-100.  
A complete explanation of the CCI is beyond the scope of the manual.  
Further details on the contents and interpretation of the CCI can be found 
in the October 1980 issue of Commodities magazine (now known as 
Futures).  The article was written by Donald Lambert. 
The CCI indicator used in older versions of MetaStock is called "CCI 
(EQUIS)."  "CCI (Standard)" is the recently modified version that is 
consistent with the author's current calculation method.  The interpretation 
of both methods is identical. 
See page 163 for more information on plotting indicators.  See page 177 
for more information on the CCI parameters. 

Interpretation 
While the CCI was originally designed for commodities, the indicator 
also works very well with stocks and mutual funds. 
There are two methods of interpreting the CCI: 
• Looking for divergences 

 
A popular method of analyzing the CCI is to look for divergences in 
which the underlying security is making new highs while the CCI is 
failing to surpass its previous highs.  This classic divergence is 
usually followed by a correction in the security's price. 

• As an overbought/oversold indicator 
 
The CCI usually oscillates between +/-100.  Readings outside these 
ranges imply an overbought/oversold condition. 

Commodity Selection Index 
The CSI is calculated using the ADXR component of the Directional 
Movement indicator.  Refer to New Concepts in Technical Trading 
Systems (see page 544) for more information on the calculation and 
interpretation of the indicator. 
See page 163 for more information on plotting indicators.  See page 178 
for more information on this indicator's parameters. 
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Interpretation 
A high CSI rating indicates that the commodity has strong trending and 
volatility characteristics.  The trending characteristics are brought out by 
the Directional Movement factor in the calculation--the volatility 
characteristic by the Average True Range factor. 
Wilder's approach is to trade commodities with high CSI values (relative 
to other commodities).  Because these commodities are highly volatile, 
they have the potential to make the "most money in the shortest period of 
time."  High CSI values imply trending characteristics, which makes it 
easier to trade the security. 
The CSI is designed for short-term traders who can handle the risks 
associated with highly volatile markets. 

Correlation 
The purpose of correlation analysis is to measure the relationship between 
two variables.  This relationship is called the "correlation coefficient."   
The correlation coefficient ranges between ±1.0.  A coefficient of +1.0 is 
a perfect positive correlation and -1.0 is a perfect negative correlation.  
Two variables with no relationship will have a coefficient of zero. 
See page 163 for more information on plotting indicators.  See page 178 
for more information on the Correlation parameters. 

Interpretation 
Correlation analysis involves a "dependent" and an "independent" 
variable.  Correlation analysis measures whether or not a change in the 
independent variable will result in a change in the dependent variable.  
A low correlation coefficient (e.g., ±0.10) suggests that the relationship 
between the two variables is weak or non-existent.  A high correlation 
indicates that the dependent variable (e.g., the security's price) will 
change when the independent variable (e.g., an indicator) changes. 
The direction of the dependent variable's change depends on the sign of 
the coefficient.  If the coefficient is a positive number, then the dependent 
variable will move in the same direction as the independent variable; if 
the coefficient is negative, then the dependent variable will move in the 
opposite direction of the independent variable. 
A useful feature of correlation analysis is its predictive capability, because 
the correlation coefficient shows how well a change in the independent 
variable (e.g., an indicator) predicts a change in the dependent variable 
(e.g., the security's price). 
 
The Correlation indicator can be used in three ways: 
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• Correlation of a security's price to an indicator 
 
You can measure the relationship between an indicator and a 
security's price.  A high positive correlation coefficient means that a 
change in the indicator usually predicts a change in the security's 
price.  A high negative correlation (e.g., -0.70) means that when the 
indicator's value changes, the security's price will usually move in 
the opposite direction.  Remember, a low (e.g., 0.10) correlation 
coefficient indicates that the relationship between the security's price 
and the indicator is not significant. 

• Correlation of one security to another 
 
Another use of correlation analysis is to measure the strength of a 
relationship between two securities.  Often, one security's price 
"leads" or predicts the price of another security.  This is especially 
noticeable with commodities.  For example, the correlation  
coefficient of gold versus the dollar shows a strong negative 
relationship.  In other words, an increase in the dollar usually predicts 
a decrease in the price of gold. 

• Correlation of one indicator to another 
 
Another use of correlation analysis is to measure the strength of a 
relationship between two indicators.  Often, one indicator's 
movement "leads" or predicts the movement of another indicator.  
For example, a volume-based indicator (i.e., Chaikin Oscillator, 
Money Flow Index, etc.) may be found to lead a momentum based 
indicator (i.e., RSI, Stochastic, etc.). 

Cycle Lines 
Cycles allow us to accurately predict events in nature: bird migrations, the 
tides, planetary movements, etc. You can also use cycle analysis to  
predict changes in financial markets, although not always with the 
accuracy found in nature. 
We know that prices are a consensus of human expectations.  These 
expectations are always changing, shifting the supply/demand lines (see 
page 523), and causing prices to oscillate between overbought and 
oversold levels. Fluctuations in prices are a natural process of changing 
expectations and lead to cyclical patterns. 
See page 205 for more information on drawing line studies.  See page 215 
for more information on Cycle Line parameters. 

Interpretation 
An obvious example of a cyclical pattern is shown in a chart of a sine 
wave.  Although security prices rarely move with this degree of 
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predictability, even a quick glance at many security charts is enough to 
see evidence of some type of cyclical pattern. 
MetaStock Pro's Cycle Line tool allows you to place equally spaced 
vertical lines on a chart.  Since you can control the spacing between the 
cycle lines, you may be able to visually extrapolate the cycles evident in a 
plot.  If you extend the right margin of a chart, the cycle lines will extend 
into the future.  This can help you anticipate when the next peak or trough 
of a cycle may occur. 

DEMA 
DEMA is a unique smoothing indicator developed by Patrick Mulloy.  It 
was originally introduced in the February 1994 issue of  Technical 
Analysis of Stocks & Commodities magazine. 
As Mr. Mulloy explains in the article:  
"Moving averages have a detrimental lag time that increases as the 
moving average length increases. The solution is a modified version of 
exponential smoothing with less lag time." 
DEMA is an acronym that stands for Double Exponential Moving 
Average.  However, the name of this smoothing technique is a bit 
misleading in that it is not simply a moving average of a moving average.  
It is a unique composite of a single exponential moving average and a 
double exponential moving average that provides less lag than either of 
the two components individually.  
See page 163 for more information on plotting indicators.  See page 179 
for more information on the DEMA parameters. 

Interpretation 
DEMA can be used in place of traditional moving averages.  You can use 
it to smooth price data or other indicators.  Some of  Mr. Mulloy's original 
testing  of DEMA was done on the MACD.  Oddly, he found that the 
faster responding DEMA-smoothed MACD produced fewer (yet more 
profitable) signals than the traditional 12/26 smoothed- MACD.  A  
custom indicator named "MACD (DEMA-smoothed)" is included with 
MetaStock Pro. 
This type of smoothing is certainly not limited to the MACD.  You may 
want to experiment on other indicators as well. 
See page 525 for information on TEMA, a similar smoothing method 
developed by Mr. Mulloy. 

Demand Index 
The Demand Index, developed by James Sibbet, combines price and 
volume in such a way that it is often a leading indicator of price change.  
The Demand Index calculations are too complex, however, for this text.  
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The calculations require 21-column accounting paper to calculate 
manually. 
MetaStock Pro uses a slight variation on the Sibbet's original Index so 
that the Index is displayed on a "normal" y-axis scale.  The author's Index 
is plotted on a scale labeled +0 at the top, 1 in the middle, and -0 at the 
bottom.  MetaStock Pro uses a scale from +100 to -100.  Other than the 
difference in y-axis labeling, the indicator is calculated exactly as 
designed by its author. 
See page 163 for more information on plotting indicators.  See page 179 
for more information on the Demand Index parameters. 

Interpretation 
There are six "rules" to the Demand Index: 
• A divergence between the Demand Index and the price trend suggests 

an approaching weakness in price. 
• One more rally to new highs usually follows an extreme peak in the 

Demand Index (the Index is performing as a leading indicator). 
• Higher prices with a lower Demand Index peak usually coincides 

with an important top (the Index is performing as a coincidental 
indicator). 

• The Demand Index penetrates the level of zero indicating a change in 
trend (the Index is performing as a lagging indicator). 

• When the Demand Index stays near the level of zero for any period of 
time, a weak price movement that will not last long is indicated. 

• A large long-term divergence between prices and the Demand Index 
indicates a major top or bottom. 

Detrended Price Oscillator 
The Detrended Price Oscillator (DPO) is an indicator that attempts to 
eliminate the trend in prices.  Detrended prices allow you to more easily 
identify cycles and overbought/oversold levels. 
The calculation is quite simple; you simply center an x-period moving 
average by shifting it back x/2 + 1 periods.  This centered moving average 
is then subtracted from the close.  The result is an oscillator that crosses 
above and below zero.  
Since the DPO is shifted back "x/2 + 1" periods, the last "x/2 + 1" periods 
will have no values. 
MetaStock Pro prompts you to enter the number of periods.  The value 
entered should be the approximate length of the cycle you wish to 
identify.  Cycles longer than the number of periods you enter will not be 
shown.  The default value is 20. 
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See page 163 for more information on plotting indicators.  See page 179 
for more information on the Detrended Price Oscillator parameters. 

Interpretation 
Long-term cycles are made up of a series of short-term cycles.  Analyzing 
these shorter term components of the long-term cycles can be helpful in 
identifying major turning points in the longer term cycle.  The DPO is 
helpful in recognizing the underlying cyclical components of the price 
action. 
You may find it helpful to fit cycle lines (see page 458) to the DPO to 
determine the length of the cycles. 

Directional Movement 
The Directional Movement System, developed by J. Welles Wilder, is 
explained thoroughly in his book, New Concepts in Technical Trading 
Systems (see page 544). MetaStock Pro calculates and plots all five of the 
indicators that comprise the Directional Movement System (i.e., CSI, 
+DI, -DI, ADX, and ADXR). 
MetaStock Pro also calculates a related indicator, the Commodity 
Selection Index (see page 456). 
Wilder's book gives complete step-by-step instructions (and examples) on 
calculating and interpreting each of the above indicators. 
You may find the expert named "Equis - Directional Movement" helpful 
in interpreting Directional Movement indicators.  See page 435 for more 
information an experts. 
See page 163 for more information on plotting indicators.  See page 180 
for more information on the Directional Movement parameters. 

Interpretation 
The basic Directional Movement trading system involves plotting the 14-
period +DI and the 14-period -DI on top of each other in the same inner 
window (see page 172).  An improved method of displaying these two 
indicators is to plot their difference using the following formula: 
pdi(14) - mdi(14)    
Positions should be taken by buying when the +DI rises above the -DI 
(i.e., the formula shown above rises above zero) and selling when the 
+DI falls below the -DI (i.e., the formula falls below zero). 
These simple trading rules are qualified with the "extreme point rule."  
This rule is designed to prevent whipsaws and reduce the number of 
trades. 
The extreme point rule requires that on the day that the +DI and -DI cross, 
you note the "extreme price."  If you are long, the extreme price is the low 



 

 
 

462 • Interpretation of Indicators and Line Studies MetaStock Professional 

 

 

 

price on the day the lines cross.  If you are short, the extreme price is the 
high price on the day the lines cross. 
The extreme point is then used as a trigger point at which you should 
implement the trade.  For example, after receiving a buy signal (the +DI 
rose above the -DI), you should then wait until the security's price rises 
above the extreme point (the high price on the day that the +DI and -DI 
lines crossed) before buying.  If the price fails to rise above the extreme 
point, you should continue to hold your short position. 
In Wilder's book, he notes that this system works best on securities that 
have a high Commodity Selection Index (CSI) value.  He says, "as a rule 
of thumb, the system will be profitable on commodities that have an 
ADXR value above 25.  When the ADXR drops below 20, then do not 
use a trend-following system." 

Dynamic Momentum Index 
The Dynamic Momentum Index (DMI) was developed by Tushar Chande 
and Stanley Kroll.  The indicator is covered in detail in their book The 
New Technical Trader. 
The DMI is identical to Welles Wilder’s RSI (see page 512) except the 
number of periods is variable rather than fixed.  The variability of the  
time periods used in the DMI is controlled by the recent volatility of 
prices.  The more volatile the prices, the more sensitive the DMI is to price 
changes.  In other words, the DMI will use more time periods during quiet 
markets, and less during active markets.  The maximum time periods the 
DMI can reach is 30 and the minimum is 3.  This calculation method is 
similar to the Variable Moving Average, also developed by Tushar 
Chande (see page 484). 
The advantage of using a variable length time period when calculating the 
RSI is that it overcomes the negative effects of smoothing, which often 
obscure short-term moves. 
The volatility index used in controlling the time periods in the DMI is 
based on a calculation using  a five period standard deviation and a ten 
period average of the standard deviation. 
See page 163 for more information on plotting indicators.  See page 180 
for more information on the Dynamic Momentum Index parameters.   

Interpretation 
Chande recommends using the DMI much the same as the RSI.  However, 
because the DMI is more sensitive to market dynamics, it often leads the 
RSI into overbought/oversold territories by one or two days.   
Like the RSI, look for overbought (bearish) conditions above 70 and 
oversold (bullish) conditions below 30.  However, before basing any trade 
off of strict overbought/oversold levels using DMI or any 
overbought/oversold indicator, Chande recommends that you first qualify 
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the trendiness of the market using indicators such as r-squared (see page 
506) or CMO (see page 454).  If these indicators suggest a non-trending 
market, then trades based on strict overbought/oversold levels should 
produce the best results.  If a trending market is suggested, you can use  
the DMI to enter trades in the direction of the trend. 
 

Ease of Movement 
The Ease of Movement indicator was developed by Richard W. Arms, Jr., 
best known for the popular Arms Index and the Equivolume charting 
method.  The Ease of Movement indicator is a product of the Equivolume 
charting method.  The Ease of Movement indicator provides one value  
(for each time period) representing the price and volume for that period.   
It calculates the ease at which prices are moving.  The larger the price 
move and the lighter the volume, the easier the movement. 
Ease of Movement (EMV) is calculated as follows: 

EMV =  
Midpoint Move

Box Ratio
 

Where:  

Midpoint  =  
Today' s High + Today' s Low

2

Yesterday' s High + Yesterday' s Low

2
−

 

Box Ratio =  
Volume (in 10,000s)

High -  Low  
The raw Ease of Movement values is usually smoothed by a moving 
average. 
See page 163 for more information on plotting indicators.  See page 180 
for more information on the Ease of Movement parameters. 

Interpretation 
The Ease of Movement indicator produces a buy signal when the 
indicator crosses above the zero center line, indicating that the security is 
moving upward easily; a sell signal is given when the indicator crosses 
below the zero center line, indicating that the security is moving 
downward easily. 
High ease of movement values correspond with easy upward price 
movement whereas low ease of movement values correspond with easy 
downward price movement.  When price movement is small on heavy 
volume, the ease of movement indicator is zero. 
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Envelope 
An envelope is comprised of two moving averages (see page 484).  One 
moving average is shifted upward and the second moving average is 
shifted downward.  The envelope is plotted around a price plot or 
indicator. 
See page 163 for more information on plotting indicators.  See page 181 
for more information on Envelope parameters. 

Interpretation 
Envelopes define the upper and lower boundaries of a security's normal 
trading range.  A sell signal is generated when the security reaches the 
upper band, whereas a buy signal is generated at the lower band. The 
optimum percentage shift depends on the volatility of the security--the 
more volatile, the larger the percentage. 
The logic behind envelopes is that overzealous buyers and sellers push the 
price to the extremes (i.e., the upper and lower bands), at which point the 
prices often stabilize by moving to more realistic levels.  This is similar to 
the interpretation of Bollinger Bands (see page 449). 

Equivolume 
Developed by Richard W. Arms, Jr., and explained in his book Volume 
Cycles in the Stock Market (see page 544), Equivolume presents a highly 
informative picture of market activity for stocks, futures, and indices. 
Equivolume departs from other charting methods with its emphasis on 
volume as an equal partner with price.  Instead of being displayed as an 
"afterthought" on the lower margin of a chart, volume is combined with 
price in a two-dimensional box.  The top line of the box is the high for the 
period and the bottom line is the low for the period.  The width of the box 
is the unique feature of Equivolume charting; it represents the volume of 
trading for the period. 
The width of the box is controlled by a normalized volume value.  The 
volume for an individual box is normalized by dividing the actual volume 
for the period by the total of all volume displayed on the chart.  
Therefore, the width of each Equivolume box is based on a percentage of 
total volume, with the total of all percentages equaling 100. 
The following illustration shows the components of an Equivolume box: 
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The resulting charts represent an important departure from all other 
analytical methods, in that time becomes less important than volume in 
analyzing price moves.  It suggests that each movement is a function of 
the number of shares or contracts changing hands rather than the amount 
of time elapsed. 
Perhaps the Equivolume charting method is best summed up by the 
developer himself as follows:  "If the market wore a wristwatch, it would 
be divided into shares, not hours."  

Interpretation 
The shape of each Equivolume box provides a picture of the supply and 
demand for the security during a specific trading period.  Short and wide 
boxes (i.e., small change in price combined with heavy volume) tend to be 
seen at turning points, while tall and narrow boxes (i.e., large change 
combined with low volume) are more likely to be seen during continuing 
moves. 
Especially important are boxes which penetrate old support or resistance 
levels, since it takes "power" to create a reliable penetration.  A "power 
box" is one in which both height and width increase substantially.  Lack 
of box width, due to light volume, puts the validity of a breakout in 
question. 
The more volume in a top or bottom consolidation, the larger the ensuing 
move is likely to be.  Volume is directly observable on an Equivolume 
chart by noting the overall width of the consolidation. 
For an in-depth understanding of Equivolume, we recommend the book 
Volume Cycles in the Stock Market by the developer, Richard W. Arms, 
Jr. (see page 544). 

Fibonacci Studies 
Leonardo Fibonacci was an important mathematician who was born in 
Italy around the year 1170.  It is rumored that Fibonacci discovered the 
relationship of what are now referred to as Fibonacci numbers while 
studying the Great Pyramid of Giza in Egypt.  
Fibonacci numbers are a sequence of numbers in which each successive 
number is the sum of the two previous numbers: 
 1, 1, 2, 3, 5, 8, 13, 21, 34, 55, 89, 144, 233, 377, 610, etc. 
These numbers possess an intriguing number of interrelationships, such as 
the fact that any given number is approximately 1.618 times the preceding 
number and any given number is approximately 0.618 times the following 
number.  The booklet Understanding Fibonacci Numbers by Edward 
Dobson (see page 544) contains a good discussion of these 
interrelationships. 
See page 205 for more information on drawing line studies.  See 
Fibonacci Arcs (page 216), Fibonacci Fans (page 217), Fibonacci 
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Retracements (page 217), and Fibonacci Time Zones (page 217) for more 
information on the Fibonacci parameters. 

Interpretation 
MetaStock Pro has four Fibonacci studies:  arcs, fans, retracements, and 
time zones.   
The general interpretation of the Fibonacci studies involves the 
anticipation of a change in trend as prices near the lines created by the 
Fibonacci studies. 

Arcs 
The calculation and interpretation of Fibonacci Arcs is similar to that of 
Fibonacci Fan Lines.  First, a trendline is drawn between two extreme 
points.  MetaStock Pro then draws three arcs, centered on the second 
extreme point, that intersect the trendline drawn between the two extreme 
points at the Fibonacci levels of 38.2%, 50.0%, and 61.8%. 
The interpretation of Fibonacci Arcs involves looking for, or anticipating, 
support and resistance as prices approach the arcs.  A common technique 
is to display both Fibonacci Arcs and Fibonacci Fan Lines and to 
anticipate support/resistance at the points where the Fibonacci studies 
cross. 
The points where the Arcs cross the price data will vary depending on the 
scaling, because the Arcs are drawn so they always appear circular 
relative to the computer screen. 

Fans 
Fibonacci Fan Lines are displayed by first drawing a trendline between 
two extreme points.  MetaStock Pro then draws an invisible vertical line 
through the second extreme point.  This vertical line is then divided at the 
Fibonacci levels of 38.2%, 50.0%, and 61.8%.  Finally, three trendlines 
are drawn from the first extreme point so they pass through the invisible 
vertical line at the above three levels.  (This technique is similar to the 
method used to calculate Speed Resistance Lines, see page 515.) 

Retracements 
Fibonacci Retracements are displayed by first drawing a trendline 
between two extreme points (i.e., a significant trough and peak).  After 
selecting Fibonacci Retracement from the Insert menu, a series of up to 
nine horizontal lines will be drawn at the Fibonacci levels of 0.0%, 
23.6%, 38.2%, 50.0%, 61.8%, 100%, 161.8%, 261.8%, and 423.6%.   
After a significant move (either up or down), prices will often rebound 
and retrace a significant portion (if not all) of the original move.  As the 
price retraces, support and resistance levels will often occur at or near the 
Fibonacci Retracement levels. 
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Time Zones 
The Fibonacci Time Zones command displays vertical lines at the 
Fibonacci intervals of 1, 2, 3, 5, 8, 13, 21, 34, etc.  The interpretation of 
Fibonacci Time Zones involves looking for significant changes in price 
near the vertical lines. 

Forecast Oscillator 
The Forecast Oscillator is an extension of the linear regression based 
indicators made popular by Tushar Chande.  The Forecast Oscillator plots 
the percentage difference between the forecast price (generated by an x-
period linear regression line) and the actual price.  The oscillator is above 
zero when the forecast price is greater than the actual price.  Conversely, 
it's less than zero if its below.  In the rare case when the forecast price and 
the actual price are the same, the oscillator would plot zero. 
For more on linear regression analysis see pages 480, 478, and 530. 

Interpretation 
Actual prices that are persistently below the forecast price suggest lower 
prices ahead.  Likewise, actual prices that are persistently above the 
forecast price suggest higher prices ahead.  Short-term traders should use 
shorter time periods and perhaps more relaxed standards for the required 
length of time above or below the forecast price.  Long-term traders 
should use longer time periods and perhaps stricter standards for the 
required length of time above or below the forecast price. 
Chande also suggests plotting a three-day moving average trigger line of 
the Forecast Oscillator to generate early warnings of changes in trend.  
When the oscillator crosses below the trigger line, lower prices are 
suggested.  When the oscillator crosses above the trigger line, higher 
prices are suggested. 

Fourier Transform 
It is beyond the scope of the manual to provide a full explanation of 
Fourier analysis.  Further information can be found in Technical Analysis 
of Stocks & Commodities magazine (TASC), Volume One issues #2, #4,  
and #7; Volume Two issue #4; Volume Three issues #2 and #7 
(Understanding Cycles); Volume Four issue #6; Volume Five issues #3 
(In Search of the Cause of Cycles) and #5 (Cycles and Chart Patterns); 
and Volume Six issue #11 (Cycles). 
Fourier Transforms were originally developed as an engineering tool to 
study repetitious (cyclical) phenomena such as the vibration of a stringed 
musical instrument or an airplane wing during flight. 
The complete analysis concept is called spectral analysis.  Fast Fourier 
Transform (FFT) is an abbreviated calculation that computes in seconds 
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rather than minutes.  The FFT sacrifices phase relationships and 
concentrates only on cycle length and amplitude (strength). 
The benefit of FFT is its ability to extract the predominate cycle(s) from a 
series of data (e.g., an indicator or a security's price). 
FFTs are based on the principal that any finite, time-ordered set of data 
can be approximated arbitrarily well by decomposing the data into a set of 
sine waves.  Each sine wave has a specific cycle length, amplitude, and 
phase relationship to the other sine waves. 
Problems occur when applying FFT analysis to security price data 
because FFTs were designed to be applied to non-trending, periodic data 
(whereas security price data tends to be trending).  This is overcome by 
"detrending" the data using either a linear regression trendline or a 
moving average.  
Security data is not truly periodic, since securities are not traded on 
weekends and some holidays.  MetaStock Pro removes these 
discontinuities by passing the data through a smoothing function called a 
"hamming window." 
See page 163 for more information on plotting indicators.  See page 180 
for more information on the Fourier Transform parameters. 

Interpretation 
As stated at the beginning of this section, it is beyond the scope of the 
manual to provide complete interpretation of FFT analysis.  The 
remainder of this section explains the interpretation of MetaStock Pro's 
Interpreted FFT. 
The Interpreted FFT displays an indicator that shows the three 
predominate cycle lengths and the relative strength (i.e., the relative 
amplitudes) of the cycles. 
The Interpreted FFT indicator is always displayed from the most 
significant cycle to the least significant cycle.  The longer the indicator 
remains at a specific cycle length, the more predominate it was in the data 
being analyzed. 
Once you know the predominate cycle length, you may want to use it as a 
parameter for other indicators.  For moving averages, use 1/2 of the cycle 
length for the optimum number of periods.  For example, if you know that 
a security has a 40-day cycle, you may want to plot a 20-day moving 
average.   
 

Gann Studies 
W. D. Gann (1878-1955) designed several unique techniques for studying 
price charts.  Central to Gann's techniques was the use of geometric  
angles in conjunction with time and price.  Gann believed that specific 
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geometric patterns and angles had unique characteristics that could be 
used to predict price action.  
All of Gann's techniques require that equal time and price intervals be 
used on the charts, so that a rise/run of 1 x 1 will always equal a 45 degree 
angle. 
Gann believed that the ideal balance between time and price exists when 
prices rise or fall at a 45 degree angle relative to the time axis.  This is  
also called a 1 x 1 angle (i.e., prices rise one price unit for each time unit). 
See page 205 for more information on plotting line studies.  See page 218 
for more information on the Gann Study parameters. 

Interpretation 
Gann Angles are drawn between a significant bottom and top (or vice 
versa) at various angles.  Deemed the most important by Gann, the 1 x 1 
trendline signifies a bull market if prices are above the trendline or a bear 
market if below.  Gann felt that a 1 x 1 trendline provides major support 
during an up-trend and when the trendline is broken, it signifies a major 
reversal in the trend.  Gann identified nine significant angles, with the 1 x 
1 being the most important:   
 1 x 8 - 82.5 degrees 
 1 x 4 - 75 degrees 
 1 x 3 - 71.25 degrees 
 1 x 2 - 63.75 degrees 
 1 x 1 - 45 degrees 
 2 x 1 - 26.25 degrees 
 3 x 1 - 18.75 degrees 
 4 x 1 - 15 degrees 
 8 x 1 - 7.5 degrees 

Note that in order for the rise/run values (e.g., 1 x 1, 1 x 8, etc.) to match 
the actual angles (in degrees), the x- and y-axes must have equally spaced 
intervals.  This means that one unit on the x-axis (i.e., hour, day, week, 
month, etc.) must be the same distance as one unit on the y-axis.  The 
easiest way to calibrate the chart is make sure that a 1 x 1 angle produces 
a 45 degree angle. 
Gann observed that each of the angles can provide support and resistance 
depending on the trend.  For example, during an up-trend the 1 x 1 angle 
tends to provide major support.  A major reversal is signaled when prices 
fall below the 1 x 1 angled trendline.  According to Gann, prices should 
then be expected to fall to the next trendline (i.e., the 2 x 1 angle).  In 
other words, as one angle is penetrated, expect prices to move and 
consolidate at the next angle.   
Gann developed several techniques for studying market action.  These 
include Gann Lines, Gann Fans, and Gann Grids. 
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Herrick Payoff Index 
The Herrick Payoff Index is used to analyze futures and commodities.  
Because the Index uses open interest in its calculations, the security must 
contain open interest. 
Briefly, the calculation of the Herrick Payoff Index involves computing 
the mean price for each day and then using this information to compute  
the difference in mean prices for each day.  The flow of money into, or  
out of, the commodity is then computed by multiplying the change in the 
mean prices by the day's volume to arrive at a total change in dollars for 
the day.  MetaStock Pro uses the dollar value of a one cent move (input  
by the user) to modify the "money flow" by changes in open interest.  The 
daily values of the "modulated dollar amount" are then smoothed with an 
exponential moving average. 
According to Herrick, the recommended input for "the value of a one cent 
move" is "100" for most commodities.  The only exception is for Silver, 
which should be "50." 
Before the Herrick Payoff Index is calculated, you will be prompted to 
enter a smoothing factor known as the "multiplying factor."  The 
multiplying factor is part of a complex smoothing mechanism.  However, 
the results are similar to the smoothing obtained by a moving average.  
For example, a multiplying factor of ten produces results similar to a 10-
period moving average. 
See page 163 for more information on plotting indicators.  See page 183 
for more information on the Herrick Payoff Index parameters. 

Interpretation 
The interpretation of the Herrick Payoff Index involves visually 
comparing the action of the Index with the price while looking for 
divergences and convergences.  An example divergence would be 
increasing prices while the Index is falling.  An example convergence 
would be decreasing prices while the Index is rising. 

Tip 
Open interest is usually not available for the most recent day.  Thus, the 
right most data point of the Herrick Payoff Index is usually blank. 

High/Low/Close Bar 
A bar chart is the most popular way to display security prices.  A bar chart 
is made up of vertical bars, with each bar representing the price  
movement for a time period (i.e., hour, day, week, month, etc.).  Hash 
marks on the left and right sides of the bar represent the opening and 
closing prices respectively.  The top of the bar represents the high price 
and the bottom of the bottom represents the low price. 
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Interpretation 
Bar charts, by themselves are used to view the movement of the security's 
prices over a specific time period.  Indicators (see page 163) and line 
studies (see page 205) can be displayed along with bar charts to help 
determine the future direction of the security's price. 

Inertia 
The Inertia indicator was developed by Donald Dorsey.  It was originally 
introduced in the September 1995 issue of Technical Analysis of Stocks 
& Commodities magazine.  It is an outgrowth of Dorsey’s Relative 
Volatility Index (see page 513). 
Dorsey chose the name “Inertia” because of his definition of a trend.  He 
asserts that a trend is simply the “outward result of inertia.”  It takes 
significantly more energy for a market to reverse direction than to 
continue along the same path.  Therefore a trend is a measurement of 
market inertia. 
In physics, Inertia is defined in terms of mass and direction of motion.  
Using technical analysis to analyze security prices, the direction of motion 
is easily defined.  However, mass is not so easily defined.  Dorsey asserts 
that “volatility” may be the simplest and most accurate measurement of 
inertia.  This theory led him to use the Relative Volatility Index (RVI) as 
the basis for a trend indicator. 
Inertia is simply a smoothed RVI.  The smoothing mechanism is a Linear 
Regression indicator (see page 475).  The RVI helps measure the general 
direction of volatility.  Dorsey found that by smoothing the RVI, a good 
long-term trend indicator resulted. 
 
See page 163 for more information on plotting indicators.  See page 183 
for more information on the Inertia parameters.   

Interpretation 
If the Inertia indicator is above 50, positive inertia is indicated.  The 
long-term trend is up and should remain up as long as the indicator is 
above 50. If it's below 50, negative inertia is indicated.  The long-term 
trend is down and should remain down as long as the indicator is below 
50. 
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Intraday Momentum Index 
The Intraday Momentum Index (IMI) was developed by Tushar Chande.  
It is a cross-breed between the RSI (see page 512) and candlestick 
analysis (see page 450).  For more information on the IMI, refer to the 
book The New Technical Trader by Tushar Chande and Stanley Kroll. 
The calculation of the IMI is very similar to the RSI, except it uses the 
relationship between the intraday opening and closing prices to determine 
whether the day is “up” or “down.”  If the close is above the open, it is an 
up day.  If the close is below the open it is a down day.  Therein lies its tie 
to candlestick charting.  For those familiar with candlestick charting, the 
IMI separates the black and white candlesticks and performs a RSI 
calculation on the candlestick bodies. 
See page 163 for more information on plotting indicators.  See page 183 
for more information on the Intraday Momentum Index parameters.   

Interpretation 
Overbought/oversold.  Index values above 70 indicate a potential 
overbought situation with lower prices ahead.  Values below 30 indicate a 
potential oversold situation with higher prices ahead.  As with all 
overbought/oversold indicators, you should first quantify the trendiness of 
the market before acting on the signals. Indicators like the VHF (see page 
533), CMO (see page 454), and r-squared (see page 506) can be used to 
gauge the trendiness of the market. 
Divergences.  The basic premise behind the IMI, is that shifts in intraday 
momentum lead shifts in interday momentum. Look for divergences 
between the indicator and the price action.  If the price trends higher 
(lower) and the IMI trends lower (higher), then a reversal may be 
imminent. 
Candlestick Confirmation.  The IMI is useful in confirming candlestick 
patterns.  For example, before acting on a bullish candlestick pattern such 
as the Engulfing Bullish Lines (see page 291), you may want to confirm 
the bullishness with the IMI. 

Kagi 
Kagi charts are thought to have been created around the time the Japanese 
stock market started trading in the 1870s.  Kagi charts were introduced to 
the western world by Steve Nison (a well-known authority on the 
Candlestick charting method).  Kagi charts display a series of connecting 
vertical lines where the thickness and direction of the lines are dependent 
on the price action.  If closing prices continue to move in the direction of 
the prior vertical Kagi line, that line is extended.  However, if the closing 
price reverses by a pre-determined "reversal" amount, a new Kagi line is 
drawn in the next column in the opposite direction.  An interesting aspect 
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of the Kagi chart is that when closing prices penetrate the prior column's 
high or low, the thickness of the Kagi line changes. 
To draw Kagi lines, compare the close to the ending point of the last Kagi 
line.  If the price continues in the same direction as the prior line, the line 
is extended in the same direction, no matter how small the move.  
However, if the closing price moves in the opposite direction by the 
reversal amount or more (this could take a number of sessions), then a 
short horizontal line is drawn to the next column and a vertical line is 
continued to the new closing price.  If the closing price moves in the 
opposite direction of the current column by less than the reversal amount 
then no lines are drawn. 
In addition, if a thin Kagi line exceeds the prior high point (on the Kagi 
chart), the line becomes thick.  Likewise, if a thick Kagi line breaks a 
prior low point, the line becomes thin. 

Interpretation 
Kagi charts are an excellent way to view the underlying supply and 
demand of a security.  A series of thick lines shows that demand is 
exceeding supply (a rally); a series of thin lines shows that supply is 
exceeding demand (a decline); and a series of alternating thick and thin 
lines shows that the market may be in a relative state of equilibrium (i.e., 
supply equals demand). 
The most basic trading technique for Kagi charts is to buy when the Kagi 
line changes from thin to thick and to sell when the Kagi line changes 
from thick to thin. 
A sequence of higher highs and higher lows on Kagi charts shows the 
underlying force of the bulls.  As a general rule of thumb, eight to 10 
higher highs on a Kagi chart often coincides with an overextended market 
(i.e., a downside reversal may be imminent). Whereas, lower highs and 
lower lows may reflect an underlying weakness. 
 
Indicators calculated on kagi charts use all the data in each column and 
then display the average value of the indicator for that column. 
For more in-depth coverage of the Kagi charting method, we recommend 
the book Beyond Candlesticks by Steve Nison (see page 544). 

Klinger Oscillator 
The Klinger Oscillator (KO) was developed by Stephen J. Klinger.  
Learning from prior research on volume by such well-known technicians 
as Joseph Granville, Larry Williams, and Marc Chaikin, Mr. Klinger set 
out to develop a volume-based indicator to help in both short- and long-
term analysis. 
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The KO was developed with two seemingly opposite goals in mind:  to be 
sensitive enough to signal short-term tops and bottoms, yet accurate 
enough to reflect the long-term flow of money into and out of a security. 
The KO is based on the following tenets: 
• Price range (i.e. High - Low) is a measure of movement and volume  

is the force behind the movement.  The sum of High + Low + Close 
defines a trend.  Accumulation occurs when today's sum is greater 
than the previous day's.  Conversely, distribution occurs when today's 
sum is less than the previous day's.  When the sums are equal, the 
existing trend is maintained. 

• Volume produces continuous intra-day changes in price reflecting 
buying and selling pressure.  The KO quantifies the difference 
between the number of shares being accumulated and distributed 
each day as "volume force."  A strong, rising volume force should 
accompany an uptrend and then gradually contract over time during 
the latter stages of the uptrend and the early stages of the following 
downtrend.  This should be followed by a rising volume force 
reflecting some accumulation before a bottom develops. 

• By converting the volume force into an oscillator representing the 
difference between a 34-period and 55-period exponential moving 
average with a 13-period trigger, the force of volume into and out of 
a security can easily be tracked.  Comparing this force to price action 
can help identify divergences at tops and bottoms. 

See page 163 for more information on plotting indicators. 

Interpretation 
Mr. Klinger recommends the following guidelines for using the KO: 
1)  The most reliable signals occur in the direction of the prevailing trend.  
Strict stop guidelines (i.e., failure to penetrate the zero line or a violation 
of the trigger line) should remain in force. 
2)  The most important signal occurs when the KO diverges with the 
underlying price action, especially on new highs or new lows in 
overbought/oversold territory.  For example, when a stock makes a new 
high or low for a cycle and the KO fails to confirm this, the trend may be 
losing momentum and nearing completion. 
3)  If the price is in an uptrend (i.e., above an 89-day exponential moving 
average), buy when the KO drops to unusually low levels below zero, 
turns up, and crosses its trigger line.  If the price is in a downtrend (i.e., 
below an 89-day exponential moving average), sell when the KO rises to 
unusually high levels above zero, turns down, and crosses its trigger line. 
While the KO works well for timing trades in the direction of the trend, it 
is less effective against the trend.  This can create problems for the trader 
trying to "scalp" a trade against the prevailing trend.  However, when the 
KO is used in conjunction with other technical indicators, better results 
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can be achieved.  William's %R (see page 538) is recommended for 
confirming an overbought/oversold price condition and Gerald Appel's 
MACD (see page 478) is recommended for confirming the short-term 
direction of price. 

Tip 
Stephen Klinger suggests the following formula for viewing the 
cumulative flow of money into and out of a security: 
cum(kvo()) 
Plot a 13-period moving average of the formula as a trigger line for 
entering buy and sell trades.  See page 299 for more information on 
creating formulas. 

Line Chart 
A line chart is the simplest type of chart.  One price (typically the close) 
is plotted for each time period (i.e., day, week, month, etc.).  A single, 
unbroken line connects each of these price points. 

Interpretation 
Line charts, by themselves are used to view the movement of the 
security's prices over a specific time period.  Indicators (see page 163) 
and line studies (see page 205) can be displayed along with line charts to 
help determine the future direction of the security's price. 
A line chart's strength comes from its simplicity.  It provides an 
uncluttered, easy to understand view of a security's price.  Line charts are 
typically displayed using a security's closing prices. 

Linear Regression Indicator 
The Linear Regression indicator is based on the trend of a security's price 
over a specified time period.  The trend is determined by calculating a 
linear regression trendline using the "least squares fit" method.  The least 
squares fit technique fits a trendline to the data in the chart by minimizing 
the distance between the data points and the linear regression trendline.   
Any point along the Linear Regression indicator is equal to the ending 
value of a Linear Regression trendline.  For example, the ending value of 
a Linear Regression trendline that covers 10 days will have the same 
value as a 10-day Linear Regression indicator.  This differs slightly from 
the Time Series Forecast indicator (see page 527) in that the TSF adds the 
slope to the ending value of the regression line.  This makes the TSF a bit 
more responsive to short term price changes.  If you plot the TSF and the 
Linear Regression indicator side-by-side, you’ll notice that the TSF hugs 
the prices more closely than the Linear Regression indicator. 
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Rather than plotting a straight Linear Regression trendline, the Linear 
Regression indicator plots the ending values of multiple Linear 
Regression trendlines. 
See page 163 for more information on plotting indicators.  See page 184 
for more information on the Linear Regression indicator parameters. 

Interpretation 
The interpretation of a Linear Regression indicator is similar to a moving 
average.  However, the Linear Regression indicator has two advantages 
over moving averages. 
Unlike a moving average, a Linear Regression indicator does not exhibit 
as much "delay."  Since the indicator is "fitting" a line to the data points 
rather than averaging them, the Linear Regression line is more responsive 
to price changes. 
The indicator is actually a forecast of the next periods (tomorrow’s) price 
plotted today.  The Forecast Oscillator plots the percentage difference 
between the forecast price and the actual price.  Tushar Chande suggests 
that when prices are persistently above or below the forecast price, prices 
can be expected to snap back to more realistic levels.  In other words the 
Linear Regression indicator shows where prices should be trading on a 
statistical basis.  Any excessive deviation from the regression line should 
be short-lived. 

Linear Regression Slope 
The Linear Regression method provides several useful outputs for 
technical analysts, including the Slope.  The Slope shows how much 
prices are expected to change per unit of time.  Some may remember this 
as “rise over run.” 
See page 163 for more information on plotting indicators.  See page 185 
for more information on the Linear Regression Slope parameters.   

Interpretation 
It is helpful to consider Slope in relation to r-squared (see page 506).  
While Slope gives you the general direction of the trend (positive or 
negative), r-squared gives you the strength of the trend.  A high r-squared 
value can be associated with a high positive or negative Slope.  
When the Slope of the trend first becomes significantly positive, you  
could open a long position.  You could sell, or open a short position when 
the Slope first becomes significantly negative.  You should refer to the 
table below to determine when a trend is deemed “significant.”  For 
example, if the 14-period Slope has recently turned from negative to 
positive (i.e., crossed above zero), you may consider buying when r-
squared crosses above the 0.27 level. 



 

 
 

MetaStock Professional Interpretation of Indicators and Line Studies • 477 

 

 

 

To determine if the trend is statistically significant for a given x-period 
linear regression line, plot the r-squared indicator and refer to the 
following table.  This table shows the values of r-squared required for 
95% confidence level at various time periods.  If the value is less than the 
critical values shown, you should assume that prices show no statistically 
significant trend. 

Number 
of Periods

r-squared 
Critical Value 

(95% 
confidence) 

5 0.77 

10 0.40 

14 0.27 

20 0.20 

25 0.16 

30 0.13 

50 0.08 

60 0.06 

120 0.03 

You may even consider opening a short-term position opposite the 
prevailing trend when you observe the Slope rounding off at extreme 
levels.  For example, if the Slope is at a relatively high level and begins to 
turn down, you may consider selling or opening a short position. 
There are numerous ways to use the linear regression outputs of Slope and 
r-squared in trading systems.  For more detailed coverage, refer to the 
book The New Technical Trader by Tushar Chande and Stanley Kroll. 

Linear Regression Trendline 
Linear regression is a statistical tool used to predict future values from 
past values.  In the case of security prices, it is commonly used as a 
quantitative way to determine the underlying trend and when prices are 
overextended. 
A Linear Regression trendline uses the least squares method to plot a 
straight line through prices so as to minimize the distances between the 
prices and the resulting trendline. 
See page 205 for more information on plotting line studies.   See page 
218 for more information on the Linear Regression parameters. 

Interpretation 
If you had to guess what a particular security's price would be tomorrow, 
a logical guess would be “fairly close to today’s price.”  If prices are 
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trending up, a better guess might be “fairly close to today’s price with an 
upward bias.”  Linear regression analysis is the statistical confirmation of 
these logical assumptions.   
A Linear Regression trendline is simply a trendline drawn between two 
points using the least squares fit method.  The trendline is displayed in the 
exact middle of the prices.  If you think of this trendline as the 
“equilibrium" price, any move above or below the trendline indicates 
overzealous buyers or sellers. 
A Linear Regression trendline shows where equilibrium exists.  Raff 
Regression Channels (see page 508) show the range prices can be 
expected to deviate from a Linear Regression trendline. 
The Time Series Forecast indicator (see page 527) displays the same 
information as a Linear Regression trendline.  Any point along the Time 
Series Forecast is equal to the ending value of a Linear Regression 
Trendline plus its slope.  For example, the ending value of a Linear 
Regression trendline (plus its slope) that covers 10 days will have the 
same value as a 10-day Time Series Forecast. 
Linear Regression trendlines is used to construct Raff Regression 
Channels (see page 220), Projection Bands (see page 503), Projection 
Oscillator (see page 504) and the Linear Regression indicator (see page 
475). 

MACD 
The Moving Average Convergence/Divergence indicator (MACD) is 
calculated by subtracting the value of a 0.075 (26-period) exponential 
moving average from a 0.15 (12-period) exponential moving average.  A 
9-period dotted exponential moving average (the "signal line") is 
automatically displayed on top of the MACD indicator line. 
You may find the expert named "Equis - MACD" helpful in interpreting 
the MACD indicator.  See page 435 for more information an experts. 
See page 163 for more information on plotting indicators.  See page 185 
for more information on the MACD parameters. 

Interpretation 
The basic MACD trading rule is to sell when the MACD falls below its 9-
period signal line.  Similarly, a buy signal occurs when the MACD rises 
above its signal line. 
A variation of the MACD can be created by plotting the following 
formula: 
macd() - mov(macd(), 9, E)  
Then change the indicator line style to a histogram (see page 169), and 
plot a 9-period dotted moving average of the indicator. 
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In a system test of this indicator, sell arrows are drawn when the 
histogram peaked and turned down and buy arrows are drawn when the 
histogram formed a trough and turned up. 

Tips 
Additional variations on the MACD (e.g., different moving average time 
periods) can be created using the Price Oscillator indicator (see page 
501). 
An example custom indicator (see page 309) shows how to calculate the 
MACD. 

Market Facilitation Index 
In his book, Trading Chaos, Dr. Bill Williams, introduces a unique 
method of combining price action with volume.  The main component of 
this method is a simple indicator he developed called the Market 
Facilitation Index (MFI). 
The MFI simply divides the day's range (high to low) by the total 
volume.  The result shows the efficiency of price movement by 
quantifying the price movement per unit of volume. 
The "Profitunity" expert, written by Bill Williams, is included with 
MetaStock Pro.  This expert labels each bar on your chart and provides 
commentary on the current bar.  See 399 for more information on the 
Expert Advisor. 
For information on other products and services offered by Bill Williams, 
call Profitunity Trading Group at 1-409-945-8880. 
See page 163 for more information on plotting indicators.  See page 185 
for more information on the MFI parameters.   

Interpretation 
The MFI as a stand-alone indicator has little value.  However, by 
comparing the current bar's MFI and volume with the previous bar's MFI 
and volume, a very tradable system emerges. 
William's defines the four possible combinations of MFI and volume as 
follows.   A plus sign means the current bar's value is greater than the 
previous bar's value.  A minus sign means the current bar's value is less 
than the previous bar's value. 
 

Volum
e 

MFI Label 

+ + Green 

- - Fade 

- + Fake 
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+ - Squat 

 
Green.  This bar shows an increase in volume and MFI relative to the 
previous bar.  Hence, there is price movement, and the MFI is larger for 
this bar than that for the previous bar.  Further, more players are entering 
the market as signaled by the increase in volume.  This activity in the 
futures market means that off-floor traders are very active.  In addition, 
the price action is directional--that is, the market is moving in one 
direction due to the involvement of new traders putting on new positions.  
This is the kind of day that you would already want to have a trade on in 
the same direction. 
Fade.  This bar shows a decrease in volume and MFI relative to the 
previous bar.  The market has slowed and there is a minor amount of 
activity as indicated by the low volume.  This type of day is called a fade, 
as the traders' interest in the market by this point is fading.  Often, this 
sort of day happens at the end of a trend.  The market has simply reached 
a point where nobody is willing to establish any new positions.  At this 
point the market appears to be suffering from a certain amount of 
boredom.  Keep in mind, however, that out of this market condition, a 
new trend could emerge. 
Fake.  This bar shows a decrease in volume but an increase in the MFI.  
This condition means that the market is moving more relative to the 
previous bar (the greater MFI), but the lack of volume is evidence that 
there is no new participation.  The price action may be driven by just the 
traders in the pit and is not attracting new players from the outside.  
Williams has an hypothesis, that the traders in the pit may be just strong 
enough to push the market to price levels where there are many stop 
orders resting in the hands of the brokers, hence faking out the off-floor 
traders. 
Squat.  This bar shows an increase in volume relative to the previous bar, 
but the MFI is lower.  The increase in volume indicates heavy activity, but 
the decrease in the MFI indicates that the market is unable to make any 
real headway.  Volume increased, the trend has stalled and the price 
movement has stopped.  This price action usually, but not always occurs 
prior to an important move in the opposite direction.  This type of bar is 
called a squat bar because the market appears to be squatting prior to a 
breakout.  Often, the breakout of such a bar will indicate whether this 
squat is a trend reversal squat or a trend continuation squat. 

Mass Index 
The Mass Index, popularized by Tushar Chande and Donald Dorsey (see 
the June 1992 issue of Technical Analysis of Stocks & Commodities 
magazine), is calculated by summing an exponentially smoothed moving 
average of the daily ranges (High-Low) over 25 periods.   
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The Mass Index is designed to identify reversals in trend by measuring 
the narrowing and widening of the average range between the high and 
low prices.  As the range widens, the Mass Index increases.  As the range 
narrows, the Mass Index decreases.   
See page 163 for more information on plotting indicators.  See page 186 
for more information on the Mass Index parameters. 

Interpretation 
The most significant pattern to watch for is called the "reversal bulge."  A 
reversal bulge occurs when a 25 period Mass Index rises above 27 and 
subsequently falls below 26.5.  A reversal in price is likely once the Mass 
Index falls below 26.5.  The overall direction of prices (i.e., trending or 
trading range), is unimportant. 
A 9-period exponential moving average is used to determine whether the 
reversal bulge indicates a "buy" or "sell" signal.  Since the Mass Index 
attempts to predict reversals in trend, positions should be taken by buying 
if the moving average is trending down and selling if the moving average 
is trending up.  Since trends can fail to reverse, stop-loss orders should be 
placed with new positions. 

Median Price 
The Median Price indicator is calculated by adding the high price and the 
low price together, and then dividing by two.  The result is the average, or 
median, price. 

Median Price =  
High +  Low

2  
See page 163 for more information on plotting indicators.  See page 186 
for more information on the Median Price parameters. 

Interpretation 
The Median Price indicator provides a simple, single-line chart of the 
day's average price.  You may find it helpful when testing moving average 
penetration systems to display moving averages of the Median Price 
indicator, rather than of the security's closing price. 

Tip 
An example custom indicator (30907) shows how to calculate the Median 
Price indicator. 
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MESA Sine Wave 
The MESA Sinewave indicator was developed by recognized cycle 
specialist John Ehlers.  The MESA Sinewave indicator looks like a 
sinewave when the market is in a cycle mode and tends to wander when 
the market is in a trend mode.  The MESA Sinewave indicator anticipates 
cycle mode turning points rather than waiting for confirmation as is done 
with most oscillators.  The MESA Sinewave indicator has the additional 
advantage that trend mode whipsaw signals are minimized. 
The Sine Wave indicator was introduced in the November 1996 issue of 
Technical Analysis of Stocks & Commodities magazine. 
See page 163 for more information on plotting indicators.  See page 186 
for more information on the MESA Sine Wave indicator parameters. 

Interpretation 
The MESA Sinewave indicator consists of two plots - one displaying the 
Sine of the measured phase angle over the time period parameter and the 
other the Sine of the phase angle advanced by 45 degrees (called the Lead 
Sine).  Together, the crossings of the Sine and Lead Sine plots give clear 
advanced indication of cycle mode turning points. 
When the MESA Sinewave indicator resembles an actual sine wave, this 
suggests the market is in a cycle mode.  The indicator lines are not well 
structured when the market is in a trend mode.  A buy signal is given 
when the Sine plot crosses above the Lead Sine plot.  A sell signal is 
given when the Sine plot crosses below the Lead Sine plot.  An obvious 
advantage that the MESA Sinewave indicator has over its 
“overbought/oversold” counterparts is that it enters and exits much more 
precisely without giving up a piece of the market’s movement by waiting 
for confirmation. 
When the market is in a trend mode the MESA Sinewave indicator does 
not resemble a sine wave.  In fact, the Sine and Lead Sine plots typically 
languish in a sideways pattern around zero, running somewhat parallel 
and distant from each other.  The correct trading strategy in the trend 
mode is to trade the trend.  Basic moving average crossovers are helpful 
for entering and exiting positions in this type of market. 
The MESA Sinewave indicator is sensitive to using the correct time 
period parameter.   You can use the Cycle Lines line study (see page 215) 
to estimate the best time period to use. 
 

Momentum 
The momentum of a security is the ratio of today's price compared to the 
price x-time periods ago.  The formula equivalent of the calculation is 
shown below: 
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Momentum =  
Close

ref(Close,-10)
 x 100 

  
Where: 
ref(Close,-10) = The closing price 10 periods ago 
See page 163 for more information on plotting indicators.  See page 186 
for more information on the Momentum parameters. 

Interpretation 
The interpretation of the Momentum indicator is identical to the 
interpretation of the Price R.O.C (see page 501).  Both indicators display 
the rate-of-change of a security's price.  The Price R.O.C. indicator 
displays the rate-of-change as a percentage.  The Momentum indicator 
displays the rate-of-change as a ratio. 

Money Flow Index 
The Money Flow Index (MFI) attempts to measure the strength of money 
flowing in and out of a security.  It is closely related to the Relative 
Strength Index (RSI); however, the Money Flow Index accounts for 
volume action.  The RSI incorporates price action only. 
Money flow (not the Money Flow Index) is calculated by determining the 
average price for the day and then comparing this figure to the previous 
day's average price.  If today's average price is greater, it is considered 
positive money flow.  If today's average price is less, it is considered 
negative money flow.  Money flow for a specific day is calculated by 
multiplying the average price by the volume.   
Money Flow =  Volume  Average Price×  
Positive Money Flow is the sum of the positive money flow over the 
specified number of periods.  Negative Money Flow is the sum of the 
negative money flow over the specified number of periods. 

Money Ratio =  
Positive Money Flow
Negative Money Flow  

Finally, the Money Flow Index is calculated using the following formula: 

Money Flow Index (MFI) =  100 -  
100  

1 +  Money Ratio  
See page 163 for more information on plotting indicators.  See page 187 
for more information on the Money Flow Index parameters. 

Interpretation 
The interpretation of the Money Flow Index is as follows: 
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• Look for divergence/failure swings between the indicator and the 
price action.  If the price trends higher (lower) and the MFI trends 
lower (higher), then a reversal may be imminent. 

• Look for market tops to occur when the MFI is above a specific level 
(e.g., 80).  Look for market bottoms to occur when the MFI is below 
a specific level (e.g., 20). 

Moving Averages 
A moving average is a method of calculating the average value of a 
security's price, or indicator, over a period of time.  The term "moving" 
implies, and rightly so, that the average changes or moves.  When 
calculating a moving average, a mathematical analysis of the security's 
average value over a predetermined time period is made.  As the security's 
price changes over time, its average price moves up or down. 
MetaStock Pro calculates and displays six different types of moving 
averages:  simple (also referred to as arithmetic), exponential, time series, 
triangular, variable, and weighted.  In addition, MetaStock Pro will 
calculate moving averages of the security's open, high, low, close, 
median price, typical price, volume, open interest, or indicator.   
The only significant difference between the various types of moving 
averages is the weight assigned to the most recent data.  Once this 
"weighting" scheme has been determined, it is held static over the range  
of calculations.  The exceptions are the variable moving average and 
volume adjusted moving average.  The variable moving average 
automatically adjusts its weighting based on market conditions.  A 
variable moving average becomes more sensitive to recent data as 
volatility increases and less sensitive to recent data as volatility decreases.  
Similarly, the volume adjusted moving average automatically adjusts as 
the security's volume increases and decreases. 
See page 163 for more information on plotting indicators.  See page 187 
for more information on moving average parameters. 

Moving Average Calculation Methods 
Exponential 
An exponential (or exponentially weighted) moving average is calculated 
by applying a percentage of today's closing price to yesterday's moving 
average value. 
For example, to calculate a 9% exponential moving average of IBM:  
First, we would take today's closing price and multiply it by 9%.  We 
would then add this product to the value of yesterday's moving average 
multiplied by 91% (100% - 9% = 91%). 
m.a. =  [(today' s close)  0.09] +  [(yesterday' s m.a.)  0.91]× ×  
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Because most investors feel more comfortable working with time periods 
rather than with percentages, MetaStock Pro converts days into an 
exponential percentage.  For example, if a 21-day exponential moving 
average is requested, a 9% moving average is calculated. 
The formula for converting days to exponential percentages is as follows: 

exponential percentage =  
2

 time periods +  1
 
 

For example, to calculate a 10-day exponential moving average, you 
would use 0.18: 

0.18 =  
2

10 + 1
 
 

To convert an exponential percentage into time periods, you would use 
the following formula: 

time periods =  
2

percentage
−1

 
Using our previous example, we can check to see that a 0.18 exponential 
moving average is actually a 10-day average. 

10 =  
2

0.18 
  -1

 
The method used to calculate an exponential moving average puts more 
weight toward recent data and less weight toward past data than does the 
simple moving average method.  This method is often called 
exponentially weighted. 

Simple 
A simple, or arithmetic, moving average is calculated by adding the 
closing price of the security for a number of time periods (e.g., 12 days) 
and then dividing this total by the number of time periods.  The result is 
the average price of the security over the time period. 
 
For example, to calculate a 21-day moving average of IBM: First, we 
would add up IBM's closing prices for the preceding 21 days.  Next, we 
would divide that sum by 21; this would give us the average price of IBM 
over the preceding 21 days.  We would plot this average price on the 
chart.  The following day (tomorrow) we would do the same calculations:  
add up the previous 21 days' closing prices, divide by 21, and plot the 
resulting figure on the chart. 

Time Series 
The time series moving average is calculated using linear regression 
techniques.  Rather than plotting a straight linear regression line, a time 
series moving average plots the last point of the line.  It does this using 



 

 
 

486 • Interpretation of Indicators and Line Studies MetaStock Professional 

 

 

 

the specified number of periods for each day.  The individual points are 
then connected together with a line to form a time series moving average. 
This moving average is sometimes referred  to as a "moving linear 
regression" study or a "regression oscillator." 
For information on calculating linear regression using the least squares 
method (the basis behind time series moving averages), refer to any basic 
statistics book. 

Triangular 
A triangular moving average is similar to exponential and weighted 
moving averages except a different weighting scheme is used.  
Exponential and weighted moving averages assign the majority of the 
weight to the most recent data.  Simple moving averages assign the weight 
equally across all the data.  With a triangular moving average, the  
majority of the weight is assigned to the middle portion of the data. 
A triangular moving average is simply a double-smoothed simple moving 
average.  To calculate a 9-period (similar for all odd periods) triangular 
moving average: 
1)  Divide 9 by 2 to get 4.5 
2)  Round 4.5 up to 5 
3)  Triangular moving average (odd periods) = (mov(mov(c,5,s)5,s) 
A 12-period (similar for all even periods) is calculated as follows: 
1)  Divide 12 by 2 to get 6. 
2)  Add 1 to 6 to get 7*. 
3)  Triangular moving average (even periods) = (mov(mov(c,6,s),7,s) 
*  The rule is to take the length divided by 2 as one average, and that 
number plus 1 as the second. 

Variable 
A variable moving average is an exponential moving average that 
automatically adjusts the smoothing constant based on the volatility of the 
data series.  The more volatile the data, the larger the smoothing constant  
used in the moving average calculation.  The larger the smoothing 
constant, the more weight given to the current data.  The opposite is true 
for less volatile data. 
Trader’s often associate high volatility with strongly trending markets.  
However, this is a mistake.  Strong trending markets are often less volatile 
because of the consistency of day-to-day price changes.  Its when prices 
are erratic in their day-to-day movements (i.e., down a lot, up a little, up a 
little, up a lot, up a little, down a little, etc.), that volatility increases.  This 
can occur in uptrending, downtrending, or sideways markets.  
Typical moving averages suffer from the inability to compensate for 
changes in volatility.  During volatile markets, you want a moving 



 

 
 

MetaStock Professional Interpretation of Indicators and Line Studies • 487 

 

 

 

average to increase its sensitivity, so that you will quickly be on the 
correct side of any wild gyrations.  By automatically adjusting the 
smoothing constant, a variable moving average is able to adjust its 
sensitivity, allowing it to perform better in both high and low volatility 
markets. 
VMA = (0.78*(volatility index) * close) + (1-0.078 * volatility 
index)*yesterday’s VMA 
The absolute value of a 9-period Chande Momentum Oscillator is used 
for the volatility index.  The higher this index the more volatile the 
market, thereby increasing the sensitivity of the moving average. 
This method of calculating a variable moving average was presented by 
Tushar Chande in the March 1992 issue of Technical Analysis of Stocks 
& Commodities magazine. 

Volume Adjusted 
Dick Arms, well-known as the developer of the Arms Index and the 
equivolume charting method (see page 464), has developed a unique 
method for calculating moving averages.  In keeping with his prior work, 
the calculation method incorporates volume and is appropriately called a 
volume adjusted moving average . 
The calculation for a volume adjusted moving average is somewhat 
complex; however, it is conceptually easy to understand.  All moving 
averages (even volume adjusted) use some type of weighting scheme to 
"average" the data.  Exponential and weighted moving averages assign the 
majority of weight to the most recent data.  Simple moving averages 
assign the weight equally across all data.  Variable moving averages 
assign the majority of the weight to the most volatile data.  And as its 
name implies, volume adjusted moving averages assign the majority of 
weight to the day's with the most volume. 
A volume adjusted moving average is calculated as follows: 
1. Calculate the average volume using every time period in the chart. 
2. Calculate the volume increment by multiplying the average volume 

by 0.67. 
3. Calculate each period's volume ratio by dividing each period's actual 

volume by the volume increment. 
4. Starting at the most recent time period and working backwards, 

multiply each period's price by the period's volume ratio and 
cumulatively sum these values until the user-specified number of 
volume increments is reached.  Note that only a fraction of the last 
period's volume will likely be used. 

Weighted 
A weighted moving average is also designed to put more weight on recent 
data and less weight on past data.  A weighted moving average is 
calculated by multiplying each of the previous day's data by a weight.   
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The following table shows how a 5-day weighted moving average is 
calculated. 
 

Day No. Weight * Price = Weighted Price 
1 1 25 25 

2 2 26 52 

3 3 28 84 

4 4 25 100 

5 5 29 145 

Totals 15 133 = 27.067 

Note how the 5-day weighted moving average gives five times more 
weight to today's price (i.e., 5 * 29) than to the price five days ago (i.e., 
1* 25). 

Interpretation 
The most popular method of interpreting a moving average is to compare 
the relationship between a moving average of the security's closing price 
and the security's closing price itself.  A sell signal is generated when the 
security's price falls below its moving average and a buy signal is 
generated when the security's price rises above its moving average. 
This type of moving average trading system is not intended to get you in 
at the exact bottom and out at the exact top.  Rather, it is designed to keep 
you in line with the security's price trend by buying shortly after the 
security's price bottoms and selling shortly after it tops. 
The critical element in a moving average is the number of time periods 
used in calculating the average.  When using hindsight, you can always 
find a moving average that would have been profitable.  The key is to find 
a moving average that will be consistently profitable.  The most popular 
moving average is the 39-week (or 200-day) moving average.  This 
moving average has a good track record in timing the major (long- term)  
market cycles.  The length of a moving average should fit the market  
cycle you wish to follow: 
 

Trend Moving Average Length 
Very Short Term 5-13 days 

Short Term 14-25 days 

Minor Intermediate 26-49 days 

Intermediate 50-100 days 

Long Term 100-200 days 
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When you display moving averages, the number of time periods you enter 
is based on the periodicity of the security that is loaded.  For example, if 
you load daily data, then entering 12 for the number of time periods in the 
moving average will cause MetaStock Pro to calculate a 12-day moving 
average.  If you had loaded weekly data, MetaStock Pro would calculate a 
12-week moving average. 
You can convert a daily moving average quantity into a weekly moving 
average quantity by dividing the number of days by 5 (e.g., a 200-day 
moving average is almost identical to a 40-week moving average).  To 
convert a daily moving average quantity into a monthly quantity, divide 
the number of days by 21 (e.g., a 200-day moving average is very similar 
to a 9-month moving average). 
MetaStock Pro enables you to plot moving averages of securities and any 
of the indicators tracked by the program.  The interpretation of an 
indicator's moving average is similar to the interpretation of a security's 
moving average:  when the indicator rises above its moving average, it 
signifies a continued upward movement by the indicator; when the 
indicator falls below its moving average, it signifies a continued 
downward movement by the indicator. 
Indicators which are especially well-suited for use with moving average 
penetration systems include the MACD, Price R.O.C., Momentum, and 
Stochastics. 
Some indicators, such as short-term Stochastics, fluctuate so erratically 
that it is difficult to tell what their trend really is.  By removing the 
indicator (i.e., setting the Indicator Style to Invisible in the Indicator's 
Properties dialog) and then plotting a moving average of the indicator, we 
can see the general trend of the indicator rather than its day-to-day 
fluctuations. 
Whipsaws can be reduced, at the expense of a slightly later signal, by 
plotting a short-term moving average (e.g., 2-10 day) of oscillating 
indicators such as the 12-day R.O.C., Stochastics, or the RSI.  For 
example, rather than selling when the Stochastic Oscillator falls below 80, 
you might sell only when a 5-period moving average of the Stochastic 
Oscillator falls below 80. 

Negative Volume Index 
The Negative Volume Index (NVI) relates a decrease in volume to the 
change in the security's price.  When volume decreases from the previous 
day, the NVI is adjusted by the percentage change in the security's price.  
If (V < (ref(V,-1)) then 
NVI = I + (((C - ref(C,-1) / ref(C,-1))) 
If (V >= ref(V,-1)) then 
NVI = I 
Where: 
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C  = Today's closing price 
ref(C,-1) = Yesterday's closing price 
I  = Yesterday's Negative Volume Index 
NVI  = Today's Negative Volume Index 
V  = Today's volume 
ref(V,-1) = Yesterday's volume 
The NVI is constructed so it only displays changes on days when volume 
decreases from the previous day.  Because falling prices are usually 
associated with falling volume, the NVI will usually trend downward. 
See page 163 for more information on plotting indicators.  See page 188 
for more information on the NVI parameters. 

Interpretation 
Interpretation of the NVI assumes that on days when volume increases,  
the crowd-following "uninformed" investors are in the market.  
Conversely, on days with decreased volume, the "smart money" is quietly 
taking positions.  Thus, changes shown in the NVI (remember that the 
NVI changes only on lower volume days) display what the smart money is 
doing. 
Stock Market Logic, by Norman Fosback, points out that the odds of a 
bull market are 95 out of 100 when the NVI of the Dow Industrials is 
above its one-year moving average. 

Tip 
An example custom indicator (see page 309) shows how to calculate the 
Negative Volume Index. 

ODDS Probability Cones  
ODDS™ Probability Cones were developed by Don Fishback, renowned 
option expert and originator of the ODDS option trading methodology.   
Perhaps Mr. Fishback's most significant contribution to option analysis 
includes the application of price volatility and its affect on the laws of 
probability.  ODDS Probability Cones are a result of this work. 
Fishback's ODDS methodology is based on the assumptions made in 
every commonly used option pricing model.  If you use an option pricing 
model to value options, you are making the probability assumptions used 
by ODDS, whether you realize it or not. 
The assumption is that the financial markets are random and that prices 
exhibit a normal distribution.  That means that if you looked at the 
market’s price changes over an extended period of time, the shape of the 
price distribution would look like a bell curve.  The x-axis of a bell curve 
is in terms of standard deviations--the y-axis in terms of price.  A normal 
distribution assumption has some very useful properties, including the one 
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that is the most important to us--probability is equal to the area under the 
curve. 

 

The official definition of volatility is equal to one standard deviation of 
the price change (expressed in logarithmic terms) annualized.  In simpler 
language, volatility provides us with a value that can be used to measure 
the "likelihood" of a significant price change.  The higher the volatility, 
the greater the likelihood of a significant price move. 
Notice that volatility is equal to one standard deviation, which happens to 
be the same unit as our bell curve’s x-axis.  It is this property that allows 
us to create the ODDS Probability Cones found in MetaStock Pro. 
Option traders may find the expert named "Don Fishback – ODDS™ 
Option Analyst" helpful.  See page 435 for more information on experts. 
See page 205 for more information on plotting line studies.  See page 219 
for more information on the ODDS Probability Cones parameters. 
For more information, contact Don Fishback at 1-800-637-8970. 

Interpretation 
ODDS Probability Cones (which are greatly influenced by recent price 
volatility) provide you with a visual  guide to the most probable range of 
future prices.  This range (i.e. the cone's width) is determined by recent 
volatility in prices, the number of time periods projected, and the 
probability percentage (e.g., 68% confidence, 90% confidence, etc.).  The 
more volatile the security prices, the wider the expected range of future 
prices and hence the wider the cones.  The cones always widen from the 
apex even if recent volatility is very low, because as time increases, the 
better the odds of a significant price move.  
By default, the cones show the expected range of prices given a 68.26% 
probability (this is equivalent to one standard deviation).   This means that 
there is a 68.26% probability that prices will remain within the cones over 
the specified time frame.  By increasing this percentage, you can control 
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the width of the cones.  As you might expect, higher percentages result in 
wider cones. 
The following illustration shows a chart and a standard bell curve (with 
one standard deviation shaded) flipped on its side.  Note that this 
corresponds to the width of the Probability Cones on the chart (which are 
plotted using 68.26%, or one standard deviation). 

 
The original use of this type of analysis was intended to help option 
traders determine the best strategy to implement.  From a probability 
standpoint, an option trader would prefer to sell options with strikes that 
lie outside the cones and buy options with strikes that lie within the cones.   
The cones also have equal value for the analysis of regular long and short 
positions.  All else being equal and assuming you are confident in your 
price directional forecast, you would prefer to establish a long or short 
position in a security with wide cones rather than one with narrow cones. 
Of course, this assumes that the recent calculated volatility will continue 
or rise.  If you expect volatility to drop, then you should reconsider. 

On Balance Volume 
On Balance Volume relates volume to price change.  It is calculated by 
adding the day's volume to a cumulative total when the security's price 
closes up, and subtracting the day's volume when the security's price 
closes down. 
If today's close > yesterday's close then 
  OBV = yesterday's OBV + today's volume 
If today's close < yesterday's close then 
  OBV = yesterday's OBV - today's volume 
If today's close = yesterday's close then 
  OBV = yesterday's OBV 
See page 163 for more information on plotting indicators.  See page 188 
for more information on the OBV parameters. 
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Interpretation 
On Balance Volume is a running total of volume.  It seeks to show if 
volume is flowing into or out of a security.  When the security closes 
higher than the previous close, all of the day's volume is considered up-
volume.  When the security closes lower than the previous close, all of 
the day's volume is considered down-volume.  
Joe Granville is the father of OBV and its analysis.  We can barely begin 
to explain a simplified version of OBV interpretation here.  If you want 
further information on OBV analysis, we recommend that you read his 
book, New Strategy of Daily Stock Market Timing for Maximum Profits 
(see page 544). 
The basic assumption, regarding OBV analysis, is that OBV changes 
precede price changes.  The theory is that smart money can be seen 
flowing into the security by a rising OBV.  When the public then moves 
into the security, both the security and the OBV will surge ahead. 
If the security's price movement precedes OBV movement, a "non-
confirmation" is said to have occurred.  Non-confirmations can occur at 
bull market tops (when the security rises without, or before, the OBV) or 
at bear market bottoms (when the security falls without, or before, the 
OBV).  
The OBV is said to be in a rising trend when each new peak is higher than 
the previous peak and each new trough is higher than the previous trough.  
Likewise, the OBV is in a falling trend when each successive peak is 
lower than the previous peak and each successive trough is lower than the 
previous trough.  When the OBV is moving sideways and is not making 
successive highs and lows, it is in a doubtful trend. 
Once a trend is established, it remains in force until it is broken.  There 
are two ways in which the OBV trend can be broken.  The first occurs 
when the trend changes from a rising trend to a falling trend, or from a 
falling trend to a rising trend. 
The second way the OBV trend can be broken is if the trend changes to a 
doubtful trend and remains doubtful for more than three days.  Thus, if the 
security changes from a rising trend to a doubtful trend and remains 
doubtful for only two days before changing back to a rising trend, the 
OBV is considered to have always been in a rising trend. 
When the OBV changes to a rising or falling trend, a breakout is said to 
have occurred.  Since OBV breakouts normally precede security 
breakouts, investors should buy long on OBV upside breakouts.  
Likewise, investors should sell short when the OBV makes a downside 
breakout.  Positions should be held until the trend changes (as explained 
in the preceding paragraph). 
This method of analyzing On Balance Volume is designed for trading 
short-term cycles.  According to Granville, investors must act quickly and 
decisively if they wish to profit from short-term OBV analysis. 
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Tip 
An example custom indicator (see page 310) shows how to calculate On 
Balance Volume. 

Open Interest 
 

The Open Interest indicator plots the number of open contracts of a given 
commodity. 
Open interest is only available for futures and can only be plotted if the 
data file contains open interest data.  A simple way to tell if the file 
contains open interest data is to select the Open Interest indicator.  If 
nothing is plotted, there is no open interest data. 
See page 163 for more information on plotting indicators.  See page 188 
for more information on the Open Interest indicator's parameters. 

Interpretation 
Open interest is used to measure the activity and strength of a commodity.  
An increase in open interest accompanied with higher prices shows that 
new buyers are continuing to enter the market and thus can be viewed as a 
confirmation of the upward price move.  Likewise, a decrease in open 
interest while prices are making new highs (a divergence) is often viewed 
as a warning sign suggesting an impending decline in prices. 
 
 

Option Indicators 
A brief interpretation of the option indicators in MetaStock Pro is 
provided below.  For more information on these indicators and option 
analysis see page 543. 
See page 163 for more information on plotting indicators.  See page 189 
for more information on the Option indicator parameters. 

Option Delta 
Delta shows the amount that the option's price will change if the 
underlying security's price changes by $1.00.   
For example, if XYZ is selling for $105.00/share, a call option on XYZ is 
selling for $2.00 and the Delta is 75%, then the option's price should 
increase $0.75 (to $2.75) if the price of XYZ increases to $106.00/share.  
In other words, the option should go up $0.75 for each $1.00 that XYZ 
goes up. 
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Option Expiration 
The Option Expiration indicator shows the month to month expiration 
cycle of stock and index options.  It is designed primarily to help in the 
development of more robust trading systems using the indicator's function 
(see page 2720 for more information on the Option Expiration function).  
The visual interpretation of the plot itself is of little value as it simply 
shows the number of days until the next monthly option expiration date. 
Stock and Index options expire on the Saturday following the third Friday 
of each month.  Options may be written for one of three cycles.  New 
options can be written every three months, with cycles beginning in 
January, February, and March.   
The option expiration day in the months of March, June, September, and 
December are referred to as "triple witching."  On these days, stock 
options, index options, and index futures all expire simultaneously.  For 
this reason, triple witching days are often very volatile. 
Since options officially expire on Saturdays (a non-trading day), the Next 
Option Expiration indicator's value on the Friday before expiration will be 
1.00—meaning one day until expiration.  This is also consistent with the 
way the Option Life function calculates (see page 272). 
Some of the most active days in the history of the markets have occurred 
at option expiration.  Because of the increasing use of options by both 
small and large investors as a means of hedging and speculating, it may be 
wise to consider the potential increase in volatility that can occur in the 
underlying security on option expiration days. 
See page 163 for more information on plotting indicators.  See page 188 
for more information on the Option Expiration parameters. 

Option Gamma 
Gamma shows the anticipated change in Delta, given a one point increase 
in the underlying security.  Thus, it shows how responsive Delta is to a 
change in the underlying security's price.  For example, a Gamma of four 
indicates that the Delta will increase four points (e.g., from 50% to 54%) 
for each one point increase in the underlying security's price. 

Option Life 
Option Life shows the number of days until expiration.  Generally 
speaking, the longer the time until expiration, the more valuable the 
option. 

Option Price 
The Option Price is the main output of the Black-Scholes model.  It shows 
how much the option should sell for based on the various components that 
make up the model (e.g., volatility, option life, security price, etc.).  It 
helps answer the question, "Is the option overpriced or underpriced?" 
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Option Theta 
Theta shows the change in the option's price (in points) due to the effect 
of time alone.  The longer the time until expiration, the less effect that 
time has on the price of the option.  However, as the option nears 
expiration, the effect can be great, particularly on out-of-the-money 
options.  Theta is also referred to as "time decay." 

Option Vega 
Vega shows the change in the option price due to an assumed 1% increase 
in the underlying security's volatility.  Vega shows the dollar amount of 
gain that should be expected if the volatility goes up one point (all else 
being equal). 

Option Volatility 
Options of high volatility stocks are worth more than those with low 
volatility, because of the greater chance the option has of moving in-the-
money by expiration.  Option purchasers should prefer options with high 
volatilities and option writers should prefer options with low volatilities 
(all else being equal).   
This measure of option volatility is a historical volatility measurement 
requiring 21 days of data.  It is based on the "High-Low-Close Estimator" 
method presented in the book, The Complete Investment Book (see page 
544). 

Parabolic SAR 
The Parabolic Time/Price System, developed by J. Welles Wilder, is 
explained thoroughly in his book, New Concepts in Technical Trading 
Systems (see page 544).  This indicator is used to set price stops and is 
often called the stop-and-reversal (SAR) indicator. 
See page 163 for more information on plotting indicators.  See page 190 
for more information on the Parabolic SAR parameters. 

Interpretation 
If you are long (i.e., the price is above the SAR), the SAR will move up 
every day, regardless of the direction the price is moving.  The amount the 
SAR moves up depends on the amount that prices move. 
The Parabolic SAR provides excellent stops.  You should close long 
positions when the price falls below the SAR and close short positions 
when the price rises above the SAR. 
The Parabolic SAR is plotted as shown in Wilder's book (above).  Each 
SAR stop level point is displayed on the day in which it is in effect.  Note 
that the SAR value is today's, not tomorrow's stop level. 
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Performance 
The Performance indicator displays a security's price performance as a 
percentage.  This is sometimes called a "normalized" chart. 
See page 163 for more information on plotting indicators.  See page 190 
for more information on the Performance parameters. 

Interpretation 
The numeric value of the Performance indicator is the percentage that the 
security has changed since the first period loaded.  For example, a value  
of 10 would mean that the security's price has increased 10% since the 
first period loaded on the left side of the chart.  Similarly, a value of -10% 
would mean that the security's price has fallen by 10% since the first 
period. 

Tip 
The Performance indicator calculates the percent that prices have changed 
since the first day loaded in the chart.  Therefore, if you want to calculate  
a security's performance from a specific date (e.g., the day you bought it), 
you should first use the X-Axis Properties dialog (see page 118) to change 
the first date loaded. 

Point & Figure 
Point & figure (P&F) charts differ from "normal" price charts in that they 
completely disregard the passage of time and only chart changes in prices.  
Rather than having price on the y-axis and time on the x-axis, P&F charts 
display price changes on both axes. 
P&F charts display an "X" when prices rise by the "box size" and display 
an "O" when prices fall by the box size.  Note that no Xs or Os are drawn 
if prices rise or fall by an amount that is less than the box size. 
Each column can contain either Xs or Os, but never both.  In order to 
change columns (e.g., from an X column to an O column), prices must 
reverse by the "reversal amount" multiplied by the box size.  For example, 
if the box size is 3 points and the reversal amount is 2 boxes, then prices 
must reverse direction 6 points (3 times 2) in order to change columns.  If 
you are in a column of Xs, the price must fall 6 points in order to change 
to a column of Os.  If you are in a column of Os, the price must rise 6 
points in order to change to a column of Xs.  The changing of columns 
signifies a change in the trend of prices. 
Because prices must reverse direction by the reversal amount, each 
column in a P&F chart will have at least "reversal amount" boxes. 
When in a column of Xs or Os, MetaStock Pro will first check to see if 
prices have moved in the current direction (e.g., rose if in a column of Xs 
or fell if in a column of Os) before checking for a reversal.  MetaStock 
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Pro uses the high and low prices to decide if prices have changed enough 
to display a new box. 
Indicators calculated on P&F charts use all the data in each column and 
then display the average value of the indicator for that column. 

Interpretation 
P&F charts are designed to display the underlying supply and demand of a 
security.  A column of Xs shows that demand is exceeding supply (a 
rally); a column of Os shows that supply is exceeding demand (a decline); 
and a series of short columns shows that supply and demand are relatively 
equal. 
There are several chart patterns that appear repeatedly in P&F charts.  
These include Double Tops and Bottoms, Bullish and Bearish Signal 
formations, Bullish and Bearish Symmetrical Triangles, Triple Tops and 
Bottoms, etc.  It is beyond the scope of the manual to fully explain all of 
the possibilities.  See page 544 for a list of recommended books. 

Polarized Fractal Efficiency 
The Polarized Fractal Efficiency indicator (PFE) was developed by Hans 
Hannula.  It was introduced in the January 1994 issue of Technical 
Analysis of Stocks & Commodities magazine.  As an engineer, 
programmer, and trader with over 30 years market experience, Mr. 
Hannula developed a unique approach to applying the laws of fractal 
geometry and chaos to the markets.  
See page 163 for more information on plotting indicators.  See page 190 
for more information on the Polarized Fractal Efficiency parameters. 

Interpretation 
Drawing upon the pioneering works of mathematician Benoit Mendelbrot, 
Mr. Hannula developed an indicator to gauge the efficiency that prices 
travel between two points in time. 
The more linear and efficient price movement, the shorter the distance the 
prices must travel between two points.   The more "squiggly" the price 
movement, the less efficient it's travel.   
The primary use of the PFE indicator is as a measure of how trendy or 
congested price action is.  PFE readings above zero mean that the trend is 
up.  The higher the reading the "trendier" and more efficient the upward 
movement.  PFE readings below zero mean that the trend is down.  The 
lower the reading the "trendier" and more efficient the downward 
movement.  Readings around zero indicate choppy, less efficient 
movement, with a balance between the forces of supply and demand. 
Several interesting phenomenon have been observed by Mr. Hannula: 
• Indexes (particularly the OEX) tend to have a maximum PFE (both 

plus and minus) of about 43%.  
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• The middle region (around zero) is a balance between supply and 
demand and therefore a congestion point. 

• A hooking pattern often occurs right before the end of an efficient 
period.  This pattern occurs when the PFE appears to have maxed 
out, turns in the opposite direction towards zero, and then makes one 
last attempt at maximum efficiency.  Trades can be entered  in the 
opposite direction, with a stop just beyond the extreme of the hook.  
Stay with the trade all the way to the other extreme, unless it slows 
around the zero line.  If it slows around zero, exit the trade and wait 
for a new maximum efficiency entry. 

Positive Volume Index 
The Positive Volume Index (PVI) relates an increase in volume to the 
change in the security's price.  When volume increases from the previous 
day, the PVI is adjusted by the percentage change in the security's price.  
If (V > ref(V,-1)) then 
PVI = I + (((C - ref(C,-1)) / ref(C,-1))) 
If (V <= ref(V,-1)) then 
PVI = I 
Where: 
C  = Today's closing price 
ref(C,-1) = Yesterday's closing price 
I  = Yesterday's Positive Volume Index 
PVI  = Today's Positive Volume Index 
V  = Today's volume 
ref(V,-1) = Yesterday's volume 
The PVI is constructed so it only displays changes on days when volume 
increases from the previous day.  Because rising prices are usually 
associated with rising volume, the PVI will generally trend upward. 
See page 163 for more information on plotting indicators.  See page 191 
for more information on the PVI parameters. 

Interpretation 
The interpretation of the PVI is the opposite of the NVI (see page 489).  
The PVI seeks to show what "uninformed" investors are doing. 

Tip 
An example custom indicator (see page 310) shows how to calculate the 
Positive Volume Index. 
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Price Channel 
Price Channels are similar in concept to other types of bands and channels 
including moving average bands, Projection Bands (see page 503), 
Envelopes (see page 464), and Bollinger Bands (see page 449).  They also 
have some of the characteristics of channel lines such as Raff Regression 
Channels (see page 508).   
Price Channels are plotted by finding the highest high over the specified 
number of periods and plotting the result above the current price to form 
the top channel.  The bottom channel is formed by plotting the lowest low 
over the specified number of periods.  The resulting plot consists of two 
lines representing the recent highest and lowest prices.    
Price Channels, in essence, are dynamic (or moving) support and 
resistance levels based.  They are constantly adjusted to reflect recent 
new highs and new lows. 
See page 205 for more information on plotting line studies.  See page 191 
for more information on Price Channel parameters. 

Interpretation 
Price Channels are used much like other types of channels and bands--
they help gauge the ebb and flow of optimism and pessimism.  When 
prices are at or near the upper channel, extreme optimism is indicated--
look for prices to meet resistance and to move down to more rational 
levels.  Likewise, when prices are at or near the lower channel, extreme 
pessimism is indicated--look for prices to find support and move up to 
more rational levels. 
Since Price Channels are calculated from absolute high and low price 
levels, they tend to provide traditional support and resistance.  For 
example, if prices bounce two or more times off of the bottom channel 
near the same price level, strong support is indicated.  Likewise, if prices 
rebound two or more times off the top channel near the same price level, 
strong resistance is indicated. 
Interestingly, much like Bollinger Bands, narrow Price Channels often 
precede significant price moves.   Several interesting observations 
involving the combination of a 20-period Bollinger Band and 20-period 
Price Channel are noted below: 
• Expect a significant upward price move when the Price Channel and 

Bollinger Bands are very narrow and the closing price exceeds the 
upper Price Channel.  Place a protective stop just below the middle 
Bollinger Band. 

• Expect a significant downward price move when the Price Channel 
and Bollinger Bands are very narrow and the closing price drops 
below the lower Price Channel.  Place a protective stop just above the 
middle Bollinger Band. 
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• Expect a short-term pullback against the prevailing uptrend when the 
Price Channel and Bollinger Bands are wide and the closing price 
exceeds the upper Price Channel.   

• Expect a short-term pullback against the prevailing downtrend when 
the Price Channel and Bollinger Bands are wide and the closing price 
exceeds the lower Price Channel. 

Price Oscillator 
The Price Oscillator displays the difference between two moving averages 
of the security's price.  The difference between the averages can be 
expressed in either points or percentages. 
See page 163 for more information on plotting indicators.  See page 191 
for more information on the Price Oscillator parameters. 

Interpretation 
Moving average analysis often generates buy signals when a short-term 
moving average (or the security's price) rises above a longer-term moving 
average.  Conversely, sell signals are generated when a shorter-term 
moving average falls below a longer-term moving average.  The Price 
Oscillator illustrates the cyclical (and often profitable) signals generated 
by one or two moving average systems.  

Tips 
For more information on moving average systems and oscillators, refer to 
Moving Averages (see page 484) and the MACD (see page 478). 
An example custom indicator (see page 310) shows how to calculate the 
Price Oscillator. 

Price Rate-Of-Change 
The Price Rate-Of-Change (R.O.C.) indicator (percent method) is 
calculated by dividing the price change over the last x-periods by the 
closing price of the security x-periods ago.  The result is the percentage 
that the security's price has changed in the last x-periods. 
If the security's price is higher today than x-periods ago, the R.O.C. will 
be a positive number.  If the security's price is lower today than x-periods 
ago, the R.O.C. will be a negative number. 
See page 163 for more information on plotting indicators.  See page 192 
for more information on the R.O.C. parameters. 

Interpretation 
A long recognized phenomenon of security prices is the fact that prices 
tend to surge ahead and retract in a cyclical wave-like motion.  The Price 
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Rate-Of-Change indicator illustrates this wave-like motion of a security's 
price in an oscillator format.  As the security's price increases, its R.O.C. 
will rise; conversely, as its price falls, its R.O.C. will fall.  The faster 
prices rise or fall, the faster the R.O.C. will rise or fall. 
MetaStock Pro allows you to select the time period used in the R.O.C. 
calculation.  The time period may range from a very short 1-day R.O.C. 
(which causes an erratic chart) to a long-term 200-day (or longer) R.O.C.  
The most popular time periods are the 12-day and 25-day R.O.C. for short 
to intermediate-term trading and a 1-year (255-day) R.O.C. for long-term 
analysis. 
The 12-day R.O.C. is best used as a short to intermediate-term 
overbought/oversold indicator.  The higher the R.O.C., the more 
overbought the security; the lower the R.O.C., the more likely a rally.  
However, as with all overbought/oversold indicators, it is best to wait for 
the market to begin to correct (i.e., turn up or down) before placing your 
trade.  A market that appears overbought may remain overbought for  
some time.  In fact, extremely overbought/oversold readings usually imply 
a continuation of the current trend. 
The 12-day R.O.C. tends to be very cyclical, oscillating back and forth in 
a fairly regular pattern.  Often, price changes can be anticipated by 
studying the previous cycles of the R.O.C. and relating the previous 
cycles to the current market. 
The optimum overbought/oversold levels (e.g., +/-5) will vary depending 
on the security being analyzed and overall market conditions.  In strong 
bull markets, it is usually beneficial to use higher levels, perhaps +10 and 
-5. 

Tips 
The predefined Price R.O.C. discussed here displays the R.O.C. as a 
percentage.  The R.O.C. also can be displayed as a ratio using the 
Momentum indicator (see page 482), or expressed in points by choosing 
the "periods" button in the properties dialog (see page 192). 
An example custom indicator (see page 310) shows how to calculate the 
Price R.O.C. 

Price Volume Trend 
The Price Volume Trend (PVT) is similar in concept to On Balance 
Volume (see page 492) in that it is a cumulative total of volume that is 
adjusted depending on changes in closing prices.  But whereas OBV adds 
all volume on days when prices close higher and subtracts all volume on 
days when prices close lower, the PVT adds only a portion of the daily 
volume.  The amount of volume added to the PVT is a function of the 
amount by which prices rose or fell relative to the previous day's close. 
PVT = (((C-ref(C,-1)) / ref(C,-1)) * V) + I 



 

 
 

MetaStock Professional Interpretation of Indicators and Line Studies • 503 

 

 

 

Where:  
C  = Today's closing price 
ref(C,-1) = Yesterday's closing price 
V  = Today's volume 
I  = Yesterday's Price Volume Trend 
The PVT is calculated by multiplying the day's volume by the percentage 
change of the underlying security and adding this value to a cumulative 
total.  For example, if the security closed up 0.5% and volume was 
10,000 shares, we would add 50 (i.e., 0.005 * 10,000 = 50) to the PVT.  
If the security had closed down 0.5%, we would have subtracted 50 from 
the PVT. 
See page 163 for more information on plotting indicators.  See page 192 
for more information on the PVT parameters. 
 

Interpretation 
The interpretation of the Price Volume Trend is similar to the 
interpretation of On Balance Volume (see page 492) and the Volume 
Accumulation/Distribution Line (see page 446). 
Many investors feel that the PVT more accurately illustrates the flow of 
money into and out of a security than does OBV.  This is because OBV 
adds the same amount of volume to the indicator regardless of whether 
the security closes up a fraction of a point or doubles in price.  However, 
the PVT adds only a small portion of volume to the indicator when the 
price changes by a small percentage and adds a large portion of volume 
to the indicator when prices change by a large percentage. 

Tip 
An example custom indicator (see page 310) shows how to calculate the 
Price Volume Trend. 

Projection Bands 
Projection Bands were developed by Mel Widner, Ph.D.  They were 
originally introduced in the July 1995 issue of Technical Analysis of 
Stocks & Commodities magazine. 
Projection Bands are similar in concept to other types of bands including 
moving average bands, Price Channels (see page 500), Envelopes (see 
page 464), and Bollinger Bands (see page 449).  They also have some of 
the characteristics of channel lines such as Raff Regression Channels (see 
page 508).   
Projection Bands are plotted by finding the minimum and maximum 
prices over the specified number of days and projecting these forward 
(parallel to a linear regression line).  The resulting plot consists of two 
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bands representing the minimum and maximum price boundaries.  Prices 
will always be contained by the bands, unlike Bollinger Bands. 
See page 163 for more information on plotting indicators.  See page 192 
for more information on the Projection Bands parameters. 

Interpretation 
Projections Bands are used much like other types of bands--they help 
gauge the ebb and flow of optimism and pessimism.  When prices are at 
or near the upper band, extreme optimism is indicated--look for prices to 
move down to more rational levels.  Likewise, when prices are at or near 
the lower band, extreme pessimism is indicated--look for prices to move 
up to more rational levels. 
It is recommended that all band generated signals be confirmed by other 
indicators, because prices will often ride along a band for an extended 
amount of time during strong trending markets.  During trending markets,  
you can use bands to trade short-term reactions against the primary trend.  
In trading range markets, you can use the bands to trade 
overbought/oversold levels.  Indicators like the VHF (see page 533), 
CMO (see page 454), and r-squared (see page 506) can be used to gauge 
the trendiness of the market. 

Projection Oscillator 
Developed by Mel Widner, Ph.D., the Projection Oscillator is a by-
product of his Projection Bands (see page 503).  The Projection 
Oscillator is basically a slope-adjusted Stochastic.  Where the Stochastic 
Oscillator (see page 521) shows the relationship of the current price to its 
minimum and maximum prices over a recent time period, the Projection 
Oscillator shows the same thing, but the minimum and maximum prices 
are adjusted up/down by the slope of the price’s regression line.  This 
adjustment makes the Projection Oscillator more responsive to short-term 
price moves than an equi-period Stochastic. 
Put another way, the Projection Oscillator shows where the current price 
is relative to the Projection bands.  A value of 50 indicates that the 
current price is exactly in the middle of the bands.  A value of 100 
indicates that prices are touching the top band.  A value of 0 indicates 
that prices are touching the bottom band. 
See page 163 for more information on plotting indicators.  See page 192 
for more information on the Projection Oscillator parameters. 

Interpretation 
The Projection Oscillator can be used as both a short- and intermediate-
term trading oscillator depending on the number of time periods used 
when calculating the oscillator.  When displaying a short-term Projection 
Oscillator (e.g., 10-20 days), it is popular to use a 3-day trigger line. 
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There are several ways to interpret a Projection Oscillator. 
Overbought/oversold.  Buy when the oscillator falls below a specific 
level (e.g., 20) and then rises above that level, and sell when the 
Oscillator rises above a specific level (e.g., 80) and then falls below that 
level.  High values (i.e., above 80) indicate excessive optimism.  Low 
values (i.e., below 20) indicate excessive pessimism. 
However, before basing any trade off of strict overbought/oversold levels, 
you should first qualify the trendiness of the market using indicators such 
as r-squared (see page 506) or CMO (see page 454).  If these indicators 
suggest a non-trending market, then trades based on strict 
overbought/oversold levels should produce the best results.  If a trending 
market is suggested, then you can use the oscillator to enter trades in the 
direction of the trend. 
Crossovers.  Buy when the oscillator crosses above its trigger (dotted) 
line and sell when the oscillator crosses below its trigger line.  You may 
want to qualify your trades by requiring that the crossovers occur above 
the 70 level or below the 30 level. 
Divergences.  You may consider selling if prices are making a series of 
new highs and the oscillator is failing to surpass its previous highs. You 
may consider buying if prices are making a series of new lows and the 
oscillator is failing to surpass its previous low.  You may qualify your 
trades by requiring that the divergence occur above the 70 level or below 
the 30 level. 

Qstick Indicator 
The Qstick indicator was developed by Tushar Chande.  Qstick provides 
a way to quantify candlesticks.  The distance between the open and close 
prices lies at the heart of candlestick charting.  For those unfamiliar with 
candlestick charting, the body of a candlestick is black if today’s close is 
less than the open; it is white if today’s close is greater than the open.  A 
majority of white candlesticks over a specified range is considered 
bullish.  Whereas a majority of black candlesticks over a specified range 
is considered bearish. 
The Qstick indicator is simply a moving average of the difference 
between open and close prices. 
For more information on the Qstick indicator, refer to the book The New 
Technical Trader by Tushar Chande and Stanley Kroll. 
See page 163 for more information on plotting indicators.  See page 193 
for more information on the Qstick parameters. 

Interpretation 
Qstick values below zero indicate a majority of black candlesticks (over 
the time periods specified) and therefore a bearish bias for the security.  
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Values above zero indicate a majority of white candlesticks (over the 
time periods specified) and therefore a bullish bias for the security. 
There are several  ways to trade the Qstick indicator: 
Crossovers.  Buy when the indicator crosses above zero.  Sell when it 
crosses below zero. 
Extreme Levels.  Buy when the Qstick indicator is at an extremely low 
level and turning up.  Sell when the Qstick indicator is at an extremely 
high level and turning down.  You may even want to plot a short-term 
moving average on the Qstick to serve as a trigger line. 
Divergences.  Buy when the Qstick is moving up and prices are moving 
down.  Sell when the Qstick is moving down and prices are moving up.  
You may want to consider waiting for the price to confirm the new 
direction before placing the trade. 

Quadrant Lines 
Quadrant Lines are a series of horizontal lines that divide the highest and 
lowest values (usually prices) into four equal sections. 
See page 205 for more information on drawing line studies.  See page 
220 for more information on the Quadrant Line parameters. 

Interpretation 
Quadrant Lines are primarily intended to aid in the visual inspection of 
price movements.  They help you see the highest, lowest, and average 
price over a specified period. 

r-squared 
The Linear Regression method provides several useful outputs for 
technical analysts, including the r-squared.  R-squared shows the strength 
of trend.  The more closely prices move in a linear relationship with the 
passing of time, the stronger the trend.   
You may find the expert named "Equis - Statistical Analysis" helpful in 
interpreting r-squared.  See page 435 for more information an experts. 
See page 163 for more information on plotting indicators.  See page 193 
for more information on the r-squared parameters. 

Interpretation 
r-squared values show the percentage of movement that can be explained 
by linear regression.  For example, if the r-squared value over 20 days is 
at 70%, this means that 70% of the movement of the security is explained 
by linear regression.  The other 30% is unexplained random noise. 
It is helpful to consider r-squared in relation to Slope (see page 476).  
While Slope gives you the general direction of the trend (positive or 



 

 
 

MetaStock Professional Interpretation of Indicators and Line Studies • 507 

 

 

 

negative), r-squared gives you the strength of the trend.  A high r-squared 
value can be associated with a high positive or negative Slope.  
Although it is useful to know the r-squared value, ideally, you should use 
r-squared in tandem with Slope.  High r-squared values accompanied by 
a small Slope may not interest short term traders.  However, high r-
squared values accompanied by a large Slope value may be of huge 
interest to traders. 
One of the most useful way to use r-squared is as a confirming indicator.  
Momentum based indicators (e.g., Stochastics, RSI, CCI, etc.) and 
moving average systems require a confirmation of trend in order to be 
consistently effective.  R-squared provides a means of quantifying the 
“trendiness” of prices.  If r-squared is above its critical value and heading 
up, you can be 95% confident that a strong trend is present.   
 
When using momentum based indicators, only trade overbought/oversold 
levels if you have determined that prices are trendless or weakening (i.e., 
a low or lowering r-squared value).  Because in a strong trending market, 
prices can remain overbought or oversold for extended periods.  
Therefore, you may want to reconsider trading on strict 
overbought/oversold levels used by many indicators.  An “overbought” 
market can remain overbought for extended periods in a trending market.  
However, a signal generated by a moving average crossover system may 
be worth following, since these systems work best in strong trending 
markets. 
To determine if the trend is statistically significant for a given x-period 
linear regression line, plot the r-squared indicator and refer to the 
following table.  This table shows the values of r-squared required for a 
95% confidence level at various time periods.  If the r-squared value is 
less than the critical values shown, you should assume that prices show no 
statistically significant trend. 
 

Number 
of Periods

r-squared 
Critical Value 

(95% 
confidence) 

5 0.77 

10 0.40 

14 0.27 

20 0.20 

25 0.16 

30 0.13 

50 0.08 

60 0.06 
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120 0.03 

You may even consider opening a short-term position opposite the 
prevailing trend when you observe r-squared rounding off at extreme 
levels.  For example, if the slope is positive and r-squared is above 0.80 
and begins to turn down, you may consider selling or opening a short 
position. 
There are numerous ways to use the linear regression outputs of r-squared 
and Slope in trading systems.  For more detailed coverage, refer to the 
book The New Technical Trader by Tushar Chande and Stanley Kroll. 

Raff Regression Channel 
Developed by Gilbert Raff, the regression channel is a line study that 
plots directly on the price chart.  The Regression Channel provides  a 
precise quantitative way to define a price trend and its boundaries.   
The Regression Channel is constructed by plotting two parallel, 
equidistant lines above and below a Linear Regression trendline.  The 
distance between the channel lines to the regression line is the greatest 
distance that any one high or low price is from the regression line. 
For more detailed information on using the Raff Regression Channel, we 
recommend the book Trading the Regression Channel by Gilbert Raff 
(available directly from Equis International). 
See page 205 for more information on drawing line studies.  See page 220 
for more information on the Raff Regression Channel parameters. 

Interpretation 
Raff Regression Channels contain price movement, with the bottom 
channel line providing support and the top channel line providing 
resistance.  Prices may extend outside of the channel for a short period of 
time.  However, if prices remain outside the channel for a long period of 
time, a reversal in trend may be imminent. 

Random Walk Index 
In an effort to find an indicator that overcomes the effects of a fixed look-
back period and the drawbacks of traditional smoothing methods, Michael 
Poulos developed the Random Walk Index.  The Random Walk Index is 
based on the basic geometric concept that the shortest distance between 
two points is a straight line.  The further prices stray from a straight line 
during a move between two points in time, the less efficient the 
movement.  
See page 163 for more information on plotting indicators.  See page 194 
for more information on the Random Walk Index parameters. 
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Interpretation 
Mr. Poulos found significant evidence during his research that the 
"dividing line" between short- and long-term time frames for most futures 
and stocks is right around eight to 10 days.  Therefore, he feels an 
effective trading system using the RWI can be devised using two different 
time frames—a short-term RWI (two to seven periods) for the market's 
frantic, random side and a long-term RWI (eight to 64 periods) for the 
market's steady, trending side. 
Peaks in the short-term RWI of highs tend to coincide with price peaks.  
Peaks in the short-term RWI of lows tend to coincide with price troughs.   
Readings of the long-term RWI of highs above 1.0 provides a good 
indication of a sustainable uptrend.  Readings of the long-term RWI of 
lows above 1.0 provide a good indication of a sustainable downtrend. 
Therefore Mr. Poulus feels that an effective trading system could be built 
that opens trades (after short-term pull-backs against the direction of the 
long-term trend) using the following guidelines: 
• Buy Order (or close short) when the long-term RWI of the highs is 

greater than 1.0, and the short-term RWI of lows peaks above 1.0. 
• Sell Short Order (or Sell Order) when the long-term RWI of the lows 

is greater than 1.0, and the short-term RWI of highs peaks above 1.0. 

Range Indicator 
The Range Indicator was developed by Jack Weinberg.  It was 
introduced in the June 1995 issue of Technical Analysis of Stocks & 
Commodities magazine.  Mr. Weinberg developed this indicator based on 
his observation that changes in the average day's intraday range (high to 
low) as compared to the average day's interday range (close to close) 
precede the start of a new trend or the end of the current trend. 
See page 163 for more information on plotting indicators.  See page 194 
for more information on the Range Indicator parameters. 

Interpretation 
The Range Indicator shows when the intraday high to low ranges exceed 
the interday close to close ranges.   
This approach proves useful in identifying the start and end of trends.  
When the intraday ranges are dramatically higher than the interday  
ranges, the market is considered "out of balance," and the Range Indicator 
will be at a high level.  When at a high level, look for the current trend to 
end.  Conversely, when the Range Indicator is at a low level (below 20 for 
example), look for the emergence of a new trend. 
Mr. Weinberg found that the Range Indicator improves many momentum 
and trend-following trading systems.  For example, he found that the 
results of a basic two moving average crossover system on the four major 



 

 
 

510 • Interpretation of Indicators and Line Studies MetaStock Professional 

 

 

 

currencies were dramatically improved by filtering the signals with the 
Range Indicator.  By waiting to enter a long position until the Range 
Indicator crossed above a defined low level and then waiting to exit until 
the indicator crossed above a defined high level, profits, number of trades, 
and risk were dramatically improved. 

Relative Momentum Index 
The Relative Momentum Index (RMI) was developed by Roger Altman.  
Impressed with the Relative Strength Index's insensitivity to the number  
of lookback periods, yet frustrated with it's inconsistent oscillation 
between defined overbought and oversold levels, Mr. Altman added a 
momentum component to the RSI.  The RMI was first introduced in the 
February 1993 issue of Technical Analysis of Stocks & Commodities 
magazine. 
As mentioned, the RMI is a variation of the RSI indicator.  Instead of 
counting up and down days from close to close as the RSI does, the RMI 
counts up and down days from the close relative to the close x-days ago 
(where x is not necessarily 1 as required by the RSI).  So as the name of 
the indicator reflects, "momentum" is substituted for "strength." 
See page 163 for more information on plotting indicators.  See page 194 
for more information on the Relative Momentum Index parameters. 

Interpretation 
As an oscillator, the RMI exhibits the same strengths and weaknesses of 
other overbought/oversold indicators. During strong trending markets the 
RMI will remain at overbought or oversold levels for an extended period.  
However, during non-trending markets, the RMI tends to oscillate 
predictably between an overbought level of 70 to 90 and an oversold 
level of 10 to 30. 
Since the RMI is based on the RSI, many of the same interpretation 
methods can be applied.  In fact, many of these "situations" are more 
clearly manifest with the RMI than they are with the RSI.  
Tops and Bottoms. The RMI usually tops above 70 and bottoms below 
30.  The RMI usually forms these tops and bottoms before the underlying 
price chart. 
Chart Formations.  The RMI often forms chart patterns (such as head 
and shoulders or rising wedges) that may or may not be visible on the 
price chart. 
Failure Swings.  (Also known as support or resistance penetrations or 
breakouts.)  This is where the RMI surpasses a previous high (peak) or 
falls below a recent low (trough). 
Support and Resistance.  The RMI shows, sometimes more clearly than 
the price chart, levels of support and resistance. 
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Divergence.  As discussed above, this occurs when the price makes a new 
high (or low) that is not confirmed by a new RMI high (or low). 
 
Note that a 20,1 parameter RMI is equivalent to a 20-period RSI.  This is 
because the 1-day momentum parameter is calculating day-to-day price 
changes, which the standard RSI does by default. As the momentum 
parameter is increased, the oscillation range of the RMI becomes wider 
and the fluctuations become smoother. 

Relative Strength Comparative 
The Relative Strength Comparative indicator compares two securities to 
show how the securities are performing relative to each other.  Be careful 
not to confuse Comparative Relative Strength with the Relative Strength 
Index. 
Comparative Relative Strength is calculated by dividing one security's 
prices by a second security's price.  The result of this division is the ratio, 
or relationship, between the two securities.   
Another way to display the Comparative Relative Strength of two 
securities, is to create a composite security using The DownLoader (see 
The DownLoader User's Manual for more information.)  
See page 163 for more information on plotting indicators.  See page 195 
for more information on the Relative Strength Comparative parameters. 

Interpretation 
A Comparative Relative Strength chart compares a security's price with 
that of another security.  When the indicator is moving up, it shows that 
the security (the one displayed in the chart)  is performing better than the 
selected security.  When the indicator is moving sideways, it shows that 
both securities are performing the same (i.e., rising and falling by the 
same percentages).  When the indicator moves down, it shows that the 
security is performing worse than the selected  security (i.e., not rising as 
fast or falling faster). 
Stock and mutual fund traders may find it helpful to track the 
Comparative Relative Strength between the stocks and funds you are 
following and an index such as the NASDAQ Composite or the Dow 
Industrials.   Or you may want to do a comparison with a closely tied  
industry group.  For example, if you were following Ford, a Comparative 
Relative Strength between Ford and the S&P Auto Index would be 
helpful to show how Ford is performing relative to the entire auto 
industry. 
Futures Traders may find it helpful to compare futures with the CRB 
index.  Or perhaps one future with another.  For example, Gold and 
Silver, the Yen and the Pound, Bonds and the Dollar, etc. 
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Tip 
When using a composite security to create a Relative Strength 
Comparative, the value is stored in the price fields (rather than the 
indicator field).  This enables you to easily display indicators of Relative 
Strength Comparatives. 

Relative Strength Index 
The Relative Strength Index (RSI) is a popular oscillator used by 
commodity traders.  It was first introduced by J. Welles Wilder in an 
article in Commodities (now known as Futures) magazine in June, 1978.  
Step-by-step instructions on calculating and interpreting the RSI are also 
provided in Mr. Wilder's book, New Concepts in Technical Trading 
Systems (see page 544). 
The name "Relative Strength Index" is slightly misleading as the RSI does 
not compare the relative strength of two securities, but rather the internal 
strength of a single security.  A more appropriate name might be "Internal 
Strength Index."  
The RSI is a fairly simple formula, but is difficult to explain without 
pages of examples.  The basic formula is: 

RSI =  100 -
100

1+
U
D


 



















 

Where: 
U = An average of upward price change.  
D = An average of downward price change.  
MetaStock Pro prompts you to enter the number of time periods in the 
averages. 
See page 163 for more information on plotting indicators.  See page 195 
for more information on the RSI parameters. 

Interpretation 
When Wilder introduced the RSI, he recommended using a 14-day RSI.  
Since then, the 9-day and 25-day RSIs have also gained popularity.  
Because you can vary the number of time periods in the RSI calculation, 
we suggest that you experiment to find the period that works best for you.  
(The fewer days used to calculate the RSI, the more volatile the 
indicator.) 
The RSI is a price-following oscillator that ranges between 0 and 100.  A 
popular method of analyzing the RSI is to look for a divergence in which 
the market index is making a new high, but the RSI is failing to surpass 
its previous high.  This divergence would be an indication of an 



 

 
 

MetaStock Professional Interpretation of Indicators and Line Studies • 513 

 

 

 

impending reversal.  When the RSI then turns down and falls below its 
most recent trough, it is said to have completed a failure swing.  The 
failure swing would be considered a confirmation of an impending 
reversal. 
In Mr. Wilder's book, he discusses five uses of the RSI in analyzing 
commodity charts (these apply to indices as well): 
Tops and Bottoms. The RSI usually tops above 70 and bottoms below 
30 (MetaStock Pro automatically draws horizontal lines at these levels).  
The RSI usually forms these tops and bottoms before the underlying 
price chart. 
Chart Formations.  The RSI often forms chart patterns (such as head 
and shoulders or rising wedges) that may or may not be visible on the 
price chart. 
Failure Swings.  (also known as support or resistance penetrations or 
breakouts):  This is where the RSI surpasses a previous high (peak) or 
falls below a recent low (trough). 
Support and Resistance.  The RSI shows, sometimes more clearly than 
the price chart, levels of support and resistance. 
Divergence.  As discussed above, this occurs when the price makes a 
new high (or low) that is not confirmed by a new RSI high (or low). 
For additional information on the RSI, refer to Mr. Wilder's book. 

Relative Volatility Index 
The Relative Volatility Index (RVI) was developed by Donald Dorsey.  It 
was originally introduced in the June 1993 issue of Technical Analysis of 
Stocks and Commodities magazine (TASC).  A revision to the indicator 
was covered in the September 1995 issue. 
The RVI is used to measure the direction of volatility.  The calculation is 
identical  to the Relative Strength Index (RSI) (see page 512) except that 
the RVI measures the standard deviation of daily price changes rather 
than absolute price changes. 
See page 163 for more information on plotting indicators.  See page 196 
for more information on the RVI parameters. 

Interpretation 
When developing the RVI, Dorsey was searching for a confirming 
indicator to use with traditional trend-following indicators (such as a dual 
moving average crossover system).  He found that using a momentum-
based indicator to confirm another “repackaged” momentum-based 
indicator is usually ineffective. 
Dorsey made this clear in the June 1993 TASC article: 
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“Technicians are tempted to use one set of indicators to confirm another.  
We may decide to use the MACD to confirm a signal in Stochastic... 
Logic tells us that this form of diversification will enhance results, but too 
often the confirming indicator is just the original trading indicator 
repackaged, each using a theory similar to the other to measure market 
behavior... Every trader should understand the indicators being applied 
to the markets to avoid duplicating information.” 
When testing the profitability of a basic moving average crossover 
system, Dorsey found that the results could be significantly enhanced by 
applying the following RVI rules for confirmation.  Similar rules are 
likely to be effective for other momentum or trend following indicators. 
• Only act on buy signals when RVI > 50. 
• Only act on sell signals when RVI < 50. 
• If a buy signal is ignored, enter long if RVI > 60. 
• If a sell signal is ignored, enter short if RVI < 40. 
• Close a long position if RVI falls below 40. 
• Close a short position if RVI rises above 60. 
Because the RVI measures a different set of market dynamics than other 
indicators, it is often superior as a confirming indicator.  As Dorsey states: 

“There is no reason to expect the RVI to perform any better or worse 
than the RSI as an indicator in its own right.  The RVI’s advantage is 
as a confirming indicator because it provides a level of 
diversification missing in the RSI.” 

Renko 
The Renko charting method is thought to have acquired its name from 
"renga" which is the Japanese word for bricks.  Renko charts were 
introduced by Steve Nison (a well-known authority on the Candlestick 
charting method). 
Renko charts are similar to Three Line Break charts except that in a 
Renko chart, a line (or brick as they are sometimes called) is drawn in the 
direction of the prior move only if a fixed amount (i.e., the box size) has 
been exceeded.  The bricks are always equal in size.  For example, in a 
five unit Renko chart, a 20 point rally is displayed as four equally sized, 
five unit high Renko bricks. 
To draw Renko bricks, today's close is compared with the high and low of 
the previous brick (white or black).  When the closing price rises above 
the top of the previous brick by the box size or more, one or more equal 
height, white bricks are drawn in the next column.  If the closing price 
falls below the bottom of the previous brick by the box size or more, one 
or more equal height, black bricks are drawn in the next column.   
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If the market moves up more than the amount required to draw one brick, 
but less than the amount required to draw two bricks, only one brick is 
drawn.  For example, in a two unit Renko chart, if the base price is 100 
and the market moves to 103, then one white brick is drawn from the 
base price of 100 to 102.  The rest of the move--from 102 to 103--is not 
shown on the Renko chart.  The same rule applies anytime the price does 
not fall on a box size divisor. 
 
Indicators calculated on renko charts use all the data in each column and 
then display the average value of the indicator for that column. 

Interpretation 
Basic trend reversals are signaled with the emergence of a white or black 
brick.  A new white brick indicates the beginning of a new uptrend.  A 
new black brick indicates the beginning of a new downtrend.  Since the 
Renko chart is a trend following technique, there will be times when the 
market induces whipsaws.  However, a trend following technique is 
intended to allow traders to ride on the major portion of the trend. 
Since a Renko chart isolates the underlying trends by filtering out the 
minor ups and downs, Renko charts are excellent for helping determine 
support and resistance levels. 
For more in-depth coverage of the Renko charting method, we 
recommend the book Beyond Candlesticks by Steve Nison (see page 
544). 

Speed Resistance Lines 
Speed Resistance Lines, also called 1/3 - 2/3 lines, are a series of 
trendlines that divide a price move into three equal sections.  They are 
similar in construction and interpretation to Fibonacci Fan Lines (see page 
466). 
See page 205 for more information on drawing line studies.  See page 220 
for more information on the Speed Resistance Line parameters. 

Interpretation 
Speed Resistance Lines are used to define price support levels.  For 
example, if a security is in a rising trend, its price will usually stay above 
the 2/3 Speed Line.  If prices do penetrate the 2/3 line, they will generally 
fall all the way to the 1/3 line before regaining support. 

Spread 
Spreads compare two securities to show how the securities are 
performing relative to each other.  Spreads are normally calculated using 
futures. 
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A spread is calculated by subtracting the value of one security from the 
value of another security.  To display a spread of two securities, you can 
create a  composite security using The DownLoader (see page 60 in this 
manual), or you can plot the Spread indicator. 
When creating the composite with The DownLoader, be sure to select 
Subtract as the operator type.  Enter the appropriate Weighting Factor.  
Certain futures spreads require that one future have more or less weight 
than the other.  The Weighting Factor may be used to specify the weight 
for each future in the spread (e.g., a Weighting Factor of 0.40 multiplies 
the future's prices by 0.40).  Entering a Weighting Factor of 1.00 for both 
futures in the composite gives each equal weight. 
See page 163 for more information on plotting indicators.  See page 196 
for more information on the Spread parameters. 

Interpretation 
A Spread involves buying one security and selling another with the goal 
of profiting from the narrowing or expanding of the spread between the 
two items.  For example, you might buy gold and sell silver short with 
the expectation that the price of silver will fall faster (or rise slower) than 
the price of gold. 

Tip 
When using a composite security to create a spread, the value of the 
spread is stored in the price fields (rather than the indicator field).  This 
enables you to display indicators of Spreads. 

Standard Deviation 
Standard Deviation is a statistical measurement of volatility.  It is derived 
by calculating an x-time period simple moving average of the data item 
(i.e., the closing price or an indicator); summing the squares of the 
difference between the data item and its moving average over each of the 
preceding x-time periods; dividing this sum by x; and then calculating the 
square root of this result. 
See page 163 for more information on plotting indicators.  See page 196 
for more information on the Standard Deviation parameters. 

Interpretation 
Standard Deviation is typically used as a component of an indicator, 
rather than as a stand-alone indicator.  For example, Bollinger Bands (see 
page 449) are calculated by adding a security's Standard Deviation to a 
moving average. 
High Standard Deviation values signify high volatility:  the data item 
being analyzed is deviating from its moving average significantly.  
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Similarly, low Standard Deviation values signify low volatility; the data 
item is remaining close to its moving average. 
Typically, low Standard Deviation values (i.e., low volatility) tend to 
come before significant upward price changes. 
Many analysts agree that major tops are normally accompanied with high 
volatility and major bottoms are generally calm with low volatility. 

Tips 
An example custom indicator (see page 310) shows how to calculate 
Standard Deviation. 
The ODDS Probability Cones are calculated using standard deviation-
based volatility (see page 490). 

Standard Deviation Channel  
Standard Deviation Channels are calculated by plotting two parallel lines 
above and below an x-period linear regression trendline.  The lines are 
plotted x standard deviations away from the linear regression trendline.  
See page 205 for more information on drawing line studies.  See page 221 
for more information on Standard Deviation Channel parameters. 

Interpretation 
Price movements are characterized by swings from one extreme to the 
other.  Markets reflect the collective mood if its participants.  When 
market participants are overly optimistic, prices are driven up at an 
unsustainable rate.  Likewise, when market participants are overly 
pessimistic, prices are beaten down at an unsustainable rate.  The 
keywords here are "extreme" and "unsustainable."  Even the most raging 
bull markets or violent bear markets will either pause for a breather or 
reverse temporarily.  
Markets tend to have an equilibrium point (i.e., a point towards which 
prices tend to be drawn).  Linear regression analysis is helpful in 
determining where this "balancing point" lies.  On the other hand,  
standard deviation analysis is helpful in determining where the "extremes" 
lie.   
Elementary statistical analysis states that approximately 67% of future 
price movement should be contained within one standard deviation and 
approximately 95% within two standard deviations.  However, this 
assumes random, trendless data.  Since most markets show overwhelming 
evidence of non-random, trending behavior, these 67% and 95% values 
are not as accurate.  Standard Deviation channels, however, incorporate 
the trend (as measured by the middle linear regression plot).  Therefore, 
they provide a trend-biased assessment of expected price movement. 
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Standard Deviation Channels can be used to enhance several types of 
technical analysis techniques.  Here are some ideas: 
• Validate candlestick patterns.   Enter long on bullish engulfing 

lines only if they form below the bottom channel line. 
• Validate overbought/oversold signals.  Close long (or enter short) 

when the Stochastic falls below 80, volume is above average, and 
prices have recently fallen below the top channel line. 

• Validate support/resistance breakouts.  If prices have broken 
above a long-term resistance level, yet volume is suspiciously light, 
wait until the prices break above the upper channel on above average 
volume. 

Standard Error 
Standard Error measures how closely prices congregate around a linear 
regression line.  The closer prices are to the linear regression line, the 
higher the r-squared value and the stronger the trend.   
For example, if each day’s closing price was equal to that day’s 
regression line value, then the standard error would be zero.  The more 
variance or “noise” around the regression value, the larger the standard 
error and the less reliable the trend. 
See page 163 for more information on plotting indicators.  See page 197 
for more information on the Standard Error parameters. 

Interpretation 
High standard error values indicate that the security’s prices are very 
volatile around the regression line.  Changes in the prevailing trend (over 
the number of time periods specified) are usually preceded by a rapidly 
increasing standard error. 
Standard error can be used effectively in combination with the r-squared 
indicator (see page 506).  Changes in trend are often signaled by a high 
downward moving r-squared, a low upward moving standard error, or a 
low upward moving r-squared  and a high downward moving standard 
error.  In other words, when the two are at extreme levels and begin to 
converge, look for a change in trend. 
Note that a change in trend does not necessarily mean that an upward 
trend will reverse to a downward trend.  Sideways movement is also 
considered a “change.” 

Standard Error Bands 
Standard Error Bands are a type of envelope (see page 464) developed by 
Jon Andersen.  They are similar to Bollinger Bands in appearance, but 
they are calculated and interpreted quite differently.  Where Bollinger  
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Bands are plotted at standard deviation levels above and below a moving 
average, Standard Error Bands are plotted at standard error levels above 
and below a linear regression plot.  See page 518 for a definition of 
standard error. 
See page 163 for more information on plotting indicators.  See page 197 
for more information on Standard Error Bands parameters. 

Interpretation 
When displaying Standard Error Bands, you are prompted to enter the 
number of periods in the bands and the number of standard errors between 
the bands and the linear regression line (see page 197).  Mr. Andersen 
recommends default values of "21" for the number of periods, a 3-day 
simple moving average for the smoothing, and "2" standard errors.  He 
also notes that very short time frames tend to produce unreliable results. 
MetaStock Pro plots Standard Error Bands on the security's prices or 
indicator.  These interpretational comments refer to bands on the 
security's closing price. 
Because the spacing between Standard Error Bands is based on the 
standard error of the security, the bands widen when the volatility around 
the current trend increases, and contract when volatility around the current 
trend decreases. 
Since Standard Error Bands are statistically based, other statistical 
indicators such as r-squared, Standard Error, Linear Regression, etc. work 
well for trade confirmation. 
Mr. Andersen notes the following characteristics of Standard Error 
Bands. 
• Tight bands are an indication of a strong trend. 
• Prices tend to bounce between the bands when the bands are wide. 
• Tight bands followed by a widening of the bands may indicate the 

exhaustion of a trend and a possible reversal. 
• When the bands reverse direction after an exhausted trend, prices 

tend to move in the direction of the bands. 
• The r-squared indicator works well in combination with Standard 

Error Bands.  A high r-squared value combined with tight bands 
confirms a strong trend.  A low r-squared value combined with wide 
bands confirms that prices are consolidating. 

Standard Error Channel  
Standard Error Channels are calculated by plotting two parallel lines 
above and below an x-period linear regression trendline.  The lines are 
plotted a specified number of standard errors away from the linear 
regression trendline.  
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See page 205 for more information on drawing a line studies.  See page 
221 for more information on Standard Deviation Channel parameters. 

Interpretation 
Price movements are characterized by swings from one extreme to the 
other.  Markets reflect the collective mood if its participants.  When 
market participants are overly optimistic, prices are driven up at an 
unsustainable rate.  Likewise, when market participants are overly 
pessimistic, prices are beaten down at an unsustainable rate.  The 
keywords here are "extreme" and "unsustainable."  Even the most raging 
bull markets or violent bear markets will either pause for a breather or 
reverse temporarily.  
Markets tend to have an equilibrium point (i.e., a point towards which 
prices tend to be drawn).  Linear regression analysis is helpful in 
determining where this "balancing point" lies.  On the other hand, 
standard error analysis is helpful in determining where the "extremes" lie.   
Standard Error Channels can be used to enhance several types of 
technical analysis techniques.  Here are some ideas: 
• Validate candlestick patterns.   Enter long on bullish engulfing 

lines only if they have formed below the bottom channel line. 
• Validate overbought/oversold signals.  Close long (or enter short) 

when the Stochastic falls below 80, volume is above average, and 
prices have recently fallen below the top channel line. 

• Validate support/resistance breakouts.  If prices have broken 
above a long-term resistance level, yet volume is suspiciously light, 
wait until the prices break above the upper channel on above average 
volume. 

Stochastic Momentum Index 
The Stochastic Momentum Index (SMI) was developed by William Blau.  
It incorporates an interesting twist on the popular Stochastic Oscillator.  
While the Stochastic Oscillator provides you with a value showing the 
distance the current close is relative to the recent x-period high/low range,  
the SMI shows you where the close is relative to the midpoint of the  
recent x-period high/low range.  The result is an oscillator that ranges 
between +/- 100 and is a bit less erratic than an equal period Stochastic 
Oscillator. 
The SMI was introduced in the January 1993 issue of Technical Analysis 
of Stocks & Commodities magazine. 
An example formula (see page 311) illustrates the calculation of the 
Stochastic Momentum Index. 
See page 163 for more information on plotting indicators.  See page 197 
for more information on the Stochastic Momentum Index parameters. 
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Interpretation 
When the close is greater than the midpoint of the range, the SMI is 
positive.  When the close is less than the midpoint of the range, it is 
negative. 
The interpretation of the SMI  is virtually identical to the Stochastic 
Oscillator.  Three popular methods include: 
• Buy when the SMI falls below a specific level (e.g., -40) and then 

rises above that level, and sell when the Oscillator rises above a 
specific level (e.g., +40) and then falls below that level.  However, 
before basing any trade off of strict overbought/oversold levels it is 
recommended that you first qualify the trendiness of the market using 
indicators such as r-squared (see page 506) or CMO (see page 454).  
If these indicators suggest a non-trending market, then trades based  
on strict overbought/oversold levels should produce the best results.  
If a trending market is suggested, then you can use the oscillator to 
enter trades in the direction of the trend. 

• Buy when the SMI rises above its signal line (dotted) line and sell 
when the SMI falls below the signal line. 

• Look for divergences.  For example, where prices are making a series 
of new highs and the SMI is failing to surpass its previous highs. 

• Mr. Blau also notes that a 1-day SMI (with large smoothing periods 
such as 100) is very sensitive to the close relative to the high and low 
of the day.  These type of parameters make the RMI useful as a 
sentiment, or trend identification indicator, thereby providing a better 
sense of the overall direction of the market. 

Stochastic Oscillator 
Sto.chas.tic (st kas'tik) adj. 2. Math. designating a process having an 
infinite progression of jointly distributed random variables.-- Webster's 
The Stochastic Oscillator compares where a security's price closed 
relative to its trading range over the last x-time periods. 
 
The formula for the %K parameter of the Stochastic is: 

(today s close) -  (lowest low  %K periods)
(highest high  %K periods) -  (lowest low  %K periods)

′
 

For example, to calculate a 10-day %K:  First, find the security's highest 
high and lowest low over the last 10 days.  For this example, let's assume 
that during the last 10 days the highest high was 46 and the lowest low 
was 38--a range of 8 points.  If today's closing price was 41, %K would 
be calculated as: 
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 41 -  38
46 -  38

=  3 / 8  =   0.375
 

The 0.375 in this example shows that today's close was at the level of 
37.5% relative to the security's trading range over the last 10 days.  If 
today's close was 42, the Stochastic Oscillator would be 0.50.  The 0.50 
would show that the security closed today at 50%, or the mid-point, of its 
10-day trading range. 
The above example used a %K Slowing Period of 1 day (no slowing).  If 
you use a Slowing Period of greater than 1 period, you would total the 
value of the numerators for the number of Slowing Periods, then total the 
value of the denominators for the number of Slowing Periods, and then 
perform the division.  For example, to calculate a 10-day %K with 3-
period slowing, you would sum the value of the numerators (i.e., today's 
close minus the lowest low in the last 10 periods) for each of the last three 
periods, then sum the value of the denominators (i.e., the highest high in 
the last 10 periods minus the lowest low in the last 10 periods) for each of 
the last three periods, and finally divide the sum of the numerators by the 
sum of the denominators.  
A moving average of %K is then calculated using the number of time 
periods you specified in the %D Periods.  This moving average is called 
%D. 
Finally, MetaStock Pro multiplies all stochastic values by 100 to change 
decimal values into percentages for better scaling (e.g., 0.375 is displayed 
as 37.5%). 
The Stochastic Oscillator always ranges between 0% and 100%.  A 
reading of 0% shows that the security's close was the lowest price that the 
security has traded during the preceding x-time periods.  A reading of 
100% shows that the security's close was the highest price that the 
security has traded during the preceding x-time periods. 
You may find the expert named "Equis - Stochastic Oscillator" helpful in 
interpreting the Stochastic Oscillator.  See page 435 for more information 
an experts. 
See page 163 for more information on plotting indicators.  See page 198 
for more information on the Stochastic Oscillator parameters. 

Interpretation 
Stochastic Oscillators can be used as both short- and intermediate-term 
trading oscillators depending on the number of time periods used when 
calculating the oscillator.  When displaying a short term Stochastic 
Oscillator (e.g., 5-25 days), it is popular to slow the %K value by 3-days. 
There are several ways to interpret a Stochastic Oscillator.  Three popular 
methods include: 
• Buy when the Oscillator (either %K or %D) falls below a specific 

level (e.g., 20) and then rises above that level, and sell when the 
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Oscillator rises above a specific level (e.g., 80) and then falls below 
that level.  However, before basing any trade off of strict 
overbought/oversold levels it is recommended that you first qualify 
the trendiness of the market using indicators such as r-squared (see 
page 506) or CMO (see page 454).  If these indicators suggest a non-
trending market, then trades based on strict overbought/oversold 
levels should produce the best results.  If a trending market is 
suggested, then you can use the oscillator to enter trades in the 
direction of the trend. 

• Buy when the %K line rises above the %D (dotted) line and sell 
when the %K line falls below the %D line. 

• Look for divergences.  For example, where prices are making a series 
of new highs and the Stochastic Oscillator is failing to surpass its 
previous highs. 

MetaStock Pro's System Tester (see page 319) can be used to 
automatically generate buy/sell signals based on methods #1 and #2 
(above). 

Tip 
An example custom indicator (see page 311) shows how to calculate the 
Stochastic Oscillator. 

Support and Resistance Levels 
Think of security prices as the result of a head-to-head battle between a 
bull (the buyer) and a bear (the seller).  The bulls push prices higher and 
the bears push prices lower.  The direction prices actually move reveals 
who is winning the battle. 
Using this analogy, consider the following chart of Motorola.  Between 
August of 1989 and February of 1990,  Motorola rose to the price level 
of 15.75 several times where it encountered upside resistance.  Also note 
how when the price dropped to 13.25 it encountered downside support. 
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Savvy investors could see that Motorola was locked in a trading range 
(between 13.25 and 15.75) and knew that it would have to break out of 
this range.  What direction?  Who knows!  The fact was that the security 
was bound to break out.  The longer it remained in its trading range, the 
more powerful the anticipated breakout. 
The price breakout finally occurred in March 1990 when prices rose 
above their resistance level.  Once the upside resistance line was 
penetrated on a closing basis, the price of the security rose rapidly.  (The 
penetration of support/resistance levels is usually accompanied with an 
increase in volume.) 
After the quick rise, the price dropped downward once again.  When the 
price reached the line that had previously been upside resistance, it 
encountered downside support and was unable to fall further.  This is a 
well-documented phenomena.  Once penetrated,  resistance lines become 
support lines.  Similarly, when prices fall below support lines, the support 
lines usually provide price resistance.  

Swing Index 
The Swing Index seeks to isolate the "real" price of a security by 
comparing the relationships between the current prices (i.e., open, high, 
low, and close) and the previous period's prices. 
The Swing Index requires opening prices. 
 Step-by-step instructions on calculating the Swing Index are provided in 
Wilder's book, New Concepts In Technical Trading Systems (see page 
544). 
See page 163 for more information on plotting indicators.  See page 199 
for more information on the Swing Index parameters. 
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Interpretation 
Wilder notes the following characteristics of the Swing Index. 
• It provides a numerical value that quantifies price swings. 
• It defines short-term swing points. 
• It cuts through the maze of high, low, and close prices and indicates 

the real strength and direction of the market. 
Refer to the Accumulation Swing Index (see page 446) for additional 
interpretational information regarding the Swing Index and the "limit 
move." 

TEMA 
TEMA is a unique smoothing indicator developed by Patrick Mulloy.  It 
was originally introduced in the January 1994 issue of  Technical 
Analysis of Stocks & Commodities magazine. 
As Mr. Mulloy explains in the article:  
"Moving averages have a detrimental lag time that increases as the 
moving average length increases. The solution is a modified version of 
exponential smoothing with less lag time." 
TEMA is an acronym that stands for Triple Exponential Moving Average.  
However, the name of this smoothing technique is a bit misleading in that 
it is not simply a moving average of a moving average of a moving 
average.  It is a unique composite of a single exponential moving average, 
a double exponential moving average, and a triple exponential moving 
average that provides less lag than either of the three components 
individually.  
See page 163 for more information on plotting indicators.  See page 199 
for more information on the Stochastic Oscillator parameters. 

Interpretation 
TEMA can be used in place of traditional moving averages.  You can use 
it to smooth price data or other indicators.  Some of  Mr. Mulloy's original 
testing  of TEMA was done on the MACD.  Oddly, he found that the 
faster responding TEMA-smoothed MACD produced fewer (yet more 
profitable) signals than the traditional 12/26 smoothed- MACD.  A  
custom indicator named "MACD (TEMA-smoothed)" is included with 
MetaStock Pro. 
This type of smoothing is certainly not limited to the MACD.  You may 
want to experiment on other indicators as well. 
See page 459 for information on DEMA, a similar smoothing method 
developed by Mr. Mulloy. 
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Three Line Break 
Three Line Break charts originate from Japan and were introduced to the 
western world by Steve Nison (a well-known authority on the Candlestick 
charting method).  The Three Line Break charting method gets its name 
from the default number of line blocks typically used. 
Using the closing price, a new white block is added in a new column if the 
previous high price is exceeded.  A new black block is drawn if the close 
makes a new low.  If there is neither a new high or low, nothing is drawn. 
With a default Three Line Break, if a rally is powerful enough to form 
three consecutive white blocks, then the low of the last three white blocks 
must be exceeded before a black block is drawn.  If a sell-off is powerful 
enough to form three consecutive black blocks, then the high of the last 
three black blocks must be exceeded before a white block is drawn. 
To draw line break blocks, today's close is compared to the high and low 
of the previous block.  A block is drawn only when today's close exceeds 
the high or low of the previous block.  If today's close is higher than the 
top of the previous block, a new white block is drawn in the next column 
from the prior high to the new high price.  If today's close is lower than  
the bottom of the previous block, a new black block is drawn in the next 
column from the prior low to the new low price.  If the close fails to move 
outside the range of the previous blocks high or low, then nothing is 
drawn. 
With the default Three Line Break chart, a downside reversal (i.e., white 
blocks change to black blocks) occurs when the price moves under the 
lowest price of the last three consecutive white blocks.  A black reversal 
block is drawn from the bottom of the highest white block to the new 
price.  An upside reversal (i.e., black blocks change to white blocks) 
occurs when the price moves above the highest price of the last three 
consecutive black blocks.  A white reversal block is drawn from the top of 
the lowest black block to the new high price. 
Indicators calculated on Three Line Break charts use all the data in each 
column and then display the average value of the indicator for that 
column. 

Interpretation 
There are many ways to trade with Three Line Break charts.  The most 
basic method involves buying when a white block emerges after three 
prior black blocks, or selling when a black block appears after three 
white blocks. 
An advantage of the Three Line Break chart is that there is no arbitrary 
fixed reversal amount.  It is the market's action which gives the indication 
of a reversal.  Reversal signals in Three Line Break charts are sent well 
after the new trend has started.  However, many traders are comfortable 
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with this insofar as they believe that it is safer to be in for the major part 
of the trend rather than trying to pick a top or bottom. 
To adjust the sensitivity of the reversal criteria, traders can adjust the 
number of blocks that need to be broken before a reversal is drawn.  Thus, 
two line or four line break charts can be used instead of the standard  
Three Line Break charts.  Shorter time frame traders should use shorter 
reversal amounts (e.g., two or three), whereas longer term investors  
should use longer reversal amounts (e.g., five or even 10).  The most 
popular line break chart in Japan is the Three Line Break chart. 
For more in-depth coverage of the Three Line Break charting method, we 
recommend the book Beyond Candlesticks by Steve Nison (see page 
544). 

Time Series Forecast 
The Time Series Forecast indicator is based on the trend of a security's 
price over a specified time period.  The trend is determined by calculating 
a linear regression trendline using the "least squares fit" method.  The 
least squares fit technique fits a trendline to the data in the chart by 
minimizing the distance between the data points and the linear regression 
trendline.   
Any point along the Time Series Forecast is equal to the ending value of 
a Linear Regression trendline plus its slope.  For example, the ending 
value of a Linear Regression trendline (plus its slope) that covers 10 days 
will have the same value as a 10-day Time Series Forecast.  This differs 
slightly from the Linear Regression indicator (see page 475) in that the 
Linear Regression indicator does not add the slope to the ending value of 
the regression line.  This makes the TSF a bit more responsive to short 
term price changes.  If you plot the TSF and the Linear Regression 
indicator side-by-side, you’ll notice that the TSF hugs the prices more 
closely than the Linear Regression indicator. 
Rather than plotting a straight Linear Regression trendline, the Time 
Series Forecast indicator plots the ending values of multiple Linear 
Regression trendlines.  The resulting Time Series Forecast indicator is 
sometimes referred to as a "moving linear regression" study or a 
"regression oscillator." 
See page 163 for more information on plotting indicators.  See page 199 
for more information on the Time Series Forecast parameters. 

Interpretation 
The interpretation of a Time Series Forecast is similar to a moving 
average.  However, the Time Series Forecast indicator has two 
advantages over moving averages. 
Unlike a moving average, a Time Series Forecast does not exhibit as 
much "delay."  Since the indicator is "fitting" a line to the data points 
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rather than averaging them, the Time Series line is more responsive to 
price changes. 
As the name suggests, the indicator can be used to forecast the next 
period's price.  This estimate is based on the trend of the security's prices 
over the period specified (e.g., 20 periods).  If the trend continues, the 
last point of the trendline (the value of the Time Series Forecast) is 
forecasting the next period's price.   

Tirone Levels 
Tirone Levels are a series of horizontal lines that identify support and 
resistance levels.  They were developed by John Tirone. 
See page 205 for more information on drawing line studies.  See page 223 
for more information on the Tirone Level parameters. 

Interpretation 
Tirone Levels can be drawn using either the Midpoint 1/3-2/3 method or 
the Mean method.  Both methods are intended to help you identify 
potential support and resistance levels based on the range of prices over a 
given time period.  The interpretation of Tirone Levels is similar to 
Quadrant Lines (see page 506). 

Trade Volume Index 
The Trade Volume Index (TVI) is designed to calculate on intraday 
securities with "minutes per bar" set to zero (i.e., a tick chart).  It is 
calculated by adding each trade's volume to a cumulative total when the 
price ticks up by a specified amount, and subtracting the trade's volume 
when the price ticks down by a specified amount.  It's based on the 
premise that trades taking place at the higher "ask" price are buy 
transactions (from market marker or specialist to trader)and trades at the 
lower "bid" price are sell transactions (from trader to market maker or 
specialist).  The TVI oscillates around zero.  Values above zero indicate 
net buying pressure, whereas values below zero indicate net selling 
pressure. 
The TVI is similar to On Balance Volume, except the TVI continues to 
cumulate the volume (be it on the buy or sell side) if the price is 
unchanged.  Tick charts (especially of stock prices) will often display 
trades at the bid or ask price for extended periods without changing 
(creating a flat spot).  The TVI continues to assign the trade volume  
during these extended flat periods to either the buy or sell side (depending 
on its last price change).  The On Balance Volume indicator only assigns 
volume when price changes occur.  This works well for daily charts but 
not for tick charts.   
MetaStock Pro prompts you to enter the "Minimum Tick Value."  The 
Minimum Tick Value controls when volume switches from the buy side 
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to the sell side.  If the absolute value of the uptick or downtick is less 
than the Minimum Tick Value, MetaStock Pro will continue to assign the 
volume to the current side (i.e., buy or sell side).  If the absolute value is 
greater than the Minimum Tick Value and the price changes direction, 
MetaStock Pro will switch and begin assigning volume to the opposite 
side. 
Although the TVI will plot on any chart, it was originally designed to 
analyze intraday tick charts.  Therefore, you may want to use On Balance 
Volume for non-tick charts (i.e., 5-minute, hourly, daily, weekly, 
monthly).  However, the TVI can be used with non-tick data by increasing 
the Minimum Tick Value.  For example,  you could set the Minimum  
Tick Value to a large value (e.g., 1, 2, 3, 4 points or more) on a daily  
stock chart.  This produces a smoothing effect when compared to On 
Balance Volume.  Volume will cumulate in the direction of the trend until 
the price reverses by the specified number of points from a previous 
trough or peak.  When this occurs, volume will then begin to cumulate in 
the opposite direction.  
See page 163 for more information on plotting indicators.  See page 200  
for more information on the Trade Volume Index parameters. 

Interpretation 
The TVI helps identify whether buyers or sellers are in control.  If the 
TVI is trending up, it indicates that buyers are in control.  If the TVI is 
trending down, it indicates that sellers are in control.  If the TVI is above 
zero, it indicates that net buying has taken place over the time period 
displayed.  If the TVI is below zero, it indicates that net selling has taken 
place over the time period displayed. 
If a large number of trades are taking place at a specific price level (i.e., a 
flat spot forms on the tick chart) and the TVI is rising (falling), look for 
the price to break out on the upside (downside). 

Trendlines 
It's difficult, if not impossible, to provide information on a topic as 
complex and multifaceted as trendlines in the small area available here.  
The best source to learn about trendlines and chart patterns is the book 
Technical Analysis of Stock Trends, by Edwards and Magee (see page 
544). 
See page 205 for more information on drawing a line studies.  See page 
224 for more information on Trendline parameters. 
 

General 
A trendline is a sloping line drawn between two prominent points on a 
chart.  Rising trendlines are usually drawn between two troughs (low 
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points) to illustrate price support while falling trendlines are usually 
drawn between two peaks (high points) to illustrate upside price 
resistance. 
The consensus is that once a trend has been formed (two or more 
peaks/troughs have touched the trendline and reversed direction) it will 
remain intact until broken. 
That sounds much more simplistic than it is!  The goal is to analyze the 
current trend using trendlines and then either invest with the current trend 
until the trendline is broken, or wait for the trendline to be broken and 
then invest with the new (opposite) trend. 
The following chart displays two trendlines.  The first trendline is a 
"falling" trendline.  Note how it is drawn between successive peaks in the 
price.  The second trendline is rising.  It is drawn between successive 
troughs.   

 
One benefit of trendlines is they can help distinguish intuitive decisions 
("I think it's time to sell...") from analytical decisions ("I will hold until 
the current rising trendline is broken").  Another benefit of trendlines is 
that they almost always keep you on the "right" side of the market.  When 
using trendlines, it's difficult to hold a security for very long when prices 
fall just as it's hard to be short when prices rise--either way the trendline 
will be broken. 

Trendline Angles 
MetaStock Pro provides two commands that deal with trendline angles:  
Gann Lines (see page 218), and Trendline by Angle (see page 224).  The 
following discussion explains how these commands function and their 
differences. 
There are basically two ways to quantify the angle of a line drawn on a 
chart.  The first method is relative to the computer screen (or the piece of 
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paper).  If you draw a line at 45 degrees using a protractor on the screen, 
the line should rise by one inch for each inch it extends (runs) to the right.  
This 45 degree angle also could be expressed as a slope of 1. 
1 inch rise

1 inch run
 

The Trendline by Angle commands work in this manner--relative to the 
computer screen.  We say it is relative to the computer screen because we 
are discussing inches, not prices, on the screen.  Regardless of how many 
days are displayed or what the x- and y-axes of the chart are set to, a 45 
degree angle will slope up and to the right at 45 degrees relative to the 
computer screen. 
A second way to quantify the angle of a line drawn on the chart is relative 
to the x- and y-axes of the chart itself. 
A 45 degree angle relative to the x- and y-axes would rise one y-axis unit 
(point) for each x-axis unit (day) that the line extends (runs) to the right. 
1 point rise
1 period run

 

This is how Gann Lines are drawn:  relative to the x- and y-axes of the 
chart.  The difference between these two methods, i.e., relative to the 
screen (inches) or to the axes (points), is substantial. 
Gann Lines specifically ask for the ratio, i.e., the periods (run) and the 
points (rise).  If you enter 1 x 1, you will get a line that rises one point for 
each day it travels to the right.  The line may or may not appear to rise at 
45 degrees relative to the screen, depending on how many periods you 
have loaded and how the left scale (y-axis) is set. 
If you want a 1 x 1 Gann Line to appear to rise at 45 degrees relative to 
the computer screen, you will have to use the X- and Y-Axis Parameters 
dialog (see page 118 and page 123) to manually adjust the x- and y-axis. 
The Trendline by Angle command draws trendlines relative to the 
computer screen.  Changing the x- and y-axes will have no effect on the 
angle of the trendline. 

TRIX 
TRIX displays the percent rate-of-change of a triple exponentially 
smoothed moving average of the security's closing price. 
It is the 1-period percent change of an x-period exponential moving 
average of an x-period exponential moving average of an x-period 
exponential moving average of the closing price. 
An article on the TRIX indicator appears in Volume One of Technical 
Analysis of Stocks & Commodities magazine (TASC).  The TRIX 
indicator presented in the TASC article uses a slightly different method to 
calculate the exponential moving averages and displays the 1-period 



 

 
 

532 • Interpretation of Indicators and Line Studies MetaStock Professional 

 

 

 

change in "points multiplied by 1,000" (whereas MetaStock Pro displays 
the change as a percentage). 
See page 163 for more information on plotting indicators.  See page 200 
for more information on the TRIX parameters. 

Interpretation 
The TRIX indicator oscillates around a zero line.  Its triple exponential 
smoothing is designed to filter out "insignificant" cycles (i.e., those that 
are shorter than x-periods). 
Trades should be placed when the indicator changes direction.  You also 
can plot a 9-period moving average of the TRIX to create a "signal" line 
(similar to the MACD indicator, see page 478) and then buy when the 
TRIX rises above its signal line, and sell when it falls below its signal 
line.   

Typical Price 
The Typical Price indicator is calculated by adding the high, low, and 
closing prices together, and then dividing by three.  The result is the 
average, or typical price. 

Typical Price =  
High +  Low +  Close

3
 

See page 163 for more information on plotting indicators.  See page 201 
for more information on the Typical Price parameters. 

Interpretation 
The Typical Price indicator provides a simple, single-line chart of the 
day's average price.  You may find it helpful when testing moving 
average penetration systems to display moving averages of the Typical 
Price indicator, rather than of the security's closing price. 

Ultimate Oscillator 
Oscillators typically compare a security's (smoothed) price with its price 
x-periods ago.  Larry Williams notes that the value of this type of 
oscillator can vary greatly depending on the number of time periods used 
during the calculation.  Thus, he developed the Ultimate Oscillator that 
uses weighted sums of three oscillators, each of which uses a different 
time period. 
 
The three oscillators are based on Williams' definitions of buying and 
selling "pressure." 
See page 163 for more information on plotting indicators.  See page 201 
for more information on the Ultimate Oscillator parameters. 
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Interpretation 
Williams recommends that you trade following a divergence and a 
breakout in the Ultimate Oscillator's trend. 
A bullish divergence occurs when the security's price makes a lower low 
that is not confirmed by a lower low in the Oscillator.  A bearish 
divergence occurs when the security's price makes a higher high that is 
not confirmed by a higher high in the Oscillator. 

Vertical Horizontal Filter 
The Vertical Horizontal Filter (VHF) determines whether prices are in a 
trending phase or a congestion phase.  The VHF compares the sum of a 
one period rate-of-change to the range between high and low prices over 
the specified period. 
The age-old problem for many trading systems is their inability to 
determine if a trending or trading range market is at hand.  Trend-
following indicators such as MACD and moving averages, tend to be 
whipsawed as markets enter a non-trending congestion phase.  On the 
other hand, oscillators (which work well during trading range markets) 
tend to overreact to price pull-backs during trending markets.  The VHF 
indicator attempts to remedy this by measuring the "trendiness" of a 
market.   
MetaStock Pro prompts you to enter the number of periods to use in the 
calculation.  The default value is 28. 
See page 163 for more information on plotting indicators.  See page 201 
for more information on the VHF parameters. 

Interpretation 
There are three ways to use the VHF indicator: 
• VHF values above or below certain levels indicate the degree of 

trending.  The higher the VHF, the higher the degree of trending. 
• The direction of the VHF can be used to determine whether a  

trending or congestion phase is developing.  A rising VHF indicates a 
developing trend; a falling VHF indicates that prices may be entering 
a congestion phase. 

• The VHF as a contrarian type indicator.  Expect congestion to follow 
high VHF values.  Low VHF values may indicate a trending phase 
will soon follow. 

Volatility, Chaikin's 
The Volatility indicator compares the spread between a security's high 
and low prices.  This is done by first calculating a moving average of the 
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difference between the daily high and low prices and then calculating the 
percent rate-of-change of that moving average. 
Before calculating the Volatility indicator, you are asked to enter the 
number of time periods in the moving average and the number of time 
periods in the R.O.C.  The author of this indicator (Marc Chaikin) 
recommends 10-periods for both the moving average and the R.O.C. 
See page 163 for more information on plotting indicators.  See page 201 
for more information on the Volatility indicator's parameters. 

Interpretation 
This indicator quantifies volatility as a widening of the range between the 
highs and the lows (i.e., wider price swings during the day). 
There are two ways to interpret this measure of volatility.  One method 
assumes that market tops are generally accompanied by increased 
volatility and that market bottoms are generally accompanied by  
decreased volatility.  An opposing method (Mr. Chaikin's) assumes that  
an increase in the Volatility indicator over a short time period indicates 
that a bottom is near (e.g., a panic sell-off) and that a decrease in volatility 
over a longer time period indicates an approaching top (e.g., a mature bull 
market). 

Tips 
Mr. Chaikin recommends that investors do not rely on any one indicator 
and suggests using a moving average penetration or trading band system 
to confirm this (or any) indicator. 
Because this indicator uses high and low prices in its calculation, it will 
not work on securities that only have a closing price (e.g., most mutual 
funds). 
An example custom indicator (see page 311) shows how to calculate 
Chaikin Volatility. 

Volume 
Volume is the number of units (i.e., shares or contracts) traded during a 
specific time period.  The analysis of volume is a basic yet very important 
element of technical analysis.  Volume helps measure the intensity of 
price movement. 
Often, the y-axis scale for volume is displayed in multiples of 10s or 100s 
rather than the actual number (i.e., 500 = 500,000 shares).  If there is a 
scaling multiple, it will be displayed at the bottom of the y-axis scale. 
Volume is normally displayed in a histogram line style below the prices 
(see page 114). 
Some real-time data vendors do not provide volume with every tick.  If 
this is the case, MetaStock Pro will automatically assign a volume value 
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of "1" for every incoming  tick.  This allows you to at least see the 
number of "ticks" that have come in during a specified period.  In other 
words, if the volume on a 1-minute bar is 22, then you know that 22 
trades came in during that minute. 
If your real-time data vendor does not supply trade volume with updates, 
and a symbol is added during a trading session, the first tick will contain 
the total volume up to that point in the trading session.  MetaStock Pro 
will then calculate the trade volume for all subsequent ticks. 
See page 163 for more information on plotting indicators.  See page 202 
for more information on Volume parameters. 

Interpretation 
Volume is important to many techniques and systems used in technical 
analysis.  In brief, volume provides clues to the intensity level of a given 
price move. 
Generally speaking, volume tends to be a leading indicator of price.  
Volume usually drops off before prices peak, and it usually picks up 
before prices rise from a market bottom. 
Low volume levels are characteristic of the indecision that typically 
accompanies consolidation periods (i.e., periods where prices move 
sideways in a narrow range).  Low volume is often found at market 
bottoms. 
High volume levels are characteristic of market tops and the beginning of 
new trends (i.e., when prices break out of a trading range).  Just prior to 
market bottoms, volume will often increase on panic driven selling. 
Volume also helps determine the health of an existing trend.  A healthy 
up-trend should have higher volume on the upward legs of the trend, and 
lower volume on the downward, corrective legs.  After a market top, it is 
common to have a sharp down day on very heavy volume.  A healthy 
downtrend usually has higher volume on the downward legs of the trend 
and lower volume on the upward, corrective  legs. 

Volume Oscillator 
The Volume Oscillator displays the difference between two moving 
averages of a security's volume.  The difference between the averages can 
be expressed in either points or percentages. 
See page 163 for more information on plotting indicators.  See page 202 
for more information on the Volume Oscillator parameters. 

Interpretation 
As volume levels are increasing, shorter-term volume moving averages 
will rise above longer-term volume moving averages.  This is similar to 
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how shorter-term price moving averages rise above longer-term price 
moving averages when prices are increasing. 
Thus, the difference between two volume moving averages of varying 
lengths (i.e., this indicator) can be used to see if overall volume trends are 
increasing or decreasing.  When the Volume Oscillator rises above zero, it 
signifies that the shorter-term volume moving average has risen above the 
longer-term volume moving average, or that the short-term volume trend 
is higher (i.e., more volume) than the longer-term volume trend. 
There are many ways to interpret changes in volume trends.  One common 
belief is that rising prices coupled with increased volume, and falling 
prices coupled with decreased volume, is bullish.  Conversely, if volume 
increases when prices fall, and volume decreases when prices rise, the 
market is showing signs of underlying weakness. 
The theory behind this is straight forward.  Rising prices coupled with 
increased volume signifies increased upside participation (more buyers) 
that should lead to a continued move.  Conversely, falling prices coupled 
with increased volume (more sellers signifies increased downside 
participation). 

Tip 
An example custom indicator (see page 311) shows how to calculate the 
Volume Oscillator. 

Volume Rate-Of-Change 
The Volume Rate-Of-Change (R.O.C.) indicator is calculated by dividing 
the volume change over the last x-periods by the volume x-periods ago.  
The result is the percent by which the volume has changed over the last x-
periods. 
If volume is higher today than x-days ago, the R.O.C. will be a positive 
number.  If volume is lower today then x-days ago, the R.O.C. will be 
negative. 
See page 163 for more information on plotting indicators.  See page 203 
for more information on the Volume R.O.C. parameters. 

Interpretation 
The Volume R.O.C. is calculated identically to the Price R.O.C. (see page 
501), except it displays the R.O.C. of the security's volume, rather than of 
its closing price.  Additional information on the interpretation of volume 
trends can be found in the discussion on the Volume Oscillator (see page 
535). 
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Tip 
An example custom indicator (see page 311) shows how to calculate 
Volume R.O.C. 

Weighted Close 
The Weighted Close indicator is calculated by multiplying the close by 
two, adding the high and the low, and dividing by four.  The result is the 
average price for the day with extra weight given to the closing price. 

Weighted Close =  
(Close  2) +  High +  Low

4
×

 
See page 163 for more information on plotting indicators.  See page 203 
for more information on the Weighted Close parameters. 

Interpretation 
The Weighted Close indicator provides a single line chart of the average 
price.  When testing moving average penetration systems, you may find it 
helpful to display moving averages of the Weighted Close indicator, 
rather than of the security's closing price. 

Tip 
An example custom indicator (see page 312) shows how to calculate 
Weighted Close. 

Wilder's Smoothing 
The Wilder's Smoothing indicator was developed by Welles Wilder, best 
known as the developer of the Directional Movement system (see page 
461) and the Relative Strength Index (see page 512). 
Wilder used this smoothing indicator as a component of many of his 
other studies.  It is basically a type of moving average, similar to the 
"exponential" method in that it retains a decreasingly smaller percentage 
of all historical data in the series. 
See page 163 for more information on plotting indicators.  See page 203 
for more information on the Wilder's Smoothing parameters. 

Interpretation 
The Wilder's Smoothing indicator should be used just as you would use a 
moving average.  Although similar to the exponential, weighted, and 
triangular moving average methods in how it has a "memory" of all 
historical data, the Wilder's Smoothing method seems to be the least 
responsive of the three. 



 

 
 

538 • Interpretation of Indicators and Line Studies MetaStock Professional 

 

 

 

For more information on the interpretation of moving averages, see page 
488. 

Williams' %R 
The formula used to calculate Williams' %R is similar to the Stochastic 
Oscillator: 
Williams' %R is plotted on an upside down scale with 0 at the top and 100 
at the bottom.  To show the indicator in this upside down fashion, 
MetaStock Pro places a minus symbol before the %R values.  You should 
ignore the minus symbol. 
See page 163 for more information on plotting indicators.  See page 203 
for more information on the Williams' %R parameters. 

Interpretation 
The analysis of Williams' %R is very similar to that of the Stochastic 
Oscillator (see page 521) except that %R is upside down and the 
Stochastic Oscillator has internal smoothing. 
Readings in the range of 80 to 100% (remember to ignore the minus 
symbol) indicate that the market is oversold, while readings in the 0 to 
20% range suggest that the market is overbought. 
As with all overbought/oversold indicators, it is best to wait for the 
security's price to change direction before placing your trades.  For 
example, if an overbought/oversold indicator (such as the Stochastic 
Oscillator or Williams' %R) is showing an overbought condition, it is 
wise to wait for the security's price to turn down before selling the 
security.  (The MACD is a good indicator to monitor change in a 
security's price.)  It is not unusual for overbought/oversold indicators to 
remain in an overbought/oversold condition for a long time period as the 
security's price continues to climb/fall.  Selling simply because the 
security appears overbought may take you out of the security long before 
its price shows signs of deterioration. 
An interesting phenomena of the %R indicator is its uncanny ability to 
anticipate a reversal in the underlying security's price.  The indicator 
almost always forms a peak and turns down a few days before the 
security's price peaks and turns down.  Likewise, %R usually creates a 
trough and turns up a few days before the security's price turns up. 

Tip 
An example custom indicator (see page 312) shows how to calculate 
Williams' %R. 
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Williams' Accumulation/Distribution 
Williams' Accumulation/Distribution is a cumulative total of "X" where: 
TRH (true range of highs) = 
 Yesterday's close or today's high, whichever is greater. 
TRL (true range of lows) = 
 Yesterday's close or today's low, whichever is less. 
If today's close is greater than yesterday's close,  
 X = today's close - TRL, 
otherwise, if today's close is less than yesterday's close,  
 X = today's close - TRH, 
 otherwise, 
 X = 0. 
See page 163 for information on plotting indicators.  See page 204 for 
information on the Williams' Accumulation/Distribution parameters. 

Interpretation 
Williams recommends trading this indicator based on divergences. 
• Distribution of the security is indicated when the security is making a 

new high and the A/D indicator is failing to make a new high.  Sell. 
• Accumulation of the security is indicated when the security is making 

a new low and the A/D indicator is failing to make a new low.  Buy. 

Tips 
Williams' Accumulation/Distribution indicator is a price indicator.  The 
Accumulation/Distribution indicator is a volume indicator (see page 446). 
An example custom indicator (see page 312) shows how to calculate 
Williams' A/D. 

Zig Zag 
The Zig Zag indicator filters out changes in the data item (i.e., the 
security or an indicator) that are less than x percent or points.  It is used 
primarily to aid in the visual inspection of a chart--punctuating the 
significant moves.  
See page 163 for more information on plotting indicators.  See page 204 
for more information on the Zig Zag parameters. 

Interpretation 
The Zig Zag indicator is useful to filter out "noise" in a security's price 
and indicators.  It is primarily intended to aid in the visual inspection of a 
chart. 
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The Zig Zag indicator can be useful for those concerned with Elliot Wave 
counts since it helps identify significant turning points. 
Be forewarned, that the last leg (i.e., segment) of the Zig Zag is dynamic, 
meaning that it can change.  Therefore, be careful when designing system 
tests, experts, etc. based on the Zig Zag indicator. 
For additional information on the Zig Zag indicator, refer to Filtered 
Waves by Arthur Merrill (see page 544). 
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Appendices 

Information About Your Computer System 
Information about your computer system is available from the About 
MetaStock dialog.  Choose About MetaStock from the Help menu. 
If you have Microsoft Office installed you can click the System Info 
button in this dialog to view information about your PC. 

Installing and Using MetaStock Pro on a Network 
A special installation procedure is required in order for MetaStock Pro to 
be accessible by multiple network users.  Information is provided here for 
both the network administrator and the workstation users. 
Note.  MetaStock Pro can be accessed simultaneously by multiple users 
on a network.  However,  each user of MetaStock Pro must be a licensed 
owner.   Please purchase a licensed copy of MetaStock Pro for each 
person using the software.  If more than one user is accessing a single 
licensed copy of MetaStock Pro, then you are violating the license 
agreement and breaking the law. 
 
Discounts are available if you purchase multiple copies. 

Information for the Network Administrator 
MetaStock Pro can be installed on a network drive for use by multiple 
workstations.  Choose the "Complete/Custom" option from the MetaStock 
Pro Setup dialog to install all files to the network drive. 
MetaStock Pro data files can also be stored on a network drive for use by 
multiple workstations.   
Each workstation must have full read/write access to the folders 
containing program and data files. 

Information for Workstation Users 
In order for MetaStock Pro to access the program's network files from a 
workstation, each workstation must complete a "Workstation" installation.  
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Choose the "Workstation" option from the MetaStock Pro Setup dialog to 
install the necessary files to the workstation drive. 
At the beginning of the workstation installation you are prompted to type 
your user name (unless you have already installed).  Be sure that this 
name is unique in order to avoid conflicts with other network users.  You 
can change the user name after installation from MetaStock Pro's 
Application Options dialog (see page 35). 
During the installation you are also asked to specify the network drive 
where the MetaStock Pro program files are located.  Ask your network 
administrator for this information.  The path to the MetaStock Pro 
program files on the network is automatically stored in each workstation's 
Windows registry. 
Do not attempt to access a real-time data folder that is in use by another 
MetaStock Pro user.  If you do, the other user will lose "write" privileges 
to the folder. 

Entering Dates in MetaStock Pro 
When entering dates in MetaStock Pro, you can type them or use a special 
drop-down calendar that allows you to easily choose specific dates. 

 
If you choose to type the dates rather than select them from the drop-
down calendar, you can enter the year using two or four digits.  If you 
enter only two digits, MetaStock Pro interprets the two digit years 26 
through 99 to mean 1926 through 1999.  Two digit years 00 through 25 
are interpreted to mean 2000 through 2025.  This means that in order to 
enter a date of 1915 or 2036, you would need to type in the four digit 
year, or MetaStock Pro would not interpret them as you intended. 

Converting Custom Formulas, System Tests, Explorations, 
and Experts 

When you installed MetaStock Pro for the first time, the installation 
program asked if you wanted to transfer your custom indicators, system 
tests, and explorations from a previous version of MetaStock to 
MetaStock Pro 8.0.  If you answered "yes," you will be asked if you want 
to update your files to be compatible with MetaStock Pro 8.0.  You are 
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asked this the first time you attempt to access the Indicator Builder, 
System Tester, The Explorer, and the Expert Advisor. 
Also, if you have deleted, moved, or renamed the MS80FORM.DTA, 
MS80PRFT.DTA, MS80EXPL.DTA, or MS80EXPT.DTA files, you are 
asked if you want to create new files.  The actual formulas, system tests, 
explorations, and experts (respectively) are stored in these files. 

Program Performance 
There are several things you can do to speed up MetaStock Pro: 
• Close other applications while running MetaStock Pro. 
• Only load as much data as you need (see page 80). 
• Limit the number of charts you have open. 
• Use the status bar (see page 27) to view the date and pointer location 

rather than the Data Window. 
• Increase the amount of RAM in your computer. 
• Install a faster CPU. 
• Limit the number of calculation-intensive indicators and experts 

attached to a chart. 

Using OptionScope 
 
 
 

 
OptionScope button 

OptionScope is a separate program provided with MetaStock Pro that is 
patterned after a spreadsheet.  It is used to analyze options on futures and 
equities.   
You run OptionScope from within MetaStock Pro by choosing 
OptionScope from the Tools menu or by clicking the OptionScope button 
on the standard toolbar. 

With OptionScope you can: 
• calculate the fair market value of put and call options. 
• calculate implied volatility to see what the "actual" option's price is 

implying the volatility should be. 
• calculate delta, vega, gamma, and theta (see page 494) to study the 

sensitivity of the option to changes in market conditions. 
• calculate "what-if" scenarios. 
• display graphs of option positions. 
The folder where the OptionScope program is located is specified in the 
Application Options dialog (see page 33). 
OptionScope includes an on-line help system that explains how to use the 
program's features.  Choose Contents from OptionScope's Help menu. 
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Suggested Reading 
 

The following books have been used by Equis for the Interpretation of 
Indicators and Line Studies chapter of the manual.  Equis also 
recommends these books to those needing additional information on 
technical analysis. 
For additional information on books, videos, software and other 
educational materials, check out the EQUISDirect catalog on our web site 
at http://www.equis.com.   
 
Achelis, Steven B.  Technical Analysis from A to Z.  Chicago, IL:  
Probus Publishing Company, 1995. 
Written by the president and founder of Equis International.  This book 
contains an introduction to technical analysis, plus a complete reference 
to over 100 indicators and studies. 
 
Appel, Gerald and Hitschler, Fred.  Stock Market Trading Systems.  
Homewood, IL:  Dow Jones-Irwin, 1980. 
Takes a thorough look at moving average trading systems, timing market 
cycles, the 12-day Rate-Of-Change, etc. 
 
Appel, Gerald.  The Moving Average Convergence-Divergence Method.  
Great Neck, NY:  Signalert, 1979. 
The MACD from its creator. 
 
Arms, Richard W., Jr.  Volume Cycles in the Stock Market.  Salt Lake 
City, UT:  Equis International, Inc., 1994. 
Thoroughly explains the Equivolume charting method, volume cycles, 
and the ease of movement indicator. 
 
Bookstaber, Richard.  The Complete Investment Book.  Glenview, 
Illinois:  Scott, Foresman and Company, 1985. 
Explains the Black/Scholes option calculations used in MetaStock Pro. 
 
Chande, Tushar S and Stanley Kroll.  The New Technical Trader. New 
York:  Wiley, 1994. 
A book describing a new statistically- based breed of price-based, and 
risk control indicators. 
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Cohen, A.W.  How To Use The Three-Point Reversal Method of Point & 
Figure Stock Market Trading.  Larchmont, NU:  Chartcraft, 1984. 
A detailed book on point & figure chart interpretation. 
 
Dobson, Edward D.  Understanding Fibonacci Numbers.  Greenville, SC:  
Traders Press, 1984. 
A brief overview of Fibonacci numbers.  Contains an extensive 
bibliography. 
 
Edwards, Robert D. and Magee, John.  Technical Analysis of Stock 
Trends.  Sixth  Edition.  Boston, MA:  John Magee, Inc., 1992. 
(Distributed by New York Institute of Finance.) 
Explains trendlines and chart patterns. 
 
Eng, William F.  The Technical Analysis of Stocks, Options, & Futures.  
Chicago, IL:  Probus Publishing,1988. 
 
Granville, Joseph E.  New Strategy of Daily Stock Market Timing for 
Maximum Profit.  Englewood Cliffs, NJ:  Prentice-Hall, 1976. 
A book from the inventor of On Balance Volume.  Mr. Granville has 
earned a bearish reputation, but his technical tools remain valid. 
 
Kaufman, Perry J.  Commodity Trading Systems and Methods.  New 
York:  Wiley, 1978. 
A serious book for the serious technician.  While not required, a strong 
background in mathematics is helpful when reading this book. 
 
Lebeau, Charles, and David Lucas.  Technical Trader's Guide to 
Computer Analysis of the Futures Market.  Homewood, IL:  Business 
One Irwin, 1991. 
An excellent book that shows the historical performance of popular 
technical indicators and oscillators.   
 
Leibovit, Mark A.  Using the Volume Reversal Survey in Market 
Analysis (520-282-1275). 
This pamphlet provides information on some of the pattern finding 
functions in the MetaStock formula language (i.e.,  Inside, Outside, 
Rally, and Reaction). 
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Merrill, Arthur A.  Filtered Waves-Basic Theory.  Chappaqua, NY:  The 
Analysis Press, 1977. 
This is an entire book about the Zig Zag indicator.  It is available from: 
Technical Trends 
John R. McGinley, Jr. 
P.O. Box 792 
Wilton, CT  06897 
 
Murphy, John J.  Technical Analysis of the Futures Markets.  New York, 
NY:  New York Institute of Finance, 1986. 
One of the best single sources of information on technical analysis.  You 
don't have to trade commodities for this book to be valuable. 
 
Natenberg, Sheldon.  Option Volatility and Pricing Strategies.  Chicago, 
IL:  Probus Publishing Company, 1988. 
Explains the Black/Scholes option calculations used in MetaStock Pro. 
 
Nison, Steven.  Japanese Candlestick Charting Techniques.  New York, 
NY:  New York Institute of Finance, 1991. 
Explains how to use and interpret Candlestick charts. 
 
Nison, Steven.  Beyond Candlesticks.  New York, NY:  Wiley, 1994. 
Explains how to use and interpret Kagi, Renko, and Three Line Break 
charts. 
 
Raff, Gilbert.  Trading the Regression Channel.  Salt Lake City, UT.  
Equis International, 1996. 
Explains how to trade the Regression Channel and objectively draw 
trendlines. 
 
Pring, Martin J.  Technical Analysis Explained.  Third edition.  New 
York, NY:  McGraw-Hill, 1991. 
A complete, well-written book on technical analysis.  Recommended. 
 
Wilder, J. Welles.  New Concepts in Technical Trading Systems.  
Greensboro, NC:  Trend Research, 1978. 
Explains the interpretation and calculation of about a dozen indicators 
including all of the Directional Movement indicators, the Relative 
Strength Index, and the Commodity Selection Index. 
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Index 

A 

About MetaStock, 541 
Absolute value function, 252 
Accelerator keys 

in commentaries, 414 
in menus, 18 

Accessibility options, 17 
Accumulation swing index 

function, 253 
interpretation, 446 
parameters, 175 

Accumulation/Distribution 
function, 252 
interpretation, 446 
parameters, 175 
sample custom indicator, 

308 
Ad() function, 252 
Add 

charts to layout, 93 
layout dialog, 90 
multiple securities, 47 

Add all 
layout dialog, 90 

Addition function, 253 
Address Book, 37 
Adjust, line study, 212 
Adx() function, 254 
Adxr() function, 258 
Alert function, 253 
Alert function, system tester, 

366 
Alerts (expert) 

creating/editing, 431 
options, 37 

pager and e-mail, 37, 430 
tips, 434 
using, 430 
viewing triggered, 434 

Alignment of header/footer, 
136 

Allow mixed case ticker 
symbols, 32 

Ambiguity menu, 147 
And/Or operators, 241 
Andrews' pitchfork 

drawing tips, 215 
interpretation, 447 
parameters, 215 

Angle 
drawing trendlines by, 224 
interpretation, 530 

Application properties, 31 
Apply button, 168 
Apply template, 99 
Arc tangent function, 253 
Arcs, Fibonacci, 216 
Aroon 

function, 253, 254 
interpretation, 447 
parameters, 175 

Arrange inner window, 113 
Arrows 

placing on chart, 222 
Aswing() function, 253 
Atan() function, 253 
Atr() function, 254 
Attach experts, 435 
Auto rotate, 171 
Autoscroll, 88 
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Average directional 
movement function, 
254 

Average true range 
function, 254 
interpretation, 448 
parameters, 176 

AVI files 
in alerts, 433 
in experts, 415 

B 

Bar chart 
displaying, 151 

Bars since function, 254 
Base security, 143 
Bbandbot() function, 254 
Bbandtop() function, 255 
Bearish 3  DDE Server 

(EqDdeSrv) 
Theethodmethod 
formation function, 
288 

Bearish harami cross 
function, 289 

Bearish harami function, 288 
Big black candle function, 

289 
Big white candle function, 

289 
Binary waves, 312 
Black body function, 289 
Blank background, 109 
Bollinger band bottom 

function, 254 
Bollinger band top function, 

255 
Bollinger bands 

interpretation, 449 
parameters, 176 
sample custom indicator, 

308 
Books, suggested, 544 
Border, chart and page, 134 
Breakeven stop, 335 
Bullish 3 method formation 

function, 289 

Bullish harami cross 
function, 290 

Bullish harami function, 290 
Buy/hold index, 354 
Buying pressure function, 

255 

C 

Cache 
File Server, 57 
online, 42, 43 

Calendar, drop-down, 542 
Candlesticks 

displaying, 151 
functions, 288 
interpretation, 450 

Candlevolume 
displaying, 151 
interpretation, 451 

Cascade 
charts, 15 
layouts, 93 

Cci 
interpretation, 456 
parameters, 177 

Cci() function, 256 
Ccie() function, 256 
CD-ROM, accessing data 

from, 78 
Ceiling function, 255 
Centering header/footer, 136 
Chaikin money flow 

function, 255 
interpretation, 453 
parameters, 177 

Chaikin oscillator 
function, 255 
interpretation, 451 
parameters, 177 
sample custom indicator, 

309 
Chande momentum 

oscillator 
function, 255 
interpretation, 454 
parameters, 177 
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Change security commands, 
83 

Channel lines, 212 
Chart 

toolbar, 24 
Chart options dialog, 104 
Chart(s) 

closing, 68, 82 
creating, 78 
definition, 63, 77 
deleting, 75 
displaying existing, 79 
modifying, 104 
moving, 108 
options, 33 
printing, 138 
resizing, 109 
saving, 69, 81 
scanning through, 83 
scrolling, 85 
selecting, 16, 103 
title bar, 34 
to clipboard, 8 

ChartTips, 34, 160 
Choose a security dialog, 84 
Clipboard commands, 8, 

355, 393 
Cloning charts, 86 
Close 

button, 16 
charts, 82 
command, 68 
inner windows, 116 
layout, 96 

Close All, 68 
Close all open charts 

when open new chart, 73 
Co() function, 255 
COL variable, explorer, 381 
Collecting data 

DataOnDemand, 152 
with The DownLoader, 43, 

58 
Collecting Data 

DataOnDemand, 42, 228 
through the Internet, 228 
with The DownLoader, 51, 

61 

Color 
data window text, 161 
inner window, 112 
of indicator, 169 
of line study, 210 
of price plot, 151 
setting defaults, 170 
toolbar, 25 
x-axis gridlines, 123 
y-axis gridlines, 126 

Commentary (expert) 
tips, 420 
using backslash, 413 
using colors, fonts, 

formatting, 413 
using constants, 411 
viewing, 418 
window, 418 
writeif() function, 408 
writeval() function, 409 
writing, 406 

Comments 
in custom indicators, 240 

Commissions 
technical reference, 363 
trading tips, 360 

Commodity channel index 
function, 256 
interpretation, 456 
parameters, 177 

Commodity selection index 
function, 256 
interpretation, 456 
parameters, 178 

Composite securities, 81 
Configuration 

real-time, 51 
Configuration, application, 

31 
Configure Server, 51 
Confirm deletions dialog, 

158 
Constants, commentary, 411 
Contents of data window, 

161 
Contents, help, 29 
Context sensitive help, 31 
Continuous contracts, 48 
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Converting 
custom formulas, system 

tests, explorations, 
experts, 542 

data, 50, 60 
Copy 

custom indicator, 304 
expert, 436 
exploration, 384 
indicator, 172 
line study, 211 
price plot, 153, 154 
system test, 337 

Copy to clipboard, 8 
Corner (expert) 

displaying, 405 
Correlation analysis 

function, 256 
interpretation, 457 
parameters, 178 

Cosine function, 256 
Create 

data folder, 50 
multiple securities, 47 
new security, 60 

Create new folder button, 73 
Cross function, 257 
Crosshairs 

displaying/removing, 161 
Csi() function, 256 
Cumulate function, 257 
Custom Formulas 

support, 5, 299, 319, 369, 
397 

Custom indicator 
comments, 240 
copying, 304 
creating, 303 
deleting, 304 
error dialog, 317 
errors, 238 
functions, 237 
location of files, 33 
math errors, 316 
multi-plot, 306 
pasting functions in, 305 
plotting, 301 
precedence, 236 

print, 304 
prompting for input, 306 
referencing others, 242 
samples, 308 
tips, 248 

Custom Toolbar, 21 
Customer service, 5 
Cut to clipboard, 8 
Cut/Copy/Paste 

in system tester, 362 
Cycle lines 

drawing tips, 215 
interpretation, 458 
parameters, 215 
plotting on equivolume, 

145 

D 

Daily data, 60 
Dark cloud cover function, 

290 
Data 

edit, 152 
end-of-day, 42 
intraday, 42 
local, 41 
online, 41, 42 
printing, 138 
viewing with data window, 

158 
What is data?, 41 

Data array parameters, 240 
Data collection 

real-time, 42 
with The DownLoader, 42, 

43, 58 
Data Collection 

DataOnDemand, 42, 228 
real-time, 51 
through the Internet, 228 
with The DownLoader, 51, 

61 
Data Server, 51, 52, 56, 57 
Data window 

changing contents, 161 
displaying/removing, 158 
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viewing indicator values, 
174 

viewing price values, 158 
DataOnDemand, 42, 228 
DataOnDemand Cache, 42, 

43 
Dates 

general guidelines for 
entering, 542 

on printout, 136 
on status bar, 27 
prompting for when 

loading, 80 
Day-of-month function, 257 
Day-of-week function, 257 
Default color and style, 170 
Default template, 78, 102 
Defaults button, 19 
Delete 

charts from layout, 94 
charts, layouts, templates, 

75 
confirming, 32, 158 
custom indicator, 304 
expert, 436 
exploration, 384 
indicator, 173 
indicators, 109 
line studies, 109 
line study, 214 
price plot, 153, 157 
selected object, 14 
symbols, 109 
system test, 337 
text, 109 

Delete All, 109 
Delta 

function, 257 
interpretation, 494 
parameters, 189 

Dema 
function, 258 
parameters, 179 

Demand index, 459 
function, 258 
interpretation, 459 
parameters, 179 

Description 

chart or layout, 108 
open dialog, 68 

Detrended price oscillator 
function, 258 
interpretation, 460 
parameters, 179 

Di() function, 258 
Dialogs, how to use, 18 
Directional movement 

function, 258 
interpretation, 461 
parameters, 180 

Directional movement rating 
function, 258 

Display base security, 144 
Displayed, x-axis properties, 

119 
Divergence function, 258 
Division by zero, 317 
Division function, 259 
Doji function, 291 
Doji star function, 291 
Down price, color of, 151 
DownLoader 

collecting data, 51, 61, 228 
editing data, 152 
location of files, 33 
maintaining local 

securities, 50, 60 
Dpo() function, 258 
Drag and drop 

indicators, 165 
inner windows, 114 
price plots, 153 

Drawing toolbar, 207 
Dual Monitors, 39 
Dx() function, 258 
Dynamic momentum index 

parameters, 180 
Dynamic momentum index 

function, 259 
Dynamic momentum index 

interpretation, 462 

E 

Ease of movement 
function, 259 
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interpretation, 463 
parameters, 180 

Edit 
chart, 79 
custom indicators, 303 
data, 152 
indicator, 167 
inner windows, 111 
layout, 93 
line study, 208 
price plot, 146 
redo, 8 
template, 101 
undo, 8 

Edit layout dialog, 92 
Ellipse, parameters, 216 
E-mail 

alerts, 37, 430 
charts, 228 
MAPI, 228 
technical support, 5 
VIM, 228 

Emv() function, 259 
End date, line study, 210 
End value, line study, 210 
End-of-day data, 42 
Engulfing bullish line 

function, 291 
Enhanced System Tester, 

327 
Enhanced System Tester 

Tutorial, 320 
Envelope 

interpretation, 464 
parameters, 181 

Equis Data Server, 51, 52, 
56, 57 

Equity 
using from system test, 

361 
Equivolume 

displaying, 151 
interpretation, 464 

Error messages 
custom indicator, 238, 

251, 316 
expert advisor, 439 

Evening doji star function, 
291 

Evening star function, 292 
Excel 

creating an OLE link to, 9 
Excel, exporting to, 9, 11 
Exiting 

charts and layouts, 68 
MetaStock, 8 

Expert advisor 
alerts, 430 
attaching alerts, 435 
components of, 402 
copy, delete experts, 436 
highlights, 421 
printing, 436 
sample experts, 437 
symbols, 425 

Expert Advisor 
creating an expert, 400 
defined, 397 
dialog, 399 
tips, 438 

Expert(s) 
pre-packaged, 398 

Exploration status dialog, 
385 

Explorer 
copy, delete explorations, 

384 
creating an exploration, 

371, 379 
defined, 369 
dialog, 371, 377 
filter, 374, 381 
formula syntax, 381 
inspect button, 389 
lists of securities, 383 
location of files, 33 
multiple explorations, 387 
options, 378 
printing, 384 
reports, 388 
running, 385 
sample explorations, 393 
selecting securities, 382 
sort, 389 
speed of, 388 
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tips, 395 
tutorial, 370 

Exponent function, 260 
Exporting formula-based 

tools, 249 
Exporting, with clipboard, 8 
Extend line study, 210 

F 

Falling window function, 
292 

Fans 
Fibonacci, 217 

Fast fourier transform 
function, 260 

Favorites 
adding to, 71, 72 
clearing, 71, 72 
creating folders in, 71 
shortcut, 65, 67, 71, 383 

Fft()function, 260 
Fibonacci 

arcs, drawing tips, 216 
arcs, parameters, 216 
fans, drawing tips, 217 
fans, parameters, 217 
interpretation, 465 
plotting on equivolume, 

145 
retracements, drawing tips, 

217 
retracements, parameters, 

217 
time zones, parameters, 

217 
File name 

open template dialog, 101 
save dialog, 70 

File Server, 51, 53, 56, 57 
Files 

location of, 33 
Filter, Explorer, 374 
Filtering securities, open 

dialog, 68 
Find command, 74 
Find, help system, 30 

Find/replace, in 
commentary, 417 

First date 
security datasheet, 59 

Floor function, 260 
Fml() function, 246, 261, 

306 
fmlvar() function, 261 
Folder 

browse for folder, 59 
creating, 50 
security datasheet, 59 

Font 
automatically reduce, 135 
header/footer, 136 
symbol labels, 222 
text, 223 
y-axis properties, 119, 125 

Fonts 
dialog, 171 

Footer, printing, 135 
Forecast oscillator 

parameters, 181 
Forecast oscillator 

function, 261 
Forecast oscillator 

interpretation, 467 
Formula 

call function, 261 
organizer wizard, 249 
tips, 248 
variable call function, 261 

Formula call function, 306 
Fourier transform 

function, 260 
interpretation, 467 
parameters, 182 

Fraction function, 261 
Fractions 

displaying y-axis in, 124 
Frame/fill of text, 223 
Full Desktop, 39 
Full screen, 38 
Functions 

custom indicator, 237 
list of, 252 
pasting, 239, 305 
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Futures, adding with the 
symbol database, 48 

Futures, system testing, 364 

G 

Gamma 
function, 262 
interpretation, 495 
parameters, 189 

Gann studies 
interpretation, 468 
plotting on equivolume, 

145 
Gap down function, 262 
Gap up function, 262 
Glossary, custom indicator, 

249 
Gravestone doji function, 

292 
Gray checkboxes, 105 
Grids 

x-axis, 122 
y-axis, 126 

Group, symbol database, 46 

H 

Hammer function, 293 
Handicapped options, 17 
Hanging man function, 293 
Header, printing, 135 
Heading 

chart, 34, 104, 112 
contents, 108 
inner window, 105 

Hearing-impaired options, 
17 

Help 
contents screen, 29 
for Windows, 4 
index, 30 
indicator interpretation, 

174 
online, 29 
on-line, 4 
ways to get, 4 

Help system, 4 

Herrick payoff index 
function, 262 
interpretation, 470 
parameters, 183 

Hhv() function, 263 
Hide a line, 169 
High/low/close 

displaying, 151 
High/low/close bar 

interpretation, 470 
Highest bars ago function, 

263 
Highest function, 262 
Highest high function, 263 
Highest high value bars 

function, 263 
Highest since bars ago 

function, 264 
Highest since function, 263 
Highlights (expert) 

creating/editing, 422 
sample, 424 
tips, 425 
using, 421 
viewing, 423 

Historical data 
intraday, 58 

History 
clearing, 71, 72 
limiting size, 71, 72 
shortcut, 65, 67, 71, 383 

Holidays on charts, 35 
Horizontal line 

attached to indicator, 169 
drawing tips, 218 
parameters, 218 

Hot keys, for commentaries, 
414 

Hpi() function, 262 
HTML file, save as, 228 

I 
If function, 241, 264 
Implied volatility, 543 
Importing formula-based 

tools, 249 
Importing, with clipboard, 8 
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Inactivity stop, 335 
Indent custom indicator, 248 
Index, help system, 30 
Indicator 

color/style, 25, 169 
copying, deleting, moving, 

172 
custom, 299 
defined, 163 
horizontal line, 169 
modifying, 167 
parameters, 174 
plotting, 163 
properties, 167 
quicklist, 165 
viewing values, 174 

Indicator builder 
defined, 299 
dialog, 302 
tutorial, 300 

Indicator editor, 303 
Indicator guide, 441 
Indicators, dialog, 164 
Inertia 

interpretation, 471 
Inertia indicator 

interpretation, 471 
Inner windows 

closing, 116 
drawing a line study in, 

205 
modifying, 111 
moving, 114 
opening, 110 
plotting an indicator in, 

163 
splitter bar, 106 
title bar, 105 

Input function, 265, 365, 
382, 437 

Input() function, 306 
Inside function, 265 
Installing third party add-

ons, 249 
Integer function, 265 
IntelliMouse 

changing periodicity with, 
121 

scanning charts with, 83 
scrolling charts with, 86 
using, 87 
zoom scaling with, 128 

Interest rate, system tester, 
360, 363 

Internet, 227 
collecting data, 228 
company news, 232 
current quote, 231 
DataOnDemand, 228 
e-mailing charts, 228 
Equis on the Web, 234 
menu file, 230 
option chain, 232 
Quotes menu, 230 
Research menu, 232 
saving HTML files, 228 
shortcut menus, 229 
technical support, 5, 234 
www.equis.com, 4 

Interpretation 
on-line help, 174 

Intertia 
parameters, 183 

Intertia indicator 
function, 264 

Intraday data, 42 
Intraday momentum index 

parameters, 183 
Intraday momentum index 

function, 266 
Intraday momentum index 

interpretation, 472 
Invalid 

exponentiation, 317 
log, 317 
power, 317 

Invert scale 
y-axis properties, 125 

Inverted black hammer 
function, 293 

Inverted hammer function, 
293 

Invisible line style, 169 



 

 
 

556 • Index MetaStock Professional 

 

 

 

J 

Japanese candlesticks 
functions, 288 
interpretation, 450 
patterns, 288 

JPEG files, saving charts as, 
228 

K 

Kagi 
displaying, 151 
interpretation, 472 
parameters, 148 

Klinger oscillator 
function, 266 
interpretation, 473 
parameters, 184 

L 

Label symbols, 222 
Last date 

security datasheet, 59 
Last value function, 266 
Lastvalue function, 361 
Layout (printing), 134 
Layouts 

cascade, stack, tile, 93 
closing, 68, 96 
creating, 90 
definition, 63, 89 
deleting, 75 
displaying existing, 91 
editing, 92 
saving, 69, 95 

Learn as you plot, 86 
Life (option) 

interpretation, 495 
parameters, 189 

Life() function, 272 
Line 

horizontal, 218 
vertical, 225 

Line chart 
displaying, 151 
interpretation, 475 

Line study 

adjusting, copying, 
deleting, moving, 211 

color/style, 25, 210 
defined, 205 
drawing, 205 
modifying, 208 
parameters, 215 
parameters (common), 209 
properties, 208 

Line style toolbar, 25 
Linear regression indicator 

function, 267 
interpretation, 475 
parameters, 184 

Linear regression slope 
function, 267 
interpretation, 476 
parameters, 185 

Linear regression trendline 
channels, 478 
interpretation, 477 
parameters, 218 

Linear regression trendline 
channel 

parameters, 220 
Links, videos, 417 
Llv() function, 268 
Load options, 72 
Load periods, 80 
Loaded 

x-axis properties, 119 
Local securities 

maintaining, 50 
Logarithm function, 267 
Long legged doji function, 

293 
Long lower shadow 

function, 294 
Long upper shadow 

function, 294 
Look-up 

multiple securities, 47 
symbol, 59 

Lowest bars ago function, 
267 

Lowest function, 267 
Lowest low value bars 

function, 268 



 

 
 

MetaStock Professional Index • 557 

 

 

 

Lowest low value function, 
268 

Lowest since bars function, 
268 

Lowest since function, 268 

M 

MACD 
function, 269 
interpretation, 478 
parameters, 185 
sample custom indicator, 

309 
Major unit 

y-axis properties, 124 
Manual, user's, 4 
MAPI, 228 
Margin requirement, system 

tester, 363 
Margins, printing, 135 
Market facilitation index 

function, 269 
interpretation, 479 
parameters, 185 

Mass index 
function, 269 
interpretation, 480 
parameters, 186 

Maximize 
button, 16, 109 
chart, 109 
dual monitors, 39 
window, 16 

Maximum 
y-axis properties, 124 

Maximum function, 269 
Maximum loss stop, 335 
Mdi() function, 270 
Median price 

function, 269 
in moving average, 188 
interpretation, 481 
parameters, 186 
sample custom indicator, 

309 
Menu bar, 17 
Mesa lead sine function, 269 

Mesa sine wave 
function, 270 
interpretation, 482 

Mesa sine wave indicator 
parameters, 186 

MetaStock File Server, 51, 
53, 56, 57 

Mfi() function, 271 
Microsoft Windows support, 

4 
Midpoint function, 270 
Minimize 

button, 16, 109 
chart, 109 
window, 16 

Minimum 
y-axis properties, 124 

Minimum function, 270 
Minor unit 

y-axis properties, 124 
Minus directional movement 

function, 270 
Mistakes, undoing, 8 
Mo() function, 271 
Modulus by zero, 317 
Modulus function, 271 
Momentum 

function, 271 
interpretation, 482 
parameters, 186 
sample custom indicator, 

309 
Money flow index, 271 

interpretation, 483 
parameters, 187 

Month function, 271 
Monthly data, 60, 120 
Morning star function, 295 
Mouse, IntelliMouse, 87 
Move 

charts, 108 
indicator, 172 
inner windows, 114 
line study, 211 
price plot, 153, 154 

Moving average 
function, 271 
interpretation, 484 
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parameters, 187 
plotting, 163 

Mp() function, 269 
Multimedia, in 

commentaries, 415 
Multiple 

explorations, 387 
Multiplication function, 272 
Multi-plot custom 

indicators, 306 
Multi-plot formulas 

in experts, 437 
in explorations, 382 
in system tests, 365 

N 

Name, network user, 35 
Negative function, 272 
Negative square root, 317 
Negative volume index 

function, 272 
interpretation, 489 
parameters, 188 
sample custom indicator, 

309 
Network 

user name, 35 
using MetaStock on, 541 

New 
chart, 78 
dialog, 64 
layout, 90 
window, 80, 86, 93 

Next security, 83 
Not sign, 154 

O 

Object linking and 
embedding, 9 

Obv() function, 272 
ODDS probability cones 

interpretation, 490 
parameters, 219 

OLE, creating links, 9 
On balance volume 

function, 272 

interpretation, 492 
parameters, 188 
sample custom indicator, 

310 
On neck-line function, 295 
Online cache, 42, 43 

exploring, 395 
Online data 

DataOnDemand, 42, 228 
Online Data, 41, 42 

updating, 152 
using with Security Data 

function, 279 
Online Data Vendor 

options, 38 
shortcut, 65, 67, 71, 383 

Open 
apply template, 98 
charts, 7, 79 
inner windows, 110 
layout, 91 
multiple charts, 80 

Open dialog, speed of, 79 
Open interest, 45, 59 

interpretation, 494 
parameters, 188 

Open link, 10 
Open price, 45, 59 
Open template dialog, 100 
Open windows list, 16 
Open/open interest 

security datasheet, 59 
Operators, custom indicator, 

236 
Optimization 

example, 358 
reports, 326 
validity of, 359 
variables, 357 

Optimizing system tests, 324 
Option expiration 

function, 272 
interpretation, 495 
parameters, 188 

Option indicators 
interpretation, 494 
parameters, 189 

Option life function, 272 
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Option() function, 276 
Options 

accessibility, 17 
application properties, 31 
Explorer, 378 
handicapped, 17 
hearing-impaired, 17 
new dialog, 80 
system test, 338 
visually-impaired, 17 

OptionScope, 543 
location of files, 33 

Or operator, 241 
Organizer, formula, 249 
Orientation, printing, 137 
Oscp() function, 275 
Oscv() function, 285 
Other periodicity, 121 
Outside function, 273 
Overlaying price plots, 153 

P 

P data array identifier, 247 
Page number, on printout, 

136 
Page setup, 134 
Pager 

alerts, 37, 430 
settings, 37 

Paper size, 137 
Parabolic SAR 

function, 273 
interpretation, 496 
parameters, 190 

Parallel trendlines, 212 
Paste from clipboard, 8 
Paste functions, 239, 305, 

380 
Paste special, 9 
Pdi() function, 274 
Peak bars ago function, 273 
Peak value function, 273 
Performance 

function, 274 
interpretation, 497 
parameters, 190 
real-time collection, 57 

Period value out of range, 
396 

Periodicity 
changing with 

intellimouse, 87 
exploration, 380 
New Security dialog, 44, 

60 
New/Open dialog, 65, 68 
of chart, 120 
other, 121 
X-Axis Properties, 120 

Periods 
controlling number loaded, 

80 
Piercing line function, 295 
Plot-based indicator, 163 
Plus directional movement 

function, 274 
Point & figure 

displaying, 151 
interpretation, 497 
parameters, 149 

Pointer mode (equivalent), 
205 

Points only system testing, 
364 

Polarized fractal efficiency 
function, 274 
parameters, 190 

Positive volume index 
function, 274 
interpretation, 499 
parameters, 191 
sample custom indicator, 

310 
Power function, 274 
Precedence, operator, 236 
Precision function, 274 
Prev constant, 246 
Preview, print, 137 
Previous security, 83 
Price (option) 

interpretation, 495 
Price array identifiers, 235 
Price channel 

function, 275 
interpretation, 500 
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parameters, 191 
Price oscillator 

function, 275 
interpretation, 501 
parameters, 191 
sample custom indicator, 

310 
Price plot 

color/style, 25, 151 
copying, deleting, moving, 

153 
modifying, 146 
parameters, 147 
properties, 146 
viewing values, 158 

Price rate-of-change 
interpretation, 501 
parameters, 192 
sample custom indicator, 

310 
Price style quicklist, 146 
Price volume trend 

function, 275 
interpretation, 502 
parameters, 192 
sample custom indicator, 

310 
Print 

charts, 138 
custom indicators, 304 
expert, 436 
exploration, 384 
preview, 137 
reports, 355 

Printer 
selecting and configuring, 

133 
Projection bands 

interpretation, 503 
parameters, 192 

Projection bands bottom 
function, 275 

Projection bands top 
function, 276 

Projection oscillator 
function, 276 
interpretation, 504 
parameters, 192 

Prompt for dates, 80 
Put/Call price 

function, 276 
Pvi() function, 274 
Pvt() function, 275 

Q 

Qstick indicator 
function, 277 
interpretation, 505 
parameters, 193 

Quadrant lines 
interpretation, 506 
parameters, 220 

Quicklist 
controlling contents of, 

166 
displaying custom 

indicators in, 303 
icons defined, 163 
plotting an indicator, 165 

Quickstart Tutorials, 3, 4, 31 
Quitting MetaStock, 8 
Quotes 

current, 231 
internet shortcut menu, 

230 

R 

R squared indicator 
function, 277 
interpretation, 506 
parameters, 193 

Raff regression channels, 
220 

Rally function, 277 
Rally with volume function, 

277 
Random walk index 

function, 277 
parameters, 194 

Range indicator 
function, 278 
parameters, 194 

Rate of change function, 278 
Reaction function, 278 
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Reaction with volume 
function, 278 

Read-only data, 78 
Real-time 

configuration, 51 
data collection, 42, 43, 51 
margin, 122 
minimum system 

configuration, 2 
OLE, 11 
options, 36 
securities, 43 
updating commentaries, 

420 
Real-time data 

updating, 152 
Recent file list, 7 
Rectangle parameters, 220 
Redo, 8 
Reference function, 278 
Referencing custom 

indicators, 242 
Reject report, 392 
Relative momentum index 

function, 279 
parameters, 194 

Relative strength 
comparitive 

parameters, 195 
Relative strength index 

function, 279 
interpretation, 512 
parameters, 195 

Relative volatility index 
function, 279 
interpretation, 513 
parameters, 196 

Remove 
layout dialog, 90 
MetaStock from hard disk, 

3 
values in title bar, 105, 112 

Remove all 
layout dialog, 90 

Renko 
displaying, 151 
interpretation, 514 
parameters, 150 

Reports 
printing, 355 
system tester, 345 

Rescale y-axis, 86 
Research 

internet shortcut menu, 
232 

Reset 
zoom scaling, 128 

Restore button, 16 
Restore workspace on 

startup, 32 
Results report, 388 
Retain scale, x-axis 

properties, 119 
Retracements, Fibonacci, 

217 
Ribbon (expert) 

displaying, 404 
Right margin 

x-axis properties, 122 
Rising window function, 

295 
Rotate buttons, 207 
Round function, 279 
Rsi 

interpretation, 512 
parameters, 195 

Rsi() function, 279 
R-squared 

parameters, 197, 198 
Running Metastock, 3 
Running Multiple 

Explorations, 387 

S 

Sar() function, 273 
Save, 69 

charts, 81 
dialog, 69 
layout, 95 
template, 101 

Save all, 70 
Save as 

chart, 81 
template, 97 

Scale 
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changing with drag and 
drop, 126 

font, 119, 125 
invert, 125 
location, 127 
semi-log, 125 
x-axis properties, 118 
y-axis properties, 123 

Scaling Options dialog, 156 
Scaling, zoom, 128 
Screen 

allotting more space for, 
38 

Screentips, 20 
Scrolling charts, 85 
Search securities, 74 
Securities 

creating local, 43, 58 
referencing in custom 

formulas, 243 
Security 

base, 143 
create button, 60 

Security Data function, 243 
Security name 

new dialog, 65, 67, 383 
Select mode, 32, 207 
Select plot dialog, 206 
Selecting 

charts, 103 
printer, 133 

Self referencing formulas, 
246 

Selling pressure function, 
280 

semi-log scale, y-axis 
properties, 125 

Send command, 228 
Separating lines function, 

296 
Setup 

page, 134 
printer, 133 

Setup key, 3 
Shaven bottom function, 296 
Shaven head function, 296 
Shooting star function, 297 
Shortcut bar, 71 

Shortcuts 
custom toolbar, 21 

SIGs, Equis, 4 
Sine function, 280 
Size 

of charts, 109 
of inner windows, 113 
of paper, 137 

Smart chart 
defined, 77 
saving as chart, 78 

Snap to price, 210 
Sort 

exploration report, 389 
results report, 390 

Sound 
in alerts, 433 

Sound, 
in commentaries, 415 

Specific contracts, 48 
Speed of open dialog, 79 
Speed of program, 

increasing, 543 
Speed resistance lines 

interpretation, 515 
parameters, 220 

Spinning top function, 297 
Splitter bar 

inner window, 106 
resizing inner windows, 

114 
Spread 

parameters, 196 
Spreads, interpretation, 515 
Spreadsheets, exporting to, 

9, 11 
Square root function, 280 
Stack, layouts, 93 
Standard deviation 

function, 280 
interpretation, 516 
parameters, 196 
sample custom indicator, 

310 
Standard deviation channel 

parameters, 221 
Standard error 

function, 280 
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interpretation, 518 
parameters, 197 

Standard error bands 
interpretation, 518 
parameters, 197 

Standard error bands bottom 
function, 280 

Standard error bands top 
function, 281 

Standard error channel 
parameters, 221 

Start value, line study, 210 
Starting MetaStock, 3 
Status bar 

displaying/removing, 28, 
32 

drawing line studies, 207 
usage, 27 

Stdev() function, 280 
Stochastic momentum index 

function, 281 
interpretation, 520 
parameters, 197 

Stochastic oscillator 
function, 281 
interpretation, 521 
sample custom indicator, 

311 
Stochasticoscillator 

parameters, 198 
Stops 

system tester, 334 
Style 

of indicator, 169 
of line study, 210 
of price plots, 151 
of x-axis gridlines, 123 
of y-axis gridlines, 126 
setting defaults, 170 

Subtraction function, 281 
Summary report, 346 
Summation function, 281 
Support 

for custom formulas, 5, 
299, 319, 369, 397 

for MetaStock, 5 
for Microsoft Windows, 4 

Support/resistance, 523 

Swing index 
function, 281 
interpretation, 524 
parameters, 199 

Symbol 
database, 59 
security datasheet, 59 

Symbol database, 46 
Symbol Database 

add symbols, 65, 72 
creating custom symbol 

lists, 49 
creating futures contracts, 

48 
creating multiple 

securities, 47 
display, 72 
edit symbols, 72 
modifying, 49 
updating, 49 
using to create securities, 

46 
Symbol palette, 222 
Symbols 

deleting, 222 
drawing tips, 223 
labeling, 222 
parameters, 222 

Symbols (expert) 
creating/editing, 426 
tips, 430 
using, 425 
viewing, 428, 429 

System info, 541 
System menu, 14 
System test 

commissions, 360 
copying, deleting, 337 
creating, 320, 331 
defined, 319 
disk space, 364 
displaying reports, 323 
entering stops, 334 
interest, 360 
optimizing, 324 
options, 338 
reports, 345 
speed, 364 
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testing, 322 
tips, 359 
trading rule syntax, 365 

System tester 
dialog, 320, 327 
location of files, 33 
tutorial, 320 

T 

Tab, inserting in custom 
indicator, 248 

Technical support 
for MetaStock, 5 
for Windows, 4 

Tema 
function, 282 
parameters, 199 

Template 
default, 102 

Templates 
applying, 98 
creating, 97 
default, 78 
definition, 97 
deleting, 75 
editing, 101 
options menu, 72 
saving, 101 

Text 
drawing tips, 223 
parameters, 223 

Theta 
function, 282 
interpretation, 496 
parameters, 189 

Thick lines, printing, 137 
Thickness, of price plot, 151 
Three black crows function, 

297 
Three line break 

displaying, 151 
interpretation, 526 
parameters, 150 

Three white soldiers 
function, 297 

Ticker symbols 
entering in datasheet, 59 

mixed case, 32 
Tile 

charts, 15 
Tile, layouts, 93 
Time 

on printout, 136 
on status bar, 27 

Time series forecast 
function, 282 
interpretation, 527 
parameters, 199 

Time zones, Fibonacci, 217 
Tip of the day, 3 
Tirone levels 

drawing tips, 224 
interpretation, 528 
parameters, 223 

Title bar 
chart, 34, 104 
contents, 108 
inner window, 105, 112 

Toolbar 
chart, 24, 34, 105 
color, 25 
custom, 21 
dialog, 20 
drawing, 207 
floating/docking, 26 
line style, 25 
removing/displaying, 20 
rotate buttons, 207 
using, 19 

Trade volume index 
function, 283 
interpretation, 528 
parameters, 200 

Trailing stop, 336 
Trend (expert) 

corner, 405 
diplaying ribbon, 404 
tips, 406 

Trend (Expert) 
defining, 403 

Trendline 
angles, interpretation, 530 
drawing by angle, 224 
interpretation, 529 
parameters, 224 
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Trendline by angle 
drawing tips, 224 
parameters, 224 

Triangle 
parameters, 224 

TRIX 
function, 283 
interpretation, 531 
parameters, 200 

Trough bars ago function, 
283 

Trough value function, 283 
Tsf() function, 282 
Tutorials 

Explorer, 370 
Indicator builder, 300 
Quickstart, 3, 4, 31 
System tester, 320 

Tvi() function, 283 
Tweezer bottoms function, 

298 
Tweezer tops function, 298 
Typical price 

function, 283 
in moving average, 188 
interpretation, 532 
parameters, 201 

U 

Ultimate oscillator 
function, 283 
interpretation, 532 
parameters, 201 

Undo, 8 
uninstalling MetaStock, 3 
Up one level button, 73 
Up price, color of, 151 
Update link, 10 
Updating 

MetaStock, 228 
symbol database, 49, 228 

User groups, Equis, 4 
User info, 35 
User name, 35 
User's manual, 4 

V 

Value when function, 284 
Variables 

in experts, 437 
in explorations, 382 
in system tests, 365 
referencing, 246 
using in formulas, 244 

Variance function, 284 
Vega 

function, 284 
interpretation, 496 
parameters, 189 

Vertical horizontal filter 
function, 284 
interpretation, 533 
parameters, 201 

Vertical line 
drawing tips, 225 
parameters, 225 

Vhf() function, 284 
Video 

in alerts, 433 
in commentaries, 415 

VIM, 228 
Visually-impaired options, 

17 
Volatility 

implied, 543 
option, 496 

Volatility (Chaikin's) 
function, 285 
interpretation, 533 
parameters, 201 
sample custom indicator, 

311 
Volatility (option) 

function, 285 
parameters, 189 

Volume 
interpretation, 534 
parameters, 202 

Volume oscillator 
function, 285 
interpretation, 535 
parameters, 202 
sample custom indicator, 

311 
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Volume rate-of-change 
interpretation, 536 
parameters, 203 
sample custom indicator, 

311 

W 

WAV file in alerts, 433 
Wc() function, 285 
web site, www.equis.com, 4 
Weekends 

on charts, 35 
Weekly data, 60, 120 
Weight, of price plot, 151 
Weighted close 

function, 285 
interpretation, 537 
parameters, 203 
sample custom indicator, 

312 
What's this command, 31 
White body function, 298 
Wilder's smoothing 

interpretation, 537 
Williams' %R 

function, 286 
interpretation, 538 
parameters, 203 
sample custom indicator, 

312 
Williams' accumulation/dist 

function, 286 
interpretation, 539 
parameters, 204 
sample custom indicator, 

312 
Williams, Bill, 479 
Windows 

chart list, 16 
standard features, 7 

Windows 98 
dual monitors, 39 

Write text, 223 
Writeif() function, 286, 408 
Writeval() function, 286, 

409 

X 

X-axis 
displaying/removing, 107 
gridlines, 122 
properties, 118 

Y 

Y-axis 
font, 119, 125 
gridlines, 126 
invert, 125 
location, 107 
on status bar, 27 
properties, 123 
rescale, 86 

Year function, 287 
Yearly data, 120 

Z 

Zig zag 
function, 287 
in system tester, 360 
interpretation, 539 
parameters, 204 

Zoom 
box, 128 
in, 128 
out, 128 
reset, 128 

Zoom scaling, 128 

 


